Copyright Notice

This software product and accompanying documentation are copyrighted and all rights reserved by Institute for Scientific Information. Please refer to the accompanying ProCite End User License Agreement for a specification of the terms and conditions governing the use of this product.

Disclaimer of Warranty

This software and manual are sold "as is" and without warranties as to performance or merchantability. The seller's salespersons may have made statements about this software. Any such statements do not constitute warranties and shall not be relied on by the buyer in deciding whether to purchase this program.

This program is sold without any express or implied warranties. Because of the diversity of conditions and hardware under which this program may be used, no warranty of fitness for a particular purpose is offered. The user is advised to test the program thoroughly before relying on it, and must assume the entire risk of using the program. Any liability of seller or manufacturer will be limited exclusively to product replacement or refund of the purchase price. In no event shall ISI ResearchSoft, or anyone else who has been involved in the creation and production of this computer software be liable for indirect, special or consequential damages, such as but not limited to, loss of anticipated profits or benefits resulting from the use of this program. Some states do not allow the exclusion or limitation of incidental or consequential damages, so the above limitation may not apply.

Trademarks

ProCite, Reference Manager, EndNote, Biblio-Link, and Reference Web Poster are registered trademarks of Institute for Scientific Information. Cite while you write is a trademark of Institute for Scientific Information. Microsoft, Windows, and Windows NT are registered trademarks of Microsoft Corporation. Apple and Macintosh are registered trademarks of Apple Computer, Inc. Corel and WordPerfect are registered trademarks of Corel Corporation. All other brand and product names may be trademarks or registered trademarks of their respective companies.
Chapter 1: Introduction
Overview of ProCite ................................................................. 19
ISI ResearchSoft ................................................................. 20
Registration ............................................................................. 20
Troubleshooting ........................................................................ 20
   Help Online ........................................................................ 20
   Technical Support .................................................................. 21
Using This Manual ..................................................................... 22
Key Concepts ........................................................................... 23
New Features in ProCite 5 ......................................................... 24

Chapter 2: Installing and Upgrading
Overview ..................................................................................... 25
Hardware and Software Requirements ......................................... 26
Installing ProCite ........................................................................ 27
   Single User Installation ......................................................... 27
   Network (Multi-User) Installation .......................................... 28
      Network Program Installation ............................................. 28
      Network User Installation ................................................ 29
   Keeping Local Copies of Lists, Styles and Databases .......... 29
   Sharing Databases ............................................................... 30
Installing "Cite While You Write" Support ................................. 30
   Word for Windows ............................................................... 31
   WordPerfect for Windows ................................................... 32
   Word for the Macintosh ....................................................... 33
Upgrading from ProCite, Reference Manager, or EndNote .......... 34
   Converting Files .................................................................. 35
   Converting Databases and Workforms ................................. 35
   Converting ProCite Punctuation Files and Lists .................. 36
   Converting Configuration Files .......................................... 37
Deleting Old Files ...................................................................... 37
Installed Files and Their Locations ............................................. 38
   Default Installation Folders ................................................. 38
   Program Files ....................................................................... 39
   System Files ......................................................................... 40
   Database Files ....................................................................... 40
   Workforms ............................................................................ 41
   List Files ............................................................................... 41
   Output Styles ........................................................................ 42
Chapter 3: Using ProCite: A Guided Tour

Overview ........................................................................................................ 45
Getting Started .......................................................................................... 46
  Online Help ............................................................................................... 46
  Opening an Existing Database ................................................................. 47
Navigating a ProCite Database .................................................................. 49
  Customizing the Record List to Display Fields ........................................ 49
  Click Sorting on a Column Heading ........................................................ 52
  Using the Preview Pane to View a Reference ........................................... 52
  Using “Go To” Commands to Find References ....................................... 54
  Drag and Drop Between Databases ........................................................ 54
Entering Records ........................................................................................ 55
  Importing Records from a Saved Text File .............................................. 56
  Searching and Importing Records Directly from an Online Database ........................................................................ 57
  Capturing Web Page Information (Windows Only) .................................. 62
  Linking a Reference to a Web Page or File ............................................. 64
  Entering and Editing ProCite References .............................................. 64
  Configuring Duplicate Checking ............................................................ 68
Searching and Sorting a Database ............................................................. 69
  Quick Searching for Records with the Terms Tab .................................. 69
  Creating a Search Strategy ....................................................................... 70
  Saving a Search Strategy .......................................................................... 74
  Creating a Group ....................................................................................... 74
  Selecting the Sort Order .......................................................................... 75
    Pre-configured Sort Options ................................................................... 75
    Custom Sorts ......................................................................................... 76
Generating Bibliographies .......................................................................... 77
  Creating a Bibliography from a Record list ............................................. 77
  Creating a Bibliography with Subject Headings ...................................... 79
Preparing a Manuscript and Bibliography ............................................... 81
  Opening a Word Processing Document ................................................... 81
    The Tools Menu and ProCite Toolbar .................................................. 82
  Identifying References to Cite ................................................................. 82
  Preparing the Bibliography and Final Manuscript ................................... 85
  Closing the Document and Exiting ProCite .............................................. 86
Chapter 4: Creating, Opening, Sharing, and Managing Files

Overview............................................................................................ 87
Starting ProCite .................................................................................. 88
Creating or Opening a Database ........................................................ 88
  Creating a Database .................................................................... 89
  Opening a Database .................................................................... 90
    Multiple Users Opening a Single Database ............................. 91
Opening a Database from an Earlier Version ............................... 92
Setting Program Options .................................................................... 93
  General Display Settings ............................................................ 94
    File Locations ........................................................................ 94
      Databases ........................................................................ 95
      Workforms ....................................................................... 95
      Output Styles .................................................................... 95
      Lists ................................................................................ 96
    Search Expressions .............................................................. 96
    Internet Search Settings ............................................................ 96
  Default Database Settings ........................................................... 97
    Record Numbering .............................................................. 97
    Duplicate Detection ............................................................. 98
    Sorting ............................................................................. 99
Closing Files ...................................................................................... 99
Backing Up Files ............................................................................... 99
Renaming Files ................................................................................ 100
Deleting Files ................................................................................... 100
Sharing Files .................................................................................... 101
  ProCite Program ....................................................................... 101
    Databases ........................................................................ 101
    Workforms ....................................................................... 102
    Output Styles .................................................................... 103
    List Files ........................................................................ 104
  Search Expressions ................................................................... 104
  Internet Search Configurations ................................................. 104
  Word Processor Files ................................................................ 105
Cross-Platform Compatibility ............................................................ 106
  File Sharing .......................................................................... 106
    Sharing Files Created with ProCite for Windows ............. 106
    Sharing Files Created with ProCite for the Macintosh ..... 107
  Character Mapping ................................................................. 107
    Macintosh to Windows Character Mapping ..................... 107
    Windows to Macintosh Character Mapping ................. 108
Damaged Files .................................................................................... 108
Rebuilding a Database .............................................................. 109
When to Rebuild a Database ..................................................... 109
  Reclaiming Disk Space ....................................................... 109
  Repairing a Damaged File .................................................. 110
  Rebuilding a Database .......................................................... 111
Leaving ProCite ........................................................................ 112

Chapter 5: Viewing Records
Overview ................................................................................ 113
Viewing Abbreviated Records: The Record Lists .................... 114
  Displaying All Records ....................................................... 116
  Displaying Marked Records ............................................. 116
  Displaying Search Results .................................................. 116
  Displaying with Field Content Lists ................................... 117
    Authors ..................................................................... 117
    Journals .................................................................... 118
    Titles ......................................................................... 118
    Keywords .................................................................... 119
    Displaying by Workform ............................................... 119
  Displaying Groups ............................................................. 119
  Displaying Duplicate Records ......................................... 120
Changing the Record List Display .......................................... 120
  The Default Display .......................................................... 120
  Setting a Custom Display .................................................. 121
    Selecting the Fields .................................................... 121
    Setting Column Headers ............................................. 122
    Selecting Visible Fields .......................................... 122
    Saving Changes to the Display .................................... 122
    Resizing the Column Widths ....................................... 123
  Changing the Display Font and Style .................................. 123
  Sorting the Display ............................................................ 123
Viewing Full Records ............................................................ 124
  Configuring the Edit Record View ..................................... 125
  Viewing Multiple Records .............................................. 126
Moving Between Records ....................................................... 127
Viewing Formatted References .............................................. 129
Viewing Bibliographies .......................................................... 130
Chapter 6: Entering and Editing Records

Overview ................................................................. 133
Inserting and Opening Records ........................................... 134
  Inserting a Record .................................................... 134
  Opening an Existing Record ........................................ 136
Copying Records .............................................................. 137
Deleting Records .............................................................. 138
Selecting a Workform ................................................... 138
  Pre-defined vs. User-defined Workforms ...................... 139
Changing the Workform Setting ..................................... 139
  New Record .............................................................. 139
  Existing Record .......................................................... 140
Changing the Record Display ........................................ 141
Entering and Editing Data In Records .............................. 142
  General Rules .............................................................. 142
Special Field Rules .................................................... 143
  Special Formatting Characters ..................................... 144
  Author Names ............................................................. 144
  Dates ....................................................................... 146
  Keywords ................................................................. 148
Editing Keys ............................................................... 149
Inserting Special Characters ........................................ 150
Applying a Font, Style, or Size ....................................... 150
Changing the Record ID ................................................. 151
Field Length .................................................................. 151
Finding and Replacing Text .......................................... 152
Attaching Files, URLs, and UIs ...................................... 152
ProCite’s Lists ............................................................ 153
  Types of Lists .............................................................. 153
    Field Content Lists .................................................. 153
    Term Lists .............................................................. 153
    Journal Title Lists ................................................... 153
    Alternate Text Lists .................................................. 154
  Using Lists ................................................................. 154
    Entering Text with Lists .......................................... 155
    Modifying Lists .......................................................... 156
Copying Text ............................................................... 156
  Copying and Pasting Text ............................................ 156
  Copying Fields from the Previous Record ...................... 157
Saving or Ignoring Changes ......................................... 157
Chapter 7: Entering Data Field-by-Field

Overview ........................................................................................................ 159
General Data Entry ....................................................................................... 160
Locating Fields by Field Number ................................................................. 161
Abstract Field (43) ..................................................................................... 163
Address/Availability Field (37) ................................................................. 163
Author Fields (01), (07), (16), (30) ......................................................... 164
Author Affiliation Field (03) ..................................................................... 167
Author Role Fields (02), (08), (17), (31) ................................................. 168
Call Number Field (44) .......................................................................... 169
CODEN Field (39) ................................................................................... 169
Connective Phrase Fields (06), (36) ....................................................... 170
Date Fields (12), (20), (21) ..................................................................... 170
Document Type Field (35) ................................................................... 174
Edition Field (15) .................................................................................... 174
Extent of Work Field (26) ..................................................................... 174
ISBN Field (41) ....................................................................................... 175
ISSN Field (40) ......................................................................................... 175
Issue ID Fields (24), (34) ....................................................................... 175
Keywords Field (45) ............................................................................. 175
Location in Work Field (25) ................................................................... 176
Location/URL Field (38) ....................................................................... 178
Medium Designator Fields (05), (14) ................................................... 178
Notes Field (42) ..................................................................................... 179
Packaging Method Field (27) ................................................................. 180
Place of Meeting Field (13) ................................................................... 180
Place of Publication Field (18) ............................................................... 181
Publisher Name Field (19) .................................................................. 181
Record ID Field ....................................................................................... 181
Report ID Field (23) ............................................................................. 182
Reprint Status Field (12) ....................................................................... 182
Reproduction Ratio Field (29) ............................................................... 182
Size Field (28) ....................................................................................... 183
Title Fields (04), (09), (10), (11), (32) .................................................. 183
Volume ID Fields (22), (33) ................................................................. 185

Chapter 8: Choosing a Workform

Overview ........................................................................................................ 187
Locating the Available Workforms ........................................................... 188
Setting the Workform for a New Record .................................................. 188
Changing the Workform for Existing Records ......................................... 189
  Changing the Workform for a Single Record ....................................... 190
  Changing the Workform for Multiple Records ................................... 191
Selecting an Appropriate Workform ................................................ 192
Relationship between Workforms and Output Styles ............... 193
Common Workform Choices .................................................... 194
Choosing Workforms for Journal and Book Entries ............... 197
  Journal Entries ................................................................. 197
  Book Entries ............................................................... 198

Chapter 9: Importing Records
  Overview .......................................................................................... 199
  Importing Tagged Records ............................................................... 200
    The Tagged Records .................................................................. 200
    Basic Procedure ........................................................................ 201
  Importing Delimited Records .......................................................... 203
    Basic Procedure ........................................................................ 203
    Preparing a Delimited Import File ............................................. 205
      Field Format ...................................................................... 205
      Field Order ......................................................................... 206
    Setting Import Options ............................................................. 209
      Comma Delimited .................................................................. 210
      Tab Delimited ....................................................................... 211
      Custom Delimited .............................................................. 212

Chapter 10: Global Editing
  Overview .......................................................................................... 215
  Global Edit ....................................................................................... 216
  Global Find and Replace .............................................................. 218
  Global Change Workform ............................................................. 220
  Global Move Field ................................................................. 221

Chapter 11: Sorting Records
  Overview .......................................................................................... 223
  The Available Sort Orders ............................................................. 224
  Selecting a Sort Order for Display ................................................... 224
  Selecting a Sort Order For Printing ................................................. 225
  Creating a Custom Sort Order ......................................................... 226
    Basic Procedure ........................................................................ 226
    Selecting the Fields ................................................................... 227
    Setting Ascending or Descending Order ................................... 228
  Sorting Special Field Data ............................................................. 229
    Sorting Empty Fields .................................................................. 229
    Sorting Author Names ............................................................. 230
    Sorting Dates ........................................................................... 230
  Character Sorting by Language ..................................................... 230
  Changing the Language Setting ................................................... 230
  How the System Specific Sort Affects Database Sharing ....... 232
How ProCite Sorts ................................................................. 233
Sort Levels .............................................................................. 233
Alphabetic Sorting ................................................................. 234
Numeric Sorting ....................................................................... 234
Symbol Removal ..................................................................... 235
Date Sorting ............................................................................ 235
Call Number Sorting ............................................................. 236
Empty Field Sorting .............................................................. 236
Using Stop Lists ........................................................................ 237
The Available Stop Lists ......................................................... 237
Generic Stop List ..................................................................... 237
Author Stop List ..................................................................... 238
Changing the Stop Lists ......................................................... 238

Chapter 12: Detecting Duplicate Records
Overview .................................................................................. 241
Detecting Duplicates During Data Entry ..................................... 241
Searching the Database for Duplicates ....................................... 242
Setting Duplicate Record Criteria ............................................. 243

Chapter 13: Searching and Finding Records
Overview .................................................................................. 247
Finding a Single Record .......................................................... 248
Quick Searching with Field Content Lists ............................... 249
Highlighting Records ............................................................... 250
Marking Records ....................................................................... 250
Searching a Database ............................................................. 252
Performing a Search ............................................................... 252
- Narrowing a Search ............................................................. 254
Elements of a Search Expression .............................................. 254
- Search Term ........................................................................ 255
- Field Identifiers .................................................................. 256
- Operators .......................................................................... 257
Creating Search Expressions .................................................. 262
- Building a Search Expression .............................................. 262
- Saving a Search Expression ............................................... 265
- Restoring a Saved Search Expression ................................. 266
- Editing a Saved Search Expression ..................................... 266
- Deleting a Search Expression ............................................. 267
- Renaming a Search Expression .......................................... 267
Sample Search Expressions .................................................... 268
- Finding a Search Term .......................................................... 268
- Finding Multiple Search Terms ......................................... 268
- Finding Dates ..................................................................... 269
- Finding Record IDs ............................................................ 270
- Finding Empty and Not Empty Fields ................................. 270
Finding the Last Records Entered .......................................... 270
Chapter 14: Saving Records in Groups
Overview ................................................................. 271
Creating a Group ......................................................... 272
  Saving Search Results .............................................. 272
  Saving Any Set of Records ....................................... 272
Using a Group ............................................................. 273
  Viewing or Printing Records in a Group ...................... 274
  Marking Records from a Group ................................. 274
  Searching a Group .................................................... 275
Deleting a Group .......................................................... 275
Modifying a Group .......................................................... 275
  Adding or Removing Records ................................. 276
  Renaming a Group ...................................................... 276

Chapter 15: Internet Capabilities
Overview ................................................................. 277
Searching and Importing from the Internet ................. 278
  Connecting to Host Servers ....................................... 278
    Dial-up Internet Connections ................................ 278
    Testing the Servers ................................................. 279
    Allowing Access Through Firewalls ....................... 281
Selecting Z39.50 Sites to Search .............................. 284
Searching Z39.50 Internet Sites or PubMed ..................... 286
Saving or Discarding Search Results ......................... 289
Creating and Managing Search Expressions ................. 290
  Creating a Search Expression ................................ 290
  Saving a Search Expression .................................... 291
  Restoring a Search Expression ................................. 293
  Editing a Saved Search Expression ......................... 293
  Deleting a Search Expression .................................. 293
  Renaming a Search Expression ................................ 293
Setting Internet and PubMed Search Options ............... 294
Configuring ProCite to Search Z39.50 Sites ..................... 296
  Adding or Modifying Z39.50 Host Configurations .......... 296
  Adding or Modifying Database Configurations ............. 298
Importing Web Pages (Windows Only) ....................... 302
Including URLs and UIs in Records ............................ 303
Printing to HTML Files ............................................ 304
Copying References to Email Messages ...................... 305
  Copying via the Clipboard .................................... 305
  Copying from the Preview Pane ............................... 305
  Copying from a Disk File ......................................... 306
Chapter 16: Cite While You Write

Overview ................................................................. 307
Word Processor Notes ..................................................... 308
  Microsoft Word for Windows or Macintosh ................. 309
    Field Codes ............................................................ 309
  Converting Word 6 or 7 documents to Word 97
    (Windows Only) ...................................................... 310
  WordPerfect for Windows ............................................. 311
    Windows Registry .................................................... 311
    Style Additions ...................................................... 311
    Field Codes ............................................................ 311
  Other Word Processors ................................................ 311
Linking Citations to ProCite Records ................................. 312
  Forms of Citations in the Manuscript ............................ 312
  Inserting Citations ..................................................... 313
    Basic Procedure .................................................... 313
  Scanning for Existing Citations .................................... 314
    Basic Procedure .................................................... 315
  Matching Inappropriate Items ...................................... 317
  Inserting Marked Records from ProCite ......................... 318
  Including Citations in Footnotes or Endnotes .................. 318
  Matching Multiple Records ......................................... 319
  Recalling a Previous Search ........................................ 320
  Unformatted Citations ............................................... 320
Generating a Bibliography .................................................. 321
  Basic Procedure ..................................................... 322
  Changing the Bibliography Layout ................................. 324
    Output Style .......................................................... 324
  Adding an Independent Reference to the Bibliography .... 326
  Using a Variable Citation Format .................................. 326
  Generating a Bibliography from Multiple Documents ....... 327
Entering Identifying Text ................................................... 328
  Entering Author Names .............................................. 330
    Single Authors .................................................... 330
    Multiple Authors .................................................. 330
    Compound Names .................................................. 331
    Repeated Authors .................................................. 331
    Corporate Authors .................................................. 332
  Entering Titles ......................................................... 332
  Entering Dates ......................................................... 332
    Date Ranges .......................................................... 333
  Entering Record IDs ................................................... 333
  Entering Multiple Citations ......................................... 334
  Entering Additional Text ............................................. 334
  Adding Commands to Identifying Text ............................ 335
Contents

Changing Linked Citations .............................................................. 335
  Editing Citations ....................................................................... 335
  Reverting to Original Text ........................................................ 336
  Moving or Copying Citations ................................................... 336
  Deleting Citations ..................................................................... 337
  Adding Citations Later ............................................................. 337

Associating ProCite Databases ........................................................ 337
  Changing the Database Association .......................................... 337
  Working with Linked Records in ProCite ................................. 338
  Making Changes to the ProCite Database ................................ 338

Using Other Word Processors .......................................................... 339
  Inserting Author-Date Citations ................................................ 339
  Inserting Numbered Citations ................................................... 339
  Generating a Bibliography ........................................................ 340

Chapter 17: Printing Bibliographies

Overview .......................................................................................... 341

Previewing and Printing a Simple Bibliography ............................ 342
  Basic Preview and Print Procedure ........................................... 342
  Printing to Catalog Cards .......................................................... 344
  Previewing Formatted References ............................................ 345
  Printing to the Clipboard .......................................................... 346

Setting Up Your Bibliography .......................................................... 346
  Reference List Settings ............................................................. 347
    Output Style ....................................................................... 348
    Reference List Title ........................................................... 348
    Reference List Order ......................................................... 348
    Numbering References ...................................................... 349
    Indentation ......................................................................... 350
    Line Spacing ...................................................................... 351
  Field Suppression or Substitution ............................................. 352
    Optional Fields .................................................................. 352
    Short Form ......................................................................... 353
    Alternate Text .................................................................... 353

Page Layout .............................................................................. 354
  Font and Size Settings ........................................................... 354
  Margins .............................................................................. 354
  Page Numbers ....................................................................... 355

Saving Your Bibliography Settings .............................................. 355
  Simple Bibliography ............................................................... 355
  Subject Bibliography .............................................................. 355
  Bibliography from a Manuscript ............................................... 356
Printing a Subject Bibliography ....................................................... 356
  Basic Procedure ........................................................................ 357
  Subject Bibliography Settings .................................................. 360
    Printing a Subject List or a Subject Bibliography ............. 360
    Including Subject Term Counts or Record IDs ................. 361
    Sorting the Subject Terms .................................................. 362
    Inserting Space or Text Around Subject Terms ................. 363
    Applying Styles .................................................................. 363
  Examples of Subject Bibliographies ......................................... 364
    Using Author Names as Subject Headings ..................... 364
    Using Keywords as Subject Headings ............................... 365
    Cross Referencing Subject Headings ............................... 365
    Using Call Numbers as Subject Headings ......................... 366

Chapter 18: Building List Files
  Overview .................................................................................. 367
  Creating Term Lists and Journal Lists ........................................ 368
    Description of the List Formats .......................................... 368
      Term Lists .......................................................................... 368
      Journal Title Lists .......................................................... 369
    Opening a List ....................................................................... 370
      Creating a New List .......................................................... 370
    Opening an Existing List .................................................... 370
    Entering, Editing, or Deleting Items ................................... 371
    Importing Items from a Text File ....................................... 372
      Creating the Text File ....................................................... 372
      Importing the File ............................................................ 376
    Styled Text in a List ............................................................ 377
  Creating an Alternate Text List ............................................... 377

Chapter 19: Printing Lists
  Overview .................................................................................. 379
  Printing a Subject List .......................................................... 379
  Printing an Indexed Subject List ............................................ 384
  Printing a Field Content List .................................................. 386
  Printing a Term List or Journal Title List ............................... 387
  Printing an Alternate Text List ............................................... 387

Chapter 20: Using Alternate Text
  Overview .................................................................................. 389
  Substitution with Journal Title Lists ...................................... 390
    Building a Journal Title List ................................................ 390
    Inserting ProCite Records ..................................................... 390
    Using a Journal Title List for Substitution ......................... 391
    Applying Styles .................................................................. 393
Substitution with Alternate Text Lists .............................................. 393
Building the Alternate Text List .................................................... 393
Preparing the ProCite Records ...................................................... 394
Activating the Alternate Text List ................................................... 394
Applying Styles ............................................................................ 396

Chapter 21: Record IDs and Renumbering
Overview .......................................................................................... 397
Using Record IDs ............................................................................. 397
Assigning Record IDs .............................................................. 398
  Automatic Numbering ........................................................... 398
    Changing the Settings for New Databases .................. 399
    Changing the Record Number Increment .................. 400
  Manual Numbering ............................................................. 400
Duplicate Record IDs ............................................................ 401
Renumbering Records .................................................................... 401

Chapter 22: Creating and Modifying Workforms
Overview .......................................................................................... 403
When to Create a Workform ............................................................ 404
  Special Document Types ....................................................... 404
  Relationship to Output Styles .............................................. 404
Implications of Modifying Workforms ............................................ 405
  Changing the Workform Definition .................................. 405
  Renaming a Workform ....................................................... 406
Creating or Modifying a Workform ................................................. 406
  Opening the Workform .......................................................... 406
    Basing a New Workform on an Existing Workform ...... 406
    Opening a New Blank Workform ................................. 407
    Editing an Existing Workform ...................................... 408
  Selecting the Fields .............................................................. 408
    Assigning Field Names .................................................... 409
    Saving the Workform ....................................................... 409
Sharing Workforms .......................................................................... 410
Deleting Workforms ........................................................................ 411
Selecting the Appropriate ProCite Fields ......................................... 411
  Fields and Their Default Names ......................................... 412
Special Fields ............................................................................. 412
  Author Fields ...................................................................... 413
  Date Fields .......................................................................... 413
  Call Number Field ............................................................. 413
  Keywords Field .................................................................... 414
  Location in Work Field ...................................................... 414
  Title Fields .......................................................................... 414
Selecting the Field Numbers ......................................................... 414
Chapter 23: Creating and Modifying Output Styles

Overview ........................................................................................................ 417
How Output Styles Work ........................................................................... 418
Creating and Modifying Output Styles ..................................................... 418
  Creating a New Output Style ................................................................. 419
  Modifying an Output Style ................................................................... 421
  Deleting an Output Style ...................................................................... 422
  Renaming an Output Style .................................................................... 422
Defining In-Text Citation Formatting ....................................................... 422
  Basic Procedure .................................................................................. 423
Numeric Citations .................................................................................... 425
  Citation Number Order ..................................................................... 426
  Delimiters and Separators .................................................................. 426
  Number Ranges .................................................................................. 427
Author-Date Citations ............................................................................. 428
  Delimiters, Separators, and Sorting ................................................... 429
  Author Formatting ............................................................................. 430
  Other Special Fields Formatting ........................................................ 432
  Including Page Numbers .................................................................... 432
Footnotes ..................................................................................................... 432
Defining Bibliography Formatting ............................................................ 433
  Basic Procedure .................................................................................. 433
Defining Workform Styles ....................................................................... 435
  Basic Procedure .................................................................................. 436
Inserting and Deleting Fields ................................................................. 438
  Inserting a Field ................................................................................ 438
  Deleting a Field .................................................................................. 439
Inserting Punctuation ............................................................................. 440
  Preceding and Following Punctuation ................................................ 441
  Suppressing Extraneous Punctuation ................................................ 443
  Applying Punctuation to Groups of Fields ......................................... 444
Inserting Additional Text ......................................................................... 445
Inserting Formatting Characters ............................................................. 446
  New Lines and New Paragraphs ........................................................... 446
  Blank Lines ....................................................................................... 447
  Page Breaks ....................................................................................... 448
  Tabs ................................................................................................. 448
Applying Type Styles ................................................................................ 449
Formatting Special Fields ........................................................................ 450
  Basic Procedure .................................................................................. 451
  Author Formatting ............................................................................. 452
  Author List ....................................................................................... 453
  Separators ......................................................................................... 457
  Name Formatting ............................................................................... 458
  Field Dependent Preceding and Following Text ................................. 461
Title Formatting ................................................................. 462
Journal Title Formatting ...................................................... 464
Date Formatting .................................................................. 465
Page Numbering ................................................................. 468
  Field Dependent Preceding and Following Text ............... 468
  Page Range Formats ...................................................... 469
Keywords ........................................................................... 469

Chapter 24: Exporting Delimited Records
Overview ............................................................................. 471
Basic Procedure .................................................................... 471
Setting Export Options ........................................................ 474
  Comma Delimited ............................................................. 475
  Tab Delimited .................................................................... 476
  Custom ............................................................................. 477

Appendix A: Troubleshooting .................................................. 481
Appendix B: ProCite Workforms and Fields ......................... 487
Appendix C: The ProCite Toolbars ........................................... 501
Appendix D: Keyboard Commands ......................................... 511
Index .................................................................................. 515
Chapter 1
Introduction

Overview of ProCite

Contents

ISI ResearchSoft ................................................................. 20
Registration ................................................................. 20
Troubleshooting ............................................................. 20
   Help Online ............................................................. 20
   Technical Support ...................................................... 21
Using This Manual ......................................................... 22
Key Concepts ................................................................ 23
New Features in ProCite 5 ................................................. 24

Welcome to ProCite® from ISI ResearchSoft! Whether you are a researcher, a writer, a librarian, an information scientist, a student, a film critic, or a consumer who wants to keep track of information from the Internet or your video or CD collection, ProCite provides a complete solution.

Information is only useful if you can find it when you need it. With a variety of supplied workforms (fill-in-the-blank templates) for data entry and formatted output, ProCite helps you control reference information. Reference information can originate from sources such as online databases, CD-ROM, library automation systems, electronic mail, and more.

Easily edit your references, and instantly search for and retrieve information. Easily format, to your exact requirements, sorted lists such as bibliographies, publication lists, acquisition lists, catalogs, or directories. Link ProCite with your word processor and you can cite references in reports or papers and automatically generate a bibliography.

ProCite efficiently manages large databases containing thousands of variable length records, and encompasses many different types of material. Unlike a general purpose database program, no database design or programming is required.
ISI ResearchSoft

ISI ResearchSoft is dedicated to developing software programs that radically improve productivity by making it easier for you to access and manage reference information. ISI ResearchSoft works with information suppliers to ensure the accurate transfer of information into ProCite.

We offer compatible software for both Microsoft® Windows® and the Apple® Macintosh® in stand-alone and networked environments, allowing great flexibility in the sharing of information.

Registration

Please register your copy of ProCite. Sign and return the product registration card included with your ProCite package or register from our website at http://www.procite.com. As a registered user you automatically qualify for product support.

Register soon so we can notify you about product enhancements and offer special pricing on product upgrades. Remember to notify us of address changes.

Troubleshooting

If you have a problem, first check Appendix A: Troubleshooting and the online Help topics. If those do not answer your questions, contact ISI ResearchSoft’s Technical Support.

Help Online

You can get online help in several ways:

- Select Help from the menu bar to find a topic. Browse the Content list or Index, or Search for a term.

- Most ProCite dialogs include a Help button; click on it to see information related to your current activity.

- Display a context-sensitive help topic by pressing the F1 key (Windows) or the help key (Macintosh).
Technical Support

Technical support is available to all registered users, Monday through Friday from 8:00 A.M. to 5:00 P.M. Pacific Time. When calling for technical support, please use a phone near your computer and have your serial number available. Look for your serial number on the CD envelope or inside the front cover of the manual.

To contact technical support:

Mail: ISI ResearchSoft
800 Jones Street
Berkeley, CA 94710
USA

Phone: +01 (510) 559-8592
Fax: +01 (510) 559-8683
WWW: http://www.procite.com

Email: Windows Technical Support: pc-procite@isiresearchsoft.com
Macintosh Technical Support: mac-procite@isiresearchsoft.com
Customer Service: info@isiresearchsoft.com

From Europe, please contact:

Mail: ISI ResearchSoft
Brunel Science Park, Bldg 1
Brunel University
Uxbridge UB8 3PQ
UK

Phone: +44 1895-813544
Fax: +44 1895-237-313
Using This Manual

This manual describes ProCite for Windows and ProCite for the Macintosh. While the screen examples show ProCite for Windows, everything is essentially the same on both platforms — including menu items and dialog boxes.

When a command, file, or folder name differs between the two platforms, both are included. For example:

To start the installation program, double-click on **Setup** (Windows) or **Install ProCite 5** (Macintosh).

Remember to use the table of contents at the front of the manual and/or the index at the back of the manual. A glossary is included in the online help.

Throughout this manual:

- Menu names, menu items, and buttons are in a bold typeface.
- ProCite field names and workforms are in italics.
- Examples are in the sans serif Helvetica font.

Many menu items in ProCite have a corresponding keyboard equivalent and/or a toolbar icon. The keyboard equivalent appears on the menu next to the associated command. You can turn toolbars on or off from the **View** menu, and hold the cursor over a toolbar icon to find out the corresponding command. Keyboard equivalents and toolbar icons are listed in the appendices, and you can use them at any time.

A right-click (Windows) or control-click (Macintosh) in the program displays a context-sensitive menu. Although this manual does not mention the context-sensitive menus, you can use them at any time.
Key Concepts

ProCite organizes information in databases, which contain records. Each record is represented by a workform, which contains up to 45 fields.

Databases

A database is a structured collection of information. A bibliographic reference database could contain information such as authorship, publication date, and physical description for a variety of works like books, journal articles, and audiovisual materials. ProCite can:

• store data for multiple types of work (such as journals, books, and video recordings)

• import data from a variety of sources (such as data disks, online information services, or manual entry)

• create bibliographies from multiple output formats (to conform to the bibliographic requirements of numerous publications)

Records

A record is the basic unit of a database. In ProCite, each record is a unique collection of information specific to one book, journal, musical score, etc. ProCite handles variable-length records, so you are not limited to a particular length for each record (or even each field).

Workforms

A workform is a fill-in-the-blanks form used to help organize the information in each record. ProCite includes predefined workforms that handle the most common works (such as journals and books). You can modify the predefined forms and create additional workforms. For a list of the workforms supplied with ProCite, see Appendix B: ProCite Workforms and Fields.

Fields

A field is a portion of a record that contains information of a single type (for example, a title or a date). Each field is indicated by a field name such as “Author” or “Title” and a field number. You can identify a field by the name, the number, or its contents.

By entering each type of information in a separate field, you can easily find information. It also allows you to output each field of information in any order, which gives ProCite great flexibility in creating bibliographies.
New Features in ProCite 5

ProCite 5 incorporates the following enhancements.

**Interface enhancements:**

- Easily move between various lists of records with the new tabbed record lists.

**Internet enhancements:**

- Quickly search PubMed and Z39.50 databases on the Internet from within ProCite and seamlessly import the search results.

**Cite while you write enhancements:**

- *Cite while you write* with Word 2000 or WordPerfect 9, in addition to the versions already supported.

- Locate unlinked citations.

- Display full ProCite records when selecting a record from multiple matches.

- Re-display a list of records to choose another citation for insertion. Select from a list of the previous 10 searches.

**Formatting enhancements:**

- When generating an HTML file, URLs automatically become “hot” links.

- Apply styles to citation numbers.

- Define a unique in-text citation format for each workform to allow accurate footnote formatting.

- Define a second format for subsequent in-text citations from the same source.

- While creating or editing output styles, view a preview of the current workform definition.

- When selecting an output style from a file dialog, view a preview of formatted output using that style.

**Sorting enhancements:**

- These additional languages have been added to the international sort options: Czech, Polish, and Russian (Cyrillic).

- Sort using the Windows system language setting.
Chapter 2
Installing and Upgrading

Overview

Contents

Hardware and Software Requirements ................................. 26
Installing ProCite ................................................................ 27
  Single User Installation .............................................. 27
  Network (Multi-User) Installation ................................. 28
    Network Program Installation ................................. 28
    Network User Installation ........................................ 29
Keeping Local Copies of Lists, Styles and Databases 29
Sharing Databases ..................................................... 30
Installing "Cite While You Write" Support ....................... 30
  Word for Windows .................................................. 31
  WordPerfect for Windows ......................................... 32
  Word for the Macintosh ........................................... 33
Upgrading from ProCite, Reference Manager,
or EndNote ...................................................................... 34
  Converting Files ..................................................... 35
    Converting Databases and Workforms ....................... 35
    Converting ProCite Punctuation Files and Lists ........ 36
    Converting Configuration Files ............................... 37
Deleting Old Files ........................................................ 37
Installed Files and Their Locations ................................. 38
  Default Installation Folders .................................... 38
  Program Files ......................................................... 39
  System Files ............................................................. 40
  Database Files ........................................................ 40
  Workforms ............................................................... 41
  List Files ................................................................ 41
  Output Styles .......................................................... 42
  Word Processor Files ................................................. 42
    Windows ............................................................... 42
    Macintosh .............................................................. 43
Configuration Files and Download Files ......................... 43
  Internet Configuration Files ...................................... 43
Uninstalling ProCite 5 ..................................................... 44
This chapter covers single user and network installation procedures for the ProCite program and includes a section about upgrading. It also lists and describes installed files.

# Hardware and Software Requirements

To install and run ProCite, your computer and system software must meet the following minimum requirements under Windows or on a Macintosh:

## Windows

- 486 or later (Pentium recommended) personal computer or compatible
- Microsoft® Windows® 95/98 (or later) or Windows NT 4 (or later)
- 16 megabytes available memory (32 recommended)
- 30 megabytes available disk space for the full installation of ProCite
- CD-ROM drive for installation
  (please contact ISI ResearchSoft if you require 3.5 inch disks)
- Microsoft Word 7.x, 97, or 2000, or WordPerfect 7.x, 8.x, or 9 to cite while you write (optional)
- Internet connection for online database searching (optional)

## Macintosh

- Power Macintosh or compatible (120 MHz recommended)
- Apple Macintosh System 7.5 or later (7.5.5 or later recommended)
- 16 megabytes available memory (32 recommended)
- 30 megabytes available disk space for the full installation of ProCite
- monitor with minimum 16 grays or 256 colors, 640 x 480 or larger
- CD-ROM drive for installation
  (please contact ISI ResearchSoft if you require 3.5 inch disks)
- Microsoft Word 6 or 98 to cite while you write (optional)
- Internet connection for online database searching (optional)
Installing ProCite

Before you begin, quit from any open applications, screen savers, etc. to prevent conflicts and give the installer room to work.

Note: Make sure you have your ProCite 5 serial number available. You will be asked to enter this number during the installation process. Look on the registration card, on the CD envelope, inside the front cover of the manual, or on the bottom of the ProCite box.

To install, you need the ProCite installation CD. Insert the installation CD. The installation program may start automatically. If it doesn’t, run Setup (Windows) or Install ProCite 5 (Macintosh). Follow the instructions on your screen. The amount of time it takes will depend upon the speed of your computer.

By default, the installer places ProCite in the folder “Program Files\ProCite5” (Windows) or "ProCite 5 Folder" (Macintosh) so as not to interfere with earlier versions.

For more detailed installation instructions, read one of the next two sections: Single User Installation or Network (Multi-User) Installation.

Single User Installation

Before you begin, quit from any open applications, and find your ProCite 5 serial number.

To install the single user version of ProCite:

1. Insert the ProCite CD into your CD-ROM drive.

2. Under Windows, the installation program should start automatically. If the installation program doesn’t start automatically, double-click on Setup (Windows) or Install ProCite 5 (Macintosh).

3. Follow the instructions on your screen.

   Before installing files, the installation program displays:
   - A Readme file that may contain late-breaking news about the installation process or the ProCite program itself
   - A license agreement which details terms of use
   - A form requesting that you enter your ProCite 5 serial number.

When done, the installation program closes and returns you to the desktop.
For a description of installed files, see *Installed Files and Their Locations* later in this chapter.

Start ProCite by double clicking the ProCite 5 icon. Under Windows, you can go to the **Start** menu, select **Programs**, then **ProCite 5**, and then the **ProCite** icon.

## Network (Multi-User) Installation

The multi-user version of ProCite is licensed for a particular number of users. You can install ProCite on a shared network for simultaneous use, or you can install ProCite locally for each of the licensed users.

**Note:** Accessing ProCite from a network server can be quite slow for Macintosh users. We recommend that Macintosh users install locally.

A network administrator should first install the ProCite program on the network. The installation includes program files, workforms, journal title lists, output styles, configuration files, and sample databases. Then the administrator, or each user, must install system files and word processor files on each local machine.

### Network Program Installation

**To install ProCite on a server or other networked drive:**

1. Put the ProCite CD in your CD-ROM drive.

2. Under Windows, the installation program should start automatically. If the installation program doesn’t start automatically, double-click on **Setup** (Windows) or **Install ProCite 5** (Macintosh).

3. Follow the instructions on your screen.

   Before installing files, the installation program displays:
   
   • A Readme file that may contain late-breaking news about the installation process or the ProCite program itself
   
   • A license agreement which details terms of use
   
   • A form requesting that you enter your ProCite 5 serial number.

4. When asked, indicate the network drive and folder where you wish to install ProCite. The default folder is **ProCite5** (Windows) or **ProCite 5 Folder** (Macintosh). If the folder you specify does not exist, ProCite creates it.
All ProCite files install on the network in the folders defined by the installation program. If you need more information about the files that are installed, see the *Installed Files and Their Locations* section later in this chapter.

You will need to install certain system files and word processor files on individual user machines as described in the next section.

**Network User Installation**

**Notes:** You need full access (read and write privileges) to Microsoft Word’s Startup folder in order to install *cite while you write* support for Word.

**To install required system files and optional word processor files on individual user machines:**

1. From the local machine, go to the ProCite program folder on the network drive.

2. Double-click to start the Netsetup program found in the ProCite folder. Follow the onscreen directions.

   The Netsetup program installs the required system files, word processor files for Microsoft Word if it is installed, word processor files for WordPerfect if it is installed, and ProCite icons for your desktop.

If you install Word or WordPerfect at a later date, you can manually install word processor support as described later in this chapter.

If any of the required system files are absent from the System folder, ProCite will either not start up at all or will display an error message during startup. If this happens, run the ProCite installation program from that particular machine. The ProCite installation program checks the System folder for required files, and adds those that are missing.

**Keeping Local Copies of Lists, Styles and Databases**

You may want to copy journal title lists, output styles, and the Sample Database to your local machine. Copy the files from the network installation of ProCite to your machine.

You will need to indicate the appropriate file folders the first time you run ProCite if you have changed the installation folders from the default settings or when you want to use local files. In ProCite, select **Options** from the **Tools** menu and click on the **File Locations** tab. Select the appropriate drive and folder for each product component and click **OK**.
ProCite will remember the new settings for your machine unless you change them again. If you do not set preferences, ProCite will always look for files in the default ProCite folders.

**Sharing Databases**

When sharing databases on a network, you can run into several multi-user situations:

- Any number of users can open the same database with read-only access. You may want to place the database in a read-only folder to make sure the database is always available to multiple users.

- One user at a time can open a database with read-write access. If a user already has a database open with read-write access, ProCite will tell other users that the database is already in use. The database is not available to others until the user with read-write access closes it.

- If a database is in use by someone, with either read-write or read-only access, you will not be able to open the database with read-write access.

- If you want to share a ProCite for the Macintosh database with a ProCite for Windows user, add the extension .PDT to the primary database file name.

**Installing "Cite While You Write" Support**

*Cite while you write* support for your word processor is added automatically during ProCite's installation. However, if you installed your word processor *after* installing ProCite, or the ProCite 5 commands do not appear on your word processor's Tools menu, you can install the *cite while you write* files.

Under Windows, you can run one of these files to install support:

**Single User:** In the ProCite program folder, run Cwyw Setup.exe.

**Network User:** In the ProCite program folder, run NetSetup.exe.

If these setup programs do not install *cite while you write* support correctly, you need to manually install support. See one of the following sections:

- Word for Windows
- WordPerfect for Windows
- Word for the Macintosh
Word for Windows

To manually install support for Word, copy the appropriate files (listed below) from ProCite’s CWYW folder to Word’s Startup folder (for each copy of Word). The Word startup folder is typically:

C:\Program Files\Microsoft Office\Startup\n
This folder can also be specified in Microsoft Word’s “Tools:Options:File Locations” dialog. Check the folder location before copying any files.

Note: You need full access (read and write privileges) to Word's startup folder in order to install cite while you write support.

Microsoft Word 7.x

Word 7 is installed with Microsoft Office 95. Copy these files from ProCite’s CWYW folder to the Microsoft Word 7.x Startup folder:

- Pc5wd32.wll
- Pc5wd7.dot

Microsoft Word 97 or Microsoft Word 2000

Copy these files from ProCite’s CWYW folder to the Microsoft Word 97 or Microsoft Word 2000 Startup folder:

- Pc5wd32.wll
- Pc5wd8.dot

After installing the required files, exit and restart any copies of Word that are currently running. When you start Word, ProCite 5 commands appear on the Tools menu.
WordPerfect for Windows

The required WordPerfect files are located in ProCite’s CWYW folder. You need to tell WordPerfect where to find the files.

To add cite while you write support manually for WordPerfect 7.x, 8.x, or 9:

1. Run Regedit.exe, which should be located in the Windows folder.

2. Navigate to:

   **For WordPerfect 7.x:**
   HKEY_CURRENT_USER\Software\Perfect Office\WordPerfect\7\Third Party

   **For WordPerfect 8.x:**
   HKEY_CURRENT_USER\Software\Corel\WordPerfect\8\Third Party

   **For WordPerfect 9:**
   HKEY_CURRENT_USER\Software\Corel\WordPerfect\9\Third Party

3. Insert a new string value named DLL#, where # is a number from 1 to 16. Set the new string value’s data to:

   **For WordPerfect 7.x:**
   C:\Procite5\CWYW\PC5WP7.dll

   **For WordPerfect 8.x:**
   C:\Procite5\CWYW\PC5WP8.dll

   **For WordPerfect 9:**
   C:\Procite5\CWYW\PC5WP9.dll

   Make sure you identify the correct path if you installed ProCite in a folder other than the default.

4. Exit Regedit.

5. Restart WordPerfect. The cite while you write commands should now be available from the Tools menu, under a ProCite submenu.
Word for the Macintosh

ProCite's installation program looks for the default Word startup folders to automatically install *cite while you write* support. However, if you installed Word in a folder other than the default, installed Word after installing ProCite, or find that ProCite 5 commands do not appear on Word's **Tools** menu, you must manually install *cite while you write* files.

**Note:** You need full access (read and write privileges) to Word's startup folder to install *cite while you write* support.

**Microsoft Word 6**

Copy these files from ProCite’s CWYW folder to the Word 6 Startup folder:

- ProCite 5 Word Add-in
- ProCite 5 Word 6 Add-in.dot

The Word 6 Startup folder is typically:

- System Folder/Preferences/Word Startup Folder(6)

**Microsoft Word 98**

Copy these files from ProCite’s CWYW folder to the Word 98 Startup folder:

- ProCite 5 Word Add-in
- ProCite 5 Word 98 Add-in.dot

The Word 98 Startup folder is typically:

- Microsoft Office 98/Office/Startup/Word

After installing word processor support, you need to exit and restart any copies of Word that are currently running. When you start Word, ProCite commands appear on the **Tools** menu.
Upgrading from ProCite, Reference Manager, or EndNote

Install ProCite 5 as described at the beginning of this chapter. Do not replace your existing bibliographic software by installing in the same folder. Even if you are a current user of ProCite, do a completely new installation of the program.

This version of ProCite, Windows or Macintosh, can convert data from various ProCite or Reference Manager databases or EndNote libraries:

- ProCite for Windows, all versions
- ProCite for the Macintosh, all versions
- ProCite for DOS, version 1.2 or later
- Reference Manager for the Macintosh, all versions
- Reference Manager for DOS or Windows, version 5.x or later
- EndNote, versions 2.x and 3.x

**Note:** Reference Manager version 6.x or 7.x users must first update databases with Reference Manager version 8 or later before converting to ProCite for the Macintosh.

The conversion creates *copies* of original files; make sure you have twice as much free disk space available for the copy as is used by the original file. The original files are not changed, and you can delete them after you verify the successful conversion.

This section explains how to convert databases, workforms, lists (formerly called authority lists), and output styles (formerly called punctuation files) from earlier versions of ProCite. It also describes how to delete your old bibliographic program once ProCite is installed and your files have been converted.

We recommend that you retain your previous bibliographic software application until you are sure that your files are successfully converted. Once your files are all successfully converted, you can uninstall your old bibliographic program.
Converting Files

You can easily convert databases created with ProCite, Reference Manager, or EndNote. If you are converting ProCite databases, you can also convert output styles (punctuation files) and lists.

Converting Databases and Workforms

Back up your ProCite, Reference Manager, or EndNote database before you begin. Then, make sure you have enough space on your hard disk for a new database that could be up to twice as large as the original database. ProCite reads the old database and creates a copy of it in the new file format.

To convert databases and workforms:

1. Start ProCite.
2. From the Tools menu, select Convert File to display a file dialog.
3. In the List Files of Type drop-down list, select All Files.
4. Locate and highlight the old database name in the file dialog, and click Open to convert it. ProCite asks whether it is okay to convert the file.
5. When you click Yes to start file conversion, ProCite displays a file dialog.
6. Type a name for the new database, select the appropriate folder for the new database (typically ProCite’s Database folder) and click Save to start the conversion.

If you created custom workforms with an earlier version of ProCite, they are converted along with your data. You may be prompted during the conversion to verify field mapping for custom workforms. For instance, ProCite now uses field 10 specifically for journal titles. Move all journal title information to field 10; move other types of information in field 10 to an unused field.

ProCite reads the database file and creates a new ProCite database from it. You cannot use the new database with earlier versions of ProCite.

Caution: Do not delete your old database until you have opened the new copy with ProCite 5 and checked to make sure the database is intact.
The ProCite program folder includes these text files which describe how records translate to ProCite 5:

<table>
<thead>
<tr>
<th></th>
<th>Windows</th>
<th>Macintosh</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference Manager for the Macintosh</td>
<td>RM2toPC.rtf</td>
<td>RM2-to-PC</td>
</tr>
<tr>
<td>Reference Manager for Windows</td>
<td>RM8toPC.rtf</td>
<td>RM8-to-PC</td>
</tr>
<tr>
<td>EndNote</td>
<td>ENtoPC.rtf</td>
<td>EN-to-PC</td>
</tr>
</tbody>
</table>

**Converting ProCite Punctuation Files and Lists**

If you have been using only the predefined lists and output styles (known as punctuation files in some earlier versions of ProCite), don't bother converting any of them. Simply use the updated versions installed with ProCite.

**Note:** Before converting these files, first convert your databases. ProCite cannot accurately convert a punctuation file until all workforms are converted and available.

Follow the following procedure for punctuation files and then do it again for lists.

**To convert punctuation files or lists for use with ProCite 5:**

1. Start ProCite 5.
2. From the Tools menu, select Convert File to display an Open File dialog.
3. In the List Files of Type box, select All Files.
4. Locate and highlight any punctuation file (with the extension .PNC) or List (with the extension .LST).
5. Click Open, and ProCite asks whether to convert the file.
6. When you click Yes to start file conversion, ProCite displays a file dialog.
7. In the file dialog, enter a name for the file, choose the appropriate ProCite folder (Styles or Lists), and click Save to save the new file to disk.

When converting a punctuation file, ProCite may ask you to map old workforms to new workforms. Map each workform appropriately.
When converting punctuation files or output styles, ProCite automatically translates *Journal Title (09)* to *Journal Title (10)* for the journal workforms. If field 10 is already listed to print for a journal workform, ProCite prompts you for an alternate field number.

8. After a file is converted, the new copy is left open in ProCite. You can edit the file or simply close it from ProCite.

**Converting Configuration Files**

ProCite 5 uses configuration files to import tagged records. You can create or modify configuration files with Biblio-Link II (Biblio-Link II is installed in your ProCite folder).

If you use only the predefined configuration files, you don't need to do anything at all — those files have been updated and installed in ProCite's **Config** folder.

No conversion is necessary to use configuration files created or modified with earlier versions of Biblio-Link II. Simply copy your custom configuration files to ProCite’s **Config** folder.

ProCite 5 uses field 10 for journal titles (versions prior to ProCite 4 stored journal titles in field 09). ProCite adjusts for that when importing data, so information directed to field 09 in a journal workform is automatically sent to field 10.

If your configuration file is set up to send journal titles to field 09 and some other information to field 10, we recommend that you redirect journal titles to field 10 and the other information to an unused ProCite field. If you do not modify the configuration file, ProCite will prompt you for the appropriate field mapping during record transfer.

**Deleting Old Files**

Once you have converted all of your ProCite, Reference Manager, or EndNote files to the new ProCite 5 format, you can delete the old files.

**Note:** Do not delete anything, especially databases, until you are sure your data transferred correctly and your new databases are in ProCite 5’s **Database** folder.

Under Windows, later versions of ProCite, Reference Manager, and EndNote include an Uninstall program. If an Uninstall program is available in the program folder, use Uninstall to remove the program rather than deleting it manually.
If an Uninstall program is not available, or the Uninstall program did not delete all files, you can manually remove the old files. Open the old program folder and move any files you wish to save. When you are certain you want to delete all files from the old ProCite, Reference Manager, or EndNote folder, you can simply delete the entire folder.

### Installed Files and Their Locations

This section describes installed ProCite files. The files are grouped into several components:

- Program Files
- System Files
- Sample Databases
- Workforms
- Journal Title Lists
- Output Styles
- Word Processor Files
- Configuration Files
- Download Files

### Default Installation Folders

These are the default installation folders:

<table>
<thead>
<tr>
<th>Windows</th>
<th>Default Folder</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Component</strong></td>
<td><strong>Default Folder</strong></td>
</tr>
<tr>
<td>ProCite Program</td>
<td>Program Files\ProCite5</td>
</tr>
<tr>
<td>System Files</td>
<td>Windows System Folder</td>
</tr>
<tr>
<td>Databases</td>
<td>Program Files\ProCite\Database</td>
</tr>
<tr>
<td>Workforms</td>
<td>Program Files\ProCite\Forms</td>
</tr>
<tr>
<td>Journal Title Lists</td>
<td>Program Files\ProCite\Lists</td>
</tr>
<tr>
<td>Output Styles</td>
<td>Program Files\ProCite\Styles</td>
</tr>
<tr>
<td>Word Processor Files</td>
<td>Program Files\ProCite\CWYW and appropriate word processor folder</td>
</tr>
<tr>
<td>Import Configuration Files</td>
<td>Program Files\ProCite\Config</td>
</tr>
<tr>
<td>Download Files</td>
<td>Program Files\ProCite\Download</td>
</tr>
<tr>
<td>Internet Configuration Files</td>
<td>Program Files\ProCite\BkwrAPI</td>
</tr>
</tbody>
</table>
Macintosh

<table>
<thead>
<tr>
<th>Component</th>
<th>Default Folder</th>
</tr>
</thead>
<tbody>
<tr>
<td>ProCite Program</td>
<td>ProCite 5 Folder</td>
</tr>
<tr>
<td>System Files</td>
<td>System Folder and Extensions Folder</td>
</tr>
<tr>
<td>Sample Databases</td>
<td>ProCite 5 Folder\Database</td>
</tr>
<tr>
<td>Workforms</td>
<td>ProCite 5 Folder\Forms</td>
</tr>
<tr>
<td>Journal Title Lists</td>
<td>ProCite 5 Folder\Lists</td>
</tr>
<tr>
<td>Output Styles</td>
<td>ProCite 5 Folder\Styles</td>
</tr>
<tr>
<td>Word Processor Files</td>
<td>ProCite 5 Folder\CWYW and appropriate word processor folder</td>
</tr>
<tr>
<td>Import Configuration Files</td>
<td>ProCite 5 Folder\Config</td>
</tr>
<tr>
<td>Download Files</td>
<td>ProCite 5 Folder\Download</td>
</tr>
<tr>
<td>Internet Configuration Files</td>
<td>Program Files\ProCite 5\BkwrAPI</td>
</tr>
</tbody>
</table>

The installation program creates these folders and installs all files. If you change the installation folders from the default settings, or you want to use additional files from another folder, you need to indicate the appropriate folders the first time you run ProCite. In ProCite, select Options from the Tools menu and click the File Locations tab. Enter the drive and path name for each product component and click OK. ProCite remembers the settings for your machine until you change them, and lists files found in the default ProCite folders as well as the folders indicated here.

Program Files

The ProCite program folder contains the ProCite program and help file, the Biblio-Link II program and help file, a Readme file, the Uninstall program, and various other files. As the ProCite program is updated, filenames may change slightly and new files may appear.

The Readme file contains late-breaking news about installation and operation of the program. You can read the Readme file within the installation program or you can open and read it with any word processor.

ProCite5 (Windows) or ProCite 5 (Macintosh) starts the ProCite program. Blink2 (Windows) or Biblio-Link II (Macintosh) starts the Biblio-Link II program for creating and editing configuration database files, which are used to import data from other bibliographic database sources.
If the help file is deleted or moved, you will not be able to access the ProCite help topics. You can delete the help file, ProCite5.hlp (Windows) or ProCite 5 Help (Macintosh), to save space.

Uninstall removes the entire ProCite program.

System Files

Several System files are required to run ProCite. Most of these files are already present and used by other programs. The installation program checks for the required files and installs them in your System folder if they are not already available.

If any of the required files are deleted or moved from the System folder, ProCite will either not start up at all or will display an error message during operation. You can reinstall ProCite in order to restore system files.

Database Files

Each ProCite database you create is made up of two files. The first file contains the text of your database, and the file with the extension .PDX contains indexes for locating and sorting records. Both files are required in order to use the database. You can create any number of ProCite databases, and should save them in ProCite’s Database folder.

We ship two sample databases for you to work with to learn the program:

<table>
<thead>
<tr>
<th>Windows</th>
<th>Macintosh</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample Database.PDT</td>
<td>Sample Database</td>
</tr>
<tr>
<td>Sample Database.PDX</td>
<td>Sample Database.PDX</td>
</tr>
<tr>
<td>Turtles.PDT</td>
<td>Turtles</td>
</tr>
<tr>
<td>Turtles.PDX</td>
<td>Turtles.PDX</td>
</tr>
</tbody>
</table>

Chapter 3: *Using ProCite: A Guided Tour* walks through the basic features of ProCite with the Sample Database.

After experimenting with the sample databases by modifying, adding, or deleting records, copy fresh versions from the ProCite CD.

If you add significant data to a sample database, please save a copy of the database with a new name. Anyone reinstalling ProCite could replace your file.
Workforms

Workforms are the “fill-in-the-blank” forms used to enter data. We supply at least the workforms listed in Appendix B: ProCite Workforms and Fields. You can modify the supplied workforms and create any number of additional workforms.

Workforms are stored in ProCite’s Forms folder. Under Windows, the files include the extension .PWF. If you want to use only a few of the available workforms, you can delete the other workforms from the Forms folder. That way the entire list will not appear each time you choose a workform for record insertion. You can later copy workforms from the ProCite CD if you change your mind.

Beware of deleting or changing the predefined workforms, especially if you will be sharing data with colleagues.

If you are using ProCite from a network server, you can use the Windows Explorer or Macintosh Finder to apply a Read Only attribute to the Forms folder. This prevents anyone from modifying the workform files.

List Files

Journal title lists and term lists are used to simplify and control data entry and searching. Journal title lists can also be used to substitute text on output. We supply at least the journal title lists below. You can modify these lists or create any number of custom lists.

<table>
<thead>
<tr>
<th>Filename</th>
<th>Description of Journal Title List</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chemical</td>
<td>1000+ Chemistry Journals with CASSI abbreviations</td>
</tr>
<tr>
<td>Medical - Full</td>
<td>9000+ Medical Journals with Index Medicus abbreviations; inserts full journal names in records and substitutes abbreviations when used for output</td>
</tr>
<tr>
<td>Medical - Abbrev</td>
<td>9000+ Medical Journals with Index Medicus abbreviations; inserts abbreviated journal names in records and substitutes full names when used for output</td>
</tr>
<tr>
<td>Humanity</td>
<td>2000+ Humanity Journals with MLA abbreviations</td>
</tr>
</tbody>
</table>

Lists are stored in ProCite’s Lists folder. Under Windows, the files include the extension .PJL.

If you do not find these lists helpful, you can delete them to release disk space.
Output Styles

Output styles make it possible to print your records in a variety of bibliographic styles. We supply many widely-used output styles. You can modify any of these, and you can create any number of additional output styles. You can check for new output styles at our web site: http://www.procite.com.

Output styles are stored in ProCite’s Styles folder. Under Windows, the files include the extension .POS. If you use only a few of the available output styles, you can delete the others from the Styles folder. That way the entire list will not appear each time you choose an output style for formatting. If you change your mind, you can copy output styles from the ProCite CD.

Word Processor Files

Word processor files installed by ProCite enable the cite while you write feature. When you start your word processor, ProCite commands appear on the Tools menu.

If you installed your word processor after installing ProCite, you must manually install the ProCite word processor files as described earlier in this chapter.

When you link citations in a manuscript, ProCite is launched. If you move the ProCite program, make sure you start ProCite before you begin inserting citations.

If you run ProCite off a network, and the network is down, you cannot cite while you write because ProCite must be available.

Windows

Microsoft Word

These files are placed in the appropriate Microsoft Word Startup folder:

Word 7.x:   Pc5wd32.wll and Pcwd7.dot
Word 97 and Word 2000:  Pc5wd32.wll and Pcwd8.dot
WordPerfect

These files are placed in ProCite’s CWYW folder:

**WordPerfect 7.x:** Pc5wp7.dll and Pc5wp7.wpt  
**WordPerfect 8.x:** Pc5wp8.dll and Pc5wp8.wpt  
**WordPerfect 9:** Pc5wp9.dll and Pc5wp9.wpt

WordPerfect also requires that you direct the program to these files. The installation program does this automatically, or you can do it manually as described earlier in this chapter.

Macintosh

The installer places word processor files in Microsoft Word's Startup folder as well as the ProCite 5 Folder/CYWY folder. These files are placed in the default Microsoft Word Startup folder:

**Word 6:** ProCite 5 Word Add-in  
ProCite 5 Word 6 Add-in.dot  

**Word 98:** ProCite 5 Word Add-in  
ProCite 5 Word 98 Add-in.dot

Configuration Files and Download Files

The Import Text tool in ProCite uses configuration files to parse tagged text from various diskette, CD, and online sources and transfer the records into appropriate ProCite workforms and fields. Configuration files are stored in ProCite’s Config folder. You can create or modify any number of configuration files with Biblio-Link II. Under Windows, configuration files include the file extension .CFG.

Several download files are also included with ProCite, and are found in the Download folder. These files are included as examples to help you learn how to import tagged records into a ProCite database.

Internet Configuration Files

The Internet Search feature uses configuration files to direct search results into appropriate ProCite workforms and fields. Configuration files used for Internet searching are stored in ProCite’s BkwrAPI folder. You can create or modify any number of configuration files with Biblio-Link II. Under Windows, these files include the file extension .CFG. Several Internet configuration files are included with ProCite.
Uninstalling ProCite 5

Before uninstalling, back up any ProCite files you wish to keep.

To remove ProCite 5:

Windows

Use the Uninstall program found in the ProCite folder to ensure that you remove all ProCite program files, word processor support files, and registry settings.

You may need to move or delete databases and other custom files to finally delete the entire ProCite folder.

Macintosh

Delete the entire ProCite 5 Folder by dragging it to the trash. Then, to delete cite while you write commands from Microsoft Word, delete these files from Word’s Startup folder:

**Word 6**: ProCite 5 Word Add-in
ProCite 5 Word 6 Add-in.dot

**Word 98**: ProCite 5 Word Add-in
ProCite 5 Word 98 Add-in.dot
Chapter 3
Using ProCite: A Guided Tour

Overview

Contents

Getting Started ................................................................. 46
Online Help ........................................................................ 46
Opening an Existing Database ........................................ 47
Navigating a ProCite Database .......................................... 49
Customizing the Record List to Display Fields ............... 49
Click Sorting on a Column Heading ................................. 52
Using the Preview Pane to View a Reference ................ 52
Using “Go To” Commands to Find References ............... 54
Drag and Drop Between Databases ................................. 54
Entering Records ............................................................... 55
Importing Records from a Saved Text File ...................... 56
Searching and Importing Records Directly from an Online Database ................................................. 57
Capturing Web Page Information (Windows Only) ....... 62
Linking a Reference to a Web Page or File ................. 64
Entering and Editing ProCite References ....................... 64
Configuring Duplicate Checking .................................. 68
Searching and Sorting a Database ..................................... 69
Quick Searching for Records with the Terms Tab .......... 69
Creating a Search Strategy .............................................. 70
Saving a Search Strategy ............................................... 74
Creating a Group .......................................................... 74
Selecting the Sort Order ................................................. 75
Generating Bibliographies .............................................. 77
Creating a Bibliography from a Record list .................. 77
Creating a Bibliography with Subject Headings ........... 79
Preparing a Manuscript and Bibliography ..................... 81
Opening a Word Processing Document ......................... 81
Identifying References to Cite ......................................... 82
Preparing the Bibliography and Final Manuscript .......... 85
Closing the Document and Exiting ProCite .................... 86
This chapter guides you through basic ProCite functions, including entering information into a ProCite database, sorting records, searching a database, printing bibliographies, and citing references within Microsoft Word or WordPerfect.

First you must have installed the full ProCite program, which includes Database and Styles folders that contain the Sample Database and various output styles. If another user has experimented with the sample database by adding, modifying, or deleting records, you may want to reinstall ProCite to start with a fresh copy.

After completing the exercises in this guided tour you should be able to:

• Easily navigate references in a database
• Build a database by importing references and by entering references manually
• Search and sort a ProCite database
• Create standard and subject bibliographies
• Prepare a manuscript and bibliography within a word processor

You can stop these lessons at any time by closing ProCite.

---

**Getting Started**

**Online Help**

When using ProCite, many of your questions can be answered using the online help that comes with the program. There are several ways to access online help when using ProCite:

• Select Help from the Menu bar to find a topic.

• Many ProCite dialogs include a Help button so you can see information related to the current activity.

• Display context-sensitive help by pressing the F1 key (Windows) or the help key (Macintosh). If no context-sensitive help is available, choose from the list of topics displayed.
Opening an Existing Database

The exercises in this guided tour use the Sample Database that installs with ProCite. This database is used to demonstrate navigating a database, entering references, searching and sorting references, and creating bibliographies.

**Exercise - Opening the Sample Database**

In this exercise you will open the Sample database. If you already started ProCite, go to the File menu and choose Open, then continue with step 3.

To open the Sample database:

1. Start ProCite:
   - **Windows**: From the Start menu, choose Programs, locate the ProCite 5 program group, and choose ProCite.
   - **Macintosh**: Open the ProCite 5 Folder and double click the ProCite program.

2. A file Open dialog displays for you to locate and open a database. If not, go to the File menu and choose Open.

   **Note**: If ProCite has already been used on this machine, it may automatically open the last ProCite file used (this could be a database, list, output style, or workform). Check the title bar to confirm the Sample database is open. If not, close the file, and from the File menu select Open. Then continue with step 3.

3. In the file Open dialog, locate and double-click on the Database folder located in the ProCite 5 folder.

   **Note**: Make sure the Open as read-only (Windows) or Read-Only (Macintosh) box is not selected. If it is checked, you cannot make any changes to the database.

4. Locate and double-click on Sample Database (under Windows it includes the extension .PDT). ProCite opens the Sample database.
The database window displays a record list of abbreviated records. By default the first Author field, Title field and Date field are shown from each record.

A Status line at the bottom of the window indicates the sort order (Author/Title/Date in Ascending order by default), the number of records marked, the number of records displayed in the current list and the total number of records in this database. The Sample database contains 40 references using different types of workforms.

In the abbreviated record list you can browse through single-line records, mark or unmark records, or display records in full for viewing or editing. Records can also be formatted for previewing the bibliographic style at this window.

**Note:** Many ProCite menu items have a corresponding keyboard equivalent and/or toolbar icon. The keyboard equivalents appear on the menus next to the associated commands.

Use the next section of this guided tour to learn ways to navigate records in a ProCite database.
Navigating a ProCite Database

In this section of the guided tour you will learn to:

- Customize the record list to display specific fields
- Click sort by column heading
- Use the Preview Pane to view a reference in more detail
- Use the GoTo tool
- Drag and drop between databases

Customizing the Record List to Display Fields

While the default record list display shows only three ProCite fields from each record (Author, Title and Date), the list can be customized to display up to six fields for each record.

In this exercise you will customize the abbreviated list by selecting four fields to display and changing the column widths.

**Exercise – Customizing the Display**

To customize the record list display:

1. From the View menu, choose Configure Record List to display the Configure Record List dialog:

![Configure Record List dialog]

The Configure Record List dialog allows you to select which fields to display and adjust the column widths.
On the Record List tab, the **Layout** box contains three columns of options:

- The **Show** column of check boxes is used to show which of the six fields are displayed.

- The **Column Header** text boxes allow you to enter header text to be displayed above each field in the record list.

- The **Displayed Field** column is where you select the fields to display in the order you want them to appear.

2. To rearrange the order in which the fields are displayed, first click on the **Show** check box for **Title** to remove this field from those shown. Next click on the first field (currently **Record ID**) to select this field for the display. Use the next step to change this field to display the **Title** field first in the record list.

3. From the **Displayed Field** column, click on the arrow to the right of **Record ID** to select the **Title** field as the first field to display. Choose **Title** from near the top of the field list.

**Note:** The field list includes all 45 ProCite fields plus five “special” fields at the top of the list. The special fields shown are **Author**, **Title**, **Date**, **Workform** and **Record Number**. These fields include all related fields respectively. For example, Author includes both the **Author, Analytic (01)** and **Author, Monographic (07)** fields from the various workforms. Use the special fields when you want to include all authors, titles and dates from a variety of workforms used in the database.

4. The Column Header needs to be changed to reflect header text appropriate for the title field. Click the first field’s **Column Header** text box and type **Title** as the descriptive text for this field.

5. Click the **Show** check box for Keywords to display the **Keywords** field as the fourth field for each record.
6. Click **OK** in the Configure Record List dialog to save the changes and return to the record list. ProCite displays the fields in the order you selected:

You can easily change the width of the columns by dragging between column titles. Use the next exercise to change the width of the *Date* field in the record list window.

**Exercise – Changing the Column Width**

To change column widths:

1. To see more of the *Keywords* field, move the pointer to the column heading divider between **Date** and **Keywords**. The pointer changes to a horizontal arrow.

2. Drag the vertical bar to the left to reduce the width of the *Date* field.

3. Experiment changing other column widths.
Click Sorting on a Column Heading

Although the Author field, or in this case the Title field, may be the first field displayed from each record, the records are not automatically sorted by that field. Use the following steps to sort by a displayed field using the click sort method.

**Exercise – Changing the Sort Order Instantly**

To quickly change the sort order of the record list:

1. To sort by the Date field, click on that field’s column header. The records are sorted by date in ascending order. Click a second time to change the sort to descending.

2. Experiment sorting the records by the Author and/or Title fields.

Using the Preview Pane to View a Reference

The Preview Pane displays a highlighted record formatted with an output style. You may find this useful when browsing a record list to compare data or to preview records formatted with various output styles.

**Exercise – Previewing a Formatted Reference**

To preview formatted references:

1. From the View menu, choose Preview Pane.

2. Highlight the record by author Kraft, Donald H. ProCite formats the highlighted record using an output style (ANSI is the default style) and displays it in the preview pane.

**Note:** You can move the horizontal divider to allow the preview pane more or less space.
3. To switch to a different output style (bibliographic format) for the preview pane, go to the View menu, choose **Configure Record List** and click the **Preview Pane** tab.

4. Click the **Output Style** arrow and select a style from the list. Use the **Optional Fields** check boxes to view additional information in your Preview. Click **OK** to view the formatted reference.

5. When you no longer want to view formatted references, deselect **Preview Pane** from the View menu or use the corresponding toolbar icon.
Using “Go To” Commands to Find References

You can move through the Sample database simply by browsing with the scroll bar. However, this is not practical when using a large database. To locate records in a large database, use the Go to Record commands.

Exercise - Using the “Go To” Commands

To use the Go To commands:

1. Use the Go To commands from View menu or the toolbar. You can go to a specific record, go to the first record, go to the previous record, go to the next record, or go to the last record in the list.

2. To find a record based on the sorted order of a database, use the Go to Record command (the first button on the Go To toolbar).

3. To locate the record by Helen Schwartz, type the first few characters of the author’s last name in the first text box in the Go To Record dialog.

4. If the sort order is not currently Author/Title/Date, select that order by using the arrow to the right of the text box.

5. Click OK to complete the search. ProCite searches from the top of the record list and highlights the record that most closely matches the text.

6. Experiment using the other Go To commands to move between records in the Sample database.

Drag and Drop Between Databases

You can copy full records between ProCite databases. To copy records between databases, you need to have both databases open. Use the following exercise to copy a record from the Sample database to another database named Turtles.

Exercise – Copying a Record from One Database to Another

To copy a record from one database to another:

1. Open the ProCite database named Turtles (Under Windows it will include the extension .PDT). From the File menu, choose Open. The Turtles database is located in the Database folder located in the ProCite 5 folder.
2. From the **Window** menu, select **Tile** to display both the Sample database and the Turtles database on the screen:

   ![ProCite Interface](image)

   - In the Sample Database, highlight the record by **Toth, Tibor** and drag it to the Turtles database. This places a copy of the record in the Turtles database.
   - Close the Turtles database. The new record is saved and marked.
   - Maximize the Sample Database window to continue working with the file.

### Entering Records

In this section of the guided tour you will learn to:

- Import tagged references from online, CD-ROM and Web-based services
- Capture Web page information using Netscape (Windows only)
- Enter and edit references manually
- Configure duplicate checking

Use the following exercises to gain experience importing, entering and editing references in ProCite.
Importing Records from a Saved Text File

Before importing files downloaded from an information service it is important to determine from which service the records were retrieved. Each service saves the same information in a slightly different format. The format is significant to the configuration file used in ProCite.

Configuration files are used to tell ProCite how a file of imported records is organized. Refer to Appendix C: Configuration Files in the Biblio-Link II Manual for a list of configuration files supplied with ProCite and the specific databases from which you can import data. The Biblio-Link II Manual is a PDF file found on your ProCite CD. If a configuration file is not available for a service you use, you can modify an existing file using the Biblio-Link II program installed along with ProCite.

Exercise — Importing Records

To import a file of records retrieved from the National Library of Medicine’s Medline database and saved to a tagged text file:

1. Go to the Tools menu and choose Import Text File.
2. In the Open Import File dialog, locate the ProCite\Download\ folder and choose the file MEDLARS – Medline.txt. ProCite displays the tagged text file:

3. In the File Type drop-down list, choose Tagged.
4. In the **File Format** drop-down list, choose the service from which you retrieved the tagged records. For this file transfer, choose **MEDLARS**.

5. In the **Target Database** drop-down list, choose the **Sample database** to receive the records.

**Note:** You can import records to an existing database or specify a new one by clicking the Browse button (...) and assigning a name to the new database.

6. Click **Transfer** to begin importing records.

7. When the transfer is complete, ProCite tells you how many records were imported. Click **OK** to continue.

8. Close the Import Text File window and return to the record list.

9. The imported records are marked. Click the **Marked Records** tab at the bottom of the window to display only the records you just transferred.

10. Click the All Records tab to return to the full list of records.

**Searching and Importing Records Directly from an Online Database**

The following exercise guides you through the basic steps of connecting to a remote database, searching the database, and saving the references that you want to keep. In order to follow this guided tour, you must be at a computer with Internet access — with either a dial-up or direct network connection.

For this guided tour, you will connect to a Medline practice database made available by Ovid Technologies, Inc., a company that provides access to bibliographic and full-text databases. Medline Practice Demo is the online database we will search; Ovid is the information provider. The Medline Practice Demo is a subset of the full Medline medical database, and is limited to records from 1993. Access to the full Medline database, and many other online databases, is available with ProCite.

See *Chapter 15: Internet Capabilities* for more information about Internet searching.
Dial-up Internet Connections

If you use a modem and phone line to connect to the Internet, as opposed to a direct network connection, please note this connection information.

**Connecting:** Most dial-up connection settings are configured to automatically dial and connect to the Internet when you use an application that requests an online connection (such as ProCite’s Internet Search feature). However, some Internet providers, such as America Online, require that you establish an online connection (sign on) before attempting an Internet Search with ProCite.

**Disconnecting:** ProCite does not disconnect your Internet connection at any point. You need to shut down your connection when you have finished using ProCite’s Internet Search feature.

**Exercise — Internet Searching**

To search and import records from an online database:

1. From the **Tools** menu, select **Internet Search** to open a temporary Internet Search database.

   ![Internet Search dialog box]

2. Select the Internet database(s) you want to search.
   
   a. Click the **Hosts** button.
   
   b. Click **Clear Marks** to deselect any selected databases.
   
   c. Scroll to **Ovid - Trial Server**.
d. From the databases listed under **Ovid - Trial Server**, select the check box next to **Medline Practice Demo**.

![Internet Hosts dialog box](image)

- **From the databases listed under Ovid - Trial Server, select the check box next to Medline Practice Demo.**
- **You could have marked multiple databases for searching.**
- **Click OK to save the setting and return to the Internet Search tab. Notice the database name next to the Hosts button.**

3. **Build your search expression.**

   Let’s say you are interested in information about the success of corrective eye surgery, such as radial keratotomy.

   - **Next to Search For, use the drop-down box to select Any Field.**
b. In the text box next to it, type radial keratotomy.

4. To connect and search, click **Search**.

**Note:** If you haven’t already established a connection, your dial-up configuration should automatically dial and connect. If the connection is not successfully established, ProCite alerts you with an error message and stops the search attempt.

ProCite sends the search request to the online database, which in this case is Medline Practice Demo. The status line between the search strategy and the record list keeps track of how many records are found and imported. When done, the search results display in ProCite’s record list:

In this case, 57 records were found.
Chapter 3: Using ProCite: A Guided Tour

5. If the search was too broad, finding too many records, you can refine the search to get closer to exactly those references you want. We will refine this search by looking for just the follow-up studies about radial keratotomy:

a. Click **Clear Results** to delete the previous search results. When asked to verify the deletion, click **Yes**.

b. Leave the first search line as entered. Click in the text box of the third search line, next to **Keywords**, and type follow-up studies.

**Note**: ProCite ignores the previous line, since no text is found in the text box. Notice that each line is connected by the word AND, which requires that each line of search criteria be met.

6. Click **Search**.

This time only 17 references are found. The references are imported and appear on Internet Search tab.

7. Save results

At this point you can peruse the retrieved records to see which ones you want to keep. All database functions are available, so you can edit, search, or perform other operations. You save records by transferring them into a new or existing ProCite database.

You can copy highlighted records to an open database using drag-and-drop or the **Copy** and **Paste** commands. You can also copy records directly to an open database, a closed database, or a new database with the **Copy Marked Records** command, as described below.

For this example, you will save some of the imported records to a new database called OvidTest.

a. Select a subset of the records by selecting the check box next to individual records.

**Note**: If too many records are found, and you find yourself waiting for hundreds or thousands of records to download, you can cancel the retrieval by clicking the **Stop** button.
b. On the toolbar, click the **Copy Marked** icon on the toolbar.

c. In the file dialog that appears, locate ProCite's Database folder, type a new name of OvidTest in the text box, and click **Open**. ProCite asks whether to create the new file. Click **Yes** and the marked records are copied to the new ProCite database.

8. Close the temporary Internet Search database.

   a. Click the database close box or choose **Close** from the **File** menu.

   b. ProCite asks whether to save your Internet search results. Since you already saved the records you wanted, click **Discard** to close the temporary database.

---

**Note:** ProCite does not disconnect your Internet connection. When you are finished searching online databases, remember to disconnect.

Because you did not close the Sample Database, it should appear when you close the temporary Internet Search database.

You can open the OvidTest database to look at the records saved from Internet searching. When you are done, close it and return to the Sample Database.

### Capturing Web Page Information (Windows Only)

You can create ProCite records from individual Web pages displayed with Netscape or Internet Explorer. The Title and URL address are automatically copied to a new record in the database. You can then change the ProCite workform and/or copy and paste additional Web page text to the record using an automated clipboard feature.

**Exercise – Copying Web Page Information to a ProCite Record**

To copy web page information to a ProCite record:

1. Start Netscape or Internet Explorer and go to:
   
   http://www.procite.com. The ProCite home page is displays.

2. Switch to the open Sample Database in ProCite.

3. From the ProCite **Tools** menu, choose **Import Web Page**. A split screen displays the text of the browser document at the top of the screen, and a new ProCite record at the bottom. The ProCite record contains the Title and URL from the Netscape or Internet Explorer display.
Notes: The ProCite workform displayed is the one last used for insertion. The Title is transferred to Title, Analytic (04) or Title, Monographic (09) and the URL is transferred to Location/URL (38).

4. Change the workform by using the Workform pull-down list at the top of the ProCite window. Choose the Web Page workform.

5. You can move text and/or copy information from the Netscape text to the ProCite record. To copy text to the Keywords field, use the mouse to highlight the text ProCite, then click on Keywords (45) field label. The term is copied to the Keywords field in the ProCite record.

6. Practice copying highlighted information to other fields in the record.

7. When done transferring text to the ProCite record, go to the Database menu and choose Save Record or click the corresponding diskette icon in the toolbar.

8. To close the record, go to the File menu and choose Close or click the window close button.

9. Before continuing with ProCite, you may want to switch to the Web page and exit Netscape or Internet Explorer.
Linking a Reference to a Web Page or File

You can add a URL or a path and filename to a ProCite record and later launch the attached URL or file. In the case of a URL, ProCite launches your default browser and directs it to the Internet location. In the case of a path and filename, ProCite launches the file as though you had double-clicked the file icon.

Use the following exercise to launch an attached URL to a Web Page on the Internet.

**Exercise – Launching a URL from a ProCite Record**

**To launch a URL found in ProCite’s Location/URL field:**

1. Go to the record by Rieger, Steve. Double-click to display the full record.

2. Notice the URL entered in the Location/URL field.

3. From the Tools menu, choose Open File/URL or click the toolbar icon:

   ProCite launches your browser and directs it to the Internet location.

4. When done using the Web Page, exit the browser and close the ProCite record.

   **Note:** You are not required to display the full record. You can launch a URL from a record list by highlighting the record and using the Open File/URL toolbar icon.

Entering and Editing ProCite References

You can add or edit records at any time. Each record can hold up to 100K of text. The following exercises will give you experience with the basic operations of entering and editing text in ProCite records.

**Exercise – Inserting a New Record**

**To insert a new ProCite record:**

1. From the Database menu, choose New Record. The New Record window appears.
2. Click the **Workform** box at the top left of the New Record window. Choose Book Short Form from the drop-down list.

![ProCite New Record window](image)

3. Start by clicking in the **Author, Monographic (07)** field and enter: **Barrett, Daniel J.**

**Notes:** Always enter author names in this order: **lastname, firstname middle.** While you can enter author names in any ProCite field, it is recommended that you enter names only in the following fields: **Author, Analytic (01), Author, Monographic (07), Author, Subsidiary (16) and Author, Series (30).** These author fields are automatically used for searching, sorting and formatting author names.

When listing multiple authors names, use a double slash (//), a semicolon(;), or a carriage return between author names. If you do not know all the names, indicate additional authors by using four slashes (////) after the last author in the field.

4. Click or tab to the **Title, Monographic (09)** field and enter: **NetResearch: Finding information online**

5. Click or tab to the **Publisher Name (19)** and enter: **Songline Studios, Inc.**

6. Click or tab to **Date of Publication (20)** and enter: **1997**
Note: ProCite assumes the following fields may contain dates: *Date of Meeting* (12), *Date of Publication* (20), and *Date of Copyright* (21). These date fields are converted to an internal format that is used for searching, sorting and formatting references correctly.

7. To use a Field Content List for keywords, move the cursor to the *Keywords* field, then click the arrow to the far right of the field. The **Insert Term** dialog appears.

![Insert Term dialog]

Note: Field Content Lists are internal lists generated from the *Author*, *Journal*, *Title* and *Keywords* fields. They can be used for data entry and searching.

8. Quickly type *co*, or scroll through the list to the word **Computers**. Select the word and click **Insert Term** to insert the text in the current field.

Note: You can also double-click on a term to insert it automatically.

9. Type *I* to move to the terms that start with the letter I. Select **Information** and click **Insert Term**.

10. When you are done inserting terms, click **Close** to return to the New Record window.
11. From the File menu, choose Close to close the record. When prompted about saving changes, click Yes to save changes to the record.

**Exercise – Editing a Record**

**To edit a record:**

1. Use the record list to locate the record by Schwartz, Helen.

2. Double click the highlighted record to edit. The Edit Record window appears:

3. Scroll to the Keywords (45) field, the last field. Position the cursor after the last term and type a slash (/).

4. Copy the phrase Information Technology from the Notes (42) field to the Keywords (45) field using Copy and Paste commands.

   **Note:** Editing a record is just like adding a record. You can copy, move, insert and delete text from any field.

5. Close the record to save your changes and return to the abbreviated record list.
Configuring Duplicate Checking

When inserting records from multiple sources into a ProCite database, it is possible to enter duplicate records. To avoid this you can have ProCite warn you when it encounters a suspected duplicate record when saving records. You can also use the Duplicates tab to check for existing duplicates. You can mark duplicates and delete them after comparing the records.

**Exercise – Setting Duplicate Detection**

To set duplicate detection criteria:

1. From the Database menu, choose Configure Duplicates.
2. Select the check box titled Warn about duplicates when saving new records.
3. Click OK to save the change and return to the record list.
Searching and Sorting a Database

In this section of the Guided tour you will learn to:

• Quick searching for records with the Terms tab
• Create a search strategy
• Save a search strategy
• Create a group of records
• Choose a sort order

Quick Searching for Records with the Terms Tab

Using the Terms tab, you can list records organized by certain fields such as Authors, Journals, Keywords, and more.

In the following exercise you will change the record list to view specific abbreviated records. The first list of records will include only those records that contain the keyword Computers.

Exercise – Specifying a List of Records to Show

To quick search with the Terms tab:

1. Click the Terms tab at the bottom of the window.

2. Use the drop-down Show list at the top left of the window to choose Keywords. A list of keywords appears in the left pane of the window. This list is compiled from all keywords in the active database. The number to the right of each keyword indicates how many records contain the term.
3. Scroll through the list and click on Computers. The records containing that term in the Keywords field appear in the right pane of the window.

4. Next, try changing the selection on the Show list to Workforms to view records organized by their workform type.

5. Click the All Records tab to return to the full listing of records.

Creating a Search Strategy

Being able to search for and find certain records in a ProCite database allows you to access information for editing or printing bibliographies as well as other functions. Once you have located specific records you can mark, delete, edit as a group, or print the references.

There are a number of ways to set up a search in ProCite. You can use the Search tab to search every field in every record or limit the search to specific fields for faster searching. You can also use field content lists to simplify searching for authors, titles, journal titles and keywords.

ProCite has powerful searching functions that allow you to use relational operators such as = (equal), <> (not equal), > (greater than) and < (less than) as well as logical operators AND, OR, and NOT for finding records. ProCite includes special search values for begins with, ends with, contains, empty, and not empty. See Chapter 13: Searching and Finding Records for complete listings of operators you can use in Search Expressions.
A Search Expression is a description of the criteria you want ProCite to use in finding records in a database. A Search Expression consists of any of the following three elements:

- **Field Identifier** (Optional) – A unique identifier that limits a search to a specific field, group of fields, workform or group.

- **Operator** (Optional) – An instruction for creating relationships between search terms or an instruction on how to search a field.

- **Search Term** – A word or phrase you want ProCite to find.

The following exercises give you experience creating and saving a Search Expression as well as showing you how to create and sort a group of references prior to printing.

**Exercise – Creating a Search Expression**

**To create a search expression:**

1. Click the Search tab to display the Search window.

**Notes:** At this point you can enter field names, operators, and search terms either by typing them or by using a combination of typing and pop-up lists. The most thorough (and time consuming) search is where the Search Expression contains only a search term. ProCite then searches all text in every field of each record. To limit the fields to search, enter a field identifier and operator prior to the search term. The fastest searches are on the indexed fields *Author, Journal Title, Title* and *Keywords.*
2. Click **Insert Fields** to limit your search to a particular field. The **Search Fields** dialog appears:

3. Highlight Keywords near the top of the list, and click **OK** to transfer the field identifier to the **Search For** text box.

4. Click **Operators** to enter a relational operator in the Search Expression. A list of operators appears:

5. Click **CONTAINS** to insert the operator in the Search Expression.

6. Click **Insert Term** to select from a list of terms. Check that the Terms drop box is properly set to Keywords. If not, use the arrow on the drop list to select the Keyword list.
7. Select **Research** from the list by scrolling or by typing **R** to quickly move to a particular alphabetic section of the list. You can also use the Up/Down directional keys to move through the list and find your selection.

8. Paste the term in your search expression by double-clicking the term or clicking the **Insert Term** button. **Close** the Insert Term dialog.

9. In the drop-down box labeled **Look in**, select **All Records**.

10. Click **Search** to initiate the search for matching records. The matching records appear in the lower pane of the Search window.
Saving a Search Strategy

It is useful to be able to save long, complicated search expressions or those that you use frequently. Use the following exercise to save a search strategy.

Exercise – Saving a Search Expression

To save a search expression:

1. On the Search tab, click Expressions and select Add to Expressions. ProCite displays the Search Expressions dialog.

2. Type Search1 in the Expression Name box to identify the Search Expression and click OK.

Note: Recall a Search Expression by clicking Expressions and then selecting the name of the expression you want to use. Click Search to retrieve the same records plus new matching records entered since the last search.

Creating a Group

Groups are a way of creating virtual subsets of a database. Saving records in a group allows you to quickly retrieve a particular set of records. A group can contain the results of one or more searches, or a set of individual records. You can save any number of groups in your database and give each a unique name.

Exercise – Adding Records to a New Group

To save records to a group:

1. Use the search results from the keyword search. On the Search tab, click in the abbreviated record list to activate it.

2. From the Edit menu, choose Select All to highlight all records in the list.
3. From the Groups menu, choose **Add Record(s) to** and then **New Group**. The **New Group** dialog appears:

![New Group Dialog](image)

4. Type **Group1** as the name of your group, and click **OK** to save it.

   **Note:** You would need to occasionally re-execute the search to update the records in a group.

5. Click the **Groups** tab at the bottom of the window to view the records in Group1. All group names are listed in the left pane.

6. To return to the full record list, click the **All Records** tab.

### Selecting the Sort Order

The sort order you select for records is constant until you specifically change it. You can click-sort on any displayed column heading. Based on the fields displayed, ProCite selects the closest predefined sort to use. A second click on the column heading toggles the sort between ascending and descending order.

### Pre-configured Sort Options

ProCite comes with seven predefined sort orders. The commonly-used sort orders are:

- Author/Title/Date
- Author/Date/Title
- Author-Title/Title/Date
- Title/Date
- Date/Author/Title
- Call Number/Author/Title
- Record Number

You can easily select any one of these for display by choosing it from the **Sort** menu.
Custom Sorts

You can set up a custom sort order by using the **Configure Sorts** command on the **Sort** menu. You can:

- Compare one to six fields to determine the sort order on the **Custom Sort Order** tab
- Indicate how to sort empty fields, author fields and date fields on the **Custom Sort Option** tab
- Develop a Stop List of words to ignore at the beginning of a field on the **Stop List** tab

The order in which you sort a printed bibliography can differ from the viewing order on your screen. By default, ProCite uses the output style sort order for the bibliography. Use the following exercise to override the default setting and print the records using a different sort order.

**Exercise – Changing a Sort Order for Printing**

To change the sort order for printing:

1. From the **File** menu, choose **Print Bibliography**. A bibliography preview displays using the default output style, or the last output style selected, and its sort order.

2. Click **Configure** on the toolbar. The **Configure Bibliography** dialog displays the current bibliographic settings:
3. On the **Reference List** tab, change the **Reference List Order** by selecting the Date/Author/Title sort order in the drop-down list. Click the **Descending** radio button to begin the list with the most current records.

4. Click **OK** to update the bibliography preview with the new sort order.

**Notes:** ProCite holds this setting until you select another sort or a different output style. See *Chapter 23: Creating and Modifying Output Styles* for information about changing the sort order associated with an output style.

5. Click **Close** to return to the record list.

---

**Generating Bibliographies**

You can “print” bibliographic citations to your computer screen, a word processor document, an HTML file, or a printer. You can print a full bibliography or a list that organizes references by subject.

In this section of the guided tour you will learn to:

- Create a bibliography from a record list
- Create a bibliography with subject headings

**Creating a Bibliography from a Record list**

ProCite always displays a preview of the formatted bibliography. You can make changes to your bibliographic settings before actually printing or saving to a file. The following exercise gives you experience with formatting and printing a bibliography.

**Exercise – Printing a Bibliography**

To print a bibliography directly from ProCite:

1. If it isn’t already displayed, click the All Records tab to list all records in the database.

   **Note:** You could also print Marked Records, Groups, or any other list of records using this method.

2. From the **File** menu, choose **Print Bibliography**. A bibliography preview displays using the last output style selected.
3. Use the buttons at the top of the window to **Zoom In** or **Zoom Out**, and to navigate through pages in a single or two page view.

4. Switch to a different output style using the drop-down list. Select **AMA, American Medical Assoc** and watch the screen refresh in the new format.

5. Click **Configure** to change the bibliography settings.

   - The **Reference List** tab provides another way to change the output style, add a title to your record list, and set the reference numbering and indentation.

   - The **Fields** tab lets you suppress fields from printing and substitute alternate text for text found in records.

   - The **Page Layout** tab controls font, size, margins and page number formatting.

6. Click the **Fields** tab to limit the fields printed. Remove the check mark from the **Notes** field to suppress it from printing. Click **OK** to save the change and update the bibliography preview.

7. Click the **Print** or **Save** button to complete the exercise.

**Note:** To save the bibliography to a file (MS Word, WordPerfect, HTML or Text Only), click the Save button and adjust the Save File as Type accordingly.
8. Click **Close** to dismiss the preview.

9. Practice printing Marked Records or groups of references using different output styles.

**Creating a Bibliography with Subject Headings**

A Subject Bibliography contains references arranged by subject headings. Typical subject headings are Keyword, Author, Title or Call Number, although you can select any ProCite field. Subject Bibliographies simplify the creation of a record list covering several topics, such as a faculty publication list or a list of holdings by category. You can also create a subject index to accompany the subject bibliography. Use the following exercise to print a standard Subject Bibliography.

**Exercise — Printing a Subject Bibliography**

To print a subject bibliography:

1. If it isn’t already displayed, click the **All Records** tab to list all records in the database.

2. From the **File** menu, choose **Print Subject Bibliography**. ProCite displays the **Subject Fields** list, with the 45 fields listed by field number and default field name. You can also create a subject list by workform, even though it is not a ProCite field.

3. Scroll down the list and highlight the **Keywords** field (45) to select the field whose contents will be used as Subject Headings. Click **OK** to display the terms found in the **Keywords** field.
Note: You can select any number of fields for subject headings. If you build the list of headings from more than one field, the subject headings generated from those fields are combined into a single list.

4. Click the Select All button to include all the keyword terms as subject headings or use a Shift-click to individually select or deselect terms to include in your subject bibliography.

5. Click OK to preview the Subject Bibliography.

6. Click the Configure button and you find the same selections as with Print Bibliography.

7. Click the additional tab, Subject Bibliography, which controls formatting specific to a Subject Bibliography.

8. Create a standard Subject Bibliography by setting the Reference List to include the Subject Terms and Reference List. Check the Recycling Reference Numbers box to restart the reference number sequence under each heading. Click OK to preview the results.
9. Next, create a Subject Index by selecting the **Configure** button and **Subject Bibliography** tab. This time, change the Reference List setting to **Subject Terms Only**. Include the **List of Record IDs** to print on the same line in the next section. Click **OK** to preview the results.

10. Click **Close** to close the preview and return to the record list.

---

**Preparing a Manuscript and Bibliography**

In this section of the guided tour you will learn to:

- Open a word processing document to use *cite while you write*
- Identify references to cite
- Prepare the bibliography and final manuscript
- Close the document and exit ProCite

**Opening a Word Processing Document**

ProCite 5 supports Microsoft Word 7, 97, and 2000 for Windows, Word 6.01 and 98 for the Macintosh, and WordPerfect 7, 8, and 2000 for Windows.
The Tools Menu and ProCite Toolbar

When you install ProCite, you also install ProCite menu items and a ProCite toolbar in your word processor. The contain cite while you write commands that allow you to locate and insert citations from your database and generate a bibliography. Each of the items on the toolbar corresponds with an item on the Tools menu.

Identifying References to Cite

The following exercises are designed for use with Microsoft Word, although you can apply the same steps to WordPerfect. The first step in formatting bibliographies is to locate the citations you want to include in a paper. ProCite provides three different ways to place citations in your document. Once the ProCite place holders are established, you are ready to generate the in-text citations and bibliography.

Exercise – Creating a Word Document

To create a Word document with linked ProCite records:

1. Start Microsoft Word.
2. From the File menu, choose New to create a new document. Click OK to continue with a blank document.
3. Type the sentence:
   It's easy to cite while you write with ProCite.
4. From the Tools menu, select ProCite 5 > Insert Citation.

Note: You could also use the Insert Citation button from the ProCite toolbar.
5. Type Turtles, a keyword, as the identifying text. Select the Turtles database in the drop-down list of databases to “Look In.”

![Insert Citation](image)

**Note:** You can look for any combination of author name, date, full or partial title, keyword and record number. Separate each item with a space or a comma. Surround phrases with quotation marks.

6. Click **Insert** to insert the citation. ProCite searches the database. When a single record matches the search, it is immediately inserted. ProCite returns a list if there is more than one item that matches the search.

In this case, you receive a list of 52 references. You can easily narrow the selection list by adding another term after Turtles, for example, the year 1996. Click the magnifying glass button to restart the search with the new parameter. This time only ten references are listed.
Note: You can change the sort order of the list by clicking on a column heading. For this tour, click the Author column heading to sort by author names.

7. Select references to cite in your document.

Note: Select references by clicking on the first one, Shift-clicking to select a series of references, or Control-clicking (Windows) or Command-clicking (Macintosh) to select a random group. Use the same commands on highlighted items to deselect them.

For this tour, select two references: the first by Gitschlag and the last by Witzell. Click the Insert button to insert the ProCite place holders in your document. The place holders look like this:

{Gitschlag 1996 #510}{Witzell, Azarovitz, et al. 1996 #390}

8. Start a new paragraph and type:

You can also search and mark references in ProCite.

9. Switch to the full ProCite application to display the Turtles database, and mark one or more records by checking the box in the left column of the abbreviated record list.

10. Switch back to Microsoft Word. With your cursor placed after the new sentence, go to the Tools menu and select ProCite 5 > Insert Marked Records to insert the ProCite place holders in your document.

11. Start a new paragraph and type:

Lastly, you can identify text in your manuscript and scan the document to add ProCite place holders.{crowder; conservation}

Note: You can use any character to delimit your identifying text. Curly brackets are a good choice and reduce the number of times you may need to “ignore” a selection. Notice that a semicolon is used to separate searches in one location.

12. From the Tools menu, select ProCite 5 > Scan Document.

13. Identify the left and right delimiters used in your document, enter the curly brackets if necessary, and select Turtles as the database to search. Click OK to begin the scan.
14. The first stop is the author name, Crowder. Insert a citation and ProCite automatically takes you to the next identifying text, conservation. Insert a citation from this list and the scan is complete.

Preparing the Bibliography and Final Manuscript

Once a ProCite place holder is inserted, it is linked to a record in a ProCite database and ready to format the final manuscript and bibliography. The format is determined by the chosen output style and can include the author name and year, numeric citations, or any combination of ProCite fields.

Exercise – Generating the Bibliography

To generate a bibliography from in-text citations:

1. From the Tools menu, select ProCite 5 > Generate Bibliography. The Configure Bibliography dialog displays.
2. Set the output style to **APA-American Psychological Assoc.**

3. Click **OK** to generate the bibliography. The citations in your manuscript are converted to the in-text citation format for the American Psychological Association, and a bibliography is added to the end of the document.

**Notes:** You can make changes to your manuscript and regenerate the bibliography at any time.

4. Select **Generate Bibliography** again and set the output style to **Journal of the Chemical Society.** You will need to use the browse button (…) and locate ProCite’s Styles folder to select the style. Click **OK** to view this completely different style.

**Closing the Document and Exiting ProCite**

Save your manuscript, close your Word document, then exit ProCite.

You have successfully completed this guided tour! You are ready to begin building your own reference collection and creating perfectly formatted bibliographies.
Chapter 4
Creating, Opening, Sharing, and Managing Files

Overview

Contents
Starting ProCite ................................................................. 88
Creating or Opening a Database ............................................. 88
Creating a Database .............................................................. 89
Opening a Database .............................................................. 90
Opening a Database from an Earlier Version ....................... 92
Setting Program Options ....................................................... 93
General Display Settings ...................................................... 94
File Locations ................................................................. 94
Internet Search Settings ..................................................... 96
Default Database Settings .................................................. 97
Closing Files .......................................................................... 99
Backing Up Files .................................................................. 99
Renaming Files ..................................................................... 100
Deleting Files ....................................................................... 100
Sharing Files ......................................................................... 101
ProCite Program ............................................................... 101
Databases ........................................................................ 101
Workforms ....................................................................... 102
Output Styles ..................................................................... 103
List Files ........................................................................... 104
Search Expressions .......................................................... 104
Internet Search Configurations ......................................... 104
Word Processor Files ........................................................ 105
Cross-Platform Compatibility ............................................... 106
File Sharing ........................................................................ 106
Character Mapping .......................................................... 107
Damaged Files ..................................................................... 108
Rebuilding a Database ....................................................... 109
When to Rebuild a Database .............................................. 109
Rebuilding a Database ....................................................... 111
Leaving ProCite .................................................................... 112
Starting ProCite

**Windows:** From the Windows Start menu, go to Programs, then ProCite 5, and select the ProCite shortcut to start the program.

Or, use the Windows Explorer to navigate to the Program Files/ProCite5 folder and double click the ProCite5 program.

**Macintosh:** When you install ProCite on a Macintosh, a ProCite 5 Folder is created containing the ProCite program. Double click the ProCite 5 program to start ProCite. You can also create a ProCite alias for your Apple menu or desktop.

If this is a new installation of ProCite 5, a file Open dialog displays allowing you to find and select a database to open. If you need more information about using this dialog, see Opening a Database later in this chapter. If you want to create a new database, first click Cancel in the file Open dialog. See Creating a Database later in this chapter for information about opening a new database.

If ProCite 5 was used on your machine previously, the program may start and open the last file used—whether a database, workform, output style, etc. You can close the file and open a different file or create a new file.

Creating or Opening a Database

The only limit on the number and size of databases is the capacity of your computer. For performance reasons we recommend a limit of 100,000 records per database. You can open multiple databases to compare records or copy text between records.
Creating a Database

Note: If you are working on a network drive, make sure you have read-write access to the folder where you wish to create the database.

To create a new ProCite database:

1. Start ProCite.

2. Depending on whether this is a new installation of ProCite, one of two things will happen:
   - If you have just installed ProCite, a file Open dialog displays. Click Cancel to dismiss the dialog.
   - If you have used ProCite before, the last opened file may automatically open. Either leave this file open or click the close box to close the file. (You can keep multiple files open at the same time, but it could get confusing.) Do not close the ProCite program.

3. From the File menu, select New. The New dialog appears.

4. Highlight ProCite Database and click OK to display a file dialog.

5. In the file dialog:
   a. Type in a file name. This name is used to store the file on disk.
   b. Make sure the appropriate folder is selected (typically ProCite’s Database folder).
c. Click Save to create the database on disk. ProCite displays a File Properties dialog.

![File Properties dialog]

6. Add any comments about the database and click OK to save the properties.

ProCite opens the new database and displays an empty record list. For information about inserting records, see Chapter 6: Entering and Editing Records.

Opening a Database

When you start ProCite, the last-used file may automatically open. If you work on one database only, this may be all you need to do. You can turn this option on or off; see Setting Program Options later in this chapter.

Before you open a different database, you may want to close the current database. If you do not close it, you will have more than one database open at the same time.

If you want to open a recently-used file, you may be able to choose the name of that file from the File menu. ProCite keeps track of the last four files that were opened so you can simply choose from the list.
If the name of the database you want to open doesn’t appear on the File menu:

1. Go to the **File** menu and choose **Open**. A file dialog appears.

2. In the dialog:
   a. Locate the appropriate Database folder.
   b. If you wish to open the database with read-only access, select the **Open as read only** (Windows) or **Read Only** (Macintosh) check box. This allows you to use the database without the possibility of changing data.
   c. Double-click on the database name in the file list.

**Multiple Users Opening a Single Database**

When sharing databases on a network, you can run into several multi-user situations:

- Any number of users can open the same database with read-only access. You may want to place the database in a read-only folder to make sure the database is always available to multiple users.

- One user at a time can open a database with read-write access. If a user already has a database open with read-write access, ProCite will tell other users that the database is already in use. The database is not available to others until the user with read-write access closes it.

- If a database is in use by someone, with either read-write or read-only access, you cannot open the database with read-write access.

- When you create a database with ProCite for the Macintosh and want to share it with ProCite for Windows users, add the extension .PDT to the primary database file.

- ProCite for the Macintosh can directly open databases created with ProCite for Windows.
Opening a Database from an Earlier Version

You can open any ProCite database, including those created with an earlier version of ProCite.

First make sure you have enough space for a copy of the database. While databases created with more recent versions of ProCite may open directly, in many cases ProCite reads the old database and makes a new database from it.

To use a database from an earlier version:

1. Go to the File menu and choose Open.

2. In the file dialog, locate, select, and open the database.
   - If the database is directly compatible, it is simply opened.
   - If the database needs updating, ProCite asks whether to convert the file.

3. Click Yes to display a file dialog.

4. In the file dialog:
   a. Locate the folder where you want the new database to reside (preferably ProCite’s Database folder).
   b. Type in a new database name.
   c. Click Save to bring up the File Properties dialog.

5. You can include comments if you wish. Then click OK. ProCite begins converting the old ProCite records into the new ProCite 5 database.

   A status line displays, following the progress of the conversion. When all the records are converted, ProCite displays the new ProCite 5 database.

If you would like more information about database conversion (ProCite, Reference Manager, or EndNote), or information about converting other ProCite files, see Chapter 2: Installation.
The first time you start ProCite, you may want to modify program options. To access program options, start ProCite, go to the Tools menu, and select Options. The General options tab displays:

You can:

- Use the General tab to turn general display items on or off.
- Use the File Locations tab to determine which folders ProCite will look in when listing files in the program.
- Use the Internet Search tab to set options for searching PubMed and Z39.50 databases.
- Use the Edit Defaults button on the General tab to change default settings for new databases.
General Display Settings

The General tab of the Options dialog allows the option of displaying or suppressing the following:

- **Show splash screen** displays the ProCite logo each time you start the program.
- **Reload last file** automatically reloads the last-opened file each time you start ProCite.
- **Tooltips** displays a short description for each toolbar button as you place the cursor over it.
- **Status bar** displays database status information at the bottom of the active ProCite window.

File Locations

Click the File Locations tab of the Options dialog to change folder settings. In some instances where ProCite displays a list of files in the program, (workforms and lists), it lists the files found in the default ProCite folders and the folders indicated here.
This feature is useful when you are running ProCite from a network and want to use a combination of shared network files and local files. ProCite automatically lists files from the network folder where ProCite is installed. You would enter your local drive and path in this dialog as a preference.

You can indicate multiple folders by separating them with semicolons. For example:

```
C:\Program Files\ProCite5\Database;C:\Personal\Database
Hard Disk\ProCite 5 Folder\Database; Hard Disk\Personal\Database
```

*Note*: These settings apply to file lists in ProCite itself. In most cases, these do not affect the standard file dialogs that appear when you create or open a disk file from ProCite.

**Databases**

ProCite uses the database folder in two instances:

- The first time you open a file with ProCite (after that it remembers the last folder accessed)
- When you use **Save As** to save a database

**Workforms**

ProCite lists workforms in several places. On the Terms tab, you see only the workforms that are used in the current database. When you insert or edit records, however, you see a list of all available workforms. The list of workforms is compiled from the **Forms** folder found in the ProCite program folder and the folder you enter on the **File Locations** tab.

**Output Styles**

You can choose from a list of output styles from the Configure Bibliography dialog when you print a bibliography.

ProCite initially lists the output styles found in the default Styles folder in the ProCite program folder unless you override that setting by entering a different folder location on the **File Locations** tab.

If you do not use certain output styles and do not want them to appear in the list of choices, you can delete them or move them out of your Styles folder.
Lists

You can select an item from a journal title list or term list when creating or editing a record, or when entering a search expression. ProCite finds the available lists in the Lists folder found in the ProCite program folder and the folder you enter in the File Locations tab. If you have two lists with the same name, both are available.

Search Expressions

ProCite saves search expressions in a single file, so you can enter only a single file location in this text box.

Internet Search Settings

Click the Internet Search tab to change options for PubMed and Z39.50 database searching. These settings are used each time you select Internet Search or PubMed Search.

These options are described in Chapter 15: Internet Capabilities in the section titled Setting Internet Search Options.
Default Database Settings

Default database settings apply to new databases created with your copy of ProCite. To access these options, go to the Tools menu and select Options. On the General tab, click the Edit Defaults button.

Record Numbering

On the Record IDs tab, you can modify the Starting Record ID and the Increment. These determine how record IDs are assigned to each new record.

The starting record ID is assigned to the first record in the database. Numbers are assigned to subsequent records by adding the Record Number Increment to the highest record ID in the database.

You can change these settings at any time, but they take effect only for new databases. Existing databases are not affected. If you want to renumber the records in an existing database, go to the Database menu and select Renumber Database.

For more information about record numbering, see Chapter 21: Record IDs and Renumbering.
Duplicate Detection

The **Duplicate Detection** tab determines which fields are used when comparing records for possible duplicates.

Remember that the database defaults set here affect only *new* databases created with your copy of ProCite.

You can find possible duplicates in three different situations. ProCite can:

- Alert you when you enter individual records
- Throw away duplicates when importing records from an outside source
- Show all duplicates when you display the **Duplicates** tab

For more information about the duplicate detection options, and how to change them for an *existing* database, see *Chapter 12: Detecting Duplicate Records*. 
Chapter 4: Creating, Opening, Sharing, and Managing Files

Sorting

On the Default Database Settings dialog, four tabs apply to sorting:

- **Custom Sort Order** allows you to create a custom sort that includes up to six sort levels, each in ascending or descending order.

- **Custom Sort Options** allows you to vary how empty fields, author fields, and date fields sort.

- **Stop Lists** allows you to list words to ignore when sorting.

- **International Settings** allows you to change the way individual characters sort based on a language setting.

You can change these settings at any time, but they affect only new databases. Existing databases are not affected. If you want to modify the sort options for an existing database, go to the **Sort** menu and choose **Configure Available Sorts**.

For detailed information about these sorting options, see Chapter 11: Sorting Records.

Closing Files

To close the current file (database, output style, workform, or list), select **Close** from the **File** menu. ProCite may prompt you to save changes to open records or files.

To close all ProCite files and exit ProCite, go to the **File** menu and select **Exit** (Windows) or **Quit** (Macintosh). All databases and any other ProCite files are closed when you close the ProCite program.

Backing Up Files

Loss of your data is not only inconvenient; reentering lost references is expensive, if it is possible at all. Back up your databases often, especially after making numerous changes or additions.

We recommend that you keep an archival backup of your databases (plus custom workforms, output styles, lists, and configuration files) on separate disks from your regular backups. You will still have an old backup to restore even if your regular backups were made after your hard disk developed a bad sector. Even an archival backup that is several months old could save your database from total disaster.
You can back up workforms, output styles, lists, and configuration files simply by copying them to floppy disks. Once your databases start growing, though, it becomes unlikely that you can fit even a single database on a floppy disk.

You can back up your ProCite databases using any backup utility available from a third-party vendor. Each database is made up of two files. For example:

<table>
<thead>
<tr>
<th>Windows</th>
<th>Macintosh</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample.PDT</td>
<td>Sample</td>
</tr>
<tr>
<td>Sample.PDX</td>
<td>Sample.PDX</td>
</tr>
</tbody>
</table>

Only the main file is absolutely essential, but you should back up both files. The main file contains the text of your records, while the .PDX file contains key information for sorting, searching, and other operations. If the main file is missing, your data is lost. If the .PDX file is missing, ProCite will simply rebuild it.

### Renaming Files

To rename any ProCite file, use the **Rename** command from ProCite's **File** menu.

If you prefer, you can instead rename files from the desktop. Remember that each ProCite database is comprised of two *required* files, one with the extension .PDX. You must rename both files, leaving extensions intact.

### Deleting Files

To delete a ProCite database, or any other ProCite file, close the file and use the **Delete** command from the ProCite **File** menu. In the case of a database, ProCite will delete the two files that comprise the database.

You may prefer to delete a file from the desktop. When deleting a database, remember to delete both database files. Each ProCite database is comprised of two files, one with the extension .PDX.

**Possible Conflict:**

- Do not delete a ProCite workform currently used in one of your databases! You will have to recreate or reinstall the workform, mark the records that were in the original workform, and use Global Change Workform to move the records into the new workform.
Sharing Files

This section discusses how to share your ProCite files with other users. It also lists possible conflicts you can experience when you share files.

ProCite Program

You can share the ProCite program with other users if you have purchased a multi-user network package. The original software package indicates how many users may legally access ProCite. See Chapter 2: Installation for information about installing the multi-user program files on a network and user files on each individual’s machine.

Databases

When the database you want to share is available on a network:

- Any number of users can open the same database with read-only access. You may want to place the database in a read-only folder to make sure the database is always available to multiple users.

- One user at a time can open a database with read-write access. If a user already has a database open with read-write access, ProCite will tell other users that the database is already in use. The database is not available to others until the user with read-write access closes it.

- If a database is in use by someone, with either read-write or read-only access, you will not be able to open the database with read-write access.

- If you are each running a separate copy of the ProCite program, make sure you all have the same workforms available to ProCite before opening the database. See the Workforms section which follows for information about possible workform conflicts.

- If you create a database with ProCite for the Macintosh and want to share it with ProCite for Windows users, you must add the extension .PDT to the primary database file name.

When you want to copy a database to another user’s machine:

- If you are both using only the predefined workforms, you can simply copy your database disk files to the other user’s Database folder.

- If you have changed the predefined workforms or created new workforms, you must supply the appropriate workforms along with the database files. See the next section about sharing workforms.
Workforms

Every ProCite installation includes the predefined workforms. If you deleted or modified workforms and would like new copies of the original files, run the installation program again to reinstall workform files. See Chapter 2: Installation for installation information.

Store your workforms in ProCite’s Forms folder. If you want to modify a workform, we recommend that you open the file and use the Save As command to make a copy of the file and give it a different name.

Share a custom workform with another user in one of the following ways:

- Copy your workform file to the other user’s Forms folder. You can copy files over a network or with diskettes.

- Export any number of marked records, with workform definitions, to a delimited text file. Then, import those records into the other user’s database. Workform definitions in the import file that do not match existing workforms are created and added to the user’s Forms folder.

- If you are both using the same copy of ProCite on a network, make sure your workform is in ProCite’s Forms folder. It will be available for all users who use that copy of ProCite.

- To share a ProCite for the Macintosh workform with a ProCite for Windows user, add the extension .PWF to the workform file name.

Possible Conflicts:

Because you can modify any workform, you can run into several conflicts:

- You renamed a predefined workform, and later want to share data with a colleague. Each of the predefined workforms has an internal code, so ProCite knows to which workform each record is linked. When you copy your database to your colleague’s machine, and your colleague has not changed his workform to match yours, the records will transfer into your colleague’s original predefined workform.

- You completely modified a predefined workform. If you already entered records into the original workform, the fields may no longer match. Data in a field that no longer exists in the workform will appear in the Edit Record window with dashes as the field name. Either use the Global Move command to move the data to the appropriate field, use Global Edit to delete the field of information, or modify the workform again to restore the field.
• You saved a copy of a predefined workform with the **Save As** command, giving it a new name before modifying it. You will not run into any conflicts in your own database, but remember to supply the new workform when you want to share your data with someone else.

**Output Styles**

If you deleted or modified some of the output styles installed with ProCite and would like a new copy of the original files, you can run the installation program again to reinstall output styles. See **Chapter 2: Installation** for more information about installing files.

Store your output styles in ProCite’s **Styles** folder. If you want to modify an output style, we recommend that you make a copy of the file and give it a different name.

**Share a custom output style with another user in one of these ways:**

• Copy your output style to the other user’s **Styles** folder. You can copy files over a network or with diskettes.

• If you are both using the same copy of ProCite on a network, make sure your output style is in the appropriate **Styles** folder. It will be available for all users who use that copy of ProCite.

• If you want to share a ProCite for the Macintosh output style with a ProCite for Windows user, add the extension **.POS** to the output style file name.

**Possible Conflicts:**

• You modified an original output style. When you got a ProCite program update and installed the new output styles, your custom output style was overwritten. Whenever you modify one of the predefined output styles, you should give it a different name to avoid overwriting it.

• You saved a copy of an original output style with the **Save As** command, giving it a new name before modifying it. That was the best thing to do and will minimize conflicts.

• You created or modified a workform, and now your output is strange or nonexistent for records in that workform. You **must** update your output style so ProCite can correctly format records in that workform. Create or modify the workform style in your output style.
List Files

You can share journal title lists and term lists simply by copying the appropriate files to the appropriate Lists folder. If you want to share a ProCite for the Macintosh list with a ProCite for Windows user, add the extension .LST to the list file name.

Share an alternate text list, ALTERNAT.TXT file by copying it to the appropriate ProCite program folder or database folder.

Search Expressions

ProCite stores saved search expressions in preference files so they can be used by all of your databases. Share your search expressions by copying the appropriate file to the other user’s ProCite program folder. Expressions are saved in files as follows:

- **ProCite Search Expressions**: SrchExpr
- **Internet Search Expressions**: InetExpr
- **PubMed Search Expressions**: PmedExpr

To share a single search expression with someone else, retrieve it on the Search tab, highlight the expression, **Copy** it to the clipboard, and **Paste** it into an email message or other document. The other user can then copy it and paste it into his ProCite Search Expression text box and save it to his preference file.

Internet Search Configurations

Your host and database configurations for Internet searching are stored in the HOST.DAT file found in your ProCite folder. You can share this file by copying it to the appropriate ProCite program folder.

**Note**: Unfortunately, there is no way to share just an individual host or database configuration. All host and database configurations are copied with the HOST.DAT file, so be careful not to overwrite a HOST.DAT file that contains custom configurations.

Individual field mapping to ProCite fields is directed by a Biblio-Link II configuration file. The configuration files used for Internet searching are stored in ProCite’s BKWRAPI folder. Share these files by copying them to another user’s BKWRAPI folder. You select one of these files when setting up a database configuration for Internet searching.
Word Processor Files

When you print a bibliography directly from ProCite to a word processor file, you can copy the file and share it with another user as you would any file created with your word processor.

You can also share a word processor document that has ProCite records linked to it with ProCite’s cite while you write commands.

**This is the most reliable way to transfer a cite while you write document (especially between different word processor versions, between different versions of ProCite, or to transfer to a different platform):**

1. Open the document with the word processor used to create the file.
2. From the **Tools** menu, choose **Revert to Original Text** for all linked citations.
3. **Save** and **Close** the document.
4. If you are sharing with another user, make sure the other user has available:
   a) The word processor document (with all citations reverted to original text).
   b) The ProCite database to which the citations were linked. See the **Databases** heading earlier in this section about **Sharing Files**.
   c) The ProCite program. See the **ProCite Program** heading earlier in this section about **Sharing Files**.
5. Have the new user open the document and use **Scan Document** to re-link all citations.

**Other ways to share a cite while you write document are:**

- Share only the word processor document itself. You must **Generate Bibliography** first, to format the in-text citations and the bibliography. The other user should not edit the citations or reference list. Editing could damage the links and the word processor file.
- If you are both using the same ProCite version and the same word processor version, make sure all of these files are available so the other user can view, print and/or edit the file at will:
  a) The word processor document with the linked citations.
  b) The ProCite database to which the word processor document is linked. See the **Databases** heading earlier in this section about **Sharing Files**.
c) The ProCite program. See the ProCite Program heading earlier in this section about Sharing Files.

With these files available, the user can continue to insert citations, can edit the file, and can format citations and a bibliography using any of the ProCite output styles.

---

**Cross-Platform Compatibility**

This section explains how to share ProCite files initially created under Windows and ProCite files initially created on a Macintosh. It also lists the text characters that do not directly map between platforms.

In order to use data from an older version of ProCite, or from a Reference Manager or EndNote database, you must convert the data from that database into a ProCite 5 database. This process is described in Chapter 2: Installation.

---

**File Sharing**

ProCite 5 for Windows 98/95/NT and ProCite 5 for the Power Macintosh can directly share files. Because Macintosh applications do not require file extensions, and Windows applications almost always use file extensions to indicate file type, you may need to modify disk file names as described in this section.

**Note:** Some file servers do not accept file names longer than eight characters. If this is the case with your server, you will need to shorten file names.

---

**Sharing Files Created with ProCite for Windows**

ProCite for the Macintosh version 5 can open any ProCite file created by ProCite 5 for Windows 98/95/NT. Simply copy the files to a common server or to your hard disk — preferably to the default ProCite folders.

When you want to access a database, make sure both database files are available, and make sure you also have access to any custom workforms used in the database.
Sharing Files Created with ProCite for the Macintosh

You can share any ProCite file with other ProCite for the Macintosh or ProCite for Windows users. When you share a database, make sure you provide both database files, and make sure you also provide any custom workforms used in the database.

To share with other Macintosh users, simply copy your files to a common server or to the other individual's hard disk — preferably to the default ProCite folders.

To share with a ProCite for Windows user, or a combination of Macintosh and Windows users, you must first add these extensions to your filenames:

<table>
<thead>
<tr>
<th>File Type</th>
<th>Add This Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Files</td>
<td>.PDT (primary database file)</td>
</tr>
<tr>
<td></td>
<td>.PDX (leave intact on the key file)</td>
</tr>
<tr>
<td>Workform Files</td>
<td>.PWF</td>
</tr>
<tr>
<td>Term Lists</td>
<td>.PJL</td>
</tr>
<tr>
<td>Journal Title Lists</td>
<td>.PJL</td>
</tr>
<tr>
<td>Output Styles</td>
<td>.POS</td>
</tr>
<tr>
<td>Configuration Files</td>
<td>.CFG</td>
</tr>
</tbody>
</table>

Character Mapping

ProCite maintains an internal character set to allow for cross-platform compatibility of text. Almost all characters directly map between Windows and the Macintosh. However, there are exceptions as noted in this section.

Macintosh to Windows Character Mapping

These Macintosh Roman characters are mapped to the Symbol font on a Windows machine:

| 173 | μ |
| 176 | \| |
| 178 | \* |
| 179 | \| |
| 182 | Õ |
| 183 | Δ |
| 184 | Ο |
| 193 | Ω |
| 215 | ϓ |
These Macintosh Roman characters do not appear under Windows because they do not exist in the Windows character set. If a Windows user does not edit a record that contains one of these characters, the character stays intact for viewing on a Macintosh. However, if a Windows user edits a record that contains one of these characters, the character is permanently removed.

| 210 | 250 |
| 222 | 251 |
| 223 | 253 |
| 240 | 254 |
| 245 | 255 |

### Windows to Macintosh Character Mapping

These Windows Latin 1 characters do not map to the Macintosh. They appear as small empty boxes when viewed on a Macintosh. If a record containing one of these characters is not modified, the character remains intact under Windows. If the record is edited and saved on a Macintosh, the character is permanently removed.

| 128 | not used | 179 | ³ |
| 129 | not used | 185 | ¹ |
| 138 | $ | 188 | ¼ |
| 141 | not used | 189 | ½ |
| 142 | not used | 190 | ¾ |
| 143 | not used | 206 | Ø |
| 144 | not used | 215 | x |
| 154 | $ | 221 | Ÿ |
| 157 | not used | 222 | ¶ |
| 158 | not used | 240 | Ø |
| 166 | † | 253 | ý |
| 173 | - | 254 | ¶ |
| 178 | ² |

### Damaged Files

Occasionally files are damaged. The most common causes are power failures and hardware failures. The easiest way to resolve a damaged file is to restore a backup....
When your files are damaged and you do not have a backup to restore:

- When a database is damaged, use the Rebuild command to attempt to repair the database. See the next section, *Rebuilding a Database* for more information.

- When a predefined output style or workform is damaged or deleted, use the ProCite Installation program to reinstall the original files from the master disk.

- If a custom output style is damaged or deleted, create a new one and redefine it to match the old file.

- If a custom workform is damaged or deleted, create a new one and redefine it to match the old file. Then, globally change the workform for all records that used the original workform to the new workform (even though it has the same name).

- If a list file is damaged or deleted, create a new one and reenter each item. You may be able to create most of the list by printing field contents to a disk file. See *Chapter 18: Building List Files* for more information.

---

**Rebuilding a Database**

You can rebuild a database to reclaim unused disk space, de-fragment your data, or repair a damaged database.

**When to Rebuild a Database**

When ProCite detects damage in a database, it displays an error message and recommends rebuilding the file. However, there are cases where ProCite is not able to warn you. There are also times when you may want to rebuild the database as a convenience, such as reclaiming unused space.

**Reclaiming Disk Space**

When you delete records from a database, disk space is not immediately reclaimed; it is reserved and reused as you insert records. If you have deleted many records from a database, and don’t plan to immediately insert records, you can rebuild the database to free unused space.
Repairing a Damaged File

Many unpredictable problems can damage databases, and most you have no control over. These are some examples:

- A power surge or power failure disrupted power to your computer when a database was open.
- Your computer was reset or restarted while a database was open.
- The disk came in contact with a magnetic source.
- The disk developed bad sectors.

Symptoms of a damaged database are not always clear, but certain error messages and program behavior are signs that a database is damaged.

Error Messages

When ProCite can detect damage in a database, an error message advises you to rebuild it. Stop the operation you are performing and rebuild before continuing.

Sometimes ProCite can not detect damage and attempts to perform an operation with the damaged database. You may get a message from the operating system indicating a problem. The program has been interrupted, and you may find yourself unable to make your machine respond to any command. You must restart your computer.

Lock-up

If ProCite or the operating system cannot detect damage, the program may lock up so that pressing keys has no effect. Try pressing several keys to make sure a lock-up has occurred.

To unlock, you must restart the computer. Turn the power off, wait a few seconds, and then turn it back on.

Restarting can damage an open database, so even if a lock-up occurs due to a hardware problem, your database may be damaged after the reset. ProCite is designed to minimize this type of damage, but it would be wise to rebuild the database you were working on when the lock-up occurred.

Garbled Text

If records display with garbled text, there may be damage that requires you to rebuild the database. First, make sure you haven’t inadvertently changed to an odd default font!
Rebuilding a Database

Before rebuilding a database, make sure you have enough disk space for another database of the same size. When rebuilding, the program creates a corrected copy of the original database—so you will end up with two databases. The copied database does not need to be on the same drive as the original.

We recommend that you keep a backup of the original, damaged database files and work with the new database until you are sure the rebuild operation was successful.

To rebuild a ProCite database:

1. Start ProCite and close the database you want to rebuild.
2. From the Tools menu, select Rebuild to display a file Open dialog.
3. Locate and double-click on the database you want to rebuild. ProCite displays a File Save As dialog.
4. Type a new database name in the text box. ProCite creates the two required database files.
5. Click Save to start rebuilding. A status line displays, giving you an idea of how long the process will take. When ProCite is done rebuilding, the new database opens.

Rebuild attempts to restore custom settings from the original database. If unable to restore an item, ProCite will use the default setting and you will need to change it manually.

If the number of records in the new database is lower than the number of records in the original database, either:
- Some records were damaged and were not repairable, or
- The record count was damaged, and the original database did not really have that many records in it.

Once you are comfortable that the new database is working correctly, you can delete the old database.

If you want the new database to have the same name as the original database, you can rename it after deleting the original database.
Leaving ProCite

To leave ProCite, choose **Exit** (Windows) or **Quit** (Macintosh) from the **File** menu. If records are open with changes made, you are prompted to save those changes. Any open databases are closed. All database settings are saved, including the current sort order and search results.
Overview

You can browse a database, quickly viewing abbreviated records. While browsing, you can display a full record for viewing or editing. You can preview individual formatted records as you highlight records in the list, or you can preview an entire formatted bibliography.
Viewing Abbreviated Records: The Record Lists

When you double-click on a database file, ProCite opens the database and displays a list of abbreviated records. (When you open a new database, no records are displayed.)

You can browse through the single-line records, mark or unmark records, or display records in full for viewing or editing.

The abbreviated record display includes the following components:

- **Title bar**  The Title bar displays the name of the active database.

- **Menu bar**  The Menu bar displays a row of menus, from which you choose commands.

- **Toolbar**  The various toolbar icons provide quick access to frequently used ProCite commands. Turn toolbars on or off from the View menu.

- **Record list**  The record list displays a list of the current records selected for display, in a particular field order.

- **Tabs**  Use the tabs at the bottom of the record list to display different subsets of records.

- **Status bar**  There are two status bars along the bottom. The first shows the current sort order of the list, the number of records marked, the number of records in the current list, and the total number of records. The second displays the current database status plus tooltip descriptions for icons and menu items, and you can turn it on or off from the View menu.
By default, ProCite shows the Author, Title, and Date for each record. These are common fields used to browse and identify records, and you may never want to change this display from the default. However, you can use the View menu’s Configure Record List command to show up to six fields for each record in a record list. For more information about configuring your database display and changing the display font and style, see Changing the Record List Display later in this chapter.

The abbreviated record list is the default database display. Use the tabs along the bottom of the list to view various sets of records in a database:

- **All Records**
- **Marked Records**
- **Search** - to search and view search results
- **Terms** - to view records that contain a particular author, journal, title, or keyword, or share the same workform
- **Groups** - to view records saved in various sets
- **Duplicates** - to view potential duplicate records, based on comparison criteria
- **Internet Search** or **PubMed Search** - to view online search results: appears only when you initiate an online database search
Note: If the window is too narrow to display all of the tabs, use the directional arrows in the bottom left corner to move between tabs. Under Windows, you can also use Ctrl+Page Up and Ctrl+Page Down to move between tabs.

Displaying All Records

Click the All Records tab to view a list containing every record in the database. You can highlight or mark a subset of records to work with or print.

Displaying Marked Records

Click the Marked Records tab to view only those records that have been individually marked for inclusion in the set of marked records.

Each record has a check box to the left of it. Click in the check box to mark or unmark an individual record. To mark a group of records, highlight them and then choose Mark Highlighted Records from the Select menu or click the marked icon on the toolbar.

Once you’ve marked a group of records, you can print that set of records or save the set as a group so you can restore the set later.

Displaying Marked Records is the only way to quickly see all the marked records. In any other record list, you may or may not see all of the marked records.

Displaying Search Results

Click the Search tab to search the database and display search results. See Chapter 13: Searching and Finding Records for more information.
Displaying with Field Content Lists

Click the **Terms** tab to display subsets of records with field content lists.

From the drop-down **Show** list, select a field content list, which displays the terms found in the current database. By default, ProCite includes field content lists for Authors, Journals, Titles, and Keywords. You can also select the Workform item to list records by reference type. These lists are automatically compiled from the records that exist in your database.

In the left pane of the window, click on terms to display various subsets of records, such as by author name or journal title. A record count appears next to each term, indicating how many records in the current database contain that term.

**Authors**

From the **Show** list, select **Authors** and ProCite displays, in the left pane of the window, a list of all authors found in the database. Click on an author name to list all records by that author.

![Sample Database](image)

ProCite compiles the **Authors** list from these fields:

*Author, Analytic (01)*

*Author, Monographic (07)*

*Author, Subsidiary (16)*

*Series Editor (30)*

“Authors” in these fields include any combination of personal authors, corporate authors, editors, composers, etc. ProCite displays author names from the first author field that contains data. For example, if a record contains author names in field 01 and field 07, only the author names in field 01 display in the record list.
If the author’s name you choose is found in field 16 or 30 of the workform, it may not be visible in the record list. Display the full record (double click on it) to see all of the data within the record. In the example above, "Gilman, Alfred G." isn't visible in the second record. However, he is listed as an editor in the field Author, Monographic (07) in that record.

**Journals**

From the Show list, select Journals to display the list of journal titles found in the database. The Journals list is compiled from this field:

*Journal Title (10)*

In the following example, the article was published in the Journal of the American Chemical Society, but only the article title appears in the record list. Display the full record to see all of the data within the record.

![Sample Database]

**Titles**

From the Show list, select Titles to display a list of all titles found in the database. Click on a specific title to view the record with that title. The Titles list is compiled from these fields:

*Title, Analytic (04)*
*Title, Monographic (09)*
*Title (11)*
*Series Title (32)*

“Titles” included in these fields are article titles, book titles, newspaper titles, etc. If the title you choose is found in field 09, 11, or 32 of the workform, it may not be visible in the record list. ProCite displays the title from the first title field that contains data.
Keywords

From the Show list, select Keywords to display a list of all unique keywords found in the database. Then, click on a term to view all records that contain that term in the Keywords field of the record.

Since the keyword list of terms is made from existing records, you can browse through the list to check for misspellings or other errors in keyword entry. If you do find an error, you can edit records individually, or you can quickly use the global find and replace feature to fix all occurrences of the error. See Chapter 10: Global Editing for more information about doing a global find and replace.

Displaying by Workform

From the Show list, select Workforms to display a list of the ProCite workforms used in the database. Click on a workflow name to view all records that were entered into that workflow type.

This feature makes it easy to view records of the same type; for example, all references to conference proceedings or all references to journal articles.

Displaying Groups

Groups are sets of records saved for use later. Although the records remain in the full database, they can also be saved in a named subset (group) for easy access at a later time. You can save any set of records to a group, including search results. See Chapter 14: Saving Records in Groups for more information.

Click the Groups tab to display the list of groups found in the database. In the left pane of the window, select a group name to list the records saved in that group.
Displaying Duplicate Records

Click the **Duplicates** tab to list possible duplicate records.

You can define the criteria to compare in detecting duplicates. See *Chapter 12: Detecting Duplicate Records* for more information.

Changing the Record List Display

You can customize the record list to make it best for you by displaying up to six (truncated) ProCite fields for each record.

The Default Display

The default display shows three fields from each record: **Author**, **Title**, and **Date**. These are the most common fields used to browse and identify records, and you may never want to change this display from the default.

- **Author**: the first author found as ProCite scans author fields 01 and 07
- **Title**: the first title found as ProCite scans title fields 04, 09, 10, and 11
- **Date**: the first date found as ProCite scans date fields 20 and 21

You can change the width of the columns by dragging the vertical bar between column titles. For example, to see more of each title and allow less room for dates, move the bar between title and date to the right.

Although the **Author** field is the first field displayed, your records are not necessarily sorted alphabetically by author. You can change the sorted order of the record list without changing the order of the fields displayed in an individual record. See *Sorting the Display* later in this chapter.
Setting a Custom Display

ProCite’s record list can show up to six abbreviated fields from each record. You can choose any combination of up to six fields.

From the View menu, choose Configure Record List. ProCite displays the Configure Record List dialog.

The Layout box in the dialog contains three columns of options:

- The Show column of check boxes indicates which of the six fields to display in the record list.
- The Column Header text boxes allow you to enter column headings for the record list.
- The Displayed Field column is where you select the fields to display, in the order you want them to appear.

Selecting the Fields

From the Displayed Fields column, choose the fields that will form the columns of the abbreviated record view in the order you want them to appear. You can display up to six fields. For each item in the column, click on the arrow to display the list of fields to choose from. If the arrow is not available (dimmed) click the Show check box to select that item for display.
The field list includes all 45 ProCite fields, plus five “special” fields at the top:

- **Author** displays the first author entry found in fields 01 or 07, whereas **Author, Analytic (01)** displays only authors entered in field 01.

- **Title** displays the first title entry found in fields 04, 09, 10, or 11, whereas **Title, Analytic (04)** displays only titles entered in field 04.

- **Date** displays the first date entry found in fields 20 or 21, whereas **Date of Publication (20)** displays only dates entered in field 20.

- **Workform** displays the name of the workform used by each record.

- **Record ID** displays the ProCite record ID assigned to each record.

In most cases you should use the special fields, since they will almost always display text from every record in your database. Be careful when selecting an individual field for display, since that field may or may not exist in all workforms; you could end up with empty columns, which are not helpful when browsing through records.

### Setting Column Headers

For each field you want to display, you can type in a column header. Type descriptive text that explains the information displayed in the column.

If a **Column Header** text box is dimmed, select the **Show** check box for that field.

### Selecting Visible Fields

The **Show** check boxes allow you to quickly turn a field on or off for display. For example, the default setting indicates **Record ID** as the first field for display. However, the **Show** check box is not selected for that field, so **Record ID** will not display in the record list. The check box makes it easy to toggle record IDs on or off for display—without changing the lists of Displayed Fields and Column Headers each time.

By default, we used the check boxes to limit the displayed fields to three: **Author**, **Title**, and **Date**.

### Saving Changes to the Display

Click **OK** in the Configure Record List dialog to save changes and return to the record list. All record lists in this database will now display the fields you selected.
If the fields you want to display do not appear, go through the Setting up a Custom Display section again:

- Make sure the fields you are displaying both exist and contain data in almost every workform. Using the generic fields usually works best.
- Make sure the Show box is selected for each field you want displayed.

**Resizing the Column Widths**

You can resize the width of the columns in the record list. For example, you may want to display only a few characters of each author’s last name, but display full titles.

To resize the width of the columns, drag the vertical bar between the column titles to the left or right from any record list.

**Changing the Display Font and Style**

You may change the font and size of the text in your record list at any time. Keep in mind, though, that changes affect the display of all databases opened with this copy of ProCite. Font, size, and style changes also affect field content lists.

To change the font and size of text in your record list:

1. From the View menu, choose Configure Record List.
2. Choose a font from the Font pull-down list.
3. Choose a point size from the Size pull-down list.
4. Click OK to return to the record list. ProCite updates your list in the new font and size.

**Sorting the Display**

Although the Author field may be the first field displayed from each record, your records may not be sorted alphabetically by author. The sorted order of your records is controlled separately from the display of fields for each record.

To change the sorted order, click on a column header to sort by that field. Or, choose a new sort order from the list under the Sort menu. The current record list immediately displays in the new order.
There are three ways to display a complete record for viewing or editing:

- Select it from a record list and press Enter (Windows) or return (Macintosh).
- Double-click the record.
- Highlight the record and choose **Edit Record** from the **Database** menu.

The Edit Record window appears. To browse the entire record, use the scroll bar. Use the tab keys to jump from field to field.

You can edit at any time when viewing full records. Use the window Close box to close a record.

**Workform**: The Workform drop-down list shows which workform was used to enter this record.

The workform indicates what document type (journal, book, etc.) is represented. See Chapter 8: **Choosing a Workform** for more information about workforms.

**Record ID**: This is the record ID assigned to the record by ProCite, unless it was later changed individually or the database was renumbered.
• **Go to Record**: To view another complete record, use the Go to Record directional buttons on the toolbar. The buttons go to the appropriate record in the current record list and in the current sorted order. Use the magnifying glass to find a specific record.

You can also use the View menu's Go to Record commands or their key equivalents to move between records.

• **Font/Size/Style**: From the Text toolbar, use the Font pull-down list to change the font for selected (highlighted) text. Use the Size pull-down list to change the font size for selected text. Click on the appropriate button to apply a style to selected text; the options are bold, italic, underline, superscript, and subscript.

• **Symbols**: Use the Symbols button on the toolbar to insert special characters.

• **Invisible Characters**: Use the ¶ button on the Text toolbar to display characters which indicate spaces, new paragraphs and line feeds.

• **Fields**: For each field, the Field Name appears in bold text and is followed by the contents of the field.

## Configuring the Edit Record View

To change the appearance of the records when editing, go to the View menu and select **Configure Edit Record**. ProCite displays this dialog:
From this dialog, you can change the default **Font** and **Size** for all records. You can also change these settings:

- **Show Invisible Characters**, when selected, displays a visible character to indicate spaces, new paragraphs and line feeds. This check box serves the same function as the paragraph symbol on the Text toolbar.

- **Show Field Numbers**, when selected, displays the corresponding field numbers next to each field name. Field numbers are helpful for searching and for modifying output styles.

- **Show Empty Fields**, when *not* selected, removes all empty fields from the record display. Only those fields that contain data remain in view, although empty fields are still part of the record.

- **Show Term List Buttons**, when selected, displays buttons to bring up field content lists and term lists in the Author, Title, and Keywords fields.

- **Show Record Toolbar**, when *not* selected, removes the toolbar that displays the workform and record ID for the current record.

**Viewing Multiple Records**

ProCite lets you view several records at once, making it easier to compare them. You can view multiple records from a single database or from several databases.

**To view two records at the same time:**

1. From a record list, double-click to open a record. Reduce the size of the record window and move it to the top of the screen.

2. Go to the **Window** menu and activate a record list window, whether in the same database or a different database.

3. Double-click to open a second record. Reduce the size of the record and move it to the bottom of the screen.

4. Go to the **Window** menu and activate the window containing the first record. This displays the records one above the other.
You can resize and move each record to view the maximum number of fields possible for each. You can open any number of databases and any number of records; the only restriction is available memory. You can switch between the records to compare, edit, or copy fields.

Moving Between Records

In a record list, you may simply want to browse through your records with the scroll bar. That may not be practical in a very large database.

To jump directly to a specific record in a record list:

1. From the Sort menu, select a sort order so the text you are looking for is included in the first level sort. For example, if you want to jump to a particular title, select the Title/Date sort or a custom sort that first compares titles.

2. Click on any record in the record list to activate the list.
3. Type the first few characters used to identify the record. The characters must be the first in the field. ProCite displays a Go to Record dialog.

4. Continue typing as many characters as you feel may be required to differentiate the record from others, then click OK.

ProCite searches from the top of the record list and highlights the record that most closely matches the text you typed. If several records match, only the first match in the list is highlighted. Stop words are ignored when jumping to records.

You can also use the Go to Record commands from the View menu to move between records in an abbreviated record list or between full records:

- **Find** displays the Go to Record dialog where you type the characters to find; it looks in the field used for the first level of the current sort
- **First** goes to the first record in the current list
- **Previous** goes to the previous record in the current list order
- **Next** goes to the next record in the current list order
- **Last** goes to the last record in the current list
- **First Marked** goes to the first marked record in the current list
- **Previous Marked** goes to the previous marked record in the current list order
- **Next Marked** goes to the next marked record in the current list order
- **Last Marked** goes to the last marked record in the current list

To make some of these commands more accessible, you can use the View menu to turn on the Go to Record toolbar.
Viewing Formatted References

As you are browsing through records, you can see a highlighted record as it looks formatted with the current output style. With a record list on the screen, select Preview Pane from the View menu.

As you move through the database, the preview pane updates to display the highlighted record as formatted using the current output style. Use your mouse to drag the divider and increase or reduce the amount of space used by the preview pane.

You can change the output style used in the preview pane and the placement of the preview pane. From the View menu, select Configure Record List and click on the Preview Pane tab.
Viewing Bibliographies

Before printing your bibliography to a printer or word processor file, you preview it on screen. You can preview with no intent to print.

To view a bibliography on-screen:

1. From the File menu, choose Print Bibliography.
2. The Bibliography Preview window appears, displaying your bibliography exactly as it would print to your printer.

- Click Next Page to move to the next page of the bibliography.
- Click Prev Page to move to the previous page.
- Click Two Page to display two pages at once.
- Click Zoom In to enlarge the preview size and look at details.
- Click Zoom Out to reduce the display for an overview of layout.
You may wish to change layout settings under Configure Bibliography. Click the Configure button to select a different output style, change margins or change other layout options. For a description of all options available under the Reference List, Fields, and Layout tabs, see Chapter 17: Printing Bibliographies.

When you are done previewing the bibliography, you can Print it to your printer, Save it to a disk file, or simply Close the window to return to the record list.
# Chapter 6

## Entering and Editing Records

### Overview

### Contents

- Inserting and Opening Records ............................................. 134
  - Inserting a Record ................................................... 134
  - Opening an Existing Record .................................. 136
- Copying Records ........................................................... 137
- Deleting Records .......................................................... 138
  - Selecting a Workform ................................................. 138
    - Pre-defined vs. User-defined Workforms .................. 139
    - Changing the Workform Setting .......................... 139
  - Changing the Record Display ........................................ 141
- Entering and Editing Data In Records ............................... 142
  - General Rules .......................................................... 142
  - Special Field Rules .................................................. 143
    - Special Formatting Characters ................................. 144
    - Author Names ..................................................... 144
    - Dates ..................................................................... 146
    - Keywords ................................................................ 148
  - Editing Keys ............................................................. 149
  - Inserting Special Characters ........................................ 150
  - Applying a Font, Style, or Size .................................. 150
  - Changing the Record ID ............................................. 151
  - Field Length .................................................................. 151
  - Finding and Replacing Text ........................................... 152
  - Attaching Files, URLs, and UIs .................................... 152
- ProCite’s Lists ....................................................................... 153
  - Types of Lists ........................................................ 153
    - Field Content Lists .............................................. 153
    - Term Lists ........................................................ 153
    - Journal Title Lists ............................................... 153
    - Alternate Text Lists .............................................. 154
  - Using Lists ................................................................... 154
    - Entering Text with Lists ........................................ 155
    - Modifying Lists ..................................................... 156
  - Copying Text ................................................................... 156
  - Saving or Ignoring Changes ........................................... 157
There are several ways to get data into ProCite. This chapter describes how to manually type or paste text into each record and how to copy full records between ProCite databases.

Other means of inserting records are described in *Chapter 9: Importing Records* and *Chapter 15: Internet Capabilities*.

**Note:** Many menu items in ProCite have a corresponding keyboard equivalent and/or a toolbar icon. The keyboard equivalent appears on the menu next to the associated command. Turn toolbars on or off from the View menu, and hold the cursor over a toolbar icon to find out the corresponding command. While this manual does not always mention keyboard equivalents or toolbar icons, you can use them at any time. For a list of keyboard equivalents and toolbars, see the appendices at the back of this manual.

---

**Inserting and Opening Records**

This section describes how to insert a new record, how to open an existing record, how to copy a record, and how to delete a record.

**Inserting a Record**

**To add a new record to a ProCite database:**

1. From the **Database** menu select **New Record**.

   The Edit Record window appears with an empty workform displayed. It is the last workform selected. If you want to use a different workform, use the drop-down list. See *Selecting a Workform* later in this chapter for more information about your options.
2. Fill in the fields of information. See *Entering and Editing Data* later in this chapter for help.

3. When you are done inserting a record, you can:

   - Choose **New Record** from the **Database** menu to save and close the current record and insert another new record with the next sequential record ID.
   - Click the Close box to save or cancel the current record and return to the abbreviated record list.
Opening an Existing Record

For information on how to find a particular record for editing, see Chapter 13: Searching and Finding Records.

To edit a record:

1. From the current record list, select a record for editing. You can:
   - Double-click on the record
   - Highlight the record, and from the Database menu choose Edit Record

   The Edit Record window appears:

   ![Sample Database: Edit Record](image)

   - **Author**, Analytic (01): Borgen, Christine L.
   - **Author Affiliation (03)**: Graduate School of Library and Information Science, University of California, Los Angeles, CA
   - **Paper/Section Title (04)**: From hands-on science to hands-on information retrieval
   - **Medium Designator (05)**: c
   - **Connection Phrase (06)**: in
   - **Editor/Compiler (07)**: Niu, Carol/Fadigah, Laura
   - **Editor/Compiler Role (08)**: compilers
   - **Proceedings Title (09)**: Managing Information and Technology
   - **Date of Meeting (12)**: October 30, 1999-November 2, 1999
   - **Place of Meeting (13)**: Washington, D.C.
   - **Place of Publication (18)**: Medford, NJ
   - **Publisher Name (19)**: Learned Information
   - **Date of Publication (20)**: 1999

2. Make the desired changes. See Entering and Editing Data later in this chapter for help.

3. Click the Close box and ProCite will prompt you to save changes and return to the abbreviated record list. You will be returned to the list most recently viewed.
Copy records

You can copy full records between databases or within a single database. When inserting a series of records that contain much duplicate information, it may be helpful to insert one record, duplicate it several times, and then edit the resulting duplicates.

You can open the two databases, arrange them to display both record lists on the screen, and use drag-and-drop to copy records from one database to the other. Or, you can copy marked records between databases.

**To copy marked records to another database:**

1. Open the ProCite database that contains the records you wish to copy.
2. From the Select menu, choose Clear Marked Set.
3. Mark the records you wish to copy.
4. From the Database menu, choose Copy Marked Records. ProCite displays a file dialog.
5. Highlight the name of an existing database (it can be the database from which you are copying) or type in a new filename and click Open. ProCite makes an exact copy of each marked record and inserts each one into the database indicated.

If you copy records into an existing database, the resulting database may contain duplicate records that were in both the source and destination databases. For information on finding and deleting duplicate records, see Chapter 12: Detecting Duplicate Records.

ProCite copies the original record IDs. If you copy into an existing database, that database may then contain duplicate record IDs. If you prefer unique record IDs, you may want to renumber the records in the destination database. For more information on renumbering, see Chapter 21: Record IDs and Renumbering.

**To duplicate a single record within a database:**

1. Display the record you want to duplicate.
2. From the Database menu, insert a New Record.
3. Select the appropriate workform from the drop-down list on the toolbar.
4. From the Edit menu, select Insert Previous Record.
Deleting Records

You can delete one record from your database or several records at once. Deleted records are removed *permanently*. Do not delete a record unless you are sure you never want to see it again!

**To delete highlighted records from your ProCite database:**

1. In any record list, highlight the record(s) you wish to delete.
2. From the **Database** menu, select **Delete Record**. ProCite will ask you to verify the deletion, just to make sure.

**To delete marked records from your ProCite database:**

1. From the **Select** menu, choose **Clear Marked Set**.
2. Mark each record you wish to delete by checking the box next to each record. You can mark across different record lists.
3. Display the **Marked Records** tab to verify the marked set. Make sure only those records you wish to delete are displayed.
4. From the **Database** menu, select **Delete Marked Records**. ProCite will ask for verification, to avoid accidentally deleting records.

Selecting a Workform

Before entering information in a ProCite record, you need to choose a workform appropriate for the type of work being entered.

A workform is a fill-in-the-blank template for records of a particular type of work. It organizes the information in the record. For correct handling by ProCite, each type of material, such as a journal, book, or patent, is entered into an appropriate workform.

This section briefly discusses how to change the workform for a record. If you would like detailed information about which workform you should use for a given work, see *Chapter 8: Choosing a Workform*.

You may want to scan through the fields to make sure the workform is an appropriate choice. To move the cursor through the fields in a workform, use either the tab key or your mouse. To quickly scan the entire workform, use the scroll bar at the right to move to the bottom of the record.
Pre-defined vs. User-defined Workforms

The workforms provided with ProCite cover frequently-encountered types of materials. These will most likely meet all of your needs. Appendix B: ProCite Workforms and Fields, lists the predefined workforms and the fields included in each. You can also create your own new workforms or modify existing workforms. However, changes to workforms may require changes to your output styles. For more information about customizing workforms, see Chapter 22: Creating and Modifying Workforms.

Changing the Workform Setting

When you insert a new record, the default workform is the workform you last selected. However, you can choose a different workform for any record within the database.

Every workform is made up of fields, with each field containing information of a particular type (for example, a title or a date). Each field has a ProCite field number and a field name, such as Author (01) or Title (04), as well as the information contained in the field.

New Record

To select a workform for a new record:

1. In the Edit Record window, check the workform selected at the top of the window. If you need to change it, click on the workform name. A drop-down list appears.
2. Scroll through the list to your choice and click on it. The drop-down list closes, with your choice in the text box. The fields displayed depend on the workform selected.

**Existing Record**

**To change the workform for an existing record:**

1. In the Edit Record window, click on the workform name. A drop-down list appears.

2. Scroll through the list to your choice and click to select it. The drop-down list closes, with your choice in the text box. The fields displayed depend on the workform chosen.

If there was information in a field that is not part of your newly-chosen workform, the field name will be a string of dashes "— — —", indicating that the field is not part of the current workform.

You should move that information into a field that *does* exist in the current workform. Although there is no harm in leaving it, you may not be able to print it. To move the information, highlight the text and use **Cut** and **Paste** from the **Edit** menu. Because the original field tagged with dashes is now empty, the next time you open the record for editing that field will no longer appear.
Changing the Record Display

To change the layout of records in the Edit Record window, first open a record, then go to the View menu and select Configure Edit Record.

![Configure Edit Record Window]

You can select a different Font and Size for the default record display. You can also use these layout options:

- **Show Invisible Characters**, when checked, displays a visible character to indicate spaces, new paragraphs and line feeds. This check box serves the same function as the paragraph symbol on the Text toolbar.

- **Show Field Numbers**, when checked, displays corresponding field numbers next to each field name. Field numbers are helpful for searching and for modifying output styles.

- **Show Empty Fields**, when not checked, removes all empty fields from the record display. Only those fields that contain data remain in view, although empty fields are still part of the record.

- **Show Term List Buttons**, when checked, displays buttons to bring up field content lists and term lists in the Author, Title, and Keywords fields.

- **Show Record Toolbar**, when not checked, removes the toolbar that displays the workform and record ID for the current record.

Click OK to save changes.
Use the View menu’s Go to Record commands to move between full records. The available records are the ones listed in the current record list. The order of the records is the same as the sorted order of the record list.

You can Find a specific record or move to the First Record in the list, the Previous Record, the Next Record, the Last Record, the First Marked Record, the Previous Marked Record, the Next Marked Record, or the Last Marked Record.

Tip: You may prefer to use the Go to Record toolbar to move between records.

Entering and Editing Data In Records

When entering data into records, some essential rules and special formatting characters are important.

General Rules

All fields in ProCite are of variable length and can handle virtually any type of information. How you enter that information is the key to creating bibliographies in the correct format. The most important thing is to be consistent with your entries, such as using standard terminology, keywords, and capitalization throughout your records.

Although you can enter character styles and punctuation into the actual text of your records, you should rely on ProCite’s output styles to provide styles and punctuation. Output style formatting provides maximum flexibility because the style and punctuation commands are completely independent of the records in a database. For example, you can use one output style to provide underlined titles and use another when you want quotation marks around titles.
Special Field Rules

For ProCite to create bibliographies with the correct formatting, it is essential that you enter information correctly. For field-by-field detailed instructions, see Chapter 7: Entering Data Field-by-Field.

There are some fields with permanent attributes that ProCite assumes to contain particular types of information. For example, if ProCite recognizes anything in a date field as a valid date, it will apply date formatting as defined in the output style.

These special fields are:

- **Author fields (01, 07, 16, 30)** ProCite uses special instructions for handling author names in formatting citations, and there are special rules for entering names so that ProCite can handle them correctly. Multiple entries are allowed.

- **Title fields (04, 09, 10, 11, 32)** These fields contain titles. ProCite uses special instructions for handling titles in formatting citations.

- **Date fields (12, 20, 21)** These fields accept a wide variety of date formats. ProCite uses special instructions when searching, sorting, and formatting dates.

- **Reprint Status field (12)** Although officially a date field, field 12 most often holds a reprint status. When the field is titled *Reprint Status*, you can type your own reprint status or choose from a drop-down list. If you select the status "On Request," ProCite inserts the current date in the Date subfield. You can overtype with a different date if you wish.

- **Location in Work field (25)** This field typically contains page numbers. ProCite uses special instructions for printing page numbers and ranges of page numbers in formatted citations.

- **Call Number field (44)** In this field, ProCite can sort the mix of alphanumeric characters that are used in the Dewey Decimal and Library of Congress classification systems.

- **Keywords field (45)** Terms entered here can be used for searches and are often used as headings for lists. Multiple entries are allowed.
Special Formatting Characters

Fields in ProCite that require special formatting characters include Authors, Dates, and Keywords. The special formatting characters let ProCite know that special formatting instructions apply. The special characters themselves do not appear in the final bibliographies you produce.

<table>
<thead>
<tr>
<th>Characters:</th>
<th>Use to:</th>
</tr>
</thead>
<tbody>
<tr>
<td>/ carriage return</td>
<td>Separate multiple keywords (words or phrases) in the field Keywords (45)</td>
</tr>
<tr>
<td>// ; carriage return</td>
<td>Separate multiple author names in a single field</td>
</tr>
<tr>
<td>////</td>
<td>Indicate additional, unlisted authors (recognized by output styles)</td>
</tr>
<tr>
<td>?</td>
<td>Designate unknown portion of four-figure year, for example, 19??</td>
</tr>
<tr>
<td>=</td>
<td>Precede corporate author names to tell ProCite to ignore personal author formatting</td>
</tr>
</tbody>
</table>

Author Names

ProCite assumes these fields contain author names:

- *Analytic Author (01)*
- *Monographic Author (07)*
- *Subsidiary Author (16)*
- *Series Author (30)*

Although you can physically put author names in any ProCite field, we strongly recommend that you stick to these four fields, because:

- These are the fields ProCite searches for authors
- Authors from these fields are included in the Authors field content list. The Authors list allows for easy data entry and quick author searching.
- The output styles allow control over how these fields are formatted. You can strip author names to initials, limit the number of authors printed, and more.
Personal Authors

Enter each name as completely as possible in this order:

lastname, firstname middle

Jordan, Karen M.

It is best to enter the full author name rather than using initials in order to accommodate bibliographic styles that require full names. ProCite can reduce full names to initials, as required by some bibliographic styles, but cannot expand initials to full names. If only an initial is available, follow it with a period. When there are two initials, separate them with a period and a space.

Examples:

Hollister, Charles Warren
Ross, T. J.
Gorman, Anne
Meade, Michael J.

Corporate Authors

Corporate authors are companies, government agencies, universities, etc. Use an equal sign (=) before the name so ProCite ignores normal author formatting. Corporate authors print as entered (but without the =).

Examples:

=Department of the Treasury
=MWS Corporation

Multiple Authors

When listing multiple authors, use a double slash (/), a semicolon (;), or a carriage return between author names. You can use these separators interchangeably, but it is best to be consistent. The separator is replaced with appropriate punctuation by the output style.

For works by many authors, include all of the names you have, because some bibliographic styles require every author name. The output style will print the number of names required for the bibliographic style.

If you do not know all of the names, enter the names you do have followed by the additional authors indicator—four slashes (/////). When you create a bibliography, these slashes are converted to the text indicated (such as “and others”) in the output style.
You can combine corporate authors with personal authors. Use an equal sign before corporate authors, and separate authors with double slashes. For example:

Smith, John Wyeth//Meade, Michael J.
Smith, Jonathon Paul///// 
Larson, Paul//Howell, James T.//// 
Brown, Michael//Williams, Doris//=MWS Corporation

ProCite differentiates corporate from personal names and formats them accordingly.

**Dates**

ProCite assumes these fields contain dates:

- **12 Date of Meeting** (or reprint request)
- **20 Date of Publication**
- **21 Date of Copyright**

We strongly recommend you stick to these fields for dates, because:

- These are the fields ProCite can intelligently search for dates, by converting each date to an internal format.

- These are the only fields which can sort dates in chronological order.

- The output styles allow control over how these date fields are formatted, so you can print each date in a consistent form for each workform.

ProCite recognizes a variety of date styles and converts these styles to a consistent internal format. When converted, any style of a date retrieves the same date entered in a different style. For example, ProCite interprets the following styles as the same date: Nov. 1, 1998, 11/1/98, and 11/1/1998. Ambiguous dates are assumed in U.S. format: 1/5/98 is January 5th, 1998.

Use a four-digit year for dates before 1900 or after 1999, such as 1896 or 2002. Two-digit years are assumed 20th century, so "98" is interpreted as "1998".
Use any of the following formats when entering dates into a Date field. ProCite can convert them to a consistent format for output:

### BC/AD

<table>
<thead>
<tr>
<th>BC/AD</th>
<th>AD</th>
<th>BC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000 B.C.</td>
<td>500BC</td>
<td>500AD</td>
</tr>
<tr>
<td>B.C. 500</td>
<td>65 BC</td>
<td>1999 A/D</td>
</tr>
<tr>
<td>BC 500</td>
<td>AD 500</td>
<td></td>
</tr>
</tbody>
</table>

### Unknown Date

| Unknown Date | 1999?      | 40? A.D.   |

### Year

<table>
<thead>
<tr>
<th>Year</th>
<th>1999a</th>
<th>1998</th>
</tr>
</thead>
<tbody>
<tr>
<td>99</td>
<td>1999B</td>
<td>2001</td>
</tr>
</tbody>
</table>

### Month/Year

<table>
<thead>
<tr>
<th>Month/Year</th>
<th>11/1999</th>
<th>November-99</th>
</tr>
</thead>
<tbody>
<tr>
<td>11.99</td>
<td>11-1999</td>
<td>Nov. 99</td>
</tr>
<tr>
<td>11/99</td>
<td>11 1999</td>
<td>November_1999</td>
</tr>
<tr>
<td>11-99</td>
<td>11_1999</td>
<td>Nov. 1999</td>
</tr>
<tr>
<td>11_99</td>
<td>11,1999</td>
<td>Nov ’99</td>
</tr>
<tr>
<td>1999/11</td>
<td>1999 11</td>
<td>1999 November</td>
</tr>
</tbody>
</table>

### Month/Day/Year

<table>
<thead>
<tr>
<th>Month/Day/Year</th>
<th>11/1/99</th>
<th>1 Nov 99</th>
</tr>
</thead>
<tbody>
<tr>
<td>1999 November 1</td>
<td>11-1-99</td>
<td>January.99</td>
</tr>
<tr>
<td>1999 Nov. 1</td>
<td>11.1.99</td>
<td>1 November 1999</td>
</tr>
<tr>
<td>November 1, 99</td>
<td>11_1_99</td>
<td>1st November 1999</td>
</tr>
<tr>
<td>Nov. 1, 1999</td>
<td>11,1,99</td>
<td>1 Nov. 1999</td>
</tr>
<tr>
<td>Nov. 1st, 1999</td>
<td>1.xi.99</td>
<td>1 November 2001</td>
</tr>
<tr>
<td>ii.14.1999</td>
<td>1999/XI/I</td>
<td>991101</td>
</tr>
<tr>
<td>1-XI.99</td>
<td>1999 11 01</td>
<td>2001/11/1</td>
</tr>
</tbody>
</table>

### Date Ranges

<table>
<thead>
<tr>
<th>Date Ranges</th>
<th>Sep-Oct 1999</th>
<th>1999 Spring-Summer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spring, 1999</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fall, 1999</td>
<td>Win 1998-1999</td>
<td>4-11 Jan 99</td>
</tr>
<tr>
<td>Winter 1999</td>
<td>Jun-Jul 99</td>
<td>99 Win-Spr</td>
</tr>
<tr>
<td>Summer-Fall, 1999</td>
<td>Jan-Feb 99</td>
<td>1998/99</td>
</tr>
<tr>
<td>Fall-Winter, 1999</td>
<td>6/12 Jan 1999</td>
<td>1999-</td>
</tr>
<tr>
<td>Win-Spr, 96-99</td>
<td>Win 98/Spr 99</td>
<td>Nov 2, 1999-</td>
</tr>
</tbody>
</table>
You can use question marks in an unknown date, such as “19??.” Internally the program converts each question mark to a zero, so that unknown dates, when sorted, appear before any similar known dates. For example, “19??” will appear before 1900 and 1902, but after 1898 and 189?.

ProCite interprets “90?” and “1990?” as the year 1990 only and not any year in the decade. Similarly, ProCite interprets “40? AD” as the specific year 40 AD and not any year in the fifth century.

**Keywords**

The 45 Keywords field holds user-selected identification terms that describe the subject content of the referenced work. Keywords are used to:

- Search for records by subject matter.
- Produce subject lists or subject bibliographies (with keywords as headings).

Consistency and control of terminology is necessary to later find records with the same terms in this field. You can use term lists to maintain a standardized list of terms.

When entering data in the Keywords field, separate multiple terms by a slash (/) or carriage return. You need to separate terms so that you can use both words and phrases as keywords. Some examples:

- History/ Nineteenth century/ England
- Computer Technology
- DNA/ Genes/ Chemical analysis
## Editing Keys

When entering or editing records, you can use editing keys as follows:

<table>
<thead>
<tr>
<th>Action</th>
<th>Windows Command</th>
<th>Macintosh Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Record</td>
<td>F9</td>
<td>F9</td>
</tr>
<tr>
<td>Edit Record</td>
<td>Enter</td>
<td>Return</td>
</tr>
<tr>
<td>Save Record</td>
<td>F10</td>
<td>Command+S</td>
</tr>
<tr>
<td>Open File/URL</td>
<td>Ctrl+L</td>
<td>Command+L</td>
</tr>
<tr>
<td>Cut</td>
<td>Ctrl+X</td>
<td>Command+X</td>
</tr>
<tr>
<td>Copy</td>
<td>Ctrl+C</td>
<td>Command+C</td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl+V</td>
<td>Command+V</td>
</tr>
<tr>
<td>Clear</td>
<td>Del</td>
<td>Delete</td>
</tr>
<tr>
<td>Select All</td>
<td>Ctrl+A</td>
<td>Command+A</td>
</tr>
</tbody>
</table>

### Move Insertion Point

- To Next Field: Tab
- To Previous Field: Shift+Tab
- To Beginning of Line: Home
- To End of Line: End
- To Beginning of Field: Ctrl+Home
- To End of Field: Ctrl+End
- To Start of Next Word: Ctrl+Right Arrow
- Up One Window: Page Up
- Down One Window: Page Down

### Delete

- Record: Ctrl+D
- Previous Character: Backspace
- Following Character: Del

### Insert

- Previous Field: F5
- Previous Record: Shift+F5
- Symbol: F7
- Term: F8
- New Paragraph: Enter
- Line Break: Shift+Enter
- Tab: Alt+09
- Nonbreaking Space: Ctrl+Shift+Space
Inserting Special Characters

To enter symbols or diacritics (umlauts, tildes, and other accents), put the cursor where you wish to insert the character and select **Insert Symbol** from the **Edit** menu. The table of characters for the current font appears.

![Insert Symbol](image)

You can select a different font to update the table of characters. Double-click on the character you wish to enter, or highlight it and click **Insert**, and ProCite will enter it at the insertion point. You can enter any number of symbols. When done, click **Close**.

### Applying a Font, Style, or Size

As a general rule, do not enter styled text into a record. Use the output style to apply styles, so you can apply different styles in different circumstances.

However, if you want to apply a style to only part of the text in a field, such as italicizing a scientific name, you will need to do that in the record. To apply a style (bold, italic, underline, superscript, subscript) to text, highlight the text and click on the appropriate style button on the Text toolbar at the top of the window. (If the Text toolbar is not displayed, you can turn it on from the **View** menu.)

Apply a font and size here only if you want to permanently change them for printing. If you want to change the default font and size for the display of all records, see *Changing the Record Display* earlier in this chapter.

To change the font and point size, highlight the text and select the new font or size from the drop-down lists on the Text toolbar.

If you want to view or change all font and style settings for the highlighted text, go to the **Edit** menu and select **Font**.
Changing the Record ID

ProCite automatically assigns a record ID as you insert each record. You can change the record ID of the current record byHighlighting and overtyping it. You can type in up to 20 alphanumeric characters.

If you want to change the interval between record IDs or renumber multiple records, see Chapter 21: Record IDs & Renumbering.

Field Length

ProCite automatically adjusts the length of a field as you enter data, so you can enter up to 100,000 characters per record without wasting disk space on smaller records.

You can minimize the field display by showing only fields that contain data. This makes it easier to scan through a full record. From the View menu, select Configure Edit Record and deselect the Show Empty Fields box. There is also a toolbar icon available to toggle this item.
Finding and Replacing Text

To find and replace text in records, browse the record lists, mark the record(s) you wish to change, and use the global editing commands.

The **Edit Marked Records** commands on the **Database** menu help you:

- Find and Replace Text in Marked Records
- Clear Text from a Field in Marked Records
- Add Text to a Field in Marked Records
- Move Text from one Field to another Field in Marked Records

For more information, see *Chapter 10: Global Editing*.

Attaching Files, URLs, and Uls

You can add a path and filename, an Internet URL, or a Medline (PubMed) unique identification number (UI) to a ProCite record and later launch the attached file, URL, or UI. Enter items in your ProCite records as shown in these examples:

<table>
<thead>
<tr>
<th>File Type</th>
<th>Enter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local File</td>
<td>Windows: <code>c:\documents\research</code></td>
</tr>
<tr>
<td></td>
<td>Macintosh: <code>file:///mac/documents/research</code></td>
</tr>
<tr>
<td>Internet URL</td>
<td><code>http://www.procite.com</code></td>
</tr>
<tr>
<td></td>
<td><code>ftp://ftp.isiresearchsoft.com</code></td>
</tr>
<tr>
<td>Medline UI</td>
<td><code>89025932</code></td>
</tr>
</tbody>
</table>

To go to the file:

- When the item is entered in the field *Location/URL (38)*, you can either highlight the record in a record list or open the record for editing. Then, from the **Tools** menu, choose **Open File/URL**.

- If the item is in a field other than 38, open the record for editing, highlight the item, and from the **Tools** menu choose **Open File/URL**.

ProCite takes action depending on the file type:

- **Local File**: ProCite launches the file as though you had double-clicked the file icon on the desktop.

- **URL**: ProCite launches your default browser and directs it to the Internet location.

- **UI**: ProCite launches your browser and directs it to the citation in the National Library of Medicine's Medline database.
ProCite’s Lists

ProCite’s lists help ensure the consistency of your entries. You can create any number of external lists that can be used across databases. However, field content lists generated for Authors, Journals, Titles, and Keywords are internal and apply only to the database where they were generated.

Types of Lists

There are several types of lists in ProCite:

- Field Content Lists
- Term Lists
- Journal Title Lists
- Alternate Text Lists

Field Content Lists

Field content lists are internal lists generated from the Author, Journal, Title, and Keywords fields. These lists contain every unique entry found in that field (or group of fields) for all records in the database. Because the field content lists are generated from text in your records, you cannot directly edit them.

You can access field content lists from the Terms tab and the Search tab, making it easy to find specific records. You can also use them for data entry.

Term Lists

Term lists are external lists that you create and edit. Use them for data entry or when building a search expression. A term list can be used by any database, and because it is not tied to a single database, it may include terms not found in a particular database.

Journal Title Lists

A journal title list is a sorted list of journal titles, each with an alternate term that can be substituted on output. These alternate terms can include standard abbreviations, acronyms, synonyms, or some other title.
Journal title lists can be used to simplify data input and searching, allowing you to select from the list rather than entering the title manually. ProCite’s output style instructions can use the journal title list for output substitution in the *Journal Title (10)* field. Journal title lists are external, so you can apply them to any or all ProCite databases.

**Alternate Text Lists**

Used only for output, the alternate text list is a sorted list of primary terms, each with an associated secondary term (alternate text). When substitution is active, each primary term will be replaced by the secondary term for formatted output.

Generally, you should use other lists instead of the alternate text list. Use the journal titles list for data entry and for substituting abbreviations for journal names on output. Use field content lists and term lists for data entry.

The alternate text list is an external, editable list that applies to all databases. For more information about using alternate text on output, see *Chapter 20: Using Alternate Text*.

**Using Lists**

ProCite’s lists can be used for:

- **Data Entry:** ProCite’s lists help you avoid problems that could arise from entering synonyms and variant forms of words and phrases. You can select a term from a list to enter directly into your record. If you entered variations of terms, you would miss some records you want when you perform a search.

- **Searching:** (1) You can use field content lists on the Terms tab to quickly list appropriate records. (2) When creating a search expression, choosing a term from a field content list ensures that the term exists in the database.

- **Text Substitution for Output:** You can choose an alternate form to be substituted for an entry on output. This is especially useful for journals, using the journal titles list, so ProCite can substitute standard abbreviations or alternate titles for the titles in your records—to meet appropriate style rules. For more information, see *Chapter 20: Using Alternate Text*. 
Entering Text with Lists

To use a ProCite list when inserting or editing a record:

1. From the Edit Record window, use one of these two methods to display the list of field content lists, term lists and journal title lists that are available:

   - When inserting text in an author, title, or keyword field, move the cursor to where you want the text inserted and click on the arrow next to the field.
   - When inserting text in any of the ProCite fields, move the cursor to where you want the text inserted and select Insert Term from the Edit menu.

   The Insert Term dialog appears:

2. To view a different list than the one displayed:

   a. From the Source list, select a ProCite database or a term list. The databases and term lists shown are those found in ProCite’s Database and List folders and the database and list folders specified by you under Tools>Options>File Locations.

   b. If you selected a ProCite database, choose a field content list from the Terms drop-down list.
3. Scroll through the list of terms to find the entry you want in your field, then:

   a. If you will typically insert a single item, check the **Close after insert** box at the bottom of the dialog. When you double click on an item, ProCite will close the dialog and insert the term at the cursor in your ProCite record.

   b. To insert multiple items, do not select the **Close after insert** box at the bottom of the dialog. Double-click on each item you want to insert, and click **Close** to close the dialog when you are done.

**Modifying Lists**

You can create any number of external lists (term lists, journal title lists) which can be shared between databases and can be modified at any time. For instructions, see *Chapter 18: Building List Files*.

Field content lists cannot be modified because they are automatically generated from existing records. However, you do have access to field content lists from other databases via the Insert Term dialog.

**Copying Text**

You can copy or move the contents of a field from one record to another, and you can copy text between applications.

**Copying and Pasting Text**

You can copy all or part of a field to a field in another record, your word processor, or any other application by using **Copy** and **Paste**. You can also use these commands to copy a long note or abstract from your word processor to a ProCite record.

1. Highlight the text you wish to copy.

2. Select **Copy** from the **Edit** menu to copy the highlighted text to the clipboard. Or select **Cut** if you wish to move the highlighted text.

3. Move the insertion point to where you wish to insert the text, whether in ProCite or another application.

4. Choose **Paste** from the **Edit** menu to paste the text from the clipboard.

If you will be copying or moving text between two ProCite records, you can keep both records open at the same time. Either resize each record so you can see them both onscreen or switch between the two windows.
Copying Fields from the Previous Record

You can copy the contents of a field to the same field number in another record. The field numbers must be the same, although the field names may vary.

To copy an entire field of text from one ProCite record to another:

1. Open for editing the record whose field contents you want to copy. You can leave the record open or close the record before going on to the next step.

2. Open the record into which you want to copy the field text. You can insert a New record or open an existing record for editing.

3. Move the cursor to the field where you want to insert the text copied from the same field number in the previously opened record. For example, if the cursor is in Author, Monographic (07), you will be inserting information from field 07 in the previous record (even though the field name may vary).

4. From the Edit menu, select Insert Previous Field. ProCite will copy the field contents from the previously opened record and insert a copy of those field contents at the cursor.

   You can move the cursor from field to field, copying the field contents from the previously opened record.

   **Tip:** To copy all fields, select Insert Previous Record from the Edit menu.

Saving or Ignoring Changes

When you are done inserting or editing a record, click on the Close box. ProCite asks whether to save changes.

- To save and close the current record, click Yes.
- To close the record without accepting your changes, click No.
- To return to the record and continue editing, click Cancel.

When all open records are closed, you are returned to the record list.

When you are done inserting a record, you can also select New Record from the Database menu to save the current record and insert a new record with the next sequential record ID. This allows you to quickly insert multiple records. When you are finished inserting records, click on the Close box to save the last record and return to the record list.
Chapter 7

Entering Data Field-by-Field

Overview

Contents

General Data Entry ............................................................... 160
Locating Fields by Field Number ........................................... 161
Abstract Field (43) ............................................................... 163
Address/Availability Field (37) ........................................... 163
Author Fields (01), (07), (16), (30) .................................... 164
Author Affiliation Field (03) .............................................. 167
Author Role Fields (02), (08), (17), (31) ............................ 168
Call Number Field (44) ..................................................... 169
CODEN Field (39) ............................................................. 169
Connective Phrase Fields (06), (36) ................................. 170
Date Fields (12), (20), (21) .............................................. 170
Document Type Field (35) ................................................. 174
Edition Field (15) .............................................................. 174
Extent of Work Field (26) ................................................. 174
ISBN Field (41) ................................................................. 175
ISSN Field (40) ................................................................. 175
Issue ID Fields (24), (34) ................................................ 175
Keywords Field (45) ........................................................ 175
Location in Work Field (25) .............................................. 176
Location/URL Field (38) .................................................. 178
Medium Designator Fields (05), (14) .............................. 178
Notes Field (42) ................................................................. 179
Packaging Method Field (27) .......................................... 180
Place of Meeting Field (13) ............................................. 180
Place of Publication Field (18) ....................................... 181
Publisher Name Field (19) ............................................ 181
Record ID Field ................................................................. 181
Report ID Field (23) ......................................................... 182
Reprint Status Field (12) ............................................... 182
Reproduction Ratio Field (29) ...................................... 182
Size Field (28) ................................................................. 183
Title Fields (04), (09), (10), (11), (32) ......................... 183
Volume ID Fields (22), (33) ............................................. 185
This chapter supplements *Chapter 6: Entering and Editing Records*. Fields are listed by default field name. Each section gives a description of the intended field usage and tips for data entry. To locate a field, use the “Locating Fields by Field Number” table.

**General Data Entry**

All fields in ProCite are variable length and can handle almost any type of information. How you enter that information is the key to getting correctly formatted output. Enter text as continuous text, the way you do with a word processor. ProCite will wrap the text and the field will expand to accommodate the information.

You should not regularly use character styles such as italics or bold when entering data. When all text is entered plain, you can apply styles to fields of text with ProCite’s output styles. There are, however, times when you will want to enter data using character styles. For example, if part of the text in a field should be superscripted or otherwise different from the rest of the field (such as a Latin term in italics or a scientific name underlined), as in:

*In vivo* transfer of the human cystic fibrosis transmembrane conductance regulator gene to the airway epithelium
## Locating Fields by Field Number

<table>
<thead>
<tr>
<th>Field #:</th>
<th>Field Name:</th>
<th>Section Heading:</th>
</tr>
</thead>
<tbody>
<tr>
<td>00</td>
<td>Record Number</td>
<td>Record Number</td>
</tr>
<tr>
<td>01</td>
<td>Artist</td>
<td>Author</td>
</tr>
<tr>
<td>01</td>
<td>Author, Analytic</td>
<td>Author</td>
</tr>
<tr>
<td>01</td>
<td>Catalog Author</td>
<td>Author</td>
</tr>
<tr>
<td>01</td>
<td>Composer</td>
<td>Author</td>
</tr>
<tr>
<td>01</td>
<td>Inventor</td>
<td>Author</td>
</tr>
<tr>
<td>02</td>
<td>Artist Role</td>
<td>Author Role</td>
</tr>
<tr>
<td>02</td>
<td>Author Role</td>
<td>Author Role</td>
</tr>
<tr>
<td>02</td>
<td>Composer Role</td>
<td>Author Role</td>
</tr>
<tr>
<td>03</td>
<td>Author Affiliation</td>
<td>Author Affiliation</td>
</tr>
<tr>
<td>03</td>
<td>Address</td>
<td>Author Affiliation</td>
</tr>
<tr>
<td>04</td>
<td>Patent Title</td>
<td>Title</td>
</tr>
<tr>
<td>04</td>
<td>Article Title</td>
<td>Title</td>
</tr>
<tr>
<td>04</td>
<td>Paper/Section Title</td>
<td>Title</td>
</tr>
<tr>
<td>04</td>
<td>Section Title</td>
<td>Title</td>
</tr>
<tr>
<td>04</td>
<td>Catalog Title</td>
<td>Title</td>
</tr>
<tr>
<td>04</td>
<td>Map Title</td>
<td>Title</td>
</tr>
<tr>
<td>04</td>
<td>Program Title</td>
<td>Title</td>
</tr>
<tr>
<td>04</td>
<td>Title, Analytic</td>
<td>Title</td>
</tr>
<tr>
<td>04</td>
<td>Title/Subject</td>
<td>Title</td>
</tr>
<tr>
<td>05</td>
<td>Computer Program</td>
<td>Medium Designator</td>
</tr>
<tr>
<td>05</td>
<td>Data File</td>
<td>Medium Designator</td>
</tr>
<tr>
<td>05</td>
<td>Medium</td>
<td>Medium Designator</td>
</tr>
<tr>
<td>05</td>
<td>Medium Designator</td>
<td>Medium Designator</td>
</tr>
<tr>
<td>05</td>
<td>Map Type</td>
<td>Medium Designator</td>
</tr>
<tr>
<td>06</td>
<td>Connective Phrase</td>
<td>Connective Phrase</td>
</tr>
<tr>
<td>07</td>
<td>Assignee</td>
<td>Author</td>
</tr>
<tr>
<td>07</td>
<td>Author, Monographic</td>
<td>Author</td>
</tr>
<tr>
<td>07</td>
<td>Editor</td>
<td>Author</td>
</tr>
<tr>
<td>07</td>
<td>Author/Programmer</td>
<td>Author</td>
</tr>
<tr>
<td>07</td>
<td>Cartographer</td>
<td>Author</td>
</tr>
<tr>
<td>07</td>
<td>Editor/Compiler</td>
<td>Author</td>
</tr>
<tr>
<td>07</td>
<td>Producer</td>
<td>Author</td>
</tr>
<tr>
<td>07</td>
<td>Recipient</td>
<td>Author</td>
</tr>
<tr>
<td>08</td>
<td>Author Role</td>
<td>Author Role</td>
</tr>
<tr>
<td>08</td>
<td>Cartographer Role</td>
<td>Author Role</td>
</tr>
<tr>
<td>08</td>
<td>Editor/Compiler Role</td>
<td>Author Role</td>
</tr>
<tr>
<td>08</td>
<td>Producer Role</td>
<td>Author Role</td>
</tr>
<tr>
<td>09</td>
<td>Collection Title</td>
<td>Title</td>
</tr>
<tr>
<td>09</td>
<td>Recording Title</td>
<td>Title</td>
</tr>
<tr>
<td>09</td>
<td>Report Title</td>
<td>Title</td>
</tr>
<tr>
<td>09</td>
<td>Short Form Title</td>
<td>Title</td>
</tr>
<tr>
<td>09</td>
<td>Title, Monographic</td>
<td>Title</td>
</tr>
<tr>
<td>10</td>
<td>Journal Title</td>
<td>Title</td>
</tr>
<tr>
<td>10</td>
<td>Magazine Title</td>
<td>Title</td>
</tr>
<tr>
<td>11</td>
<td>Newspaper Name</td>
<td>Title</td>
</tr>
<tr>
<td>Field #:</td>
<td>Field Name:</td>
<td>Section Heading:</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
<td>------------------</td>
</tr>
<tr>
<td>11</td>
<td>Title</td>
<td>Title</td>
</tr>
<tr>
<td>11</td>
<td>Translated Title</td>
<td>Title</td>
</tr>
<tr>
<td>11</td>
<td>Subsidiary Title</td>
<td>Title</td>
</tr>
<tr>
<td>12</td>
<td>Abstract Journal Date</td>
<td>Date</td>
</tr>
<tr>
<td>12</td>
<td>Date of Meeting</td>
<td>Date</td>
</tr>
<tr>
<td>12</td>
<td>Reprint Status</td>
<td>Reprint Status</td>
</tr>
<tr>
<td>13</td>
<td>Place of Meeting</td>
<td>Place of Meeting</td>
</tr>
<tr>
<td>13</td>
<td>Country</td>
<td>Place of Meeting</td>
</tr>
<tr>
<td>14</td>
<td>Document Type</td>
<td>Medium Designator</td>
</tr>
<tr>
<td>14</td>
<td>Medium Designator</td>
<td>Medium Designator</td>
</tr>
<tr>
<td>15</td>
<td>Edition</td>
<td>Edition</td>
</tr>
<tr>
<td>15</td>
<td>Version</td>
<td>Edition</td>
</tr>
<tr>
<td>15</td>
<td>Patent Number</td>
<td>Edition</td>
</tr>
<tr>
<td>16</td>
<td>Author, Subsidiary</td>
<td>Author</td>
</tr>
<tr>
<td>16</td>
<td>Director</td>
<td>Author</td>
</tr>
<tr>
<td>16</td>
<td>Performer</td>
<td>Author</td>
</tr>
<tr>
<td>17</td>
<td>Author Role</td>
<td>Author Role</td>
</tr>
<tr>
<td>17</td>
<td>Director Role</td>
<td>Author Role</td>
</tr>
<tr>
<td>17</td>
<td>Performer Role</td>
<td>Author Role</td>
</tr>
<tr>
<td>18</td>
<td>Place of Publication</td>
<td>Place of Publication</td>
</tr>
<tr>
<td>18</td>
<td>Abstract Journal</td>
<td>Place of Publication</td>
</tr>
<tr>
<td>19</td>
<td>Distributor</td>
<td>Publisher Name</td>
</tr>
<tr>
<td>19</td>
<td>Publisher Name</td>
<td>Publisher Name</td>
</tr>
<tr>
<td>19</td>
<td>University</td>
<td>Publisher Name</td>
</tr>
<tr>
<td>20</td>
<td>Date of Letter</td>
<td>Date</td>
</tr>
<tr>
<td>20</td>
<td>Date of Publication</td>
<td>Date</td>
</tr>
<tr>
<td>20</td>
<td>Patent Issue Date</td>
<td>Date</td>
</tr>
<tr>
<td>21</td>
<td>Application No./Date</td>
<td>Date</td>
</tr>
<tr>
<td>21</td>
<td>Date of Copyright</td>
<td>Date</td>
</tr>
<tr>
<td>21</td>
<td>Original Publication Date</td>
<td>Date</td>
</tr>
<tr>
<td>22</td>
<td>Acquisition Number</td>
<td>Volume ID</td>
</tr>
<tr>
<td>22</td>
<td>Catalog Number</td>
<td>Volume ID</td>
</tr>
<tr>
<td>22</td>
<td>Section</td>
<td>Volume Identification</td>
</tr>
<tr>
<td>22</td>
<td>Abstract Journal Volume</td>
<td>Volume ID</td>
</tr>
<tr>
<td>22</td>
<td>Volume ID</td>
<td>Volume ID</td>
</tr>
<tr>
<td>23</td>
<td>Matrix Number</td>
<td>Report ID</td>
</tr>
<tr>
<td>23</td>
<td>Report ID</td>
<td>Report ID</td>
</tr>
<tr>
<td>24</td>
<td>Issue ID</td>
<td>Issue ID</td>
</tr>
<tr>
<td>24</td>
<td>Abstract Journal Issue</td>
<td>Issue ID</td>
</tr>
<tr>
<td>24</td>
<td>Plate Number</td>
<td>Issue ID</td>
</tr>
<tr>
<td>25</td>
<td>Location in Work</td>
<td>Location in Work</td>
</tr>
<tr>
<td>25</td>
<td>Pages</td>
<td>Location in Work</td>
</tr>
<tr>
<td>25</td>
<td>Abstract Journal Page(s)</td>
<td>Location in Work</td>
</tr>
<tr>
<td>26</td>
<td>Extent of Letter</td>
<td>Extent of Work</td>
</tr>
<tr>
<td>26</td>
<td>Extent of Work</td>
<td>Extent of Work</td>
</tr>
<tr>
<td>26</td>
<td>Timing</td>
<td>Extent of Work</td>
</tr>
<tr>
<td>27</td>
<td>Packaging Method</td>
<td>Packaging Method</td>
</tr>
<tr>
<td>28</td>
<td>Size</td>
<td>Size</td>
</tr>
<tr>
<td>29</td>
<td>Reproduction Ratio</td>
<td>Reproduction Ratio</td>
</tr>
</tbody>
</table>
Abstract Field (43)

The abstract field usually contains an abbreviated representation of the content of the work. For example:

Selected document texts of American presidents

As with any ProCite field, you can type up to 32,000 characters. You may wish to enter the entire text of short publications.

Address/Availability Field (37)

Use this field for the author's address, the address from which to obtain a reprint of an article, or to indicate where to consult the work.

Examples: University of Michigan, Ann Arbor, MI 48103
Syracuse University, Bird Library
Email address: info@isiresearchsoft.com

For field names by workform see Appendix B: ProCite Workforms and Fields.
Author Fields (01), (07), (16), (30)

An author field can contain multiple entries—any combination of personal authors and/or corporate authors.

Author Name Fields:

- **Author, Analytic (01):** Artist, Catalog Author, Composer
  
The party (author, authors, corporation, etc.) responsible for the creation or artistic content of a work that is part of a larger work (such as an article in a journal or a chapter in a book). Also used for the assignee of a patent.

- **Author, Monographic (07):** Author/Programmer, Cartographer, Editor/Compiler, Producer
  
The party (authors, editors, translators, compilers, etc.) responsible for an entire work, described as a unit. For example, the author of a single work (like a book), or the editor or compiler of a collective work (such as a journal issue) in which an analytic work is found.

- **Author, Subsidiary (16):** Director, Performer
  
The party responsible for adapting, interpreting, or otherwise modifying the intellectual or artistic content of a preexisting work (the work of the primary author). Subsidiary authors include translators, editors, and performers of musical works. May also be used for the birth name of an author when the primary author is a pseudonym. List an editor in this field only when another person or organization serves as author.

- **Series Editor (30)**
  
Compiler or editor of a collection of separate works (monographs), usually related in subject and issued in succession with a collective title.

Entry rules

Always enter author names into one of ProCite’s four author fields to ensure proper output when formatting citations. ProCite applies author formatting instructions only to the four author name fields.

Enter the primary author into the first author field that appears in the workform (field 01 or field 07). This allows appropriate sorting by generic author. Enter a secondary author in the second author field in the workform (field 07 or field 16).
Personal Authors

It is best to enter the full author name rather than using initials, in order to accommodate bibliographic styles that require full names. ProCite can reduce full names to initials, as required by bibliographic styles, but cannot expand initials to full names.

• Enter author names in this order:

   Lastname, Firstname Middlename

   Type the first character of each name in upper case and all other characters in lower case. Put a comma between the last name and first name, a space between the first name and middle name, and a period after each initial. For example:

   Hollister, Charles Warren
   de Gaulle, Charles
   Ruth, G. H.
   Meade, Michael J.

• ProCite recognizes two letters followed by a period as a “two-letter” initial that is already abbreviated, and will be used “as is.” For example:

   Robinson, JH.

   If you don’t intend it as a two-letter initial, change the entry to avoid misinterpretation by ProCite. For interpretation as two separate initials, put periods after both initials, or separate them with a space. For example:

   Robinson, J.H.
   Robinson, J. H.
   Robinson, J H

• For multiple authors, either enter each name on a separate line, or use double slashes (//) or semicolons (;) between author names entered on the same line. For example:

   Smith, John Wyeth//Meade, Michael J.

• Include all the names you have. Instructions in ProCite’s output styles will use the number of names required for the bibliographic style.

   If you do not know all of the names, enter as many as possible followed by the multiple author indicator, four slashes (////). When you create a bibliography, ProCite will convert these slashes to the multiple indicator defined in the output styles (for example, “et al.” or “and others”). For example:

   Smith, John Wyeth////
   Smith, Alexander, J.; Smith, John Wyeth////
• Some author surnames include a prefix. If you wish, you can ignore the prefix for sorting. For example:

von Goethe, Johann Wolfgang

can sort under “von Goethe” or “Goethe.” To ignore “von” for sorting, put that prefix in the Author stop word list. See Chapter 11: Sorting Records for more information about using stop word lists.

If “von” is in the Author stop word list, but you still want to alphabetize a name such as:

Von Euler, Ulf Svante

under “Von,” enter a nonbreaking space after “Von” to group “Von Euler” as a single term not affected by the Author stop word list. To enter a nonbreaking space, press Ctrl+Shift+Space (Windows) or option+spacebar (Macintosh)

**Corporate Authors**

Corporate authors are entities such as corporations, universities, or government agencies for which you don’t want author formatting to apply. The address of a corporate author may be included with the name, but it is normally put in **Affiliation (03)**.

Turn off personal author formatting by preceding the item with an equal sign (=), as in:

=Department of the Treasury
=Toy Manufacturers of America

Always precede a corporate author name with an “=” even if the field contains a mixture of corporate and personal author names. For example:

=Department of Housing//Rogers, Cheryl
Smith, John//Howell, Michael//=MWS Corporation

The separator allows ProCite to recognize the corporate name as part of a list of authors rather than the affiliation of one or more of the listed authors.
Associating Other Information With A Name

Typically, you should enter only author names into the ProCite author fields. Never include prefixes such as “Mr.,” “Mrs.,” or “Dr.,” as ProCite will interpret them as surnames.

You can include suffixes or other information after an author name. The drawback to this is that the additional text will always print with the author’s name; you can't turn it on or off according to a bibliographic style.

Names with Suffixes

Enter an equal sign (=) before a suffix after an author’s name. The equal sign tells ProCite not to manipulate the suffix as part of the author’s name. Enter the suffix, including punctuation, exactly as you wish it to print. For example:

Sodeman, W. A. =, Jr
Stevenson, Adlai E. = III

Additional information with individual names

By using an (=) after an author’s name, you can include other information, such as birth and death dates or author roles. For example:

Hendrix, Jimi = (1945-1970)
Ikuta, J = (née Matsumoto)
Sullivan, Paul =, piano & synthesizers//Fuller, Jeff =, bass

Enter text after the equal sign exactly as you want it to appear — including spaces. If there is only one author, or if all authors have the same role, use the Author Role field(s) for the qualifying information rather than including it in this field.

Author Affiliation Field (03)

This field is used to hold the name of the organization or corporate body, including department or division, where the author was located when the work was created. This can also include the city, state, and country.

Enter information exactly as you want it to appear in formatted output, including capitalization. Abbreviations are acceptable. For example:

Special Finance, GMAC, Detroit, MI
Author Role Fields (02), (08), (17), (31)

An author role field is intended to have a single entry descriptor that applies to all names in the author field that precedes it. Author roles include actor, cartographer, composer, conductor, editor, illustrator, librettist, performer, producer, and translator.

Author Role Fields:

- **Author Role (02):** Artist Role, Composer Role
- **Author Role (08):** Cartographer Role, Editor/Compiler Role, Producer Role
- **Author Role (17):** Director Role, Performer Role
- **Series Editor Role (31)**

Entry rules

- Do not capitalize the first letter of a role name.
- Abbreviate the role identifier as required.
- Enter either a role that applies to all authors (such as “editors”) or just the first author’s role (if any). If there are multiple authors, each with a role, enter each author’s role after the author’s name in the author field (using an equal sign, as described in the previous section).

Single Authors With Role

Examples of single-author roles to enter in an Author Role Field:

- actor, cartographer, composer
- conductor, editor, illustrator
- performer, producer, translator

Multiple Authors With Multiple Roles

If there are two or more authors, each with a role, then enter each author’s role after the appropriate name in the Author field (rather than using the Author Role field). For example:

Meade, Michael =, prod.//Cook, Laura =, comp.

The “=” tells ProCite not to format the author role as if it were part of the author name. Make sure that you put any punctuation associated with the author role after the “=”.
Author Roles As Part Of An Output Style

It is possible to use Special Formatting in an output style that automatically appends an author role to an author field. The output style can supply different text depending on whether you have one or multiple authors (for example “Ed.” versus “Eds.”). This feature saves you from entering the author role into each record if you always want the same author role associated with this field in every record. You can set this in the output style (see Chapter 23: Creating and Modifying Output Styles for more information).

Call Number Field (44)

This field can be used for a classification number of any kind. It frequently shows the physical location of an item in a library, using either a Library of Congress or Dewey Decimal call number.

ProCite can sort valid call numbers using a special sort. All other entries are treated as normal alphanumeric text.

Since the numbers 0 through 999 (optionally followed by up to eight decimal places) are valid Dewey Decimal Class Whole Numbers and Class Decimal Numbers, this field can also be used as an alternative to the record number if you need records in a numeric sort order. For example, it could be used to hold an accession number, location code, etc.

Enter call numbers as they appear on the work, including any phrases. For example:


CODEN Field (39)

CODEN is a unique alphanumeric code for the identification of serial and non-serial titles. Use the alphanumeric code as it appears on the work. For example:

- AAFBAU  or  JONRA9
Connective Phrase Fields (06), (36)

Use the Connective Phrase Fields for a word or phrase clarifying the relationship between two works, often one being part of another. Common connective phrases include “in” and “submitted for publication in” and “cited in.”

A Connective Phrase in field 06 usually qualifies a monographic title. A Connective Phrase in field 36 qualifies the field Address/Availability (37).

The Connective Phrase field may be used instead of the Title (11) field, to hold a retraction statement or published comment/erratum.

Capitalize the first letter of the phrase. For example:

In accompanying
Within
Available from

Date Fields (12), (20), (21)

ProCite will recognize many date formats and will apply special formatting when printing any of these fields.

Date Fields:

Date of Meeting (12): see also Reprint Request
Date of Publication (20): Date of Letter, Patent Issue Date
Date of Copyright (21)

Entry rules

Enter dates as fully as possible, including month and day if available. Enter the primary date in field 20, which allows record sorting by generic date. The output style determines how much of the date will print.

To accommodate information downloaded from online and CD-ROM services, ProCite recognizes a wide variety of date styles and converts them to a consistent internal format. ProCite interprets these all as the same date: Nov. 1, 1999, 11/1/99, and 991101.

• Three-part dates consisting entirely of numbers are assumed to be in U.S. date format (month/day/year). However, although “1.11.99” is interpreted as “January 11, 1999,” “14.ii.1999” is correctly interpreted as “February 14, 1999” because ProCite knows that there is no 14th month.
• A two-digit year is automatically expanded as though in the 20th century, so “99” is actually “1999.”

• For works published before 1900 or after 1999, enter all four digits for years (such as "1898" or "2001").

• To enter a year before 100 AD, always include BC or AD (as in “98 AD”).

• When text surrounds the date, ProCite looks for the first identifiable date in the field. This means that you can still use the date in sorting and in formatting output. Note, however, that ProCite will identify a date only when it is within the first 255 characters of the date field.

• Dates for unpublished works, such as "in press" or "submitted" sort after other valid dates.

• Text that appears in a date field and does not include a valid date is printed as it appears in the record. For example:

    in press
    submitted for publication

• A single letter (upper or lowercase) appended to a year is treated as part of the date, as in: “1999a”, which will sort ahead of “1999b.”

• You can use a question mark (?) to enter an unknown date, such as 19???. In sorting, these are treated as zeros so that 19??? appears before known 20th century dates but after 19th century dates (and before 21st century dates). The question mark is ignored when added to a two- or four-digit year, or added to a date with AD or BC. For example, ProCite interprets “90?” as 1990 specifically, and “40? AD” as 40 AD rather than “any year in the fifth century.” For example, this list of dates would sort in this order:

    19??
    1915
    1920
    1925?
    1930

• Date ranges are recognized by using a slash (/) or hyphen (-) as a delimiter, as in “1998 Nov 30-Dec 3.” Output styles will format the beginning and ending dates in the same way, as in “Nov 30 1998-Dec 3 1998.”
• Avoid dates which could be ambiguous, such as:

   1901/02
   January 1901/02

   ProCite will interpret these as “February 1901” and “January 2, 1901.”

• To print dates exactly as they appear in your records, turn off custom date formatting in the output style. When custom date formatting is turned off, ProCite prints each date exactly as entered. See Chapter 23: Creating and Modifying Output Styles for more information about date formatting.

   If you want a specific date to always print exactly as it appears in a single record, enter an equal sign (=) as the first character in the field. For example:

   =1997/98

• If a cited work has more than one publication group (place, name, date), you can include the secondary group at the end of the Date field. Type the punctuation that would normally be supplied by ProCite. For example:


   ProCite applies date formatting only to the first date found in the field.

   Or, you can use date field 20 for the publication date of a reprint of a work, and field 21 to hold the original publication date.

Examples Of Recognized Date Input Formats

   Use any of the following formats when entering dates (including variations such as omitting or including periods or commas, or using abbreviated versus full month names or years). Use any of these formats in a single database; the output style can convert the various formats to a standard format for printing.
### BC/AD

<table>
<thead>
<tr>
<th>BC/AD</th>
<th>500BC</th>
<th>500AD</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000 B.C.</td>
<td>500BC</td>
<td>500AD</td>
</tr>
<tr>
<td>B.C. 500</td>
<td>65 BC</td>
<td>1999 A/D</td>
</tr>
<tr>
<td>BC 500</td>
<td>AD 500</td>
<td></td>
</tr>
</tbody>
</table>

### Unknown Date

<table>
<thead>
<tr>
<th>Year</th>
<th>1999?</th>
<th>1999?</th>
</tr>
</thead>
<tbody>
<tr>
<td>19??</td>
<td>1999?</td>
<td>40? A.D.</td>
</tr>
</tbody>
</table>

### Year

<table>
<thead>
<tr>
<th>Year</th>
<th>1999</th>
<th>1999a</th>
<th>1898</th>
</tr>
</thead>
<tbody>
<tr>
<td>99</td>
<td>1999B</td>
<td>2001</td>
<td></td>
</tr>
</tbody>
</table>

### Month/Year

<table>
<thead>
<tr>
<th>Month/Year</th>
<th>11/1999</th>
<th>November-99</th>
</tr>
</thead>
<tbody>
<tr>
<td>11.99</td>
<td>11/1999</td>
<td>November-99</td>
</tr>
<tr>
<td>11/99</td>
<td>11-1999</td>
<td>Nov. 99</td>
</tr>
<tr>
<td>11-99</td>
<td>11 1999</td>
<td>November_1999</td>
</tr>
<tr>
<td>11 99</td>
<td>11_1999</td>
<td>Nov. 1999</td>
</tr>
<tr>
<td>11_99</td>
<td>11,1999</td>
<td>Nov '99</td>
</tr>
<tr>
<td>1999/11</td>
<td>1999 11</td>
<td>1999 November</td>
</tr>
</tbody>
</table>

### Month/Day/Year

<table>
<thead>
<tr>
<th>Month/Day/Year</th>
<th>1/1999</th>
<th>November 99</th>
</tr>
</thead>
<tbody>
<tr>
<td>1999 November 1</td>
<td>11/1/99</td>
<td>1 Nov 99</td>
</tr>
<tr>
<td>1999 Nov. 1</td>
<td>11.1.99</td>
<td>1 November 1999</td>
</tr>
<tr>
<td>November 1, 99</td>
<td>11_1_99</td>
<td>1st November 1999</td>
</tr>
<tr>
<td>Nov. 1, 1999</td>
<td>11,1,99</td>
<td>1 Nov. 1999</td>
</tr>
<tr>
<td>Nov. 1st, 1999</td>
<td>1.xi.99</td>
<td>1 November 2001</td>
</tr>
<tr>
<td>ii.14.1999</td>
<td>1999/XI/I</td>
<td>991101</td>
</tr>
<tr>
<td>1-XI.99</td>
<td>1999 11 01</td>
<td>2001/11/1</td>
</tr>
</tbody>
</table>

### Date Ranges

<table>
<thead>
<tr>
<th>Date Ranges</th>
<th>Sep-Oct 1999</th>
<th>1999 Spring-Summer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spring, 1999</td>
<td></td>
<td>1999 Spring-Summer</td>
</tr>
<tr>
<td>Fall, 1999</td>
<td>Win 1998-1999</td>
<td>4-11 Jan 99</td>
</tr>
<tr>
<td>Winter 1999</td>
<td>Jun-Jul 99</td>
<td>99 Win-Spr</td>
</tr>
<tr>
<td>Summer-Fall, 1999</td>
<td>Jan-Feb 99</td>
<td>1998/99</td>
</tr>
<tr>
<td>Fall-Winter, 1999</td>
<td>6/12 Jan 1999</td>
<td>1999-</td>
</tr>
<tr>
<td>Win-Spr, 96-99</td>
<td>Win 98/Spr 99</td>
<td>Nov 2, 1999-</td>
</tr>
</tbody>
</table>
Document Type Field (35)

This field is used for information concerning additional characteristics of a work (compare with Medium Designator), as well as to designate the language in which a work is published (as distinct from the country in which it was issued or created).

Entry rules

- Capitalize the way you want it in the formatted output. For example:
  
  Personal communication  Typewritten  Comment
  Unpublished essay  unpublished draft  abstract
  Handwritten  Forthcoming

- Spell languages the as you want them to appear in formatted output (e.g., “Eng” or “Russian”).

- If you want to have both a language and a document designation, include one after the other, supplying any necessary additional punctuation, as in:

  (Eng, Fre, Ger). Forthcoming

Edition Field (15)

Used for identification of a different form or version of a previously published work, this field can also be used for a Patent Number or item number. For example:

  2nd  version 5.1
  Reprint of 1948  WO9316169
  8th ed.  PBS Research Monograph No. 5

Extent of Work Field (26)

This is the numeric part of the physical description of the size of the work, and is usually followed by field 27 Packaging Method. For example, in “5 p.”, the “5” would be the Extent of Work and the “p” would be the Packaging Method.

If you need to include more than one physical form, include additional extent and packaging methods after the first one, supplying necessary punctuation. This is shown in the example for field 27: Packaging Method.
ISBN Field (41)

The International Standard Book Number, providing unique identification of the country of publication, the publisher, and of the published item. Enter the ISBN as it appears on the work. For example: 0-12-379050-6

ISSN Field (40)

The International Standard Serial Number, providing unique identification of serial publications. Enter the ISSN as it appears on the work. For example: 0006-4178

Issue ID Fields (24), (34)

Identifies subunits of information for the volume field. The issue number is often printed in parentheses following the volume number and preceding the page range (Location in Work), as in “Journal of Democracy 1(4):80-83.” It may also be followed by the serial, supplement, or part number of a monograph. For example:

7 7, Pt. 2  no. 8
7, Serial No. 432  Suppl. 2  sheets 3-5

Keywords Field (45)

This field is used for identification terms or keywords that describe the subject content of the referenced work. This field can contain multiple entries with separators.

A keyword can be used for searching by topic or as a heading in a subject bibliography. Keywords are not printed unless the field is listed in the output style for printing and is also checked for printing when you Configure Bibliography.

For ProCite to find records with the same terms in this field, you must be consistent when entering keywords. Use field content lists to help maintain consistent use of terms.
Entry rules

- You may use both words and phrases as Keywords.
- For multiple entries, enter each keyword on a separate line, or separate multiple terms with a slash (either a single slash, or a slash and a space). For example:

  History/England/Nineteenth century
  DNA/ Genes/ Chemical analysis
  Alcoholism-Prevention and Control/Politics
  Angioplasty
  Coronary Arteries
  Heart Disease

- If the source information uses a different character (such as a semicolon or comma) to separate keywords, either replace the character with a valid separator as part of the Biblio-Link II transfer process or use ProCite’s Global Edit to do the replacement.

Location in Work Field (25)

Identifies the place in a work where the referenced item is located. For works such as journals or books, this is usually a page number or range of pages. A page range typically follows any volume or issue number, as in “Journal of Democracy 1(4):80-83”.

For text recognized as a page number or a page range, ProCite can apply special field formatting with an output style to control preceding and following punctuation, as well as to control the formatting of page ranges. See Chapter 23: Creating and Modifying Output Styles for more information about special field formatting.

This field may also be used for text such as “in press” when a date is available, but page numbers are not available.

Entry rules

- A page number is recognized when it starts with a number and consists of numbers or letters.
- A page range consists of two page numbers separated by a hyphen(-) or a slash (/), with any number of intervening spaces.
- Always enter full page numbers, as in “170-190”. Page number range formatting is only applied if the beginning and ending page numbers...
are entered in full. Any required suppression of repeating digits, as in 101-4, can then be handled by the output style.

- If descriptive information such as “pp.” is required by the output style it is usually included as special formatting for the field, which enables ProCite to automatically punctuate references to single pages (p. 170) differently than references to multiple pages (pp. 170-190).

- If the information in the field is not recognized as a valid page number or range, it will be printed “as is,” without the Special Fields Formatting.

- Roman numerals are not recognized as page numbers, so any punctuation must be entered into the field as well.

- If there is text surrounding the page number or range, ProCite still finds the first identifiable page reference in the field to apply formatting. ProCite only identifies a page reference if it is within the first 255 characters of the field.

- If you don’t want page number formatting applied to a specific page number entry, enter an equal sign “=” at the beginning of the field in the ProCite record.

### ProCite Formatting

ProCite will apply page formatting instructions as much as possible.

- Field entries that are recognized as page ranges can be formatted using Special Fields punctuation (can correctly apply singular or plural punctuation — “p.” versus “pp.”) as well as page number range formatting (“170-190” can be stripped to “170-90”).

- Field entries that are recognized as page numbers, or as the starting number of a range (where the ending number is not the full form) only have Special Field punctuation applied.

- Entries that are not recognized as pages or ranges are output “as is” (without Special Fields punctuation or page range formatting).

<table>
<thead>
<tr>
<th>Will be Formatted</th>
<th>Will be Punctuated</th>
<th>Will Not Be Formatted</th>
</tr>
</thead>
<tbody>
<tr>
<td>170-190</td>
<td>5,6</td>
<td>in press</td>
</tr>
<tr>
<td>31S-37S</td>
<td>170-90</td>
<td>p. xxvi-xxvii</td>
</tr>
<tr>
<td>3/8</td>
<td>33-5,45,59</td>
<td>pp. R2-R48</td>
</tr>
<tr>
<td>slides 23-38</td>
<td>23</td>
<td></td>
</tr>
</tbody>
</table>
Location/URL Field (38)

The Location/URL Field contains information about where the work is stored. You can enter a Uniform Resource Locator (URL) a Medline Unique Identification Number (UI), or a path and filename for an electronic copy of a document.

<table>
<thead>
<tr>
<th>File Type</th>
<th>Enter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local File</td>
<td>Windows: hard disk\documents\research</td>
</tr>
<tr>
<td></td>
<td>Macintosh: file:///mac/documents/research</td>
</tr>
<tr>
<td>Internet URL</td>
<td><a href="http://www.procite.com">http://www.procite.com</a></td>
</tr>
<tr>
<td></td>
<td>ftp://ftp.isiresearchsoft.com</td>
</tr>
<tr>
<td>Medline UI</td>
<td>89025932</td>
</tr>
</tbody>
</table>

Highlight a record in a record list (or the URL or UI in a record) and select Open File/URL from the ProCite Tools menu to launch your browser and go to that location. Highlight a path and filename and select Open File/URL to launch the appropriate program and open that file.

You could also use this field to qualify information in the Address/Availability (37) field, indicating a drawer, file, or shelf number:

- **Connective Phrase (36):** Located at
- **Address/Availability (37):** Syracuse University, Bird Library
- **Location/URL (38):** shelf 323

Medium Designator Fields (05), (14)

Use these fields for non-print or special materials to denote the type of medium (physical format) or the material in which the work was issued. You can also use these fields to qualify information in the Title field. For example:

T. E. Lawrence and Arab Nationalism [Review of the film Lawrence of Arabia]

The Medium Designator is usually preceded by a title or the name of a source and followed by Extent of Work (26) and Packaging Method (27), or Connective Phrase (36) and Address/Availability(37). In the case of the Patent workform, field 14 is used to qualify the Country (field 13) with the Patent Type, as in:

<table>
<thead>
<tr>
<th>Country</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Br.</td>
<td>Patent</td>
</tr>
<tr>
<td>Swiss</td>
<td>Patentschrift</td>
</tr>
</tbody>
</table>
Entry rules

Use these fields primarily for non-print or special materials, and capitalize the first letter. You can also use them for the type of publication (such as “dissertation”) or type of article (such as a letter or editorial in a journal) when the Document Type (35) field is not in the workform.

Examples of medium designator formats are:

- Artifact
- Filmstrip
- Mercator projection
- Online
- Sound recording

CD-ROM
Letter to the Editor
Microfilm
Painting
Special Issue

Database
masters thesis
Monograph
Plastercast
Transparency

Examples of records including Medium Designator:

<table>
<thead>
<tr>
<th>Field</th>
<th>Record A</th>
<th>Record B</th>
</tr>
</thead>
<tbody>
<tr>
<td>Medium</td>
<td>Motion Picture</td>
<td>Motion Picture</td>
</tr>
<tr>
<td>Extent of Work</td>
<td>1</td>
<td>28</td>
</tr>
<tr>
<td>Packaging Method</td>
<td>film-loop cartridge</td>
<td>min.</td>
</tr>
</tbody>
</table>

Record C

<table>
<thead>
<tr>
<th>Field</th>
<th>Record C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Journal</td>
<td>Postmodern Culture: An Electronic Journal of Interdisciplinary Criticism</td>
</tr>
<tr>
<td>Medium</td>
<td>Online</td>
</tr>
<tr>
<td>Connective Phrase</td>
<td>Available from:</td>
</tr>
<tr>
<td>Location/URL</td>
<td>email: <a href="mailto:Pmc@ncsuvm.bitnet">Pmc@ncsuvm.bitnet</a></td>
</tr>
</tbody>
</table>
Packaging Method Field (27)

This field is used to qualify Extent of Work (26) by denoting “how many of what.” For example, “1,586,405 records” where the number is in Extent of Work (26) and “records” is in Packaging Method (27).

Entry rules

- Do not capitalize the first letter. For example:
  
  pages transparencies negatives cassettes

- If you must include more than one physical form, include additional extent and packaging methods after the first, supplying necessary punctuation. For example, to output “1 reel; 333 pages,” the entries would be:

  Extent of Work (26): 1
  Packaging Method (27): reel; 333 pages

- This field may also be used to supply information about accompanying material. For example:

  Extent of Work (26): 23

Place of Meeting Field (13)

Used for the location of a meeting, conference, etc. Examples:

  Geneva, Switzerland or San Francisco, CA

In the Patent workform, this field indicates the country issuing the Patent, which qualifies the type of Patent. For example:

<table>
<thead>
<tr>
<th>Country (13)</th>
<th>Type (14)</th>
</tr>
</thead>
<tbody>
<tr>
<td>U.S.</td>
<td>Patent</td>
</tr>
<tr>
<td>Japanese</td>
<td>Patent</td>
</tr>
<tr>
<td>French</td>
<td>Demande</td>
</tr>
</tbody>
</table>
Place of Publication Field (18)

This field is used for the city and state or country of the publisher, or the place where a work was created. For example: Chicago, IL

If you need to enter more than one place of publication, it is best to put the second entry in a field that you would not normally use in the same workform. This will allow you to format the first Place of Publication and Publisher differently than the second pair of these elements. This is analogous to using field 20 for the publication date of a reprint of a work, and field 21 to hold the original publication date.

Publisher Name Field (19)

The name of the person or organization responsible for making the work available to the public should go in this field. For example:

- Weiser Books
- Appleton-Crofts
- John Wiley

If you need more than one publisher name, it is best to enter the second publisher in a field that you would not normally use in the same workform. This will allow you to format the first Place of Publication and Publisher differently than the second pair of these elements. This is analogous to using field 20 for the publication date of a reprint of a work, and field 21 to hold the original publication date.

Record ID Field

The record ID field is not counted as one of ProCite’s 45 data fields. This identifier for a ProCite record is initially assigned by ProCite, but it can be changed. You may use the record ID as a reference to a physical file, as an acquisition number, or to index a subject bibliography. While automatic numbering is numeric, you can manually enter any combination of up to 20 alphabetic and numeric characters.

A database can have more than one record with the same record ID. This can happen after copying records or when you manually change record IDs.

You can use a record ID for sorting, searching, etc. It is always present, no matter which workform you are using. The record ID will not print
unless it is listed in the output style and is checked as an Optional Field under Configure Bibliography.

Record IDs sort in numerical and then alphabetical order. All other ProCite fields, apart from Date and Call Number, sort characters from left to right.

By default, ProCite starts record numbering sequentially from the number 10 with increments of 10. See Chapter 21: Record IDs and Renumbering for information about how to change the starting record ID or increment.

**Report ID Field (23)**

Used for the complete alphanumeric identifier that uniquely identifies a report. For example: 32A4680

**Reprint Status Field (12)**

When field 12 is assigned the field name Reprint Status, the field appears with a pull-down list of choices plus a Date subfield. You can type a reprint status or choose from these options on the pull-down list:

- **In File:** You have a reprint in your files.
- **Not in File:** You do not have a reprint, and do not expect to have one (the default setting).
- **On Request:** You have requested a reprint. When you choose On Request, ProCite enters the current date in the Date subfield. You can overtype with a different date. Entering the date you requested the reprint helps you manage pending reprints.

When field 12 is assigned a field name other than Reprint Request, the field is treated as a regular date field.

**Reproduction Ratio Field (29)**

The rate, ratio, or frequency at which a work is produced or reproduced, this field is used for map scales, recording speeds, and frequency of publication. For example:

- 33 1/3 rpm
- 1:50000
- monthly
Size Field (28)

This field contains the physical dimensions or format of a work.

- Use metric system measurements if they are available, otherwise use the units as given. For example:
  
  32 x 50 mm
  2 x 2 in.
  16 mm.

- This field may also be used to supply information about accompanying material, as in:

  **Extent of Work (26):** 2
  **Packaging Method (27):** computer disks:
  **Size (28):** 3.5 in.; Accompanied by: 1 user manual.

Title Fields (04), (09), (10), (1 1), (32)

ProCite uses special instructions for handling title fields in formatting citations. For certain workform styles, field 10 is configured to use a specific abbreviation of the journal title, exactly as it appears in a journal title list. You can also apply title case formatting to any title to modify capitalization.

Title fields:

- **Title, Analytic (04):** Paper/Section Title, Article Title, Catalog Title, Map Title, Program Title, Subject

  The analytic title is the title of a contribution to, or part of, a monographic work. For example, the title of an article in a journal, a chapter in a book, a film in a set, or a band on a recording disk are analytic titles.

- **Title, Monographic (09):** Collection Title, Proceedings Title, Recording Title, Report Title

  The chief, distinguishing title for a single volume, non-serial work, or the title unique to each single volume in a multiple-volume set. For serial works, it is the title that is unique to a single issue. Book titles are monographic titles. You should not use this field for subtitles, collective titles, or analytic-level titles.

- **Journal Title (10):** Journal Title, Magazine Title
• **Title (11): Newspaper Title**

Also used for a supplementary title, which can be either a primary or a subsidiary title, depending on the workform. You may use this field for translated titles, or collective titles.

• **Series Title (32)**

The collective title associated with a number of separate works issued in succession. These are usually issued by the same publisher in a uniform style and are related by a common title.

**Entry rules**

• Enter the primary title for a work into the title field that appears first in the workform (04, 09, 10, or 11). This allows sorting by generic title.

• Enter the primary title for a work by an analytic author in field 04.

• Enter the title of a monograph in field 09.

• Enter journal titles in field 10.

• Use field 11 for a primary title, such as the title of a newspaper, or for a translated title.

• Enter a subsidiary title, such as the title of a series that may have an associated series editor or compiler, in field 32.

**Journal Titles**

• The most important rule is to be consistent. When entering journal names, either always enter full names or always enter abbreviations.

• To substitute an abbreviated form of the title in formatted output using a journal title list, the record should contain the full form of the journal title exactly as it appears in the journal title list. This allows ProCite to find the matching abbreviation when formatting output. You can do this most easily by using the same journal title list for entering journal titles into the record.

• If there is no entry for the journal in the journal title list you are using, enter the title exactly as you want it to appear in the printed bibliography.
Other Titles

- It is best to enter titles in “sentence style,” where only the first word of the title (and subtitle) and proper nouns are capitalized. For example:

  The elements of grammar
  Datamation
  Why Johnny can't read

When you enter titles in “sentence style,” the output style can modify the case of the title for printing. This allows you to meet the requirements of various bibliographic styles on output, without changing the original title entry in the record. For example:

<table>
<thead>
<tr>
<th>Style</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>sentence style</td>
<td>Why Johnny can’t read</td>
</tr>
<tr>
<td>headline style</td>
<td>Why Johnny Can’t Read</td>
</tr>
<tr>
<td>uppercase</td>
<td>WHY JOHNNY CAN’T READ</td>
</tr>
<tr>
<td>lowercase</td>
<td>why johnny can’t read</td>
</tr>
</tbody>
</table>

- Include a parallel or subordinate title following a colon. For example:

  Language and computers: Studies in practical linguistics

- Headline capitalization cannot distinguish between titles in English and titles in other languages; ProCite treats all titles the same way. If the rules for a particular language are different than those for English, you need to treat titles in that language as exceptions. Enter them as you wish them to appear, preceded by an “=” so ProCite will not format them. For example:

  =L’amí du peuple

If the output style has Title Case set to none, the field prints as entered and you don’t need to use the “=” to prevent title formatting.

Volume ID Fields (22), (33)

The primary numbering used by the publisher to identify the units of the work, the volume number typically follows the title and precedes any issue number or page range, as in “Journal of Democracy 1(4):80-83.”

If descriptive information such as “Vol.” or “Message no.” is required by the bibliographic style, it is included in the output style as preceding punctuation for the field.

Examples:

2
1st vignette
sheet 3
Choosing a Workform

Overview

Contents

Locating the Available Workforms ....................................... 188
Setting the Workform for a New Record .............................. 188
Changing the Workform for Existing Records ..................... 189
  Changing the Workform for a Single Record ................. 190
  Changing the Workform for Multiple Records ............ 191
Selecting an Appropriate Workform ..................................... 192
  Relationship between Workforms and Output Styles .... 193
Common Workform Choices ............................................ 194
Choosing Workforms for Journal and Book Entries ..... 197
  Journal Entries ....................................................... 197
  Book Entries ......................................................... 198

ProCite supplies predefined workforms for a wide range of types of work, including books, journal articles, patents, conference proceedings, maps, and art works. Workforms help you structure information so that each component is stored in a separate field. This enforces consistent data entry and allows precise control over formatted output.

By using specific fields for similar purposes, regardless of the workform being used, you can easily retrieve records containing common information. Using different workforms for different types of documents also makes it easy to select all records that reference a particular document type. You can always change the workform associated with a record if the original choice was unsuitable.

Since users have varied needs, the supplied workforms may not be ideal for your application. However, there are advantages to using predefined workforms:

- You can standardize record entry.
- You can easily share data with other ProCite users.
- You can use existing output styles without the need to change them.
Although ProCite is set up and intended for bibliographic references, the information stored in ProCite can be of any type. However, you must create custom workforms and custom output styles for non-bibliographic data.

**Locating the Available Workforms**

Predefined workforms are supplied with ProCite. If your list of workforms does not match our list, or if no workforms appear to be available, it may be that:

- The predefined workforms are not installed. See *Chapter 2: Installation* for information about installing ProCite.

- ProCite cannot find your workform files. All workforms in ProCite’s *Forms* folder are available. If your workforms are stored elsewhere, choose **Options** from the **Tools** menu and check the **File Locations** tab to make sure the correct folder is indicated.

- The predefined workforms were renamed and/or modified. Compare your workforms to the workform definitions in *Appendix B: ProCite Workforms and Fields*.

- Custom workforms were created. Beware of using custom workforms, as they will require custom workform styles in each output style. Whereas the predefined workforms are available to every ProCite user, the ones you create are available to others only when specifically copied from your machine.

**Setting the Workform for a New Record**

For each record you insert, you can choose from the predefined workforms plus any custom workforms that may be available.

1. Go to the **Database** menu and choose **New Record**. ProCite displays an empty workform for data entry. The current workform setting is in the list box at the top left of the window.

2. If you want to change the workform for this record, select a different workform from the list box.
The fields displayed in the Edit Record window change to reflect the new workform. This workform stays in effect for this record until you specifically change it.

The last workform selected is used when you add a new record to any database. This makes it easy to enter many records from the same types of work, such as multiple journal articles. If you subsequently want to add a record for a different type of work, simply choose a different workform for the new record.

### Changing the Workform for Existing Records

You may want to change the workform for existing records when:

- Several people inserted records, and they were not consistent when choosing workforms.
- You import records into the database from an outside source. Other bibliographic systems do not always differentiate between document types, so all records may transfer into one workform type.

If your workform does not have the appropriate fields for the type of work that you are using, you can either change to a different workform for that record or modify the workform definition for all records that use it.
Changing the Workform for a Single Record

To change the workform of a single record:

1. Open the record for editing. In the Edit Record window, the current workform setting displays at the top.

2. Click on the workform box to select a different workform from the pull-down list, and the record displays in the new workform.

When you change the workform for a record, existing data remains in the same field (by number), although the field names may be different in the new workform.

If you had data in fields that do not exist in the new workform, that data is not lost. Even though the fields are not part of the new workform definition, you can still see them each time you access a record until you move or delete the data in those fields for that record. Such fields are indicated on the screen by dashes in place of the field name.
This data should be moved into fields in the new workform by using the 
**Edit** menu commands **Cut** and **Paste**. If you don’t move the data, the 
record behaves as if all of the extra fields are part of the new workform. 
The data is still available for most ProCite operations, such as Searching 
and Sorting.

Because the record is now associated with a workform of a different 
name, the output style formatting will not necessarily be the same as it 
was with the old workform. Modifying output styles is described in 
*Chapter 23: Creating and Modifying Output Styles*.

### Changing the Workform for Multiple Records

To change the workform of multiple records to a single different workform:

1. From the **Select** menu, choose **Clear Marked Set**.
2. Mark the records you want to change. The marked records can use the 
same or any number of different workforms.
3. From the **Database** menu's **Edit Marked Records** submenu, pick 
**Global Change Workform**.
4. Click to highlight the new workform in the list of available work- 
forms.
5. Click **OK** to start the conversion. The workform for each marked 
record is changed to your selected workform.

Having changed the workform for the marked records, there is no 
automatic way to restore the original workforms. You can change each 
record back individually—if you remember what the original workforms 
were.

If you had data in fields that do not exist in the new workform, you do not 
lose it. Even though the fields are not part of the new workform definition, you will be able to see them each time you access a record. Such 
fields are indicated on the screen by a dash in place of the field name.
This data should be moved into fields in the new workform. If you don’t move the data, the record behaves as if all of the extra fields are part of the new workform. The data is still available for most ProCite operations, such as Searching and Sorting. You can use the Global Move Field command, described in Chapter 10: Global Editing, to move a field of information to another field for all marked records.

Because the record is now associated with a workform of a different name, the output style formatting will not necessarily be the same as it was with the old workform. Modifying output styles is described in Chapter 23: Creating and Modifying Output Styles.

**Selecting an Appropriate Workform**

For most types of work, you simply select the workform appropriate for the type of material you are referencing. See Appendix B: ProCite Workforms and Fields for a complete description of the workforms supplied with ProCite:

- Abstract
- Art Work
- Audiovisual Material
- Bill/Resolution
- Book Chapter
- Book Long Form
- Book Short Form
- Book Whole
- Case
- Computer Program
- Conference Proceedings
- Data File
- Dissertation
- Electronic Citation
- Email
- Generic
- Hearing
- In Press
- Journal Article
- Journal Long Form
- Journal Short Form
- Journal Whole
- Letter
- Magazine Article
- Manuscript
- Map
- Monograph
- Motion Picture
- Music Score
- Newspaper
- Patent
- Report
- Sound Recording
- Statute
- Trade Catalog
- Unenacted Bill/Resolution
- Unpublished Work
- Video Recording
- Web Page
It may be helpful to first familiarize yourself with field usage by referring to information in Chapter 7: Entering Data Field-by-Field, in particular for the Special Fields, and for fields such as Document Type, Medium Designator, Connective Phrase, Location in Work, Extent of Work, Packaging Method, Size, and Availability.

In most cases, by comparing the fields available in each workform, you will find a predefined workform that meets your needs. If you have an occasional record that does not fit into the workforms that you commonly use because it has an extra piece of information for which there is no field available, it is easiest to add this extra information to another field (such as Notes (42)) in the existing workform. If you regularly have an additional piece of information, you may want to modify one of the existing workforms. For documents that don’t fit any of the predefined forms, you can create custom workforms. See Chapter 22: Creating and Modifying Workforms for more information about creating a custom workform or modifying an existing workform.

**Relationship between Workforms and Output Styles**

Output styles control which fields will be printed for each workform, the order in which the fields are printed, and the punctuation and type styles associated with each field. Because each bibliographic element is entered in a separate workform field, those elements can be output in various ways to meet a wide range of bibliographic styles.

You can preview the formatted output using any available output style. This will show you both the field order and any accompanying punctuation. You can customize the output style to get the desired formatting for a particular workform.

While you may use the Dissertation workform for a hard copy dissertation, you may want to use Journal Long Form for a dissertation from Dissertation Abstracts. Which workform you use, and whether you decide to create a custom workform, depends upon how you want that document formatted upon output and what additional information you wish to store.

Modifying the output style to accommodate a particular type of work should be done only when you want the modifications to apply to all works for which you plan to use that workform. You don’t want to inadvertently change the formatting of existing records by forcing a reference that needs to be handled differently into the same workform.
Common Workform Choices

The table below indicates typical choices of predefined workforms for various bibliographic references. This information is for guidance only; you must choose what is best for your particular circumstances. Different output styles format workforms differently, so you may determine the appropriate workform by the desired output.

<table>
<thead>
<tr>
<th>Type of Work</th>
<th>Workform(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>abstract</td>
<td>Abstract</td>
</tr>
<tr>
<td>annual report</td>
<td>Report</td>
</tr>
<tr>
<td>artwork</td>
<td>Art Work</td>
</tr>
<tr>
<td>atlas</td>
<td>Book Short Form; Book Long Form</td>
</tr>
<tr>
<td>audio tape</td>
<td>Audiovisual Material</td>
</tr>
<tr>
<td>audiovisual material</td>
<td>Audiovisual Material</td>
</tr>
<tr>
<td>bibliography</td>
<td>Book Whole</td>
</tr>
<tr>
<td>book (contribution)</td>
<td>Book Chapter</td>
</tr>
<tr>
<td>book (monograph)</td>
<td>Monograph; Book Short Form; Book Whole</td>
</tr>
<tr>
<td>book (part)</td>
<td>Book Chapter, Book Long Form</td>
</tr>
<tr>
<td>book (series)</td>
<td>Book Whole; Book Long Form</td>
</tr>
<tr>
<td>book introduction</td>
<td>Book Long Form</td>
</tr>
<tr>
<td>book review (in journal)</td>
<td>Book Whole; Journal Article</td>
</tr>
<tr>
<td>booklet / brochure</td>
<td>Book Short Form</td>
</tr>
<tr>
<td>cartoon</td>
<td>Journal Long Form; Journal Short Form</td>
</tr>
<tr>
<td>case</td>
<td>Case</td>
</tr>
<tr>
<td>cassette recording</td>
<td>Sound Recording</td>
</tr>
<tr>
<td>catalog</td>
<td>Trade Catalog</td>
</tr>
<tr>
<td>chapter</td>
<td>Book Chapter</td>
</tr>
<tr>
<td>checklist</td>
<td>Book Short Form; Manuscript; Report</td>
</tr>
<tr>
<td>computer program or manual</td>
<td>Computer Program</td>
</tr>
<tr>
<td>conference proceedings</td>
<td>Book Long Form; Conference</td>
</tr>
<tr>
<td>(published)</td>
<td>Proceedings; Report</td>
</tr>
<tr>
<td>conference proceedings</td>
<td>Conference Proceedings</td>
</tr>
<tr>
<td>(unpublished)</td>
<td></td>
</tr>
<tr>
<td>correspondence</td>
<td>Letter, Email</td>
</tr>
<tr>
<td>(raw) data collection</td>
<td>Manuscript</td>
</tr>
<tr>
<td>data file records</td>
<td>Data File</td>
</tr>
<tr>
<td>dictionary</td>
<td>Book Whole</td>
</tr>
<tr>
<td>directory</td>
<td>Book Short Form; Book Long Form</td>
</tr>
<tr>
<td>disc or disk (audio)</td>
<td>Sound Recording</td>
</tr>
<tr>
<td>disc or disk (data)</td>
<td>Data File</td>
</tr>
<tr>
<td>disc or disk (software)</td>
<td>Computer Program</td>
</tr>
<tr>
<td>disc or disk (multimedia)</td>
<td>Audiovisual Material</td>
</tr>
<tr>
<td>dissertation</td>
<td>Dissertation; Book Long Form</td>
</tr>
<tr>
<td>Type of Work</td>
<td>Workform(s)</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>dissertation abstract</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>dissertation (unpublished)</td>
<td>Manuscript; Journal Long Form</td>
</tr>
<tr>
<td>editorial</td>
<td>Newspaper</td>
</tr>
<tr>
<td>electronic article</td>
<td>Electronic Citation, Journal Article, Web Page</td>
</tr>
<tr>
<td>electronic mail</td>
<td>Email</td>
</tr>
<tr>
<td>encyclopedia</td>
<td>Book Whole; Book Long Form</td>
</tr>
<tr>
<td>field notes</td>
<td>Manuscript</td>
</tr>
<tr>
<td>film</td>
<td>Motion Picture</td>
</tr>
<tr>
<td>film review (in journal)</td>
<td>Journal Article</td>
</tr>
<tr>
<td>hearing</td>
<td>Hearing</td>
</tr>
<tr>
<td>in press</td>
<td>In Press</td>
</tr>
<tr>
<td>interview</td>
<td>Manuscript</td>
</tr>
<tr>
<td>letter</td>
<td>Letter</td>
</tr>
<tr>
<td>journal article</td>
<td>Journal Article, Journal Short Form; Journal Long Form</td>
</tr>
<tr>
<td>journal (entire issue)</td>
<td>Journal Long Form, Journal Whole</td>
</tr>
<tr>
<td>legal materials</td>
<td>Bill-Resolution, Case, Hearing, Statute, Unenacted Bill/Resolution</td>
</tr>
<tr>
<td>magazine article</td>
<td>Magazine Article</td>
</tr>
<tr>
<td>manuscript</td>
<td>Manuscript</td>
</tr>
<tr>
<td>map (sheet)</td>
<td>Map</td>
</tr>
<tr>
<td>memo</td>
<td>Letter, Email</td>
</tr>
<tr>
<td>meeting minutes (published)</td>
<td>Conference Proceedings</td>
</tr>
<tr>
<td>meeting minutes (unpublished)</td>
<td>Manuscript; Conference Proceedings</td>
</tr>
<tr>
<td>meeting paper</td>
<td>Conference Proceedings</td>
</tr>
<tr>
<td>meeting paper (unpublished)</td>
<td>Manuscript</td>
</tr>
<tr>
<td>microfilm</td>
<td>use workform appropriate to filmed work, or Audiovisual Material</td>
</tr>
<tr>
<td>monograph</td>
<td>Monograph; Book Short Form</td>
</tr>
<tr>
<td>music score</td>
<td>Music Score</td>
</tr>
<tr>
<td>negatives</td>
<td>Audiovisual Material</td>
</tr>
<tr>
<td>newsletter</td>
<td>Journal Long Form; Newspaper</td>
</tr>
<tr>
<td>newspaper article</td>
<td>Newspaper</td>
</tr>
<tr>
<td>newspaper (entire issue)</td>
<td>Newspaper</td>
</tr>
<tr>
<td>patent</td>
<td>Patent</td>
</tr>
<tr>
<td>periodical</td>
<td>Journal Article; Journal Whole; Magazine Article, Newspaper</td>
</tr>
<tr>
<td>personal communication</td>
<td>Letter, Email</td>
</tr>
<tr>
<td>photograph</td>
<td>Audiovisual Material</td>
</tr>
<tr>
<td>plan</td>
<td>Map; Art Work</td>
</tr>
<tr>
<td>play</td>
<td>Book Short Form; Book Long Form</td>
</tr>
<tr>
<td>preface</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>Type of Work</td>
<td>Workform(s)</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>press release</td>
<td><em>Book Short Form, Book Long Form, Newspaper</em></td>
</tr>
<tr>
<td>radio or TV program</td>
<td><em>Video Recording</em></td>
</tr>
<tr>
<td>report</td>
<td><em>Report</em></td>
</tr>
<tr>
<td>review (in a journal)</td>
<td><em>Journal Article</em></td>
</tr>
<tr>
<td>script</td>
<td><em>Book Short Form</em></td>
</tr>
<tr>
<td>serial</td>
<td><em>Journal Whole</em></td>
</tr>
<tr>
<td>slide</td>
<td><em>Audiovisual Material, Art Work</em></td>
</tr>
<tr>
<td>sound recording</td>
<td><em>Sound Recording</em></td>
</tr>
<tr>
<td>statute</td>
<td><em>Statute</em></td>
</tr>
<tr>
<td>technical drawing</td>
<td><em>Art Work</em></td>
</tr>
<tr>
<td>trade catalog</td>
<td><em>Trade Catalog</em></td>
</tr>
<tr>
<td>transcript</td>
<td><em>Manuscript</em></td>
</tr>
<tr>
<td>translated article</td>
<td><em>Journal Article</em></td>
</tr>
<tr>
<td>translated book</td>
<td><em>Book Whole</em></td>
</tr>
<tr>
<td>transparencies</td>
<td><em>Audiovisual Material</em></td>
</tr>
<tr>
<td>thesis</td>
<td><em>Dissertation</em></td>
</tr>
<tr>
<td>unpublished work</td>
<td><em>In Press, Manuscript, Monograph, Unpublished Work</em></td>
</tr>
<tr>
<td>video recording</td>
<td><em>Video Recording</em></td>
</tr>
<tr>
<td>web page</td>
<td><em>Web Page, Electronic Citation</em></td>
</tr>
<tr>
<td>word processor document</td>
<td><em>Letter</em></td>
</tr>
<tr>
<td>work within a work</td>
<td>workform appropriate to type of material referenced</td>
</tr>
</tbody>
</table>
Choosing Workforms for Journal and Book Entries

You have a choice of workforms to use for books and journals, depending on whether you are citing the entire work or a contribution to a work. For example, you may be citing an entire book, a chapter in a book, or a separate contribution to a book.

Choose a workform that allows you to enter the most complete bibliographic data, especially the data that uniquely identifies the work, without leaving too many fields blank. For example, Book Long Form allows three levels of titles: analytic title, used for a chapter or section title; monographic title, used for the title of a volume; and series title, used for the collective title of the monographic series. Book Chapter has only two titles, analytic and monographic.

Determine the fields you need and find a workform that most closely matches those fields. Field usage by workform is shown in Appendix B: ProCite Workforms and Fields. Below are descriptions of the different journal and book workforms.

Journal Entries

- **Journal Article** For journal articles, including online sources.

- **Journal Short Form** A shorter form for articles that do not supply information for all of the fields included in Journal Article.

- **Journal Long Form** For journal articles and other works that require fields not included in Journal Short Form or Journal Article. For example, field 03 Author Affiliation.

- **Journal Whole** For cataloging the run of a journal or for citing an entire journal or journal series, including online journals. For special issues of journals with an issue title, you may want to use Journal Long Form.

- **In Press** For journal articles not yet published. This workform includes the same fields as Journal Short Form. Include "In Press" in the date field. You may need to exclude such works from your bibliography. Once the article is published, change the workform to one of the other journal workforms and update the date field.
Book Entries

- **Book Short Form** For monographs with only a monographic author(s).

- **Book Whole** For monographs with editors or translators in addition to author(s), or which require other fields (such as series level information) that are not in *Book Short Form* or *Monograph*.

- **Book Chapter** For a volume in a series or a chapter in a book that requires both analytic and monographic levels. May also be used for online information.

- **Book Long Form** For works cited within other works, such as contributions to a series or collective works, for which *Book Chapter* does not have enough fields or is otherwise not suitable.

  For example, a chapter or part of a book (with an analytic title) within a separate volume (with a monographic title) that has a title separate from the collective title (series title).

  You may also want to use *Book Long Form* when another workform would be adequate for producing formatted references, but you want to store additional information in the record.

- **Monograph** For monographs with monographic authors, editors or translators. *Monograph* is the same as *Book Short Form* except for the addition of fields 08 Author Role and 15 Edition.

- **Unpublished Work** For books not yet published. This workform includes the same fields as *Monograph*. Include "Unpublished" in the date field. You may need to exclude such works from your bibliography. Once the book is published, change the workform to one of the other book workforms and update the date field.
Use ProCite’s Import features to copy bibliographic data to ProCite from other software programs, OPACs, and online, diskette, and CD services.

A tagged file format is where each bit of bibliographic information in a record, such as Author, Title, Date, and Publisher, is preceded by a field tag or field label to identify it. You can import tagged records retrieved from various bibliographic online databases, OPACs, World Wide Web services, diskette services, and CD-ROM services.

A delimited file format is where each field in a record is in a specific position and is separated by a special character. Some delimited formats also surround each field with a special character. Common formatting types are Tab Delimited and Comma Delimited, so we have defined a format for each. You can also create a custom delimited format.

Several OPACs and CD-ROM services offer an “Export to ProCite” option, which creates a comma delimited file for easy import into ProCite. Contact your vendors to find out whether they offer this feature.

Note: For information about searching and importing from Z39.50 compliant Internet databases, and about importing from web pages, see Chapter 15: Internet Capabilities.
Importing Tagged Records

ProCite installs many configuration files that are set up to read and transfer tagged records retrieved from various bibliographic information services. In the Biblio-Link II manual found on your ProCite CD, see Appendix C: Configuration Files for a list of configuration files supplied with ProCite and the specific databases from which you can import data.

If a configuration file is not available for the service you use, find the configuration file that most closely matches your records, save a copy of it, and modify the copy with Biblio-Link II. The Biblio-Link II program is found in your ProCite folder. The Biblio-Link II manual is a PDF file found on your ProCite CD, and is easily viewed with the Adobe Acrobat Reader (also supplied).

The Tagged Records

This is just one example of tagged records, where each field of information is preceded by a descriptive tag:

<table>
<thead>
<tr>
<th>Record 1 of 24 – MEDLINE (R) 1994</th>
</tr>
</thead>
<tbody>
<tr>
<td>TI: A clinical study of colchicine in childhood asthma.</td>
</tr>
<tr>
<td>AU: Adalioglu-G; Turkas-T; Sacilar-Y; Tuncer-A</td>
</tr>
<tr>
<td>SO: J-Asthma. 1994; 31(3): 361-6</td>
</tr>
<tr>
<td>LA: ENGLISH</td>
</tr>
<tr>
<td>AB: A double-blind, randomized, crossover study was done to determine the</td>
</tr>
<tr>
<td>ME: Albuterol-administration-and-dosage; Albuterol-therapeutic-use; Asthma</td>
</tr>
<tr>
<td>DE: Asthma-drug-therapy; Colchicine-therapeutic-use</td>
</tr>
<tr>
<td>AN: 95014003</td>
</tr>
</tbody>
</table>

The configuration file tells ProCite how a file of tagged records is organized, such as how to identify the beginning of a new record and the beginning of a new field. It also maps each field tag to a corresponding ProCite field. For example, fields tagged with AU: or Author: may be configured to transfer to ProCite field 01 Author, Analytic. It may also be able to separate information from a single Source field (containing some combination of journal title, date, volume, issue, and pages) and put each bit of information into the appropriate ProCite field.
The most significant part of importing tagged records is to determine from which service the records were retrieved. For example, *Medline* records could be retrieved from the National Library of Medicine's MEDLARS online system, from the SilverPlatter CD-ROM system, from Reference Update's diskette system, or from one of many other sources that offer this information. Each service saves the same information in a slightly different tagged format, and that format is significant for a software program to interpret bibliographic information.

### Basic Procedure

**To import tagged records:**

1. Save bibliographic records from your online service (or OPAC, CD-ROM service, etc.) as *tagged* or *labelled* output to a plain text file (Text Only).

2. In ProCite, go to the *Tools* menu and select *Import Text File* to display a file dialog.

3. Locate and open the text file that contains the tagged records you want to import into ProCite. ProCite displays the file onscreen.

4. In the *File Type* drop-down list, select *Tagged*.
5. In the **File Format** drop-down list, select the service from which you retrieved the tagged records.

6. In the **Target Database** drop-down list, select the ProCite database to receive the records.

7. Click **Transfer** to begin importing the records.

When the transfer is completed, ProCite tells you how many records were imported into your database. Click **OK** to dismiss the alert.

8. You can import another file of records or you can click the close box to display the database record list.

---

**Note:** The imported records are marked. To see only the records you just transferred, display the **Marked Records** tab.

If fields do not transfer into the ProCite fields of your choice, or if you prefer to not transfer certain fields at all, you can modify the configuration file. Create or modify configuration files with Biblio-Link II; these changes cannot be made with ProCite directly.

If a configuration file is not available for the service you use, find the configuration file that most closely matches your records, save a copy of it, and modify the copy with Biblio-Link II.

You can transfer suspected duplicates to look at later, or you can ignore them during the transfer. For more information about detecting duplicates, see *Chapter 12: Detecting Duplicate Records*. 
Importing Delimited Records

Many database programs can automatically generate a comma or tab delimited file that ProCite can import. If you want to import records from a word processing program, you must create a delimited file yourself.

For an import operation to work properly, make sure your import file—the file containing the information you want to transfer into ProCite—adheres to conventions for file type, field format, and field order.

Basic Procedure

To import records from a delimited text file:

1. Prepare or verify your import file as described in the next section, Preparing the Import File.

   Either your import file must contain workform definitions (which can be exported from ProCite), or the appropriate workforms must be available from ProCite before importing.

2. In ProCite, go to the Tools menu and select Import Text File to display a file dialog.

3. Locate and open the text file that contains the delimited records you want to import into ProCite. ProCite displays the file onscreen.

4. In the File Type drop-down list, select Delimited.
5. In the **File Format** drop-down list, select the appropriate delimited format of your records:

- **Comma Delimited**, where each field is enclosed in quotation marks and separated from the next field by a comma, and each record ends with a carriage return. This format assumes that each record includes a field for the workform indicator, a field for a record ID, and all 45 ProCite fields, with data in the fields used by your workform and empty place holders for fields that either do not contain data or do not exist in the workform.

- **Tab Delimited**, where each field is separated from the next by a tab, and each record ends with a carriage return. This format assumes that each record includes a field for the workform indicator, a field for a record ID, and then only those fields used in your workform, with empty place holders for fields that do not contain data.

- **Custom**, which you define for a format other than the predefined Comma Delimited or Tab Delimited. You can specify any single character as a field separator, delimiter, or end-of-record character. Use the **Modify** button to bring up the options.

See *Setting Import Options* later in this chapter for a full description of the file formats, including how to set Custom options.

6. In the **Target Database** drop-down list, select the ProCite database to receive the records.

7. Click **Transfer** to start the transfer.

ProCite alerts you when the transfer is complete, and tells how many records were imported. Click **OK** to dismiss the alert.

8. You can import another file of records or you can click the close box to return to the database record list.

---

**Note:** The imported records are marked. To see only the records you just transferred, display the **Marked Records** tab.

Make sure to view several full records in the Edit Record window. If a field in a record appears with three dashes as a field name (---) in the Edit Record window, data was placed in a field not specified in the workform definition. To remedy this, you can:

- Use the **Global Move Field** command to move the information to the appropriate field (see *Chapter 10: Global Editing* for more information).
• Use the **Global Edit** command to delete the entire field of information from the marked records (see *Chapter 10: Global Editing* for more information).

• Modify the workform itself, adding the field that now contains data.

• Delete the marked records (the records you just imported), modify your delimited file to match the field order to the appropriate workform, and import the records again.

You can transfer suspected duplicates to look at later, or you can ignore them during the transfer. For more information about detecting duplicates, see *Chapter 12: Detecting Duplicate Records*.

### Preparing a Delimited Import File

Your delimited file must be a *Text Only* file with the fields in the proper format and field order as described in this section. Since the file must be plain text, no special font or style information will be included.

#### Field Format

Your import file should contain special characters that separate each field and end each record. If you want, you can also include delimiters—single characters that enclose each field.

For the field separators, end-of-record characters, and delimiters, you can choose from a variety of characters. However, most database programs have a feature for importing and exporting data delimited with specific characters. The most common types are Comma Delimited and Tab Delimited formats.

**Comma Delimited**

Comma delimited output is available from many general-purpose database programs. This format includes the following features:

• The contents of each field are enclosed in quotation marks (").
• Fields are separated by commas.
• Records are separated by carriage returns.
This is an example of a record in a comma delimited format, where all 45 ProCite fields are included: (¶ = carriage return)

"Olson, Lise","staff writer","Research fund faces cuts","In","","Detroit Free Press","Detroit, MI","June 18, 1990","Business section E","1-2","The State Research Fund faces drastic cuts from the levels of past years","Budget/Research"¶

**Tab Delimited**

Tab Delimited output is often available from general-purpose database programs for the Macintosh. This format includes the following features:

- Individual fields are separated by a tab. The tab character signifies the end of a field and the beginning of another field.
- Records are separated by carriage returns.

This is an example of a record in a tab delimited format, where only those fields used in the workform are included: (> = tab and ¶ = carriage return)

Olson, Lise>staff writer>Research fund faces cuts>In>Detroit Free Press>Detroit, MI>June 18, 1990>Business section E>1-2>>The State Research Fund faces drastic cuts from the levels of past years>>Budget/Research¶

**Field Order**

When you import data, you want information to transfer to the appropriate fields in a ProCite record. To ensure proper transfer, each field in the delimited records should appear in the same order as the corresponding fields in a ProCite workform.

You should order your fields according to the field number order of a specific ProCite workform. The field order should be:

- The first field can contain a workform indicator. This is optional; when you don't include a workform indicator, the last workform used will be used for record insertion.
- The first or second field can contain a record ID. This is optional, but if you don't include record IDs, you must set up a custom format.
- The remainder of the import record must consist of separated fields, each representing a ProCite field in the field number order of a particular workform. Each record in your import file can contain a field placeholder for each of the 45 ProCite fields (as in the default Comma Delimited format), or a field only for each field in the workform (as in the default Tab Delimited format).
Once you verify your import file adheres to the field format and field order conventions, you can proceed with importing the records.

**Workform Indicator**

The best way to make sure data transfers into the correct workform and the correct fields is to include a workform indicator with each record in the import file. If you include a workform indicator, it must be in the first field of each delimited record. The indicator can be either the full field name or, in some cases, a one-letter code:

<table>
<thead>
<tr>
<th>Workforms by Name with Corresponding Letter</th>
<th>Workforms by Letter with Corresponding Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abstract no letter</td>
<td>A Book Long Form</td>
</tr>
<tr>
<td>Art Work R</td>
<td>B Book Short Form</td>
</tr>
<tr>
<td>Audiovisual Material P</td>
<td>C Journal Long Form</td>
</tr>
<tr>
<td>Bill-Resolution no letter</td>
<td>D Journal Short Form</td>
</tr>
<tr>
<td>Book Chapter no letter</td>
<td>E Report</td>
</tr>
<tr>
<td>Book Long Form A</td>
<td>F Newspaper</td>
</tr>
<tr>
<td>Book Short Form B</td>
<td>G Dissertation</td>
</tr>
<tr>
<td>Book Whole no letter</td>
<td>H Trade Catalog</td>
</tr>
<tr>
<td>Case no letter</td>
<td>I Letter (Correspondence)</td>
</tr>
<tr>
<td>Computer Program S</td>
<td>J Manuscript</td>
</tr>
<tr>
<td>Conference Proceedings K</td>
<td>K Conference Proceedings</td>
</tr>
<tr>
<td>Data File T</td>
<td>L Map</td>
</tr>
<tr>
<td>Dissertation G</td>
<td>M Music Score</td>
</tr>
<tr>
<td>Electronic Citation no letter</td>
<td>N Sound Recording</td>
</tr>
<tr>
<td>Email no letter</td>
<td>O Motion Picture</td>
</tr>
<tr>
<td>Generic no letter</td>
<td>P Audiovisual Material</td>
</tr>
<tr>
<td>Hearing no letter</td>
<td>Q Video Recording</td>
</tr>
<tr>
<td>In Press no letter</td>
<td>R Art Work</td>
</tr>
<tr>
<td>Journal Article no letter</td>
<td>S Computer Program</td>
</tr>
<tr>
<td>Journal Long Form C</td>
<td>T Data Files</td>
</tr>
<tr>
<td>Journal Short Form D</td>
<td>no letter Abstract</td>
</tr>
<tr>
<td>Journal Whole no letter</td>
<td>no letter Bill-Resolution</td>
</tr>
<tr>
<td>Letter (Correspondence) I</td>
<td>no letter Book Chapter</td>
</tr>
<tr>
<td>Magazine Article no letter</td>
<td>no letter Book Whole</td>
</tr>
<tr>
<td>Manuscript J</td>
<td>no letter Case</td>
</tr>
<tr>
<td>Map L</td>
<td>no letter Electronic Citation</td>
</tr>
<tr>
<td>Monograph no letter</td>
<td>no letter Email</td>
</tr>
<tr>
<td>Motion Picture O</td>
<td>no letter Generic</td>
</tr>
<tr>
<td>Music Score M</td>
<td>no letter Hearing</td>
</tr>
<tr>
<td>Newspaper F</td>
<td>no letter In Press</td>
</tr>
<tr>
<td>Patent no letter</td>
<td>no letter Journal Article</td>
</tr>
<tr>
<td>Report E</td>
<td>no letter Journal Whole</td>
</tr>
<tr>
<td>Sound Recording N</td>
<td>no letter Magazine Article</td>
</tr>
<tr>
<td>Statute no letter</td>
<td>no letter Monograph</td>
</tr>
<tr>
<td>Trade Catalog H</td>
<td>no letter Patent</td>
</tr>
<tr>
<td>Unenacted Bill-Resolution no letter</td>
<td>no letter Statute</td>
</tr>
<tr>
<td>Unpublished Work no letter</td>
<td>no letter Unenacted Bill-Resolution</td>
</tr>
<tr>
<td>Video Recording Q</td>
<td>no letter Unpublished Work</td>
</tr>
<tr>
<td>Web Page no letter</td>
<td>no letter Web Page</td>
</tr>
</tbody>
</table>
When you export records from a ProCite database, the letters A–T are used as workform indicators, with full workform names for other workforms. Indicators for new workforms that you create must be the full workform name.

**To add workform indicators to your import file:**

1. Open your import file with a word processor.
2. Add a workform indicator as the first field in each record. For example,

   "Newspaper", "Olson, Lise", "staff writer", "Research fund faces cuts", "In", "Detroit Free Press", "Detroit, MI", "June 18, 1990", "Business section E", "12", "The State Research Fund faces drastic cuts from the levels of past years", "Budget/Research"

   or

   "F", "Olson, Lise", "staff writer", "Research fund faces cuts", "In", "Detroit Free Press", "Detroit, MI", "June 18, 1990", "Business section E", "12", "The State Research Fund faces drastic cuts from the levels of past years", "Budget/Research"

3. When finished adding workform indicators, save your import file as Text Only.

If you do not include a workform indicator, ProCite picks the last workform used for record insertion.

**Record ID**

You may wish to include a record ID in front of each delimited record.

- If you do not include a workform indicator for each record, the record ID field must appear as the first field for each record.
- If you include a workform indicator in the first field, the record ID must appear in the second field.
- If you do not include a record ID field at all, you must use a custom import format, since the default Comma Delimited and Tab Delimited formats assume a record ID field.
- You can include an empty placeholder (a set of double quotes) for a record ID. ProCite will assign numbers as the record are imported.
This example shows a record ID in the second field position, after the workform indicator:


Setting Import Options

In order to correctly import records, you must tell ProCite:

- What format is used for the records in the import file.
- What characters separate fields and end records in the import file.
- Whether the import file includes additional delimiters to surround text.
- Whether the records contain a workform indicator and/or a record ID.
- Whether the records include all 45 ProCite fields or only the fields included in the workform used.

If you have created the import file by using an “Export to ProCite” option from an OPAC or CD-ROM service, you must examine the import file to determine which settings to use.

If the import file was created by exporting from a ProCite 3 or later database, it may contain workform definitions at the beginning of the file. ProCite can import these definitions to create the appropriate workforms. Each workform definition begins with the string, “<Workform Definition>”.

To set importing options, go to the Tools menu and choose Import Text File. Locate and open your delimited file. Under File Type, select Delimited. Under File Format, you must select the format that tells ProCite what the data looks like in your import file. There are three possible formats from which to choose: comma delimited, tab delimited, and custom.
Comma Delimited

The predefined Comma Delimited format looks for the following settings in your import file:

The example below shows the workform indicator in the first field position (in this case it is a full workform name, but it could be a single letter for certain workforms), an empty field allowed for a record ID, and then each of the 45 ProCite fields, with data in most of the fields found in the Monograph workform:


The quotation mark delimiters further identify fields, so that commas in your text are not interpreted as field separators.
Tab Delimited

The predefined Tab Delimited format looks for the following settings in your import file:

The example below shows the workform indicator in the first field position (in this case it is the full workform name, but it could be a single letter for certain workforms), an empty field allowed for a record ID, and then each of the fields found in the *Monograph* workform, with empty fields left for those that do not contain data:

\[
\text{Monograph} \quad \text{Adams, Alexander, B} \quad \text{John James Audubon: A Biography} \quad \text{New York} \quad \text{G.P. Putnam’s Sons} \quad 1966 \quad 0-03-316218-4 \\
\text{Traces the checkered career of artist and Naturalist, John James Audubon (1785-1851)}
\]
Custom Delimited

You define the custom format. You may want to base it on the comma-delimited or tab-delimited format and make minor modifications. You can specify any single character as a field separator, delimiter, or end-of-record character.

To change or verify the custom import options, click the Modify button. ProCite displays a Delimited Format tab:

**Fields Separated With:**
Select the character that separates each field in your import file: **Commas**, **Tabs**, **Carriage Returns**, or **Other**. If you select **Other**, type a single character in the text box.

**Records Terminated With:**
Select the character that separates each record in your import file: **Carriage Returns** or **Other**. If you select **Other**, type a single character in the text box.
Optional Field Delimiters:

You may or may not have delimiters in your file. Delimiters enclose individual fields in addition to the field separators. For example, in the default Comma Delimited format, a set of quotation marks (”) encloses each field so that commas in your records will not be mistaken for field separators.

In order to avoid confusion between a delimiter and punctuation in a record, some systems translate any punctuation in a record that matches the delimiter into a different character on output. For example, a field can contain information in quotation marks—such as a title in the abstract field. On export, the system (such as ProCite) may translate those double quotes to single quotes.

With the Replacement Character option, you can tell ProCite to translate a character in a record (the replacement character) back to the delimiter character. Be careful with this. If you translate all single quotes back to a double quote, you will replace the single quote in contractions and French articles with a double quote!

Included Fields:

Workform Indicators: Select this check box if the first field of each record contains a workform indicator. The indicator can consist of the full workform name or a corresponding letter. For a list of the pre-defined workform names and their corresponding letters, see Preparing the Import File earlier in this chapter.

Record IDs: Select this check box if the import file includes a record ID field for each record. ProCite will expect to find a record ID in the first field position (the second field position if you use a workform indicator). If that field contains a number, ProCite will assign it to the record when it is transferred to the ProCite database. If the field exists, but is empty, ProCite will assign a number.

All 45 Fields: Select this check box if your import file includes fields or empty place holders representing each of ProCite’s 45 fields. ProCite will expect to find 45 fields, in field number order, with data in those field included in your workform.

Do not select this check box if each record contains a delimited field only for each field that is included in the workform indicated.

When you are finished setting the importing options, click OK to save changes. Make sure the File Format list is set to Custom so ProCite will use your custom settings for importing records.
Use ProCite’s global editing commands to make changes to all marked records in the current database.

- **Global Edit** allows you to add text to a field or clear text from a field.
- **Global Find/Replace** allows you to find a string of text and replace it with a new string of text.
- **Global Change Workform** allows you to change the workform type of records.
- **Global Move Field** allows you to move an entire field of text from one field to another.

**Important!** Be careful when using these commands. Make sure you mark only those records you want to change. Once a global change is made, it cannot be reversed.
Global Edit

With the Global Edit command, you can change the contents of a particular field or group of fields within multiple records in the following ways:

- **Clear Text**: You can delete existing text in a specific field. For example, if you imported extraneous data into a field throughout the database, you can easily clear the contents of the field.

- **Replace Text**: You can strip a field of all existing text and replace it with a specific word or phrase. For example, if you imported references from a CD service, you may want to delete the supplied keywords in the 45 Keywords field of every record and replace them with your own terms.

- **Add Text**: You can copy text to a specific field. For example, you can add a particular keyword to the 45 Keywords field in every marked record.

If the field you are adding text to does not exist in a particular record (based on the workform in use), no text will be added to that record.

You can insert text in the default font only. If you want to add characters in a different font, you must edit the records individually.

**To make global changes to the current database:**

1. From the Select menu, choose **Clear Marked Set** to clear the check box for each record.

2. Mark the records you wish to modify. When you are done marking, we recommend that you display **Marked Records** in the Quick Search window to make sure you have marked only the records you want to change.
3. From the **Database** menu's **Edit Marked Records** submenu, select **Global Edit**. ProCite displays this window:

![Global Edit Window](image)

4. In the fields list, click to highlight the field (or fields) that you want to change.

The 45 ProCite fields are listed by field number and default field name. Be careful! A particular field number used in one workform may contain different information than the same field number used by another workform.

5. Use the **Change** pull-down list to select the type of change you want to perform. Choose one of the following options:

- **Add to the beginning of each field** copies text to the beginning of the highlighted field(s). Existing text in the field is left intact. ProCite adds text separators (/ or //) in the author and keywords fields as needed.

- **Add to the end of each field** copies text to the end of the highlighted field(s). Existing text in the field is left intact. ProCite adds text separators as necessary.

- **Replace the entire field** deletes a field’s contents and then adds text.

- **Clear the entire field** deletes a field’s contents.

6. If you are adding text or replacing an entire field, type the new text into the **Text to Add** box

7. Click **OK** to start the operation. ProCite asks whether it is okay to modify the selected fields in each of the marked records.
8. Click OK to dismiss the alert and perform the global edit operation. Upon completion, ProCite indicates how many records were changed.

9. Click OK to dismiss the message.

**Global Find and Replace**

You may want to change every occurrence of a particular word or phrase in a database. With the Global Find and Replace command, you can quickly locate and modify specific text in the current set of marked records.

You can find and replace text in the default font only. Any text in a record that has a different font applied to it will not be replaced.

To globally find and replace text:

1. From the Select menu, choose Clear Marked Set to clear the check box for all records.

2. Mark only the records you wish to modify.

3. Go to the Database menu, and from the Edit Marked Records submenu choose the Global Find/Replace command. ProCite displays:

4. In the fields list, highlight the field(s) in which to find and replace text. The ProCite fields are listed by field number and default field name. You may have changed field names in your workform, but field numbers are constant.
5. Enter information into the following text boxes:

   a. In **Find Text**, specify the characters or string of text you want to find. ProCite will find text in the default font only.

   b. In **Replace With**, specify the characters or string of text you want as the replacement for the found text. You can type text in the default font only.

   **Tips**: Use the arrow buttons to choose from a field content list or term list. You can also enter three special characters:
   
   \^p = carriage return, \^l = line feed, \^t = tab

6. You can narrow the searching process by selecting one or both of these options:

   - **Match Case**, when checked, matches only exact capitalization when searching for the specified text. If not checked, ProCite searches for the text regardless of case.

   - **Find Whole Words Only**, when checked, finds only whole words; characters embedded in other words are ignored.

7. Click **OK** to start the operation. ProCite asks:

   **OK to replace all occurrences of "old text" with "new text" in each marked record?**

8. Click **OK** to dismiss the message and perform the global find and replace operation.

   ProCite alerts you when the process is complete, and indicates the number of records changed.

9. Click **OK** to dismiss the message.
Global Change Workform

With the Global Change Workform command, you take a marked set of records that are in any combination of workforms, and modify the set so that all of those records use one particular workform.

To change the workforms of multiple records to one workform type:

1. From the Select menu, choose Clear Marked Set to clear the check box for all records.

2. Mark the records whose workforms you wish to change.

3. Go to the Database menu’s Edit Marked Records submenu, and choose Global Change Workform. ProCite displays:

4. Select a new workform from the pull-down list of available workforms and click OK to start the operation.

   ProCite displays a message asking if it is OK to change each marked record to the new workform.

5. Click OK to allow ProCite to change the workform for the marked records.

   ProCite alerts you when the process is complete, and indicates the number of records changed.

6. Click OK to dismiss the message.

   All information in fields common to both the original and the new workform remains intact. That is, if both workforms include a particular field number, the contents of the field remain in that field, although the field name may change from workform to workform.

   If an original field has no corresponding field in the new workform, it will still be included in the new record. However, it is not part of the new workform and should be moved to the appropriate field or deleted. Either Cut the text and Paste it into the appropriate field for each record, or mark the affected records and use the Global Move Field feature described next.
Global Move Field

With **Global Move Field**, you can move an entire field of text to another field in the current set of marked records.

We recommend that you move fields of text within one workform type at a time, so you are certain the target field actually exists in the workform used for each record. If the target field does not exist in a record, the field of text will *not* be moved.

**To globally move a field of text:**

1. From the **Select** menu, choose **Clear Marked Set** to clear the check box for all records.

2. Mark only the records you wish to modify.

   To display all records that use the same workform, choose **Workforms** from the Show list and click on the appropriate workform name. Then mark the records you wish to change.

3. Go to the **Database** menu’s **Edit Marked Records** submenu and choose the **Global Move Field** command. ProCite displays:

   4. Use the **Move From** list to select the field that contains the text you wish to move. Although you may have renamed fields from the default names listed, the field numbers remain constant.

   5. Use the **Move To** list to select the field you want to contain the text.

   6. Use the **Change** list to indicate where to put the text in the new field:

      - **Move to beginning of field** moves all text from the first selected field to the beginning of the second selected field. ProCite adds text separators (// or /) in the author and keywords fields as needed.

      - **Move to end of field** moves all text from the first selected field to the end of the second selected field. ProCite adds text separators as necessary.

      - **Move to replace entire field** moves all text from the first selected field and use it to replace any text in the second selected field.
7. Click **OK** to start the operation. ProCite displays an alert message asking if it is okay to move field information for each marked record.

8. Click **OK** to allow ProCite to dismiss the alert and change the marked records.

   ProCite alerts you when the process is complete, and indicates the number of records changed.

9. Click **OK** to dismiss the message.
You can sort records in your ProCite database or bibliography in alphabetic, numeric, or chronological order based on the contents of the fields selected for comparison.
Chapter 1: Sorting Records

The Available Sort Orders

These commonly-used sort orders have been supplied with ProCite for your convenience:

• Author/Title/Date
• Author/Date/Title
• Author-Title/Title/Date
• Title/Date
• Date/Author/Title
• Call Number/Author/Title
• Record ID

Most of these sort orders are self-explanatory. The Author-Title/Title/Date sort order is able to handle the situation where there is no author name, substituting the contents of the first title field as the first sort criterion. This conforms to ANSI sorting requirements. You can reverse any sort order, to order records in ascending or descending order.

Selecting a Sort Order for Display

When you change the sort order for display, the new setting is remembered until you specifically change it.

To change the display order, go to the Sort menu and choose the order in which you want to see the record list. The current list displays in that order. You can also reverse your entire record list from ascending to descending order for the current sort. Use the Ascending/Descending option on the Sort menu.

Tip: A quick way to change the sort order is to click on a column heading in the record list. Based on the field displayed, ProCite selects the closest predefined sort. Click on the same column heading to toggle between ascending and descending order.

To switch a single sort level (field) from Ascending to Descending order, you must set up a custom sort order. In a custom sort order, you can set each of the sort levels to ascending or descending order, so you could have the author name sorted from A to Z, which is ascending order, while having the date sorted from most recent to earliest, which is descending order.

You can switch the entire list between ascending and descending order from the Sort menu, whether you are using a predefined sort or a custom sort.
Selecting a Sort Order For Printing

The order in which you sort a printed bibliography can differ from the viewing order on your screen. By default, ProCite uses the sort order set in the current output style.

To override the output style setting and print in a different sort order:

1. Choose Print Bibliography from the File menu, and a bibliography preview displays. The sort order matches the setting in the current output style.

2. Click the Configure button on the toolbar to bring up the Configure Bibliography dialog.

3. On the Reference List tab, select a different sort order from the Reference List Order pull-down list.

4. Set the Ascending/Descending radio buttons as desired. This can be set independent from the sort order for display.

5. Click OK to update the bibliography with the new sort order.

ProCite remembers this sort setting until you change it manually or until you select a different output style.

Note: To change the sort order associated with an output style, see Chapter 23: Creating and Modifying Output Styles.
Creating a Custom Sort Order

If none of the seven predefined sort orders meet your needs, you can define a custom sort order. You can define a default custom sort order for all new databases, or you can define a custom sort order specific to an existing database. ProCite saves your custom sort setting for the current database until you specifically change it. You can apply the custom sort order to your record lists in the database or on output.

Basic Procedure

This is a general description of how to set up the custom sort order. Field options for defining your custom sort are described in detail in following sections of this chapter.

To change the custom sort order:

1. Display the custom sorting options, either to change the default custom sort (new databases only) or the current database setting:

   • Changing the default:
     From the Tools menu, select Options to display the Options dialog. On the General tab, click the Edit Defaults button to bring up a Default Database Settings tabbed dialog. Click on the Custom Sort Order tab.

   • Changing the current database setting:
     From the Sort menu, select Configure Sorts and click on the Custom Sort Order tab.

2. On the Custom Sort Order tab, select up to six fields to compare for sorting, and set ascending or descending order for each field. This is described in the next two sections, Selecting the Fields and Setting Ascending or Descending Order.

3. On the Custom Sort Options tab, indicate how to sort empty fields, author fields, and date fields. This is described later in this chapter under Sorting Special Field Data.

4. Click OK to save the custom sort settings.

If you changed the current database setting, you can go to the Sort menu and select Custom to sort the current record list in your custom sort order. When you change the default sort order, the new order is used only for new databases.
Selecting the Fields

You can compare anywhere from one to six fields to determine the sort order. For example, when printing references to journal articles, you could specify four sort levels—to order your records first by journal title, then date, then author name, then article title. If several records have the same journal title, ProCite compares dates. If several records have the same journal title and the same date, ProCite compares author names. If several records have identical journal titles, dates, and author names, ProCite compares article titles.

In the first pull-down list, at the top of the Custom Sort Order tab, choose the first field to compare for sorting. In the next pull-down list, choose the second field to compare for sorting, and so on—up to six levels.

All 45 ProCite fields are available for sorting, plus several special fields:

- **None**: For the sort levels you won’t be using, set the pull-down list to “None.”

- **Author**: ProCite sorts by the text in the first non-empty author field found in a record. ProCite scans the author fields 01 and 07. If field 01 is empty or doesn’t exist in the workform used, ProCite looks in field 07 for author names. This “generic” author field makes it easy to sort multiple document types, since not all workforms use the same author field.
• **Author-Title:** ProCite sorts first by authors, but if no author is available in a record it sorts by title. The order of fields scanned is 01, 04, 07, 09, 10, and 11. If field 01 is empty, ProCite looks to field 04 for data. If field 04 is empty, ProCite looks to field 07 for data, etc. This type of sort will intermingle author names and titles for sorting, as required by ANSI and several other bibliographic styles.

• **Title:** ProCite sorts by the first title found in a record. ProCite scans fields 04, 09, 10, and 11. If field 04 is empty or doesn’t exist in the workform used, ProCite looks in field 09. If field 09 is empty or doesn’t exist in the workform used, ProCite looks in field 10 for a title, etc. This “generic” title field makes it easy to sort multiple document types, since not all workforms use the same title field.

• **Date:** ProCite scans date fields 20 and 21 and sorts each record by the first date found. If you want to sort by Date field 12, you must choose that field specifically.

• **Record ID:** ProCite sorts by record ID.

• **Workform:** ProCite sorts based on the name of the workform used for each record.

Keep in mind that when you sort by an individual field, that field may or may not exist in all records (depending on the workforms in use).

### Setting Ascending or Descending Order

On the **Custom Sort Order** tab, you can set each sort level to ascending or descending order. Use the Ascending/Descending radio buttons next to each sort level to make your selection.

Ascending order is 0-9 and A-Z order. Ascending date sorting places the earliest date before the more recent date. Therefore, “1980” appears before “1990” which appears before "2000", and “4/15/90” comes before “4/30/90.”

Descending order is Z-A and 9-0 order. Descending date order places the most recent entry before the oldest entry date so that 1998 lists before 1898.

After your custom sort is set up, you can reverse the order of the entire reference list by going to the **Sort** menu to choose **Ascending** or **Descending** order.
Sorting Special Field Data

The Custom Sort Options tab includes options for sorting empty fields, author names, and dates. ProCite uses these settings for all sort levels in the custom sort. The values set here are used only when you sort on a field affected by a particular option.

**Sorting Empty Fields**

On the Custom Sort Options tab, use the Sort empty fields option to determine how empty fields sort in relation to fields that contain data.

Select **Before all other fields** to sort empty fields before fields that contain data of any kind. For example, when sorting on author names, a record that does not have any text in the author field would sort like this:

<table>
<thead>
<tr>
<th>Ascending Order:</th>
<th>Descending Order:</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Empty]</td>
<td>Zimmerman, John</td>
</tr>
<tr>
<td>Baer, Colleen</td>
<td>Baer, Colleen</td>
</tr>
<tr>
<td>Zimmerman, John</td>
<td>[Empty]</td>
</tr>
</tbody>
</table>

Select **After all other fields** to sort empty fields after fields that contain data of any kind. For example, when sorting author names, a record that does not have any text in the author field would sort like this:

<table>
<thead>
<tr>
<th>Ascending Order:</th>
<th>Descending Order:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Baer, Colleen</td>
<td>[Empty]</td>
</tr>
<tr>
<td>Zimmerman, John</td>
<td>Zimmerman, John</td>
</tr>
<tr>
<td>[Empty]</td>
<td>Baer, Colleen</td>
</tr>
</tbody>
</table>
Sorting Author Names

On the Custom Sort Options tab, use the author options to determine how much text is compared in author field sorts.

From the Sort author fields using option, select:

- **All authors in field** to compare all author names in the field, whether there is one or any number of authors in the field

- **First author only** to use only the first author name in the field for sorting

From the Sort authors by option, select:

- **Full name** to compare complete author names, including last, first, and middle names or initials (as much text as is entered for each author)

- **Last name only** to use only the last name from each author name

Sorting Dates

On the Custom Sort Options tab, use the Sort dates by option to select one of these:

- **Exact date** to compare month, day, and year (as much date information as is entered in the field)

- **Year only** to compare only the year while ignoring month and day

Character Sorting by Language

Languages vary in their rules for character sorting. One example of this is à, which sorts after z in certain languages, but sorts like any other accented a in other languages.

ProCite sorts each character according to the current language setting. Even when you mix fonts in your records to insert characters from multiple languages, sorting is still based on a single language.

Changing the Language Setting

The language setting is saved for each database. You can select a default language setting for new databases, but you need to individually change the setting for your existing databases.
It is best to select the appropriate language *before* creating a database, since ProCite must rebuild the database after changing the language setting.

**To change the language setting:**

1. Display the International Settings tab, either to change the default setting (new databases only) or the current database setting:

   - Changing the default:

     From the **Tools** menu, select **Options** to display the Options dialog. On the **General** tab, click the **Edit Defaults** button to bring up a Default Database Settings tabbed dialog. Click on the **International Settings** tab.

   - Changing the current database setting:

     From the **Sort** menu, select **Configure Sorts** and click on the **International Settings** tab.
2. From the drop-down list, select the appropriate language setting:

- **General**: Select for Dutch, English, German, Indonesian, Italian, Portuguese, and modern Spanish.
- **Czech**
- **Danish and Norwegian**
- **Finnish and Swedish**
- **French**
- **Polish**
- **Russian (Cyrillic)**
- **Spanish (Traditional)**
- **System Specific**

**Note**: The System Specific sort uses the language defined by your computer’s operating system. This can cause conflicts when you share a database with another user who is using a different system sort. See the next topic, titled *How the System Specific Sort Affects Database Sharing*.

3. Click **OK** to save the change.

When you change the default language setting, the change is reflected in each new database you create.

When you change the language for the current database, ProCite rebuilds the database to reflect the new character sorting.

The language setting governs how characters sort in ProCite and how characters are uppercased for subject headings when printing subject bibliographies.

**How the System Specific Sort Affects Database Sharing**

The System Specific sort uses the language defined by your computer’s operating system. This is helpful when you want to use a language sort not currently provided by ProCite.

However, you should not use the System Specific sort if you want to share your database with others -- who may or may not have the same system sort in effect.
If you are using the System Specific sort and wish to share your database, use one of these options:

- The best option, especially if you plan to make the database available over a network, is to first change to one of the other language sorting options on the International Settings tab. The other language settings are internal to ProCite so that you can accurately share databases between users (and between ProCite for Windows and ProCite for the Macintosh).

- If users plan to install your database on their own machines, tell them to rebuild the database so the sort keys are updated according to their system sort.

- Make sure all computers that may access the database are using the same system sort.

**Note:** If you apply the System Specific sort from your computer, and a computer with a different system sort accesses the file, it may initially work just fine. However, when that user starts adding or editing records, especially when extended characters are used, the database will become obviously damaged. Use Rebuild to repair the file.

---

### How ProCite Sorts

This section explains how ProCite sorts field levels and characters when comparing and ordering records. It tells how ProCite sorts variables such as punctuation, diacritics, dates, numbers, and empty fields.

#### Sort Levels

To understand how the multiple sort levels work, here is an example using the three-level Author/Date/Title sort:

1. ProCite compares the author names from each record and sorts them alphabetically, from A-Z.

2. If two or more references have identical author entries, ProCite sorts that group of records by date. The earliest dates sort first.

3. If two or more references have identical authors and date entries, ProCite compares titles.

The “Author-Title/Title/Date” sort has a special sort in the first level. Author-Title in the first level compares authors first. However, if the first author field in a record is empty so the program first encounters text in a
title field, the title will be the first sorted text. You could have author
names and titles intermingled in the first-level sort. If two or more authors
names are identical, ProCite compares titles in the second level. If two or
more titles are identical, ProCite compares dates. This order meets the
ANSI bibliographic sorting requirements.

**Alphabetic Sorting**

Fields are sorted on characters from left to right. An alphabetic ordering
by author fields would result in:

- Albert, John
- Albright, Walter
- Brown, James

Diacritical marks are handled according to the language chosen with the
International Settings option. (See *Character Sorting by Language* earlier
in this chapter.)

**Numeric Sorting**

The fields that sort numbers correctly are the Record Number field and 44
*Call Number*. In these two fields, numbers sort appropriately, as in:

1
2
10
11
20

There are no other numeric fields, so in all other fields numbers are
compared from left to right—the same as alphabetic characters, one
character at a time. This means that sorting on fields containing numbers
can seem a little strange. A sorted numeric list would look like this:

1
115
2
200
35

In order to properly sort the previous list of numbers, you would have to
pad the numbers with zeros. A left to right character sort would properly
sort numbers that are padded to the largest number’s width, such as these:

0001
0035
0115
0200
1234
Symbol Removal

ProCite ignores all punctuation (such as “[“ and “(“) before sorting, by replacing any group of punctuation with a space. All characters other than letters and numbers are removed in this process:

! " ’ ( ) * + = , . / : ; < > ?

This character stripping is temporary and does not affect actual records or printed output—just the order in which the record appears.

For example, when sorting the title [The Tragedy of] Romeo and Juliet, ProCite ignores the brackets.

Date Sorting

ProCite provides special date sorting for putting publication dates and other date fields in chronological order. Alphabetical sorting is inappropriate for dates because of the wide variety of date formats you can use with ProCite. Numerical sorting is also inappropriate.

ProCite accepts a wide variety of date formats and converts each into a single internal format that you never see. When the program sorts dates, it sorts these internal equivalents. For example, dates entered into your database could be entered in formats such as 12/04/97 and December 4, 1997. ProCite can correctly interpret both formats as the same date for sorting. ProCite can also sort date ranges, such as “December 4-6, 1997.”

Dates entered as two digits are translated as in the 20th century. So, "97" is interpreted as "1997". For dates before 1900 or after 1999, you should always enter all four digits.

The special date sorting instructions are applied only to data in the following date fields:

Date (generic date—field 20 or 21, the first that contains data)
12 Date of Meeting
20 Date of Publication
21 Copyright Date

Anything entered in one of these fields will be interpreted by ProCite as a date for sorting purposes. Dates entered in other fields will not sort with the special date format instructions. Because of this, it is important that the date fields contain ONLY dates, and that anything you want sorted as a date is in one of the date fields.
If the text in a date field is not recognized by ProCite as a valid date, it is sorted alphabetically as regular text after the valid dates. So, if you entered “unknown” into a date field, that record would sort after all other records that contain valid dates.

**Call Number Sorting**

When sorting the **44 Call Number** field, both the alphabetic and numeric components of the call number are taken into account.

ProCite supports two call numbering systems: Dewey Decimal and Library of Congress. If you enter your data using one of these call numbering systems, ProCite can order your database in true call number order. ProCite can read and interpret the following numbers:

- a whole number, such as 300
- a decimal number, such as 301.79
- an alphanumeric number, such as H37.9

ProCite sorts the Library of Congress classifications first, followed by Dewey Decimal classifications, and then any that don’t match the Library of Congress or Dewey Decimal format in alphabetic order.

You can use the **44 Call Number** field simply to store and sort whole numbers.

**Empty Field Sorting**

By default, empty fields are sorted before fields that contain data. For example, when ordering records in Author/Date/Title order, those records that do not contain an author name would be ordered first in the list (before authors whose names start with “A”).

The sort Author-Title/Title/Date will substitute the title if there is nothing in the first two Author fields (01 and 07). If you have empty author fields, this will result in an alphabetic listing that mixes some author names with some titles (where there was no author listed in the record):

Adams, Alexander B.
Christie, Agatha
The Dwarfs' Dilemma
Joplin, Scott

In a Custom Sort, you can place empty fields either before or after non-empty fields. In any case, if you need to sort empty fields last (after “Z”) you must create a custom sort order.
Using Stop Lists

A Stop List is a list of words that, when they appear at the beginning of a field, are ignored for sorting. These words remain in the database and are printed on output. For example, “the” is normally ignored during sorting when it appears at the beginning of a title. A word ignored in such a manner is called a stop word.

Default Stop Lists, which you can modify, are applied to each new database. You can also modify the Stop Lists stored in each existing database, so that each database can maintain unique Stop Lists.

A database's Stop Lists are used every time ProCite sorts records in the database, whether a predefined sort or a custom sort order.

You can expand the lists to include articles in various languages or include any other words you want (such as prepositions and conjunctions). You can deactivate the stop word feature altogether by removing all stop words from the list.

The Available Stop Lists

Two different types of Stop Lists are available: the Generic Stop List, which applies to titles, keywords, and corporate authors; and the Author Stop List, which applies to personal author names.

Generic Stop List

The Generic Stop List is used on titles from fields 04, 09, 10, 11, and 32; corporate authors from fields 01, 07, 16, and 30; and keywords from field 45. If you are sorting on one of these fields, ProCite will look at the first word in the field and compare it to the words in your Stop List.

When ProCite recognizes a stop word at the beginning of a title, it jumps to the next word when composing a sort. For example, when the word “a” is a stop word, ProCite skips it when taking sort information from the title *A History of the Modern World*. The title would sort among other titles starting with “H.”

When sorting by author, ProCite first looks for the equal sign (=) that indicates a corporate author. Corporate authors could include such names as *The University of Michigan* or *The Toy Manufacturers of America*. When “the” is a stop word, it would be ignored for sorting in both cases. *The University of Michigan* would sort under “U,” and *The Toy Manufacturers of America* would sort under “T.”
Stop words in keywords are significant particularly for subject bibliographies or subject lists, since they may affect the sort order of subject headings.

By default, the Generic Stop List contains seven words:

\[
\begin{align*}
\text{a} & \quad \text{le} \\
\text{an} & \quad \text{la} \quad \text{les} \\
\text{the} &
\end{align*}
\]

However, you can modify the Stop List to include other words. You can add articles in other languages and include prepositions and conjunctions. Or, you can remove all words from the list to deactivate the Stop List.

Occasionally, a record may contain a word that exists in the Stop List, but should still be used for sorting. For example, you may have “los” in your Stop List, but not want it to affect the sorting of “Los Angeles.” When entering “Los Angeles” into your record, insert a hard space after “Los” (by pressing Control-Shift-Space) to group “Los Angeles” as a single term that is not affected by the stop word “los.”

**Author Stop List**

The Author Stop List is used when sorting personal author names from fields 01, 07, 16, and 30. It is not used on any author name that is preceded by an equal sign (=), which indicates a corporate author; the Generic Stop List is used on corporate author names.

When ProCite identifies a stop word at the beginning of an author’s last name, it jumps to the next word when composing a sort. For example, if you enter the Arabic particle “al” into the Author Stop List, the name

\[
\text{al-Jamal, Muhammad Hamid}
\]

Would sort under “J.” The full name would still print on output.

By default, the Author Stop List is empty. You can add as many stop words as you wish.

**Changing the Stop Lists**

It is easiest to set up your Stop Lists before entering records into a database. You can set the default stop lists so every database you create uses the same list. Stop Lists are used to update the sort orders as each new record is entered.
If you change the Stop List for an existing database, ProCite automatically updates the sorts to reflect the changes. This could take some time, depending on the number of records in your database and the number and size of fields sorted.

You can open a Stop List simply to view it. When you are done viewing it, click Cancel to leave without saving changes.

To change the Stop Lists:

1. Display the Stop Lists tab, either to change the default lists (new databases only) or the current database settings:

   - Changing the default lists:
     From the Tools menu, select Options to display the Options dialog. On the General tab, click the Edit Defaults button to bring up a Default Database Settings tabbed dialog. Click on the Stop Lists tab.

   - Changing the current database settings:
     From the Sort menu, select Configure Sorts and click on the Stop Lists tab.

2. Use the pull-down list to select a Stop List. Author applies to personal author names, and Generic applies to titles, corporate authors, and keywords. ProCite displays the list of stop words in the list box. If no stop words currently apply, the box is empty.
3. Modify the list:

- **Add an item:** Click on the Add button. Type the new word in the text box and click OK. Stop word identification is not case sensitive, so it doesn’t matter whether you enter items in upper or lower case.

- **Modify an item:** Highlight the term and click on the Edit button. Edit the text and click OK.

- **Delete an item:** To delete a word, highlight the word in the list and click the Delete button. ProCite will remove the word from the list.

- **Remove the List:** If you want to deactivate the Stop List feature so that all words are used for sorting, you should delete all of the stop words.

Stop words are delimited from the next word in a field by a space or a punctuation mark.

4. Repeat step 3 as many times as necessary, then click OK to save changes.

When you change a list for the current database, ProCite automatically updates the database to reflect the changes.

When you change a default list, the changes are reflected in each new database you create.
Detecting Duplicates During Data Entry

To detect possible duplicates as you enter records:

1. From the **Database** menu, select **Configure Duplicates**.

![Configure Duplicates](image)

This tab contains various options for field comparison when scanning for duplicates. In most cases, the default Author, Title, and Date comparison works best. For more information about these options, see **Setting Duplicate Record Criteria** later in this chapter.
2. Select the check box titled **Warn about duplicates when saving new records**.

3. Click **OK** to save changes and dismiss the dialog.

Now, when you save a new record, ProCite warns you when it encounters a possible duplicate. You may want to save the record and compare the duplicates before deleting one of them.

### Searching the Database for Duplicates

To list duplicate records in your database, mark them, and delete them:

1. Click on the Duplicates tab at the bottom of the record list window. ProCite displays all possible duplicates based on the current duplicate detection settings.

2. Mark the duplicates you want deleted. You may prefer to manually mark each duplicate record you want to delete. To quickly mark duplicates, two buttons are available in the Search Duplicates window:
   - **Mark by Date** leaves unmarked the first-entered (oldest) record from each set of duplicates, and marks all later duplicates.
   - **Mark by Size** leaves unmarked the longest record from each set of duplicates, and marks all shorter duplicates. The longest record is not marked because it contains the most data (often notes or an abstract).
3. Verify that the marked records identified as duplicates are really duplicates before deleting them. You may want to first sort the records by the fields used to detect duplicates.

Scan through the list of records, making sure the marked records are truly duplicates. You can view full records in order to compare all fields of information. You may even want to view two records at once, sizing the windows so they are next to one another.

In the unlikely case that a marked record is not a duplicate, even though it contains some of the same information as another record, click the check box to unmark the record so you won’t delete it.

**Important!** Make sure the only records marked are the records you want to delete.

4. Delete the marked records. Remember that once you delete a record, it is gone forever. From the **Database** menu, choose the **Delete Marked Records** command. ProCite asks for verification.

### Setting Duplicate Record Criteria

You can determine which fields ProCite compares when detecting possible duplicate records. There are three ways to access the duplicate detection options:

- From the **Tools** menu, select **Options**. Click the **Edit Defaults** button and select the **Duplicate Detection** tab. These are the initial settings for any *new* database you create with this copy of ProCite.

- From the **Database** menu, choose **Configure Duplicates**. ProCite uses these settings for the current database.

- In the main record list window, select the **Duplicates** tab to display possible duplicates based on the current duplicate detection settings. Click on the **Configure** button to change those settings for the current database.
To set the duplicate detection options:

1. In the list of fields, check those fields you want ProCite to compare for duplicate information.

   The default is set to work in most cases: generic Author, Title, and Date. By using the generic items, you are more likely to catch duplicates entered in different workforms.

   You want to compare fields that are consistent in entry, not too general, and contain unique information. For example, a comparison by journal title is usually not helpful because the same journal title can appear in many records.

   In comparing text, ProCite ignores letter case, diacritics, spaces, and punctuation. ProCite generates a key for each record based on the information in each selected field. The key is made up of up to 255 characters, and each selected field contributes to the key. For example, if there are three text fields selected, each field contributes 85 characters to the key. The more fields you select, the fewer characters are compared from each field.

2. Select **For authors, include just the last name** when you want to limit the author field to compare only last names. This is significant when you import records from various online or cd bibliographic services. Services vary in whether they include full first names or only initials.
3. Select **For dates, include just the year** when you want to limit the date comparison to year only.

4. Select **Warn about duplicates when saving new records** and ProCite will warn of a possible duplicate when you save a manually entered record.

5. Select **Discard duplicates when importing** to automatically throw away duplicates ProCite detects during an Internet or PubMed search or while importing tagged or delimited records. If you download hundreds (or thousands!) of bibliographic records on a regular basis, you may not want to verify each possible duplicate.

---

**Note:** Make sure your field comparison is specific enough so you do not throw away similar but different records.
Overview

It is easy to quickly find a set of related records or to collect a set of unrelated records in ProCite. Once you collect a set of records, you can save them for later use, print a bibliography from them, or copy them to a separate database.
Finding a Single Record

To jump directly to a specific record in a record list,

1. Select a sort order so the text you are looking for is included in the first level sort. For example, if you want to jump to a particular title, select the Title/Date sort or a custom sort that first compares titles.

2. Click on any record in the record list to activate the list.

3. Type the first few characters used to identify the record. The characters must begin the first sorted field. ProCite displays a Go To Record dialog.

4. Continue typing as many characters as you feel may be required to differentiate the record from others and click OK.

ProCite searches from the top of the record list and highlights the record that most closely matches the text you typed. If several records match, only the first match in the list is highlighted. Stop words are ignored when jumping to records.

Note: To jump to a specific record when viewing full records for editing, you can go to the View menu, Go to Record, and then Find. This displays the Go to Record dialog. You can also access this from the Go to Record toolbar.
Quick Searching with Field Content Lists

The easiest way to find records is to look up particular Authors, Journals, Titles, or Keywords. A field content list shows all unique entries in the chosen field in the active database, so you can choose a term from the field content list knowing that ProCite will find and list at least one matching record.

To find records using field content lists:

1. Click the Terms tab.

2. Select Authors, Journals, Titles, or Keywords from the Show list at the top of the window. A list of all Authors, Journals, Titles, or Keywords found in the database will appear in the left pane. The number next to each entry indicates how many records contain that entry.

3. Click on the term for which you are looking and ProCite lists all the records that match the term you selected.

For example, if you are looking for all works by Alfred Gilman, select Authors, then click on Gilman, Alfred G.

If you do not see the term in one of the abbreviated records, you can double-click to view the full record and locate the term. The name could be part of a list that was too long to appear in the display, or it could reside in an author field that is not displayed.

You may simply want to print the records in the list. If you want to combine these records with other records to create a subset, you can mark them. See Marking Records later in this chapter.
Highlighting Records

You can highlight a single record or multiple records while browsing a record list. You can then mark them to print or save them to a group.

Highlighting is useful when the records you want are displayed in a contiguous block, allowing you to highlight many records at once.

Scroll through any record list, then:

- To highlight an individual record, click on it.
- To highlight several records, press the mouse button and drag through the records to highlight all of them.
- To highlight records that are not displayed consecutively, hold down the control key while you click on the individual records.
- To highlight an entire record list, such as all works by a certain author or search results, choose Select All from the Edit menu.

To save highlighted records to a group, see Chapter 14: Saving Records in Groups.

Marking Records

Marking is an ideal way to collect a set of records that are difficult to define in a single Search Expression. While browsing through a database, you can mark individual records to add them to the marked set.

You can highlight records only in the current list, but marking is a good way to collect individual records from more than one record list. For example, you can list and mark all works by Tom Peters and then list and mark all works by Philip Crosby. The set of marked records will include the works of both authors.

The check box to the left of the displayed record is selected (X) when the record is marked. To view all marked records, click the Marked Records tab. This is the only reliable way to see all of the marked records at once.

Many ProCite operations work on marked records only, rather than on the entire database. These operations include:

- Globally editing marked records
- Copying marked records
- Exporting marked records
- Deleting marked records
To Mark records:

1. Choose **Clear Marked Set** from the **Select** menu (or the corresponding toolbar icon), unless you want to add to the current group of marked records.

2. Display any record list, which could include search results or a group.

3. Select the check box for each record you want marked.
   a. To mark an individual record, click on the check box at the left.
   b. To mark an entire record list, such as search results, choose the **Mark List** icon (xx) from the **Bibliography** toolbar.
   c. To mark highlighted records, choose **Mark Highlighted Records** from the **Select** menu or the corresponding toolbar icon (x).

   You can switch between record lists and continue marking records.

Once a record is marked, it remains marked until you specifically unmark it, or until the marked set is changed by importing records, detecting duplicates, or generating a bibliography from within a manuscript.

You can individually unmark a record by clicking on the check box. To unmark all records, choose **Clear Marked Set** from the **Select** menu or from the toolbar.

**Note:** The marked set is changed when you import records, detect duplicates, or generate a bibliography from a word processor document with *cite while you write.*
Searching a Database

Generally, a search starts with a search expression—whether typed in by you or called up from a list of saved search expressions. In the search expression, you tell ProCite what string of text to look for and in what field(s) to look.

This section is divided into four parts:

• Performing a Search
• Elements of a Search Expression
• Creating Search Expressions
• Sample Search Expressions

Performing a Search

To search all records in the current database:

1. Click the Search tab. The Search window appears, with the cursor in the text box.

2. Enter your search expression in the Search for text box. You can create a new expression, modify the existing expression, or restore a saved expression (see the next section for more information). Type the search expression manually or use the buttons along the top of the window to guide you. In this search expression:

   AUTHOR=Wheeler
• "AUTHOR", the field identifier, indicates which field(s) to search.
• "=", the operator, says that the search term must match a term that appears anywhere in the field.
• "Wheeler" is the search term ProCite is looking for in each record (in this case, an author name).

3. In the **Look in** drop-down box, select the set of records you wish to search:
   - **All Records**, to search all records in the current database
   - **Marked Records**, to search marked records
   - **Search Results**, to search the records listed on this search window
   - The drop down box also lists available groups of records to search

4. Click the **Search** button.

ProCite searches the set of records for matching records and lists the matching records in the current sort order. You can then sort the search results in any order, print the search results, etc.

You can save the current search results as a group to be called up later. See *Chapter 14: Saving Records in Groups* for more information. If you will be adding new records to the database, you will need to re-execute the search for an updated set of matched records.

When you close ProCite, the current search expression and search results are cleared from the Search window.
Narrowing a Search

You can refine a search to search only the list of records found in the previous search. This allows you to narrow the Search Expression if you have selected more records than you want.

To limit your search to the previous search results:

1. In the Look in drop-down list, select Search Results.
2. Enter a search expression.
2. Click the Search button to execute the search. ProCite searches only the list of records found in the previous search.

Elements of a Search Expression

A Search Expression is a description of the criteria you want ProCite to use in locating records in a database.

A Search Expression can consist of almost any combination of these three elements:

- **Search Term** - The word or phrase you want ProCite to find.
- **Field Identifier** - A unique identifier that limits a search to a specific field, group of fields, workform or group.
- **Operator** - An instruction for creating relationships between multiple search terms or an instruction on how to search a field.

You can enter field names, operators, and search terms either by typing them from the keyboard or by using a combination of typing and pop-up lists.

The most thorough search is full text searching, where the search expression contains only a search term. ProCite goes through every piece of text in every field in every record, which may take a long time.

If you add a field identifier and an operator to your search expression, you speed up the search by limiting it to a specific field. The fastest searches are on the Author, Journal Title, Title, or Keyword fields, since those fields are already indexed for field content lists.
Search Term

The search term is the character, word, or phrase ProCite is to find. You can enter a search term manually from the keyboard, or you can copy an item from a list into a search expression.

You can search for a single word or a phrase. A phrase is any series of characters containing at least one blank space. It must be enclosed in double quotation marks. A hyphenated word is considered a single word in searching. These are possible search terms:

- greco-roman
- “genetic engineering”
- “New York”
- genetics

Searching ignores letter case, so ProCite selects all records matching the search expression without regard to capitalization. ProCite also ignores diacritics when searching. So whether you search for “a” or “ä”, ProCite finds all variations: a, á, à, ã, å, A, Á, Á, Â, Ä.

When your search expression consists of a search term only, ProCite does a full-text search—checking every field in each record in the database.

Wildcard Character

The wildcard or truncation character, an asterisk (*), can be substituted for one or more characters in a search term to increase the number of possible matches.

You cannot use a wildcard within a word, such as anthr*gy, and you can use it only for full-text searching or with the equal (=) operator. If you use an asterisk with any other relational operator or special operator, it is interpreted literally—as though you were searching for an asterisk.

These are examples of search terms using a wildcard:

<table>
<thead>
<tr>
<th>Search Term</th>
<th>Matches in Record</th>
</tr>
</thead>
<tbody>
<tr>
<td>sulfa*</td>
<td>sulfa, sulfasuxidine, and sulfate</td>
</tr>
<tr>
<td>*ology</td>
<td>biology, microbiology, geology and gerontology</td>
</tr>
<tr>
<td><em>olog</em></td>
<td>biology, biological, ecology, and zoologist</td>
</tr>
<tr>
<td>“Roman p**”</td>
<td>Roman people and Roman police</td>
</tr>
<tr>
<td>“ish history”</td>
<td>English history and Spanish history</td>
</tr>
</tbody>
</table>
Field Identifiers

Field Identifiers limit the search to a field, group of fields, workform, or group. All field numbers, along with default field names, are available in the Fields list. Note that a field number represents each field in a search expression, since the field name can change between workforms.

For example, Author (01) could also encompass Inventor (01) and Composer (01). So a search on Field #1 would appear as:

#1=Anderson

You can also use certain field names to search specific fields or groups of fields:

<table>
<thead>
<tr>
<th>Identifier:</th>
<th>Searches:</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABSTRACT or ABST</td>
<td>Abstract (43)</td>
</tr>
<tr>
<td>AUTHOR or AUTH</td>
<td>All author fields:</td>
</tr>
<tr>
<td></td>
<td>Author, Analytic (01)</td>
</tr>
<tr>
<td></td>
<td>Author, Monographic (07)</td>
</tr>
<tr>
<td></td>
<td>Author, Subsidiary (16)</td>
</tr>
<tr>
<td></td>
<td>Series Editor (30)</td>
</tr>
<tr>
<td>CALL</td>
<td>Call Number (44)</td>
</tr>
<tr>
<td>DATE</td>
<td>All date fields:</td>
</tr>
<tr>
<td></td>
<td>Date of Meeting (12)</td>
</tr>
<tr>
<td></td>
<td>Date of Publication (20)</td>
</tr>
<tr>
<td></td>
<td>Date of Copyright (21)</td>
</tr>
<tr>
<td>JRNL</td>
<td>Journal Title (10)</td>
</tr>
<tr>
<td>KEYWORDS or KEY</td>
<td>Keywords (45)</td>
</tr>
<tr>
<td>NOTE</td>
<td>Notes (42)</td>
</tr>
<tr>
<td>PLPU</td>
<td>Place of Publication (18)</td>
</tr>
<tr>
<td>PUBL</td>
<td>Publisher Name (19)</td>
</tr>
<tr>
<td>TITLE or TITL</td>
<td>All title fields:</td>
</tr>
<tr>
<td></td>
<td>Title, Analytic (04)</td>
</tr>
<tr>
<td></td>
<td>Title, Monographic (09)</td>
</tr>
<tr>
<td></td>
<td>Journal Title (10)</td>
</tr>
<tr>
<td></td>
<td>Title (11)</td>
</tr>
<tr>
<td></td>
<td>Series Title (32)</td>
</tr>
</tbody>
</table>
For example, by using the identifier AUTHOR, ProCite searches all four author fields. If you want to search a specific author field, such as Author, Analytic (01), you would select that specific identifier from the list.

For record IDs, workforms, or groups, you can use a special identifier to perform a limited search:

<table>
<thead>
<tr>
<th>Identifier</th>
<th>Searches for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>REC#</td>
<td>A record with a specific record ID or a range of record IDs when used with a relational operator</td>
</tr>
<tr>
<td>RECORD#</td>
<td></td>
</tr>
<tr>
<td>RECORD ID</td>
<td></td>
</tr>
<tr>
<td>WORKFORM</td>
<td>Records that use a specific workform</td>
</tr>
<tr>
<td>GROUP</td>
<td>Records contained in a specific group</td>
</tr>
</tbody>
</table>

**Operators**

An operator is a character that ProCite interprets as a special searching instruction. There are two basic types of operators: relational and logical. There are also two Special Values.
**Relational Operators**

Use these relational operators between an identifier and a search term:

<table>
<thead>
<tr>
<th>Relational Operator:</th>
<th>Definition:</th>
</tr>
</thead>
<tbody>
<tr>
<td>= (equal)</td>
<td>Text anywhere in the field must match the search term. Only whole words match unless you use the wildcard character.</td>
</tr>
<tr>
<td>&lt;&gt; (not equal)</td>
<td>The search term must not match any text in the field.</td>
</tr>
<tr>
<td>&gt; (greater than)</td>
<td>Text must follow the search term numerically or alphabetically. Primarily used for dates or record IDs; ProCite looks at only the first character of any other field.</td>
</tr>
<tr>
<td>&lt; (less than)</td>
<td>Text must precede the search term numerically or alphabetically. Primarily used for dates or record IDs; ProCite looks at only the first character of any other field.</td>
</tr>
<tr>
<td>&gt;= (greater than or equal to)</td>
<td>Text must match or follow the search term numerically or alphabetically. Primarily for dates or record IDs; ProCite looks at only the first character of any other field.</td>
</tr>
<tr>
<td>&lt;= (less than or equal to)</td>
<td>Text must match or precede the search term numerically or alphabetically. Primarily for dates or record IDs; ProCite uses only the first character of any other field.</td>
</tr>
<tr>
<td>BEGINS WITH</td>
<td>The field (or subfield, in the case of authors and keywords) must begin with this text. Right truncation is assumed.</td>
</tr>
<tr>
<td>ENDS WITH</td>
<td>The field (or subfield, in the case of authors and keywords) must end with this text. Left truncation is assumed.</td>
</tr>
<tr>
<td>EXACTLY</td>
<td>The entire field (or subfield, in the case of authors and keywords) must exactly match the text entered after this operator.</td>
</tr>
<tr>
<td>CONTAINS</td>
<td>The search term can appear anywhere in the field. The same as equal (=) with a left and right wildcard.</td>
</tr>
</tbody>
</table>
Examples with Relational Operators:

AUTH="Christie, Agatha"  All matching records must list Christie, Agatha as an author in any one of the author fields.

AUTH>Johnson  All matching records must have an author name that alphabetically comes after the letter J.

DATE<1994  All matching records must have a date that comes before, but does not include, 1994.

DATE>=1994  All matching records must have a date that comes after or includes 1994.

REC#<=547  All matching records must have a record ID that comes before or includes 547.

#45 BEGINS WITH egg  Matching records must contain a keyword that begins with “egg.” This expression matches “egg implantation” but not “chicken egg.”

#45 ENDS WITH diabetes  Matching records must contain a keyword that ends with “diabetes.” This expression matches “juvenile diabetes,” but not “diabetes treatment.”

#45 EXACTLY cancer  Matching records must contain the full keyword “cancer.” This expression does not match keywords such as “breast cancer” or “cancer treatment.”

#45 CONTAINS disease  Matching records must have the term “disease” anywhere in the Keywords field, whether as a complete word or as part of a word.

The equal sign is the operator most used. When searching most fields, the equal sign attempts to match the word or phrase anywhere in the field.

The CONTAINS operator attempts to match the search term anywhere in the field. It assumes left and right truncation, so this search expression:

   AUTHOR CONTAINS son

would match these authors:

   Anderson, Mark
   Sontag, Edith
   Bono, Sonny
If you want to search for the actual word “contains” or the phrase “begins with” you must enclose the term in quotation marks. For example,

Keywords="ends with"

**Logical Operators**

Logical Operators (often called Boolean Operators) are used to create a relationship between multiple search expressions. ProCite uses four logical operators: AND, OR, NOT, and AND NOT.

<table>
<thead>
<tr>
<th>Logical Operator:</th>
<th>Definition:</th>
</tr>
</thead>
<tbody>
<tr>
<td>AND</td>
<td>Use this operator between two search terms or expressions to find records that match both terms.</td>
</tr>
<tr>
<td>OR</td>
<td>Use this operator between two search terms or expressions to select records that match at least one search term.</td>
</tr>
<tr>
<td>NOT</td>
<td>Use this operator before a search term to find all records that do not contain the search term.</td>
</tr>
<tr>
<td>AND NOT</td>
<td>Use this operator between search terms to find all records that do contain the first term but not the second.</td>
</tr>
</tbody>
</table>

**Examples with Logical Operators:**

flag AND Australia  
Matching records must have both the words *flag* and *Australia* anywhere in the record.

#45=flag AND #45=Australia  
Matching records contain both of these words in the *Keywords (45)* field.

flag* OR Australia  
Matching records must have either the base word *flag* (flag, flags, flagging, etc.) or the full word *Australia* or both in the record.

#45=flag OR Australia  
Matching records must have either the word *flag* in the *Keywords (45)* field or the word *Australia* in any field.

#45=flag OR #45=Australia  
Matching records must have either the word *flag* or the word *Australia* or both in the *Keywords (45)* field. Another way to enter this search expression is: #45=flag, Australia.

NOT flag  
Matching records cannot contain the word *flag* in any field.
flag AND NOT Australia  Matching records must contain the word *flag* in any field, but must not contain the word *Australia* in any field.

**Special Values**

ProCite uses two special values to look for fields that do or do not contain text.

<table>
<thead>
<tr>
<th>Special Value</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>=EMPTY</td>
<td>The field must be empty (no text at all).</td>
</tr>
<tr>
<td>=NOT EMPTY</td>
<td>The field must contain text.</td>
</tr>
</tbody>
</table>

**Examples with Special Values:**

AUTH=EMPTY Matching records must have all four author fields empty.

#7=NOT EMPTY Matching records must have text in author field *Author, Monographic (07)*.

If you want to search for the actual word “empty” or the phrase “not empty” you must enclose the term in quotation marks. For example,

Keywords="empty"

**Special Characters**

ProCite recognizes special characters in search expressions:

<table>
<thead>
<tr>
<th>Special Character</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>( ) (parentheses)</td>
<td>Use of parentheses affects the order in which ProCite executes a search expression, starting with the search terms in the innermost parentheses first and working outward. It is helpful to use parentheses in search expressions that include different logical operators.</td>
</tr>
<tr>
<td>, (comma)</td>
<td>Use a comma between terms when you want to search for more than one term in the same field.</td>
</tr>
</tbody>
</table>
Examples with Special Characters:

(flag OR Germany) AND date=1993 This expression selects any record published in 1993 with either flag or Germany in any field.

flag OR (Germany AND date=1993) This expression selects any record with flag in any field, or any record published in 1993 with Germany in any field.

author=Smith, Morris, Brown This expression selects any record that contains the author Smith or the author Morris or the author Brown.

Creating Search Expressions

Building a Search Expression

To build a new search expression:

1. Click the Search tab. ProCite displays the Search window, with a text box for building a search expression.

If there is already an expression in the text box, remove it by clicking the New Search button.
2. If you want to do a full text search, skip to step 4. To limit your search to particular fields, workforms, groups, or record IDs, click the **Fields** button or select **Insert Field** from the **Edit** menu and the Search Fields dialog appears:

![Search Fields dialog](image)

To search a specific field, select that field number from the list. ProCite transfers the field identifier to the text box.

Or, choose a special identifier: AUTHOR, TITLE, DATE, KEYWORDS, RECORD ID, WORKFORM, GROUP. ProCite adds the identifier to the search expression.

3. Enter a relational operator by clicking on the **Operators** button and choosing from the list.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>=</td>
<td>Equal, this text appears anywhere in the field</td>
</tr>
<tr>
<td>&lt;&gt;</td>
<td>Not Equal, field does NOT contain this text</td>
</tr>
<tr>
<td>&lt;</td>
<td>Less Than</td>
</tr>
<tr>
<td>&lt;=</td>
<td>Less Than or Equal</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater Than</td>
</tr>
<tr>
<td>&gt;=</td>
<td>Greater Than or Equal</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AND</td>
<td>Both expressions match</td>
</tr>
<tr>
<td>OR</td>
<td>Either expression matches</td>
</tr>
<tr>
<td>NOT</td>
<td>Expression does NOT match</td>
</tr>
<tr>
<td>AND NOT</td>
<td>First expression matches, second expression does not</td>
</tr>
<tr>
<td>BEGINS WITH</td>
<td>Field, Author, or Keyword begins with this text</td>
</tr>
<tr>
<td>ENDS WITH</td>
<td>Field, Author, or Keyword ends with this text</td>
</tr>
<tr>
<td>EXACTLY</td>
<td>Entire Field, Author, or Keyword matches this text</td>
</tr>
<tr>
<td>CONTAINS</td>
<td>Field contains this text, possibly as part of another word or phrase</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>= EMPTY</td>
<td>Field is empty</td>
</tr>
<tr>
<td>= NOT EMPTY</td>
<td>Field contains any text</td>
</tr>
</tbody>
</table>

ProCite adds the operator to the current search expression.
4. Enter your search term in one of two ways:

- Type the term in the text box. If your search term is a phrase, enclose it in quotation marks.

Since ProCite does not distinguish between uppercase and lowercase characters, you can type any variation. ProCite also does not distinguish between diacritics, so “a” finds all variations (such as â or ä).

To insert a symbol, select **Insert Symbol** from the **Edit** menu, double-click the character you want to insert, and click **Close**.

- Copy text from a list.
  a. Place the cursor where you want the term inserted.
  b. Click the **Insert Term** button, or select **Insert Term** from the **Edit** menu, to display a dialog box for locating and opening the field content list, term list, group, or workform list you want. The last-used list opens automatically.
  c. Select the appropriate list name in the pull-down list at the top of the window to display the terms in that list.
  d. Locate the term you want to insert, double click on it to transfer the item to the text box at the cursor, and click **Close**.

If a journal title list has full journal titles plus journal abbreviations, ProCite copies only the full journal titles.
5. To link multiple search expressions:
   a. Use the **Operators** button to select an appropriate logical operator (AND, OR, NOT, AND NOT) to express the relationship between terms.
   b. Repeat steps 2 through 4.
   You can continue adding identifiers, operators, and terms to build a complex search expression.

You can modify the search expression or save it before you perform the search.

**Saving a Search Expression**

You can save the current search expression. It is particularly useful for long, complicated search expressions—especially if you intend to insert more records and perform the same search at a later date.

**To save a search expression:**

1. Click the **Expressions** button and select **Add to Expressions** to display the Add Search Expression dialog.

   ![Add Search Expression dialog](image)

2. Type a unique name in the **Expression Name** box to identify your search expression and click **OK**.

   **Note:** If you give the search expression a name that is already in use, ProCite asks to replace the existing expression with the same name.

   ProCite saves the expression for later use. Search expressions are kept in a preference file (SRCHEXPR) in your ProCite folder, so are available to all your ProCite databases.
Restoring a Saved Search Expression

To restore a saved search expression:

1. Click the **Expressions** button and select a saved search expression in one of these two ways:
   a. Select the expression name from the menu (ProCite lists the 10 most recent expressions).
   b. Select Expressions from the menu. ProCite displays the Load Search Expression dialog, which lists all saved search expressions.

   ![Load Search Expressions](image)

   Double-click the name of the search expression you wish to use.

2. ProCite inserts the selected expression in the search expression text box.

   Click **Search** to execute the search. ProCite lists the matching records below the text box.

Editing a Saved Search Expression

To edit a saved search expression:

1. Restore the expression as though you were going to use it for searching.

2. Make the desired edits to the expression.

3. Save the expression again with the same name.

4. When asked whether to replace the existing expression, click **Yes**.
Deleting a Search Expression

To delete the current search expression, click the **New Search** button.

**To delete a saved search expression:**

1. Click the **Expressions** button and select **Organize Expressions**. ProCite displays this dialog:

   ![Organize Search Expressions](image)

   2. Highlight the search expression you wish to delete and click the **Delete** button. Verify the deletion and ProCite permanently removes the search expression.

Renaming a Search Expression

To rename a saved search expression:

1. Click the **Expressions** button and select **Organize Expressions**.

2. Highlight the search expression you wish to rename and click the **Rename** button to display the Rename Search Expression dialog:

   ![Rename Search Expression](image)

   3. Type in the new name and click **OK**.
Sample Search Expressions

This section shows example search expressions to use as a guide for creating your own.

Finding a Search Term

To Search:  Example:

Full text of record  “ish history”
compu*
sulfaguanidine

An individual field  #45=“english history”
#43=aids OR #42=aids
#42 CONTAINS “french history”
KEYWORDS EXACTLY “coronary artery”

A group of fields  AUTH=Smith
TITLE=“ology AND NOT zoology
DATE>1960 AND DATE<1990
DATE=1960-1990

A particular workform  WORKFORM=“Art Work”
WORKFORM=“Book Whole”, “Book
Chapter”

With exclusions  “orange” AND NOT “william of orange”
NOT psych*

Finding Multiple Search Terms

To Search:  Example:

Full-text of record  Italy AND “common market”
Zeus OR Jupiter
(France OR Italy) AND wine

An individual field  #10=Gumbel, Smith, Brown

A group of fields  AUTH=Smith OR AUTH=McEvoy

A particular workform  DATE>1970 AND FORM=“Data File”

With exclusions  bio* OR botan* AND NOT plant*
Finding Dates

To Search for:                           Example:
A range of years                      DATE>1989 AND DATE<1996
                                        DATE=1990-1999
A specific year                       DATE=1997
                                        DATE=98
A specific date                        DATE=3/25/96
                                        DATE=“June 12, 1998”
A specific date field                  #20=“September 1999”

Notes on Matching Dates

• **Year**  If the search term consists only of the year, ProCite matches any record with a date occurring in that year, regardless of the season, month or day. You can enter a 2- or 4-digit year for a year in the twentieth century. You must enter a 4-digit year for the year 2000 or later.

• **Month (or Season) and Year**  For searching, ProCite equates each season with a month: Spring is the equivalent of March, Summer of June, Fall of September, and Winter of December. For example, the search expression:

```
DATE = "spring 1999"
```

matches March 1999 but not February 1999 or April 1999.

The seasons, their equivalent months, and the date format variations of both form the following four season groups:

<table>
<thead>
<tr>
<th>Spring Group</th>
<th>Summer Group</th>
<th>Fall Group</th>
<th>Winter Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>Winter-Spring</td>
<td>Summer</td>
<td>Fall</td>
<td>Winter</td>
</tr>
<tr>
<td>Spring</td>
<td>Summer-Fall</td>
<td>Fall-Winter</td>
<td>December</td>
</tr>
<tr>
<td>Spring-Summer</td>
<td>June</td>
<td>September</td>
<td></td>
</tr>
<tr>
<td>March</td>
<td>June-July</td>
<td>September-October</td>
<td></td>
</tr>
<tr>
<td>March-April</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

• **Day, Month, and Year**  If you enter day, month, and year, ProCite matches only those records with that same date, regardless of the date format.
Finding Record IDs

To Search for:  

Example:

Specific numbers  

REC#=1000
REC#=25 OR REC#=26
REC#=25, 26, 35, 40

A range of numbers  

REC#>10 AND REC#<300
REC#=20-85

Finding Empty and Not Empty Fields

To Search:  

Example:

An individual field  

#45=EMPTY
#27=NOT EMPTY

A group of fields  

AUTH=EMPTY
DATE=NOT EMPTY

Finding the Last Records Entered

ProCite assigns record IDs consecutively as you insert records, so you can use the Record ID to find the most recent records. This will work only if you haven’t renumbered your database in a different sorted order or manually numbered each record.

To list records in order of entry:

1. Display the All Records tab.

2. From the Sort menu, pick Record ID to display in Record ID order.

3. To see the most recent records at the top of the list, go to the Sort menu and select Descending order. To list the records in the order entered, keep the records in Ascending order.

By default, the record list displays an author, title, and date field from each record. You may also want to display record IDs. Use the Configure Record List command from the View menu and check the appropriate box to Show Record ID. For more information about configuring the record list, see Chapter 5: Viewing Records.

If it is important to know when records were entered, include the date of entry in the Reprint Status field, the Notes field, or an unused field. You can mark the most recent entries and use Global Edit to add the date to multiple records at once. However, ProCite cannot correctly sort dates in the note field or any other field that is not specifically intended for dates.
Overview

Contents

Creating a Group .............................................................. 272
  Saving Search Results .................................................. 272
  Saving Any Set of Records ...................................... 272
Using a Group .................................................................. 273
  Viewing or Printing Records in a Group ...................... 274
  Marking Records from a Group ................................ 274
  Searching a Group .................................................... 275
Deleting a Group .............................................................. 275
Modifying a Group ............................................................ 275
  Adding or Removing Records ............................. 276
  Renaming a Group .................................................. 276

Groups are an effective way of breaking a large database into subsets. They can include the results of a search, but you can also build a set by highlighting individual records and adding them to a Group. You can save any number of Groups in your database.

A Group lets you point to a subset of records. This does not copy the records into a separate database. When you delete a Group, the records still exist in the database. You can include an individual record in any number of Groups or none at all.
Creating a Group

Saving records in a Group allows you to quickly retrieve a particular set of records. Once you create a Group, it is available until you change it again.

Saving Search Results

First, search your database as you normally would. See Chapter 13: Searching and Finding Records for more information about searching. Your search results are displayed in a list on the Search tab.

To save these records as a Group:

1. Click on the record list, and from the Edit menu choose Select All to highlight all records in the list.

2. From the Groups menu, choose Add Record(s) to and then New Group. The New Group dialog appears:

3. Type in a descriptive name for the Group and click OK to save it.

Your Group is not updated as you insert records. You may need to occasionally re-execute the search and replace the Group.

Saving Any Set of Records

You can save any set of records as a Group. You may work with a set of records that aren’t easily found with a search expression.

To save a group of “unrelated” records:

1. Scroll through your record lists. When you find a record you want to add to the Group, highlight it (or highlight any number of records).

2. From the Group menu choose Add Record(s) to and then New Group.

3. Type in a descriptive name for the Group and click OK to save it.
4. Continue browsing through your record lists. As you find records you want to add to the Group, highlight them and from the Group menu choose Add Record(s) to and then the name of the appropriate Group.

You can add records to a group one-by-one or choose Select All from the Edit menu and add an entire list of highlighted records to a Group.

To add Marked records to a Group, display the Marked Records tab, highlight the entire list, and then add the highlighted records to the Group.

You can quickly call up the Group later, for printing or other ProCite operations.

**Using a Group**

Saving records to a group is only helpful if you can later use the group to save you time and effort. You can call up a group to view those records, print them, modify them, or search them.
Viewing or Printing Records in a Group

To view the records in a Group, click on the Groups tab. Select the Group name in the drop-down list at the top of the tab, and ProCite lists all Groups in the current database.

The number at the right of each Group name indicates how many records are in the set. Click on the name of the set you wish to view. The record list displays those records that are saved in the Group:

Each Group points to certain records in the database. The same record could appear in several different Groups.

Once a Group is displayed, you can print it by selecting Print Bibliography from the File menu to print all of the records in the current list.

Marking Records from a Group

Many global ProCite operations work only on marked records.

To restore a set of records in a Group as the marked set:

1. From the Select menu, choose Clear Marked Set.

   **Tip:** If the ProCite toolbars are displayed, you can click on the appropriate icon to Clear Marked Set.

2. Click on the Groups tab to display the list of available groups in the current database.

3. In the drop-down list at the top, select a Group name to list the records in that Group.

4. From the Edit menu choose Select All, and then from the Select menu choose Mark Highlighted Records.
Tip: If the ProCite toolbars are displayed, you can click on the Mark All icon to Mark all records in the current list.

You can perform almost any ProCite operation on these marked records. You can sort the records, globally edit the records, export the records, print the records, etc.

Searching a Group

To limit a search to only the records saved in a particular Group:

1. Click on the Search tab.

2. In the drop-down box labelled Look in, select the Group you wish to search.

3. Enter your search expression in the text box. See Chapter 13: Searching and Finding Records if you need more information about searching.

4. Click the Search button to execute the search. The current search expression looks only at those records in the selected Group, and lists matching records.

Deleting a Group

You can remove an entire Group by deleting it. When you delete a Group, you remove the instructions that group those records—but not the records themselves.

To delete a group:

1. Click on the Groups tab and display the Group you want to delete.

2. From the Groups menu, choose Delete. ProCite will ask for confirmation before permanently removing the Group.

Modifying a Group

The records included in a Group do not change as you add records to the database or modify individual records. However, if you delete a record from a database, it will also be deleted from Groups (since the record can no longer be found by ProCite).
Adding or Removing Records

To add a record to an existing Group:

1. Highlight the record(s) you wish to add to the Group.
2. From the Group menu, choose Add Record(s) to and select the name of the Group.

To remove a record from a Group:

1. Click on the Groups tab and display the Group.
2. Highlight the record(s) you wish to remove from the Group.
3. From the Group menu, select Remove Records.

Renaming a Group

To rename an existing Group:

1. On the Groups tab, display the Group.
2. Select Rename from the Groups menu.
3. Type in a new name for the Group and click OK to save it.
Chapter 15
Internet Capabilities

Overview

Contents

Searching and Importing from the Internet ......................... 278
  Connecting to Host Servers .................................. 278
  Dial-up Internet Connections ............................... 278
  Testing the Servers ........................................ 279
  Allowing Access Through Firewalls ....................... 281
Selecting Z39.50 Sites to Search ................................. 284
Searching Z39.50 Internet Sites or PubMed .................. 286
Saving or Discarding Search Results .............................. 289
Creating and Managing Search Expressions ................... 290
  Creating a Search Expression .............................. 290
  Saving a Search Expression ................................. 291
  Restoring a Search Expression .............................. 293
  Editing a Saved Search Expression ...................... 293
  Deleting a Search Expression ............................... 293
  Renaming a Search Expression ............................... 293
Setting Internet and PubMed Search Options .................. 294
Configuring ProCite to Search Z39.50 Sites .................. 296
  Adding or Modifying Z39.50 Host Configurations 296
  Adding or Modifying Database Configurations .... 298
Importing Web Pages (Windows Only) ................................. 302
Including URLs and UIs in Records .......................... 303
Printing to HTML Files ............................................. 304
Copying References to Email Messages ......................... 305
  Copying via the Clipboard ................................. 305
  Copying from the Preview Pane ............................ 305
  Copying from a Disk File ................................. 306

The first section in this chapter describes how to use the Internet searching feature in ProCite, which directly searches and retrieves records from Z39.50 compliant libraries. PubMed searching is included in the description of Internet searching. You may want to follow the exercise in Chapter 3: Using ProCite: A Guided Tour titled Searching and Importing Records Directly from an Online Database.
ProCite also has the ability to import tagged or delimited records from any record source. See Chapter 9: Importing Records for more information.

ISI ResearchSoft sells Web Poster, a supplemental program which allows you to post ProCite databases on the worldwide web for use by others. ProCite, Reference Manager, and EndNote users can search your ProCite databases and retrieve records for local use. Please contact ISI ResearchSoft for more information.

## Searching and Importing from the Internet

The Internet Search feature allows you to quickly search Z39.50 library collections and view the records in ProCite. You can search multiple online databases simultaneously.

What is Z39.50? The Z39.50 standard is a national standard that defines a protocol for computer-to-computer information retrieval.

## Connecting to Host Servers

Make sure you have Internet access and a valid connection. If your web browser (Netscape Navigator or Internet Explorer) is able to run, it should be okay.

### Dial-up Internet Connections

If you use a modem and phone line to connect to the Internet, as opposed to a direct network connection, please note this connection information.

**Connecting:** Most dial-up connection settings are configured to automatically dial and connect to the Internet when you use an application that requests an online connection (such as ProCite’s Internet Search feature). However, some Internet providers, such as America Online, require that you establish an online connection (sign on) before attempting an Internet Search or PubMed Search with ProCite.

**Disconnecting:** ProCite does not disconnect your Internet connection at any point. You need to shut down your connection when you have finished using ProCite’s Internet or PubMed search features.
Testing the Servers

You can test the response of any Z39.50 server.

To test a server connection:

1. From the Tools menu, select Internet Search.
2. Click Hosts to display the list of servers currently configured.
3. Click Configure Hosts.
4. Highlight the server you want to test.
5. Click **Test Host**. A status dialog similar to this displays:

![Status dialog](image)

If your connection is valid and the server is responding properly, the bottom of the dialog should indicate:

Success: Server responding properly.

**Note:** You can click **Test All** to test all servers in the list. The server list is large, so this could take quite some time!
Allowing Access Through Firewalls

Firewalls are used for security, so they restrict access between computers and the Internet. Some firewalls simply require that you enable the ports used by the Z39.50 servers you intend to access. Other firewalls, known as proxy servers, require additional information.

Enabling Port Numbers

If a firewall is blocking a port to which you need access, you will get a message that begins:

Failed to connect...

Check the port number for the server and consult your Network Administrator. Your Network Administrator needs to allow access to each port you intend to use.

Z39.50 servers typically use port 210, but many firewalls do not have port 210 enabled. If port 210 or other necessary port numbers are not enabled, ProCite cannot connect to your selected search sites.

Tip: The Library of Congress uses port 2210, and the OVID Trial Server uses port 220.

Listing All Current Port Numbers

For a list of all port numbers entered for use by ProCite:

1. From the Tools menu, select Internet Search.
2. Click Hosts.
3. Click Configure Hosts.
4. Click Port Numbers.

To allow searching of all the currently configured hosts, your network administrator must give access to each of these ports.
**Finding the Port Number for a Specific Host**

To determine the port number for a specific host already configured in ProCite:

1. From the **Tools** menu, select **Internet Search**.

2. Click **Hosts**.

3. Click **Configure Hosts**.

4. Highlight the name of the server in the scrollable list and click **Properties**.

5. Write down the **Port Number**. This is the number that must be enabled on the firewall machine.

**Note:** If you are setting up a new server, you need to get the port number from that host’s network administrator.
Configuring Proxy Servers

ProCite supports the SOCKS proxy server protocol, versions 4 and 5.

If your firewall is a proxy server:

1. Contact your network administrator to determine these settings:
   - Does the proxy server use SOCKS version 4 or 5?
   - What is the proxy server address?
   - What is the port number?
   - Will the proxy server perform DNS?
   - What Username and Password should I enter?

2. On the Internet Search tab, click Hosts and then Configure Hosts.

3. Click Proxy Server to display:

   ![Proxy Server Properties](image)

   By default, Not using a Proxy Server is selected.

4. Enter settings as instructed by your network administrator.

5. Click OK and ProCite will use the proxy server to access the Internet.

Please note these incompatibilities:

- **WinGate 3.0**: Using SOCKS version 4, the proxy server does not perform DNS lookup. Using SOCKS version 5, the username and password authentication is not supported.

- **NetProxy 3.0.2**: The username and password authentication is not supported.
Selecting Z39.50 Sites to Search

ProCite is configured for searching many free online databases and library catalogs as well as databases that require payment and/or a password for access. When you attempt to search a restricted database, ProCite prompts for the necessary information.

Note: To gain access to a restricted database, you must contact the information provider directly to set up an account.

Two major databases that allow free access are the Medline database from the National Library of Medicine (PubMed), and the Library of Congress. Most university library catalogs are also unrestricted.

You can search a single Internet site or search any number of different sites simultaneously.

To select the Z39.50 sites you wish to search:

1. From the Tools menu, select Internet Search to display the Internet Search tab.

2. Click the Hosts button to display the Internet Hosts dialog. The All Hosts tab lists all the host databases configured for searching:
3. Scroll through the list and select the check box for each database you want to search.

Many hosts supply a single database, while others may list multiple databases for searching. Click the plus sign (+) to list multiple databases.

**Tip**: Click the column headings to sort the list by host name, location, or type.

4. Click the Marked Hosts tab to view a list of only the databases you marked. These are the databases ProCite accesses when you start an Internet search.

If you plan to search various combinations of databases when you retrieve references, you should display this dialog before each search.

5. Click **OK** to save your changes. The selected hosts are listed to the right of the **Hosts** button.
Searching Z39.50 Internet Sites or PubMed

This section assumes that you already have a connection to the Internet. You may have a direct network connection, your dial-up connection may automatically dial and connect when ProCite requests it, or you may need to establish an online connection before executing the search.

To search and retrieve records from selected online databases:

1. From the Tools menu, select either:
   - **Internet Search** to open a temporary database and display an Internet Search tab. This allows you to search any number of Z39.50 databases.
   - **PubMed Search** to open a temporary database and display a PubMed Search tab. This is specifically for searching PubMed, the National Library of Medicine’s public access database.

2. If you are viewing the Internet Search tab, click the **Hosts** button to select databases to search. See *Selecting the Z39.50 Sites to Search* in the previous section for more information.

3. Enter a search expression on the Internet Search or PubMed Search tab.
For each field you want to search:

a. Use the drop-down field lists to select the fields to search. The most common fields are already set up: Author, Title, and Keywords.

b. Enter the word or phrase you want to find.

Combine multiple search lines with AND, OR, or NOT.

See *Creating an Internet Search Expression* later in this chapter for more information.

4. Click **Search** to start the search.

---

**Note:** If you haven’t already established a connection, your dial-up configuration should automatically dial and connect. If the connection is not successfully established, ProCite alerts you with an error message and stops the search attempt.

ProCite sends the search request to the online database. The status line, between the search strategy and the record list, keeps track of how many records are found and imported. You can stop record retrieval at any time with the **Stop** and **Pause** buttons on the toolbar.

---

**Note:** If your search does not execute correctly, click the icon on the status line for a description of the last search. The dialog lists status messages from the last search and a list of data that was downloaded. These status messages can help you determine a connection problem or troubleshoot after configuring a new host or database.
5. ProCite displays your search results in the record list below the search expression.

Note: Single and double character diacritics found in MARC records are mapped to the Windows ANSI character set or the Macintosh Apple Standard Roman character set before being imported into ProCite.

6. Your search results are in a temporary database that can be saved or discarded when you close ProCite. To save the retrieved records, you must copy them to a new or existing ProCite database as described in the next section.

You can search the Internet, or PubMed, as many times as you wish. You have the option to clear the previous search results each time you start a new search or add records to the existing search results. This is described under Setting Internet Search Options later in this chapter.

You can click **Clear Results** on the toolbar at any time to clear the current record list.

Note: ProCite does not disconnect your Internet connection. You may need to close your dial-up connection when you are done using Internet Search or PubMed Search.
Saving or Discarding Search Results

Listed here are several options for saving or discarding search results.

To save all records listed on the Internet Search tab or PubMed Search tab to a new database:

• Use Save As from the File menu.

• Close the Internet Search or PubMed Search database. When prompted, select Save.

To save a subset of records or to add records to an existing database:

• Use the Copy and Paste commands from the Edit menu to copy highlighted records and paste them into another open database.

• Resize the database window and use drag-and-drop to copy records from the Internet Search tab or PubMed Search tab to another open database.

• Copy Marked Records:

  1. Mark those records you want to save. Display the Marked Records tab to verify the marked set.

  2. From the Database menu, use the Copy Marked Records command (or the Copy Marked button on the toolbar) to copy the marked records to a new or existing ProCite database.

To discard search results:

• Click the Clear Results button on the toolbar before starting a new search.

• Close the Internet Search or PubMed Search database. When prompted to save search results, select No. The search database is discarded.

• You can set an option to clear the previous search results each time you start a new search, as described under Setting Internet Search Options later in this chapter.
Creating and Managing Search Expressions

You can save search expressions to use later. This is particularly helpful for long search expressions and expressions you plan to use frequently.

Creating a Search Expression

On the Internet Search tab and the PubMed Search tab, four search lines are initially set up for Author, Title, Keywords, and All Fields. These are the fields typically searched most often. If you want to search only one or two of those fields, leave the search text box empty for those you don’t want to search.

If you want to search more than four fields, use the New Item button to add additional search lines. You can scroll to see all of the search expression or you can use your mouse to move the divider between the search expression and the record list.

If you always search only one or two fields at a time, you can use the Delete Item button to reduce the number of search lines displayed.

To create an Internet or PubMed search expression:

1. Because each online database may have a different set of fields available for searching, you should first select those databases you wish to search. The list of fields available for searching may change depending on the databases you select.

   See Selecting the Z39.50 Sites to Search earlier in this chapter if you need information about selecting the databases to search.

2. Click New Search to clear a previous expression.

3. You need to complete a search line for each field you want to search in the online database(s). To the right of Search for, the first drop-down list contains the fields available for searching. You can use the field currently displayed or select a different field from the drop-down list.

4. Move the cursor to the text box and type the word or phrase you want to locate.

   Tip: Use the Terms button to select a word or phrase from a Field Content List or Term List.

5. If you are searching on a single field, click the Search button to start the search. If not, go to step 6.
6. Move to the next line and combine the previous search line to this second line with AND, OR, or NOT.

   AND: Both the previous line and this line must match the record.
   OR: Either the previous line or this line must match the record.
   NOT: The previous line must match the record, and this line must not match the record.

7. Select the next search field, and enter your search text.

8. Continue adding search lines to refine your search.

9. Click **Search** to start the Z39.50 Internet search or PubMed search.

**Saving a Search Expression**

To save a search expression:

1. With the search expression onscreen, click **Expressions**.

2. Select **Add to Expressions** from the drop-down list to display the Expressions dialog:
3. Type a descriptive name in the box to identify the search expression and click OK. When you give the search expression a name that is already in use, ProCite asks whether to replace the existing expression.

To determine the folder where your Internet or PubMed search expressions are stored:

1. From the Tools menu, select Options.
2. Click the File Locations tab.

3. Under Search Expressions, either use the browse button (...) to select the appropriate folder or type the full path to the folder.

ProCite saves your Internet search expressions to the file inetexpr and your PubMed search expressions to the file pmedexpr in the folder selected here.
Restoring a Search Expression

To use a previously saved search expression:

1. Click the Expressions button.
2. Select the expression name from the drop-down list, and ProCite adds
   the expression to the search interface, replacing any existing expres-
   sion.

   **Note**: The drop-down list shows up to 10 saved search expressions. If
   you have more than 10 saved expressions, you may need to use the
   Expressions item at the bottom of the list.

3. Click Search to execute the search.

Editing a Saved Search Expression

To edit a saved search expression:

1. Restore the search expression you wish to edit.
2. Make your changes to the expression.
3. Save the expression with the same name.
4. When asked whether to replace the existing expression, click Yes.

Deleting a Search Expression

To delete a saved search expression:

1. On the Internet Search tab, click the Expressions button and select
   Organize Expressions.
2. Highlight the expression you want to delete and click Delete.
3. Click OK to save the change.

Renaming a Search Expression

To rename a saved search expression:

1. On the Internet Search tab, click the Expressions button and select
   Organize Expressions.
2. Highlight the expression you want to rename and click Rename.
3. Type a new name for the expression and click OK.
Setting Internet and PubMed Search Options

The Internet Search options determine which fields are listed for searching, what happens to existing search results when you start a new search, and what happens to search results when you close the Internet Search or PubMed Search window. These settings are saved for the current copy of ProCite.

To set the Internet and PubMed Search options:

1. From the Tools menu, select Options.
2. Click the Internet Search tab:

3. Select what to do with existing search results when starting a new search:
   - **Retain previous search results**: This keeps adding new search results to your existing list of search results.
   - **Prompt to clear previous search results**: This prompts you each time you start a new search. You can decide each time whether to add to the existing results or clear the existing results.
   - **Clear previous search results**: This option always clears the existing search results before starting a new search.
4. Select which action to take when closing the Internet Search window:
   - **Prompt to save search results**: Every time you close the Internet Search window, you are asked whether to save the existing search results.
   - **Discard search results**: No warning is displayed. Each time you close the Internet Search window, your existing search results are discarded.

5. Select these from these downloading options (PubMed only):
   - **Always prompt before downloading records**: After seeing the number of records that match your search expression, you decide how many to download.
   - **Prompt if the number of records is more than XX**: You are prompted about downloading only if the number of matches exceeds the number you enter here.
   - **Do not prompt before downloading records**: ProCite starts downloading all search results.

6. Select the fields to list for searching:
   - **Only those fields common to all marked hosts**: This displays only search fields that are found in every one of the marked hosts.
   - **All fields supported by all marked hosts**: This displays a cumulative list of fields; some may not be valid for certain databases.

7. Click **OK** to save your changes.
Configuring ProCite to Search Z39.50 Sites

Many Z39.50 host servers and databases are already configured for searching (see Selecting the Z39.50 Sites to Search earlier in this chapter). However, you may want to add new sites or make changes to existing configurations.

Adding or Modifying Z39.50 Host Configurations

Before you can begin creating a new host configuration, you need to contact your librarian or information provider to obtain Z39.50 configuration instructions for the host and database you want to add.

To add a new Z39.50 host configuration or modify an existing configuration for searching:

1. On the Internet Search tab, click the Hosts button to display the Internet Hosts dialog.

2. Click Configure Hosts to display the list of Z39.50 servers currently configured:

   ![Configure Hosts dialog]

3. To display a Host Properties dialog:
   - If you are setting up a new Z39.50 host, click New Host.
   - If you are modifying an existing host, highlight the host in the list and click Properties.
4. On the General tab, enter or modify the following. Contact an administrator from the Internet host if you need assistance with this information.

**Host Name**: This name for the Z39.50 server is for display only, so make it descriptive for yourself.

**Domain Name or IP Address**: This is the Internet address for the Z39.50 server, and is mandatory.

**Port Number**: This is the Internet port for the server, and is usually 210. If your Internet access is restricted by a firewall, your network administrator must allow access to this port.

**Library Type**: Select or enter the host’s library type; Academic, Corporate, Government, or enter your own type. It appears in the host list, and you can use it to sort the list by type.

**Location**: Select or enter the host’s location. Choose from the list or enter your own. The location appears in the host list, and you can use it to sort the list.

**URL**: The web address of this host (not required). It is helpful as a reference in case you have questions later.

**Description**: A short description of the host, for this display only.
**User Name and Password:** The host server may require a user name and/or password. Contact an administrator from the Internet host if you need assistance with this information. The user name and password are used only when the check boxes are selected.

If you prefer the security of being prompted for a password before each search, select the check boxes but do not enter your password.

**Note:** The User Name and Password are kept in a registry file so that you can share your host configurations without sharing this personal information.

5. Click **OK** to save changes to the Host Properties.

6. Your next action depends on whether you modified an existing host or added a new host:

   a. If you modified host properties, click **OK** until you return to the Internet Search tab.

   b. If you added a new host, ProCite prompts you to configure at least one database available from the host.

   **Note:** You can add or modify a database configuration as described under the next section, *Adding or Modifying Database Configurations*.

---

**Adding or Modifying Database Configurations**

To add a database configuration, a host configuration must already be defined.

**To add or modify a Z39.50 database configuration for searching:**

1. Display the Database Properties dialog.

   - If you have just added a new host, ProCite automatically displays a Database Properties dialog.

   - If you are adding a new database configuration to an existing host or modifying a database configuration:

     a. On the Internet Search tab, click the **Hosts** button to display the Internet Hosts dialog.

     b. Click **Configure Hosts** to display the list of Z39.50 servers and databases that are currently configured.
c. To add a new database, highlight the host that offers the new database and click **New Database**. To modify a database, click the plus sign (+) next to the host to list databases, highlight the existing database that you wish to modify, and click **Properties**.

![Database Properties dialog box](image)

2. Type the **Database Name**. This must be the name of the database on the Z39.50 server. It is used by the server, and is often a very short version of the full database name.

3. Select the **Record Type** from the drop-down list:

   - USmarc
   - UNImarc
   - UKmarc
   - CANmarc
   - GRS-1
   - SUTRS

   Almost all of the databases currently configured send data as USmarc records. Check with an administrator from the Internet host if you are not sure which record type to select.

4. Select the **Format** from the drop-down list. It is the file format used by the host server. This selects the Biblio-Link configuration file used to map data to ProCite fields.
Note: You can use the Biblio-Link II program found in the ProCite folder to modify these configuration files. Be careful, as changes affect all databases which use the same configuration file.

5. Type a **Description** of the database. This is a more complete form of the database name and appears in the database list.

6. Enter the search attributes for the database:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Field Type</th>
<th>Use</th>
<th>Rel</th>
<th>Pos</th>
<th>Struct</th>
<th>Trunc</th>
<th>Comp</th>
</tr>
</thead>
<tbody>
<tr>
<td>Author</td>
<td>Author (Last First M)</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Title</td>
<td>Generic</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Keywords</td>
<td>Generic</td>
<td>21</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Notes</td>
<td>Generic</td>
<td>63</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ISBN</td>
<td>Generic</td>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ISSN</td>
<td>Generic</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LCCN</td>
<td>Generic</td>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Corporate Name</td>
<td>Generic</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The table defines the various search options available for a particular database. You can obtain this information from the organization (information provider) that maintains the host server; it is often included on the host’s web site. The attributes, as defined by the Z39.50 standard, are:

a. **Field Name**: This is the word or phrase that appears in the field list on the Internet Search tab. You can use ProCite’s generic field names for ease of use.

b. **Field Type**: This defines the format of the text. When you click in this field, a list appears from which you select:

   - **Generic**: The search text is sent to the server exactly as it was entered.
   - **Author (Last First M)**: The search text is read as an author in any of the procite formats and is converted to this author form for searching.
   - **Author (Last FM)**: The search text is read as an author in any of the procite formats and is converted to this author form for searching. Most of the Medline databases require these initials.
   - **Date**: Any date recognized by ProCite is converted into a date format that any server should be able to use for searching.
• **Exclude Stop Words:** Stop words in the search text are removed. Some hosts do not index insignificant words, and would fail if you tried to search for those words.

c. **Use:** The ID number for the index to be searched (such as Keywords).

d. **Relation:** The relation of the search term to the index (such as equal, greater than, or less than)

e. **Position:** The position of the search term in the MARC record field (first, last, anywhere, etc.)

f. **Structure:** The structure of the term, such as a word or phrase

g. **Truncation:** Available truncation options used to interpret the search term (for example: right truncation, wildcards, no truncation)

h. **Completeness:** Indicates whether or not the search term should be the complete subfield in the MARC record corresponding to the field searched

**Note:** The **Use** attributes are mandatory, while other attributes are often left blank to use the server’s defaults.

7. Click **OK** to save your settings. If you added a new database, ProCite asks whether you want to add another database to the current host.

8. To add another database for this host, click **Yes.** If you are finished adding databases for this host, click **No.**


**Importing Web Pages (Windows Only)**

You can create ProCite records from individual web pages displayed with Netscape or Internet Explorer.

**Note:** Import Web Page always creates a new record. You cannot use this command to add a title and URL to an existing record.

To copy the URL and Title from the document currently displayed in Netscape or Internet Explorer and paste them into a ProCite record:

1. Display the web page in Netscape or Internet Explorer.
2. Start ProCite (or switch to ProCite if it is already open) and open or create the database to which you want to add records.
3. From the Tools menu, choose Import Web Page.

A split screen displays the text of the browser document at the top of the screen and the ProCite record on the bottom. This makes it easy to copy information from the browser document into the ProCite record.

The new ProCite record at the bottom of the screen contains the Title and URL from the Netscape display. The Title transfers to ProCite’s Title, Analytic (04) field and the URL to Location/URL (38).
The ProCite Workform is the one last used for insertion in ProCite. If you want to use a different Workform, preferably the Web Page Workform, use the pull-down list at the top of the window.

You can switch between the browser text and the ProCite record (the top and bottom panes in the window) to copy and paste information into the appropriate ProCite fields. Highlight information from the browser text, then click on the appropriate field name in the ProCite record to copy the highlighted information directly into that corresponding ProCite field.

You can manually add text to any of the ProCite fields. You may wish to include a note or relevant keywords. All ProCite editing features are available, including Field Content Lists and Term Lists.

Close and save the ProCite record as you would any new record. Select Close from the File menu or click on the Close box and save changes when prompted.

---

**Including URLs and UIs in Records**

You can add an Internet URL or a PubMed unique identification number (UI) to a ProCite record and later launch the URL or UI. Enter items in your ProCite records as shown in these examples:

<table>
<thead>
<tr>
<th>URL/UI</th>
<th>Enter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internet URL</td>
<td><a href="http://www.risinc.com">http://www.risinc.com</a></td>
</tr>
<tr>
<td></td>
<td>ftp://ftp.risinc.com</td>
</tr>
<tr>
<td>PubMed UI</td>
<td>89025932</td>
</tr>
</tbody>
</table>

To go to the location:

- When the item is entered in field Location/URL (38), you can either highlight the record in a record list or open the record for editing. Then, from the Tools menu, choose Open File/URL.

- If the item is in a field other than 38, open the record for editing, highlight the item, and from the Tools menu choose Open File/URL.

ProCite takes action:

**URL:** ProCite launches your default browser and directs it to the Internet location.

**UI:** ProCite launches your browser and directs it to the citation in the National Library of Medicine's Medline database.
Print a bibliography to an HTML file as you would to any disk file:

1. Display the records you wish to print.

2. From the **File** menu, select **Print Bibliography**. ProCite displays a full page preview of the bibliography.

3. Make sure the bibliography contains the records you want. The choices are in the drop-down list at the top of the preview window.

4. Select the appropriate output style from the **Output Style** drop-down list. You can also click on the **Configure** button to verify or change other settings in the **Configure Bibliography** dialog.

5. Click the **Save** button and a file save dialog appears.
   a. Locate the folder where you wish to place the file.
   b. In the **Save as** text box, type a name for the file.
   c. In the **Save File as Type** box, select **HTML** to save the file with HTML codes for publishing on the Worldwide Web (WWW). URLs found in the formatted records are formatted as hot links.
   d. Click **Save** to create the HTML file.
Copying References to Email Messages

You have three options for copying formatted references to an email message:

• Copying via clipboard commands
• Copying from the preview pane
• Copying from a disk file

Copying via the Clipboard

To copy a record to an email message via the clipboard:

1. In any record list, highlight the record(s) you want to format.
2. From the Edit menu's Copy Special submenu, choose:
   • Copy Formatted Reference to format the highlighted record using the current Configure Bibliography settings (including output style) and copy it to the clipboard.
   • Copy In-Text Citation to format the highlighted record according to the current output style and copy it to the clipboard. The in-text citation format is typically an Author-Date format used when citing records within a manuscript, but it could also be a full footnote format.
3. Switch to your email application and Paste the formatted reference or in-text citation into the body of a message.

Copying from the Preview Pane

To copy a record to an email message from a preview pane:

1. From the View menu, select Preview Pane.
2. Highlight the record you wish to copy. In a preview pane, ProCite formats and displays the highlighted record using the current output style settings (if no output style is currently selected, ProCite asks you to locate one).

Tip: To switch to a different output style for the preview pane, go to the View menu, select Configure Record List and click on the Preview Pane tab.
3. In the preview pane, highlight the text you want to copy to your email message.

4. From the **Edit** menu, select **Copy**.

5. Switch to your email application and **Paste** the formatted reference into the body of a message.

### Copying from a Disk File

**If you want to include many references, or a full bibliography, in an email message:**

1. Print your bibliography to a disk file. Go to the **File** menu and choose **Print Bibliography**. See *Chapter 17: Printing Bibliographies* if you need help.

2. Open the disk file with your word processor.

3. Highlight the formatted bibliography.

4. From the **Edit** menu, select **Copy** to copy the bibliography to the clipboard.

5. Switch to your email application and **Paste** the formatted bibliography into the body of a message.
Chapter 16

Cite While You Write

Overview

Contents

Word Processor Notes ........................................................... 308
Microsoft Word for Windows or Macintosh .......... 309
WordPerfect for Windows ............................................. 311
Linking Citations to ProCite Records ................. 312
Forms of Citations in the Manuscript .................. 312
Inserting Citations .......................................................... 313
Scanning for Existing Citations ............................. 314
Inserting Marked Records from ProCite .......... 318
Including Citations in Footnotes or Endnotes ....... 318
Matching Multiple Records ..................................... 319
Recalling a Previous Search .................................... 320
Unformatted Citations ................................................... 320
Generating a Bibliography .................................................... 321
Basic Procedure ............................................................. 322
Changing the Bibliography Layout ...................... 324
Adding an Independent Reference to the Bibliography 326
Using a Variable Citation Format ........................... 326
Generating a Bibliography from Multiple Documents .. 327
Entering Identifying Text .................................................. 328
Entering Author Names ................................................. 330
Entering Titles .............................................................. 332
Entering Dates .............................................................. 332
Entering Record IDs ...................................................... 333
Entering Multiple Citations ........................................ 334
Entering Additional Text .............................................. 334
Adding Commands to Identifying Text ............... 335
Changing Linked Citations ............................................... 335
Editing Citations ......................................................... 335
Reverting to Original Text ........................................... 336
Moving or Copying Citations ................................. 336
Deleting Citations ....................................................... 337
Adding Citations Later ............................................... 337
Associating ProCite Databases ............................. 337
Using Other Word Processors ................................. 339
Once you have a ProCite database of bibliographic records, you can cite those records within the body of a manuscript and generate a formatted bibliography. This cite while you write™ approach makes it easy to insert citations as you write, rather than painstakingly adding citations later.

The main steps to cite while you write are:

1. In your word processor document, enter identifying text for each citation you wish to insert, and link each citation to a corresponding ProCite record.
   - Insert Citation(s) individually as you write, or
   - Scan Document to automatically insert existing citations.

2. Generate Bibliography, which formats each citation in the body of the manuscript and creates a bibliography at the end of the manuscript.

   Citations in text are typically in an Author-Date format or a numeric format, but ProCite lets you customize the format to include information from any field. Whether you are creating Author-Date or numeric citations, you insert links to ProCite records the same way.

   ProCite’s output styles allow you to print bibliographies in any style, such as APA, MLA, or Index Medicus. Specifying the output style formatting of in-text citations and references in a bibliography is described in Chapter 23: Creating and Modifying Output Styles.

Word Processor Notes

ProCite's installation program installs cite while you write support for Microsoft Word (Windows and Macintosh) and Corel’s WordPerfect (Windows). If you install your word processor after installing ProCite, you must either reinstall ProCite or manually install cite while you write support. For more information, see Chapter 2: Installation.

ProCite commands appear either directly under or in a ProCite 5 submenu of the Tools menu in your word processor. Or, you can use the corresponding ProCite Toolbar for easy access.

The Toolbar:
The Menu:

Under Windows, you may prefer to execute these commands from the keyboard:

- Insert Citation: Alt-1
- Insert Marked Records: Alt-2
- Generate Bibliography: Alt-3

Microsoft Word for Windows or Macintosh

Field Codes

We recommend that you not View Field Codes in Word. If you choose to view field codes, please don’t modify them. Changing field codes could corrupt links to your ProCite database.

For example, the unformatted citation:

The State Research Fund faces drastic cuts from the level of past years. [Olson 1990 #290]

appears with these field codes:

The State Research Fund faces drastic cuts from the level of past years. {QUOTE *[Olson 1990 #290] "ADDIN PROCITE y(1990:1)PG200000000011 | Olson 1990 #290]0:0:0:14:0:0:0:0:0:0:0010 | PROCITE[XSCDatabase]XSCSample. Database: y(1990:1)PG200000000011 "}
Converting Word 6 or 7 documents to Word 97
(Windows Only)

When a Word 6 or Word 7 document is opened in Word 97 and saved, existing *cite while you write* linked citations get corrupted and ProCite does not recognize them. You will not be able to format or unformat citations. This reflects a field code bug in early releases of Word 97. This situation also arises when using Word 97 and upgrading from ProCite 3 to a later version of ProCite. There are three options that allow you to continue using *cite while you write* in your manuscript.

This is the best and most reliable way to convert a *cite while you write* document to Word 97 or to upgrade from ProCite 3 to a later version:

1. Before removing the old version of Word, use it to open the original Word 6 or Word 7 document.
2. From the Tools menu, Revert to Original Text all linked citations. Surround original text with delimiters to allow scanning later.
3. From the File menu, Close and Save the document.
4. Open the document with Word 97.
5. From the Tools menu, Scan Document to re-link all citations.

If you already removed the old version of Word:

1. Open the original document with Word 97.
2. Before saving the document as a Word 97 file, Revert to Original Text all linked citations. Surround original text with delimiters to allow scanning later.
3. From the Tools menu, Scan Document to re-link all citations.

If you already saved the document as a Word 97 file:

From the Tools menu, choose Recover Citations.

This command attempts to scan and re-link each citation. Because it looks at the formatted citation rather than original text, this works only when citations are formatted in an author-date form.


WordPerfect for Windows

Windows Registry

WordPerfect uses files found in ProCite’s CWYW folder. During installation, the Window’s Registry is modified so WordPerfect can locate the appropriate files.

Style Additions

ProCite adds two styles to your WordPerfect style list: Citation and RefList. Do not delete or modify these styles. ProCite uses them when inserting records and when generating a reference list.

Field Codes

Be careful when viewing codes so you do not corrupt your links. If you select a citation to move or delete, you must include the surrounding codes. Modifying field codes could corrupt links to your ProCite database.

For example, the unformatted citation:

{Olson, 1990#290}

expands with field codes added:

Char Style: Citation {Olson<> 1990<>#290} Char Style: Citation

Third Party

Other Word Processors

ProCite 5 supports Microsoft Word (Windows and Macintosh) and WordPerfect (Windows).

If you are not using a different word processor, you can still generate a manuscript bibliography. The procedure for doing this is described at the end of this chapter.
Linking Citations to ProCite Records

There are three ways to link citations to ProCite records.

- Use **Insert Citation** to link each citation as you write.

- Use **Insert Marked Records** to link records marked in a ProCite database.

- Use **Scan Document** to process a “batch” of citations. Use this command if you have a manuscript with citations in delimiters, such as

  [Anderson, 1990]
  
or
  (45)

ProCite scans either highlighted text or your entire document, and automatically executes an Insert Citation on each delimited citation.

Forms of Citations in the Manuscript

In-text citations can appear in several forms:

- **Identifying text** is text you manually enter to find a record from a ProCite database. It is immediately replaced by a linked unformatted citation when you choose **Insert Citation, Insert Marked Records, or Scan Document**.

- An **unformatted citation** appears after you **Insert Citation, Insert Marked Records, or Scan Document** to link records, or **Unformat** a formatted citation. It is generated by ProCite and is linked directly to a ProCite record.

- A **formatted citation** is created when you **Generate Bibliography**. It is generated by ProCite and reflects the final output.

You can link citations in a particular document to records in any number of ProCite databases.
Inserting Citations

Use the Insert Citation feature to link individual citations to ProCite records.

Basic Procedure

To select a citation and insert it into the text of your manuscript,

1. Start your word processor and create or open the document in which you wish to insert citations.

2. Move the cursor to where you want the citation inserted, and from the ProCite 5 commands on the Tools menu, select Insert Citation. ProCite displays an Insert Citation dialog:

4. In the Identifying Text box, type sufficient text for ProCite to locate the record you want to cite.

   For example, to find a work published in 1982 by the author Paul Dickson, you would enter:

   Dickson, 1982

   If you have several ProCite records that were published in 1982 by Dickson, you could narrow the search by including part of the title or the ProCite record ID:

   Dickson, "A connoisseur", 1982, #150

   See the section Entering Identifying Text later in this chapter for more information about how you can enter identifying text.

5. At the bottom of the Insert Citation dialog, indicate the database(s) in which to look for records. Select an individual database or All Open Databases. Click the Browse button to locate and select a database that isn't currently open.
6. Click **Insert** and ProCite compares the identifying text to your ProCite records.
   a. If a single ProCite record matches your identifying text, ProCite replaces the highlighted text with an unformatted citation that is linked to the appropriate ProCite record.
   b. If several records match the identifying text, ProCite lists the matching records in an Insert Citation dialog. See *Matching Multiple Records* later in this chapter if you need help inserting the appropriate citation from this dialog.
   c. If no records match, or if more than 500 records match, you need to modify your identifying text.

   Once a citation is inserted, it is linked to a record in a ProCite database.

7. Continue inserting citations throughout your manuscript. You can insert citations in an existing manuscript or as you write.

8. Having inserted your citations, save your document.

To format your in-text citations according to a bibliographic style and create a reference list, see *Generating the Bibliography* later in this chapter.

**Scanning for Existing Citations**

The **Scan Document** process automatically steps through your document to find identifying text and insert citations. Unless you later enter more identifying text or use **Revert to Original Text**, you only need to use **Scan Document** once per manuscript. Once you have linked records to your manuscript, you can format the citations using **Generate Bibliography** and unformat them as often as you like without losing the links. You can also use **Insert Citation** if you need to add citations later.

ProCite can identify and match text to records only when you enter the identifying text in one of the forms described under *Entering Identifying Text* (described later in this chapter) and surround the text with delimiters. Delimiters can be single characters or multiple characters. Typical delimiters are parentheses, brackets, or curly braces:

{...} (…) [...] <....>

as in:

... the relationship between a market economy and democracy (Lipset, 1992).
You must use the same set of starting and ending delimiters throughout your document, whether they are parentheses, brackets, etc. These examples are all delimited by brackets:

[“Van Allen”]
[Warren 1994]
[Diamond, Linz, and Lipset, 1990]
[“Methods of financing economic development”]
[#23]
[Warren, #23]

Each element in the identifying text for a single citation must be separated by a comma, space, or ampersand (&).

The total amount of text (including spaces) within the delimiters is limited to 1024 characters, regardless of whether you are matching a single or multiple citation. You may need to break up multiple citations and surround each with delimiters.

If you prefer to work with record IDs only, you can use records IDs as identifying text, as in:

... the relationship between a market economy and democracy (43).

However, you cannot combine this record ID form with other forms of identifying text. The "record ID only" form is useful if you have already set up the manuscript for an older version of ProCite or Reference Manager.

**Basic Procedure**

To link existing citations in your manuscript to ProCite records, use the Scan Document feature:

1. Start your word processor and open the document that contains identifying text.

2. Make sure each string of identifying text is surrounded by delimiters. For example, to find a work published in 1982 by the author Paul Dickson, your document may include:

   [Dickson, 1982]
3. From the **Tools** menu, select **Scan Document** to display the Scan Document dialog:

![Scan Document dialog](image)

4. In the dialog:

   a. Indicate whether ProCite should scan for any form of **Identifying Text** or **Record IDs** only.

   **Note**: If your document contains reference IDs inserted from previous versions of Reference Manager, choose Record IDs.

   b. Enter the delimiters that surround the identifying text or record IDs in your document. These may or may not be the same delimiters that are used in formatted output, which are set in the output style.

   c. Select the database(s) you want ProCite to search for matching records.

   d. Choose the format for the unformatted citation: Author, Date, Record ID or Record ID.

   e. Check the **Generate an Updated Bibliography** box if you want to automatically generate or update an existing bibliography at the end of the manuscript.

5. Click **OK** to save the settings and continue.

6. ProCite starts at the beginning of your document and steps through your citations, highlighting them one by one to attempt to Insert Citation.
a. If a single ProCite record matches your identifying text, ProCite replaces the highlighted text with an unformatted citation that is linked to the appropriate ProCite record.

b. If several records match the identifying text, ProCite lists the matching records in an Insert Citation dialog. See Matching Multiple Records later in this chapter if you need help inserting the appropriate citation from this dialog.

c. If no records match, or if more than 500 records match, you need to modify the identifying text.

If you do not want to insert a citation from the Insert Citation dialog, click the Ignore button to ignore and move to the next citation. Ignore All skips over unmatched citations; this is useful when you have extraneous text within the same delimiters. The Stop button stops the matching process.

Once a citation is inserted, it is linked to a record in a ProCite database.

7. If you selected Generate an Updated Bibliography on the Scan Document dialog, the Configure Bibliography dialog appears. Check your settings and click OK. For more information about these settings, see Generating a Bibliography later in this chapter.

8. When done, Save your document.

Matching Inappropriate Items

Scan Document automatically inserts an unformatted citation when identifying text matches a single ProCite record.

To avoid unwanted matches, use different delimiters to surround identifying text than delimiters used for other purposes in your document. For example, if you use parentheses around notes, use brackets around identifying text.

When several ProCite records match a single string of identifying text, ProCite lists the references to choose from, and you have the option to Ignore the citation. If you ignore, ProCite leaves the identifying text unchanged and moves to the next citation.

When a single record matches text that is not meant as an in-text citation, it is replaced with a link to the ProCite database. You do not get the opportunity to ignore the match. In this case, you need to highlight the citation and choose Revert to Original Text from the Tools menu to convert it back to its original form.
Inserting Marked Records from ProCite

You can mark any number of records in a ProCite database and then insert those records at one place in your manuscript.

In the ProCite database, mark the records you want to insert. Then, in your manuscript, choose Insert Marked Records from the Tools menu.

This is helpful in two situations:

- You want to place multiple records in one place in your manuscript. Finding and marking the records in ProCite may be easier than typing identifying text for each record.

- You can’t remember enough unique text for Insert Citation to identify the one record you want. It may be easier to find and mark the record in ProCite.

Marking the records in ProCite gives you access to full searching capabilities and groups.

Including Citations in Footnotes or Endnotes

You can insert citations in footnotes or endnotes. All linked citations are found and formatted when you Generate Bibliography.

You may need to specify suitable in-text citation formats in the output style. Citations usually appear as numbers or as "(Author, Date)". Your footnotes or endnotes may require a full reference. You can indicate a full reference for in-text citations in the output style. Set up a single default list of fields to print for all workforms or a separate list for each workform on the In-Text Citations tab in the output style.

Some bibliographic styles require that subsequent citations of the same reference use shortened forms of the original reference. For example, only the author’s last name and an abbreviated title. Successive citations of the same reference may use Ibid. You can set this up in the output style on the In-Text Citations tab.

You can include specific page numbers in a citation by using the Additional Text feature described later in this chapter under Entering Identifying Text.

If you don’t need the list of references that is added to the end of your document, simply delete it from the finished document. Or, indicate in the output style that you do not want a bibliography generated.
Matching Multiple Records

When you are inserting a citation, several ProCite records may match your identifying text. ProCite lists the matching records in an Insert Citation dialog.

The top of the dialog displays the highlighted record, so you can make sure you insert the correct citation. Use the scroll bar or move the horizontal divider to see more of the highlighted record. You can also resize the window.

You can drag the column dividers to show more or less of each field in the list (record ID, author, title, and date), and you can click on the column headings to change the sort order of the list.

Highlight the reference(s) you want to insert and click **Insert**.
Recalling a Previous Search

You can insert a record from a list of matching records, then later easily display the same list of records again to choose another reference from the list. From the Tools menu, choose Recall Last Search.

Use the drop-down list at the top of the dialog to select from a list of the previous 10 searches and click the search icon. Highlight the record(s) you want to insert and click Insert.

Unformatted Citations

When you Insert Citation, Insert Marked Records, Scan Document or Unformat Citation, ProCite displays an unformatted citation. This includes either a record ID only or the author’s last name, the year, and the record ID enclosed in delimiters. For example,

{ Brown 1992 #128 }

If there is no author in a record, the unformatted reference displays the primary title.

You cannot change the appearance of the unformatted citation, and the unformatted citation does not reflect how the citation will look when you generate the final reference list.
The unformatted citation makes it easy to identify the record cited. It also allows you to easily change the order of the elements in a multiple citation (more than one citation referenced at the same point in the text). Even if your final goal is numeric citations, you can see meaningful information while you are working on your document.

Unformatted citations with multiple authors show the first two author names from the primary author field in a record. If there are more than two authors, the second author is followed by “et al.” So, for multiple authors you may see unformatted citations like:

{ Powers & Jones 1986 #32 }
{ Powers, Jones, et al. 1986 #9 }

An unformatted multiple citation for two references appears like this:

{ Powers 1986 #437 }{ Smith 1987 #212 }

When formatted, the multiple citation may appear as:

[16,26] in a numbered style
(Powers 1986, Smith 1987) in an author-date style

### Generating a Bibliography

Once you have entered identifying text and inserted each citation in your manuscript to link it to a ProCite record, you can generate a bibliography.

Generating a bibliography serves two functions:

- It formats each in-text citation according to a bibliographic style.
- It adds a complete bibliography to the manuscript (unless you override this with a setting in the output style).

The format used to print citations and references is determined by the output style selected.

**Note:** ProCite generates a bibliography only if that option is selected in the output style. The output style can be set up to format only the in-text citations.
Basic Procedure

To generate a bibliography:

1. From the ProCite commands on the Tools menu, select Generate Bibliography to display the Configure Bibliography dialog. Changes made to this dialog are remembered for this document.

2. The Reference List tab displays first. Verify or change the items on the tab.

The **Output Style** determines how each citation in text is formatted and how each reference in the bibliography is printed—which fields will print from each record and in what order.

The **Reference List Order** determines the sort order of references in the bibliography. The **In-Text Citation Order** determines the order of multiple citations inserted at the same point in a manuscript.

The rest of the options on the Reference List tab are updated to reflect settings in the output style. You can override any of those settings here, or you can modify the output style itself.

For more detailed information about the options on the Reference List tab, see the next section, *Changing the Bibliography Layout*, or *Chapter 17: Printing Bibliographies*. 
3. The **Fields** tab under Configure Bibliography gives you the option to print all fields listed in the output style or abbreviate the style and print a limited number of fields. For more information about optional fields, see *Chapter 17: Printing Bibliographies*.

4. Use the **Font** tab to determine the font and size for the bibliography.

5. Click **OK** to Generate the Bibliography.

   The citations in your manuscript are converted to the in-text citation format specified in the current output style. If set in the output style, each reference cited is also formatted and included in a bibliography at the end of the manuscript.

6. View the formatted citations and the bibliography by scrolling through your document or by using your word processor’s **Print Preview**.

These notes may help you create the bibliography you need:

- ProCite inserts a Bookmark at the end of the document to indicate the beginning of the bibliography. You can later add in-text citations after the bibliography, but each time you generate a new bibliography it is replaced at the Bookmark. If you add text after the existing bibliography but you want the new bibliography placed at the end of the document, delete the entire existing bibliography (including the title and line before it) to make sure the Bookmark is deleted. You can **Show Bookmarks** in your word processor to see where the reference list begins, and you can Cut and Paste the Bookmark anywhere in the document to determine where the reference list will begin.

- Each reference in the bibliography is generated from a corresponding linked citation in the text of the document. If you want a reference in your bibliography without citing it in the manuscript, see *Adding an Independent Reference to your Bibliography* later in this chapter.

- If you generated a bibliography only because you wanted to format the citations in the body of your manuscript, you can delete the reference list that was inserted at the end of the document. In the output style, you can request that no bibliography be generated, in which case **Generate Bibliography** will format only your in-text citations.

- The margins for your bibliography, as well as any headers or footers, are taken from the document into which you are inserting. The title, line spacing, and paragraph information is taken from the output style, but can be changed in the *Configure Bibliography* dialog.

- If you subsequently make changes to your manuscript and regenerate the bibliography, ProCite replaces any previously generated bibliography and regenerates the in-text citations.
Changing the Bibliography Layout

You can Generate Bibliography as many times as you want, replacing the existing reference list each time, by choosing Generate Bibliography from the Tools menu. The Configure Bibliography dialog appears first, and is comprised of three tabs: Reference List, Fields, and Font.

The Reference List tab allows you to change the output style used to format the references. When you choose an output style, the other settings on the tab (except for the Reference List Order and In-text Citation Order) are updated to reflect the settings in the output style. You can change items in this dialog to override the output style settings. Use the Reset button to go back to the original settings from the current output style, or choose another output style to switch to the settings for that Style. The Fields tab allows you to suppress fields that would normally print. The Font tab allows you to choose a font and size for the bibliography. In-text citations use the font applied at that location in the manuscript.

These settings are saved with your manuscript. You can keep different settings in the Configure Bibliography dialog for different manuscripts.

This section describes Configure Bibliography options that directly affect your manuscript bibliography. For general information about the Configure Bibliography options, see Chapter 17: Printing Bibliographies.

Output Style

The output style you choose governs the formatting of citations in text and the formatting of references in the bibliography. Try the various output styles supplied with ProCite. If you want to modify an existing output style or create a new output style, see Chapter 23: Creating and Modifying Output Styles.

When you generate a bibliography, ProCite replaces your unformatted citations with formatted citations. The formatted citation may bear little or no resemblance to the original identifying text or the unformatted citation.

Numbered Citations

The output style is where you indicate numbered citations. You can number citations in order of occurrence or based on a sort order of all references.
In a style with numbered citations, a formatted multiple citation appears with the numbers in ascending order, even when they appear in a different order in the unformatted multiple citation.

The output style governs how multiple citations in the manuscript print, including handling ranges of numeric citations. For example, in a numbered style where you cite multiple references, you may want to represent multiple citations as:

...as described by several authors.¹, ², ³, ¹⁵

or

...as described by several authors.¹⁻³, ¹⁵

**Author-Date Citations**

The output style allows you to choose any number and combination of fields to print for each citation. The Author-Date style is common. For example:

(Jiang, 1998)

From the Configure Bibliography dialog that appears when you Generate Bibliography, you can choose an In-text Citation Order to sort citations within a multiple citation independent from the sort order of the reference list. This example uses semicolons as separators and sorts by Author:

...(Fischer et al. 1988; Fontaine et al. 1986; Yagel et al. 1988)

**Reference Format**

The output style defines which fields will print for each reference in the bibliography and with what punctuation. You can specify a unique format for each document type referenced.

The reference list order is indicated on the Reference List tab of the Configure Bibliography dialog when you Generate Bibliography. You will normally choose one of the alphabetic sort orders from the selection list for author-date style citations.

If the current output style specifies numeric citations in the text of your manuscript, you may want to use Manuscript Order to print the references in your bibliography in the order found in your manuscript. In-text citations are numbered sequentially, in the order found. Reference numbers in the bibliography match the numeric citations in text.

If you have numeric in-text citations and sort the reference list alphabetically, the citations are automatically numbered based on the order of the alphabetized reference list.
In addition to sort order, you can verify these items on the Reference List tab:

- Whether to number references, and if so the **Starting Reference Number**
- The **Indentation** used for each reference
- The **Line Spacing** within each reference and between references

If you need more information about the Reference List options, see *Chapter 17 Printing Bibliographies*.

### Adding an Independent Reference to the Bibliography

You may want to include a reference in a bibliography without citing the reference in the text of your manuscript.

One way to do this is to insert the independent reference(s) at the end of the manuscript and apply "hidden text." (You can insert independent references anywhere, but when you put them at the end of the manuscript you can find them later.) When you Generate Bibliography, all linked citations are used to create the bibliography, including those in hidden text.

Or, you can add a `/h` switch to the identifying text for that reference. For example,

```
Rieger, 1999 /h
```

The `/h` tells ProCite to suppress formatting the in-text citation, but use the record in the bibliography. However, this switch is ignored for numeric citations.

### Using a Variable Citation Format

Some bibliographic formats do not adhere to a consistent style. For example, this style of in-text citation varies in the use of parentheses as delimiters:

```
...cultural factors appear even more important than economic ones (Lipset et al. 1993:168-70; Huntington 1991:298-311). Dahl (1970:6), Kennan (1977:41-43), and Lewis (1993) have emphasized that...
```

For citations that require year-only, type the author name as part of your text and, when entering identifying text to link the citation, include a "date" switch to suppress the author name. For example:

```
[Lewis, 1993 /d]
```
When you Generate Bibliography, this citation appears in text as date only (1993). The full reference formats appropriately in the bibliography.

The examples below illustrate another type of variable citation format, where references in text do not require a separate citation unless they are numbered:

...as Dressler mentioned in his 1995 research. And yet other prominent researchers did not join his campaign for early testing. (Johnson, 1997; Smith, 1996)

...as Dressler mentioned in his 1995 research. And yet other prominent researchers did not join his campaign for early testing. ²,³

You can switch between these two styles. Use a "hidden" switch to suppress the Dressler citation completely when using an in-text citation format other than numbering. For example:

[Dressler, 1995 /h]

Generating a Bibliography from Multiple Documents

You can use Word or WordPerfect’s Master Document feature to generate a single bibliography from multiple documents. This allows you to create a cumulative bibliography from any number of book chapters.

1. In each of your documents, or chapters, insert (or scan) the in-text citations to link them to a ProCite database.

2. Close all of your documents.

3. Create a New document.

4. Designate the new document as a master document, then insert and display each of your chapters as subdocuments.

   Note: This procedure is different for each version of Word and WordPerfect, so check your word processor’s documentation for step-by-step instructions.

5. Select Generate Bibliography from the Tools menu.

6. Verify the Configure Bibliography settings and click OK.

ProCite generates the bibliography, using in-text citations from the master document and all displayed subdocuments, and places it at the end of the master document.
Chapter 16: Cite While You Write

Entering Identifying Text

The text you type in order to Insert Citation or Scan Document identifies each unique ProCite record. The identifying text does not affect the text of the final formatted citation that will appear when you generate the bibliography.

If you already entered record IDs within delimiters in your manuscript for a previous version of ProCite or Reference Manager, such as:

... as mentioned in the report by Smith. [24]

you can use the Scan Document command, telling ProCite to look for record IDs only.

In almost any other instance, it is easier to enter a combination of identifying text. The identifying elements you enter for a single citation can include any combination of author names, keywords, title, journal title, date, or record ID. ProCite replaces this text first by the unformatted form of the citation and then, when you generate a bibliography, by the form of citation defined in the current output style.

If you match records by typing a single identifying element, you may find many matching records. You can choose the appropriate reference from a list of matches, or you can limit the search by supplying more identifying text. Separate each element from a single record with one of these separators: a comma, a space, an ampersand “&,” or the word “and.” For example:

Kenney, 1999

Smith & Jones 1997

When you enter identifying text:

- DO NOT enter delimiters, such as parentheses, around identifying text when you use the Insert Citation command. ProCite can supply delimiters for your final output based on the output style.

- DO enter delimiters around identifying text when you use Scan Document to process citations in the manuscript. For example, “[Brown, 1994].” ProCite replaces or strips the delimiters for output based on the output style.

- ProCite assumes that words and phrases in the identifying text may be right truncated. For example, "Smith" would match "Smithsonian."
• When searching for an element of more than one word (such as a phrase or author name), surround that element with quotes.

• When searching for an exact phrase, enclose the text in quotes so ProCite will match it as a single element.

• You can omit diacritics, since all variants are found; “à” will find all variations of the letter, such as “â,” “ä,” and “ã.”

The **Insert Citation** command and the **Scan Document** command attempt to match your identifying text to a ProCite record and replace your identifying text with an unformatted citation.

<table>
<thead>
<tr>
<th>Identifying Text</th>
<th>Examples of Matching ProCite Records</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warren, 1998</td>
<td>A work from 1998 that lists <em>Warren</em> as one of any number of authors.</td>
</tr>
<tr>
<td>Morris &amp; Rycus</td>
<td>A work that lists both <em>Morris</em> and <em>Rycus</em> as authors (including records that contain <em>Morris</em>, <em>Rycus</em> and any number of other authors).</td>
</tr>
<tr>
<td>Smith, &quot;Van Allen&quot;</td>
<td>A record with both <em>Smith</em> and <em>Van Allen</em> as authors.</td>
</tr>
<tr>
<td>Diamond, Linz, and Lipset, 1990</td>
<td>A work published in 1990 that lists all three authors (in any order and in any author fields).</td>
</tr>
<tr>
<td>&quot;Rycus, Peter&quot;, 1987</td>
<td>A work from 1987 that specifically contains <em>Rycus, Peter</em> as an author. Will not find works by <em>Rycus, P</em> or <em>Rycus, Carol</em>.</td>
</tr>
<tr>
<td>&quot;Methods of financing&quot;</td>
<td>The title <em>Methods of financing economic development in underdeveloped countries</em>.</td>
</tr>
<tr>
<td>&quot;Nov. 1990&quot;</td>
<td>All date forms of November 1990, such as 11/1990, 11/90, Nov. 1990, etc.</td>
</tr>
<tr>
<td>#23</td>
<td>Any ProCite record with record ID 23.</td>
</tr>
</tbody>
</table>

Matching Smít will find all records containing an author named Smith and all records with titles that contain words starting with Smith, such as The Smithsonian Institute. You can limit the search by adding a date or by adding more characters (such as Smithson).
Entering more words for an element (such as entering Smit Ins) works like using the AND operator. For example, using Smit Ins will find all records with titles that contain words beginning with Smit AND Ins (in any order), such as The Smithsonian Institute, or The Institute of Smiths, but not just The Smithsonian. It would also find records that contain the authors Smith AND Insull.

If an element is enclosed in quotes, only the last word is treated as being truncated, so "The Smith" will find both The Smithsonian and The Smithsonian Institute.

Since the Author fields are multiple entry fields, the record is a match if any author in any author field matches the identifying text. If you enter the author name "Smith, Robert" as identifying text, it will match an entry such as: Williams, John//Smith, Robert.

**Entering Author Names**

ProCite compares your identifying text to personal author names and corporate author names found in each record.

**Single Authors**

When you type the last name of a single author, ProCite looks for all works that include that author. For example, the identifying text

Diamond

will find works by Diamond only, titles that contain the word “Diamond,” the work by Diamond, Linz, and Lipset, and any other work in which Diamond is listed as an author. You may have to pick the appropriate record from a list of matching records when you Insert Citation.

To narrow the search to a direct match, you might want to add a date or title to the identifying text. For example,

Diamond, 1989

**Multiple Authors**

For two or more authors of a single work, separate each author name with a comma, a space, an “and,” or “&.” For example,

Diamond, Linz, and Lipset

You can enter multiple authors in any order, and you can truncate names if you aren’t sure how to spell them. ProCite ignores “et al.” after an
author’s name, but will match any author names specifically listed. These examples will all find the same record authored by Diamond, Linz and Lipset:

- Diamond, Linz, and Lipset
- Linz, Diamond, and Lipset
- Diamond, Linz, 1990

**Compound Names**

If you have a compound author name in your database, such as De Martino, it could have been entered with a standard space or a nonbreaking space between the two parts of the name.

If you enter De Martino as identifying text, using a normal space and no quotes around the name, ProCite will not find a record authored only by De Martino. The De would match De Martino, but ProCite would look for an additional author named Martino.

You could enter only De. If multiple authors match, such as De Martino, DeMitchell, and Dennis, you will be presented with a list of matching records from which to choose the appropriate match.

To find exact matches only, enter the compound name within quotes, using the same type of space as is used in the database:

- “De Martino”

**Repeated Authors**

To cite works by the same author, Insert Citation for each reference. If you want to insert them all at one point in the manuscript, enter the author’s name as identifying text and then select the citations you want from the list of multiple matches.

If you are typing references to Scan Document later, the correct entry for three works by the same author would be:


Notice that multiple citations are separated by a semicolon. Do not omit the repeated author name, as in:

- [Kuznets, 1955; 1963; 1976]

In this example, ProCite would find all records for 1963 and 1976, rather than just those records authored by Kuznets.
Corporate Authors

When a corporate author name is more than one word, you may want to surround the name with quotes for an exact match. To match this author in your ProCite record:

\[ \text{=ISI ResearchSoft} \]

you could enter one of these or several variations:

“ISI ResearchSoft”

ISI ResearchSoft

Research

Entering Titles

You can enter any combination of words from a title, in any order. ProCite assumes right truncation on every word or phrase. These examples of identifying text:

Thera Pharm

Pharm Basis

“Basis of Thera”

will all match the same title:

The Pharmacological Basis of Therapeutics

Entering Dates

You can enter a date in any form recognized by ProCite (as described in Chapter 7: Entering Data Field-by-Field). If the identifying text element is a valid date, ProCite will match records that have dates that contain that date or titles that contain the text.

If you are entering a date that includes more than simply a year, you must enclose the date in quotes. For example:

“November 2, 1999”

“Jan. 1999”

1999
A date by itself typically is not enough information to limit record
matching. You should enter an author name and date or a title and date:

Goodman, 1993
“A Room with a view,” 1985
Dates after an = in an author field are ignored, as in
Roberts, Frank=, 1880-1962”

**Date Ranges**

You may use a date range such as “1997-1998” or “1997/1998,” and
ProCite will match any valid date in the range.

“1990a” and “1990?” are valid dates; ProCite will search for records
with 1990 dates.

“In press,” “forthcoming,” “unpublished,” ”submitted,” and similar
designations are recognized as valid dates, as in:

Povinelli & Godfrey, “in press”

**Entering Record IDs**

You can use a ProCite record ID as a unique identifier. A record ID is
useful if you are citing a work by an author who has published several
works in the same year. For example, the identifying text:

Ross, 1993
Would match all works by Ross that were published in 1993. If there are
multiple matches, you would have to choose the appropriate record from
a list. You would get a direct match by including the appropriate record
ID:

Ross, 1993, #100

#80

ProCite allows duplicate record IDs, so using only a record ID in the
identifying text will not necessarily find a unique match. You could match
more than one record and still have to choose from a list.

If you already have only record IDs entered within delimiters, as in:

... as described by Warren in his latest publication. [97]

You can use the **Scan Document** command, selecting the **Record IDs
Only** option.
Entering Multiple Citations

You can cite more than one reference in a group. You can insert citations one right after another, select one or more from a list of matching references, or highlight and insert an entire group of citations by using a semicolon as a separator in the identifying text:

Warren, 1994; Milburn, 1990

Citations within a multiple citation will appear and print in the in-text citation order selected on the Reference List tab when you Generate Bibliography.

When inserting a citation that should be part of a multiple citation, make sure you insert the citation immediately after the previous citation. This assures a single set of delimiters:

(Brown, 1996; Wright, 1997; Little, 1997)

Intervening spaces keep citations from formatting as part of the group:

(Brown, 1996) (Wright, 1997) (Little, 1997)

Entering Additional Text

To add additional text to your citation, the text must follow a switch and be enclosed with quotations:

/pt indicates preceding text; surround the text with quotation marks

/ft indicates following text; surround the text with quotation marks

You can include additional text wherever you type identifying text. Additional text is typically a page number or page range. ProCite ignores additional text when matching records, but includes it in formatted output as part of the in-text citation. Some examples:

<table>
<thead>
<tr>
<th>Identifying Text</th>
<th>Formatted Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>Huntington, 1993 /ft &quot;,:25-29&quot;</td>
<td>(Huntington, 1993:25-29)</td>
</tr>
<tr>
<td>Morris &amp; Rycus, 1988 /ft &quot;, p. 20&quot;</td>
<td>(Morris and Rycus, 1988, p. 20)</td>
</tr>
<tr>
<td>Tocqueville, 1976 /pt &quot;See also &quot;</td>
<td>(See also Tocqueville 1976)</td>
</tr>
</tbody>
</table>

You can use both preceding and following text for a single citation.

If you want to add preceding or following text to a citation that is already linked, highlight the citation and use Revert to Original Text to first change back to the original identifying text. Add the additional text after the appropriate switch, and insert the citation again to link it to a ProCite record.
Adding Commands to Identifying Text

You can add these commands to identifying text. You can use multiple commands (for example, both preceding and following text), and you can enter the commands in any order. The commands are not case sensitive.

/pt = preceding text; enclose text in quotation marks
/ft = following text; enclose text in quotation marks
/d = suppress author names
/h = suppress entire citation; ignored for numeric citations; overrides all other switches

For examples of preceding and following text, see the previous section, "Entering Additional Text." For examples showing suppression of author names or suppression of entire citations, see "Using a Variable Citation Format" earlier in this chapter.

If you want to add a command to a citation that is already linked, first highlight the citation and use Revert to Original Text. Add the appropriate command (plus any preceding or following text), then Insert the citation or Scan Document again to link the citation to your ProCite record.

Changing Linked Citations

You can change citations anytime. After making changes, Generate Bibliography again to format the new or modified citations and regenerate the reference list.

Editing Citations

Once you have linked a citation to a ProCite record you should not edit it directly. Changes are lost the next time you Generate Bibliography.

To edit a single citation to enter or change additional text associated with it:

1. Highlight the citation you wish to change, Revert to Original Text, and delete it.
2. Insert Citation and enter the identifying text again, along with the additional text.
To edit several citations to enter or change additional text associated with them,

1. Highlight the citation you wish to change.

2. Use Revert to Original Text to revert to the text that was originally entered. Make sure you Include Delimiters.

3. Make the desired changes.

4. Do steps 1-3 for each citation you want to modify.

5. Use Scan Document to again link the citations.

Reverting to Original Text

The Revert to Original Text command replaces unformatted or formatted citations with the original text entered and removes the links to the ProCite database.

If you originally entered:

(Powers 1986; Smith 1987)

and then used Insert Citation or Scan Document, the unformatted citations would appear as:

{ Powers 1986 #437 }{ Smith 1987 #212 }

If you then Revert to Original Text, the result is:

(Powers 1986)(Smith 1987)

Note: You can set or remove delimiters in the Revert to Original Text dialog. Make sure you use delimiters if you plan to Scan Document later to link citations.

Moving or Copying Citations

You can highlight any text that includes linked citations, then use the Edit menu commands to Cut or Copy and then Paste it elsewhere in the document. You can do this with formatted or unformatted citations.

To move or copy only the citation itself, we recommend that you first unformat it. Make sure you highlight the entire citation (including the surrounding delimiters of the unformatted citation). We recommend that you view field codes to make sure you select the entire citation -- including surrounding codes. You may then Cut or Copy and then Paste it elsewhere in the document.
Deleting Citations

To delete a citation, first click on it and **Revert to Original Text** to return it to the original identifying text. Then, delete the identifying text.

When the citation is part of a multiple citation (a group of more than one citation), highlight the group of citations, use **Unformat Citation** and then delete the citation you want to remove. Insert the remaining citations and generate a new bibliography to reflect changes.

Adding Citations Later

You can use **Insert Citation**, **Insert Marked Records**, or **Scan Document** to add more citations at any time.

You can enter delimited identifying text while writing, such as (Brown, 1999) and later use the **Find Previous Unlinked Citation** and **Find Next Unlinked Citation** commands to locate citations that need to be inserted.

Associating ProCite Databases

When inserting a citation, both the Insert Citation dialog and the Scan Document dialog prompt you to choose the ProCite database(s) in which to search.

You can work with your manuscript without having a ProCite database open, and you can share it with a colleague who does not have ProCite. However, if you attempt to insert a citation or generate a reference list, ProCite tries to open any database(s) associated with your document.

To close a database, in order to limit the open databases for searching, switch to ProCite, display the database you want to close, and choose **Close** from the **File** menu.

Changing the Database Association

If you move a record from one ProCite database to another, links to that record in your manuscript are no longer valid.

For each invalid link, highlight the citation and use **Revert to Original Text** to return to the original identifying text. Do not surround with delimiters. Then, use **Insert Citation** to link the identifying text to a record in the new database. Locate and select the appropriate database in the Insert Citation dialog.
If a database is moved or renamed, ProCite may prompt you to locate the database before executing any *cite while you write* command.

**Working with Linked Records in ProCite**

When you generate a bibliography from your manuscript, the existing marked records in the associated databases are cleared. ProCite marks all of the records linked to your word processor document for inclusion in the bibliography.

You can then switch to ProCite and perform any operation on the marked records (such as editing them, exporting them, generating a Subject Bibliography, or highlighting them and saving them in a group). If you want to keep the original set of Marked records, you should first save it as a group.

If you have read-only access to the ProCite database, *cite while you write* record marking is lost when you close the database.

**Making Changes to the ProCite Database**

When you change the contents of a ProCite record that is linked to a manuscript citation, the manuscript is updated the next time you generate a bibliography. If the change alters the appearance of the unformatted citation, you will see the change when you **Unformat Citations**.

When you delete a ProCite record that is cited in a manuscript, the next time you generate a bibliography from the manuscript or unformat citations ProCite warns that a citation from the document was not found in the database. You will need to remove the citation from your document. You can always enter the record into ProCite again and then insert it in your manuscript.

Other changes to your database, such as renumbering records or Rebuilding the database, have no effect on the link between citations in the manuscript and records in the database. When you renumber your database, the citations in your manuscript will not show the updated record IDs until you Unformat Citations. If you Rebuild your database, you will need to give it the same name as the original database or, when prompted from your manuscript, change the database selection so the link to records is maintained.
Using Other Word Processors

When using word processors that are not integrated with ProCite, you can Copy and Paste in-text citations or formatted references using the clipboard.

Inserting Author-Date Citations

To insert Author-Date style citations in your manuscript:

1. In a ProCite record list, highlight the record you wish to cite.

2. From the Edit menu's Copy Special submenu, choose Copy In-Text Citation to copy the citation to the clipboard. The citation formats according to the output style in effect for the database.

3. Switch to your word processor and move the insertion point where you wish to insert the citation.

4. From the Edit menu, Paste the citation at the insertion point. Manually add additional text such as separators between multiple citations.

5. Repeat steps 2-4 for each citation you wish to include in your manuscript.

Inserting Numbered Citations

Many word processors can automatically number citations, maintain the numbering of the footnote or endnote as you insert more citations, and allow you to position all references at the end of the document. See your word processor documentation for more information.

To insert numbered citations in your manuscript:

1. In ProCite, highlight the record you wish to cite.

2. From the Edit menu, go to the Copy Special item and choose Copy Formatted Reference to copy the reference to the clipboard. The Reference formats according to the output style currently in effect for the database.

3. Switch to your word processor and insert a footnote (or end note).

4. From the Edit menu, Paste the reference into the footnote or end note. The word processor will number the citation.

5. Repeat steps 1-4 for each citation you wish to include in your manuscript.
Generating a Bibliography

To produce a reference list:

1. In ProCite, mark each record you wish to include in your bibliography and then display the Marked Records tab.

2. From the File menu, choose Print Bibliography to display a preview.

3. Click on Configure to verify the output style in use and update any other Configure Bibliography options. Click OK to save changes.

4. Click the Save button to print to a Word Processor File. A file dialog will appear.

5. In the Save File as Type box, select a file format that your word processor can translate.

6. Click Save to print the records to the disk file.

7. Depending on the word processor, you may be able to append the file to your existing manuscript, or you may need to open the file to Copy the bibliography and Paste it at the end of your manuscript.

If you cannot easily add the entire bibliography to the end of your manuscript, you can highlight records in ProCite and, from the Edit menu, Copy Formatted References to the clipboard and Paste them at the end of your manuscript.
Chapter 17

Printing Bibliographies

Overview

Contents

Previewing and Printing a Simple Bibliography ................. 342
  Basic Preview and Print Procedure ................................ 342
  Printing to Catalog Cards ............................................ 344
  Previewing Formatted References .................................. 345
  Printing to the Clipboard .......................................... 346

Setting Up Your Bibliography ........................................ 346
  Reference List Settings ............................................... 347
    Output Style ......................................................... 348
    Reference List Title ............................................... 348
    Reference List Order ............................................... 348
    Numbering References ............................................. 349
    Indentation .................................................................. 350
    Line Spacing ............................................................ 351

Field Suppression or Substitution .................................... 352
  Page Layout .................................................................. 354
    Font and Size Settings ............................................. 354
    Margins .................................................................... 354
    Page Numbers .......................................................... 355

Saving Your Bibliography Settings ................................. 355

Printing a Subject Bibliography ....................................... 356
  Basic Procedure .......................................................... 357
  Subject Bibliography Settings ....................................... 360
    Printing a Subject List or a Subject Bibliography .......... 360
    Including Subject Term Counts or Record IDs ............. 361
    Sorting the Subject Terms ......................................... 362
    Inserting Space or Text Around Subject Terms ............. 363
    Applying Styles ........................................................ 363

Examples of Subject Bibliographies .................................. 364
  Using Author Names as Subject Headings ...................... 364
  Using Keywords as Subject Headings ............................. 365
  Cross Referencing Subject Headings ............................. 365
  Using Call Numbers as Subject Headings ...................... 366
You can print bibliographic citations to your computer screen, a word processor or HTML document, a printer, or the clipboard. You control the page layout and the bibliographic style. You can print a single alphabetical list, or you can print a list that separates references by subject.

ProCite always shows a preview onscreen before printing to paper or a word processor file. This makes it easy to spot problems with your bibliography settings. You may also want to preview individual records as you work with your database.

To cite references in a manuscript and print a bibliography from those citations, see *Chapter 16: Cite While You Write*.

**Previewing and Printing a Simple Bibliography**

The most common bibliography is simply an alphabetized list of formatted references. ProCite displays a preview of your bibliography before printing or saving to disk. You can also preview individual formatted references as you work.

**Basic Preview and Print Procedure**

**To print a simple bibliography:**

1. Use the record list tabs to display the records you wish to print.

2. From the **File** menu, select **Print Bibliography**. ProCite displays a full page preview of the bibliography:
3. Make sure the bibliography contains the records you want. The choices are in the drop-down list at the top of the preview window:

- **All Records in List** prints each of the records in the current record list. The current record list could consist of all records in the database, records you have individually marked, search results, or various other combinations of records. You may find it easiest to always print All Records in List.

- **Marked Records** prints every record that has a selected check box, whether or not they appear in the current record list. You get the same result by displaying Marked Records in the record list and printing All Records in List.

- **Highlighted Records** prints only the highlighted record(s) in the current list.

- **Groups** (pick one of the named groups saved in the database).
4. Select the appropriate output style from the **Output Style** drop-down list. The number of output styles displayed in the list is limited, so you may need to use the browse button (...) next to the list to locate additional output styles.

5. You can click **Configure** to verify or change settings in the **Configure Bibliography** dialog. You can override certain settings in your output style on the **Reference List** tab (all three tabs are discussed in detail under **Setting up your Bibliography** later in this chapter). When you click **OK** to save changes, ProCite updates the bibliography preview with the new settings.

6. Select the destination for your bibliography:
   
a. To print to a printer, click **Print** and a print dialog appears. Verify the settings and click **Print**.

b. To save to a file (text, word processor, or HTML), click **Save** and a file save dialog appears.
   
   • Locate the folder where you wish to place the file.
   
   • In the **Save as** text box, type a name for the file.
   
   • In the **Save File as Type** box, select the type of word processor file you wish to create, or select HTML to save a file formatted with HTML codes for publishing on the World Wide Web (WWW).

   Click **Save** to create the file. Click **Cancel** to stop the operation.

   c. To simply dismiss the preview, click **Close**.

---

**Printing to Catalog Cards**

The ability to print single citations on catalog cards depends upon the capabilities of your printer and your printer driver.

To change the page size, choose **Print Setup** from the **File** menu. The Print Setup dialog is supplied by your printer driver and is unique for each printer. Your driver may or may not include the appropriate settings for catalog cards. You may find it easier to print your bibliography to a word processor file and then print to cards from your word processor.

In any case, you will probably want to make a copy of your output style and modify it to adjust output for your cards. You can insert blank lines and tabs with your output style as needed.

ProCite is not intended as a full-feature library cataloging system. It does not offer the option of printing references in columns, such as the call
number in the left column and the bibliographic information in the right column. If you separate the call number from the rest of the reference with a tab, you may be able to use your word processor to format the reference into a two-column table.

You will need to insert a page break after each reference. Under **Configure Bibliography**, activate the **Reference List** tab and set the **Space** **After** item to **Page Break**. If you want to print terms such as author names or keywords in uppercase at the top of the card, you can use the Subject Bibliography option to print subject terms before each citation (see **Printing Subject Bibliographies** later in this chapter).

### Previewing Formatted References

To format individual records to the screen as you work in your database:

1. From the **View** menu, select **Preview Pane**.

2. Highlight the record you wish to preview formatted. ProCite formats and displays the highlighted record using the current output style settings (if no output style is currently selected, ProCite displays a file dialog for you to locate one).

To switch to a different output style for the preview pane, go to the **View** menu, select **Configure Record List** and click on the **Preview Pane** tab. The preview pane makes it easy to see how individual references format according to different output styles.
When you no longer want to view formatted references, select **Preview Pane** from the **View** menu again to deselect it. A toolbar icon is also available to make this feature easy to turn on and off.

To preview a full bibliography, select **Print Bibliography** from the **File** menu (see the basic procedure for printing at the beginning of this chapter).

### Printing to the Clipboard

Copying a single formatted reference or in-text citation to the clipboard is helpful when you want to paste into another application.

**To copy a record to the clipboard:**

1. In any record list, highlight the record you want to format.
2. From the **Edit** menu's **Copy Special** submenu, choose:
   - **Copy Formatted Reference** to format the highlighted record using the current Configure Bibliography settings (including output style) and copy it to the clipboard.
   - **Copy In-Text Citation** to format the highlighted record according to the current output style and copy it to the clipboard. The in-text citation format is typically an Author-Date format used when citing records within a manuscript.

Switch to your word processor or other application and **Paste** the formatted reference or in-text citation at the cursor location.

### Setting Up Your Bibliography

You have control over a wide variety of bibliography printing options. These options are available from several areas in the program:

- **Output Styles**: When you create an output style, you set reference list settings to match the bibliographic style you want. When you select an output style for printing, ProCite uses the reference list settings from the output style unless you specifically override those settings.

- **Simple Bibliography**: Select **Print Bibliography** from the **File** menu in ProCite and click on the **Configure** button or click the Configure Bibliography icon on the Bibliography toolbar. You can change the current output style selection here or override the reference list settings found in the current output style.
• **Subject Bibliography:** Select **Print Subject Bibliography** from the File menu in ProCite and click on the **Configure** button. The dialog is the same as for a simple bibliography, except that it includes an additional **Subject Bibliography** tab to determine the layout of subject headings.

• **Bibliography from a Manuscript:** Select **Generate Bibliography** from the Tools menu in your word processor to display the Configure Bibliography dialog. The linked citations are formatted, and the bibliography is automatically appended to the manuscript.

See Chapter 16: *Cite While You Write* for more information about creating a bibliography from a manuscript.

See *Saving the Bibliography Settings* later in this section for information about where the Configure Bibliography settings are saved.

**Reference List Settings**

Use the **Reference List** tab under **Configure Bibliography** to verify or change the style of formatted references. Most of the Reference List options are also saved with each output style.
Output Style

ProCite uses output styles to transform database records into formatted citations when you generate a bibliography. Output styles correspond to various standards set by professional journals and societies. The output style determines which fields print for each workform, in what order the fields print, and what punctuation is printed before and after each field. It also allows you to manipulate the printing of author names, titles, dates, and page numbers.

To select an output style for a bibliography, use the Output Style drop-down list. The list is limited in how many styles it can display, so you may need to use the browse button (...) to locate a style. Once you select an output style, ProCite uses that style each time you generate a bibliography—until you select a different output style.

When you select an output style, the other items on the Reference List tab update to reflect settings in the output style. You can override those settings by changing individual items. To return to the original settings in the output style, click Reset.

ProCite comes with many output styles already set up, but you can create your own output style or modify an existing one. To learn about modifying output styles, see Chapter 23: Creating and Modifying Output Styles.

Reference List Title

To print a title at the top of your bibliography, type text in the Reference List Title box. The title is limited to 255 characters.

Reference List Order

Use the Reference List Order list to choose the sort order for your references. The initial sort order is the order indicated in the current output style. You can override that order by choosing a new order from the list. You can switch back to the settings indicated in the current output style by clicking Reset. For a description of the various sort orders, see Chapter 11: Sorting Records.

Use the Ascending/Descending radio buttons to switch between an ascending and descending sort order, with ascending being 1 to 9 and then A to Z and descending being Z to A and then 9 to 1.
Numbering References

Select the check box to number references and then type a starting number in the **Beginning With** text box. When you print your bibliography, each citation numbers sequentially. If the check box is not selected, all numbering options are ignored.

You can enter a prefix and/or a suffix in the appropriate text boxes. For example, to get citation numbers such as:


enter no prefix and a period as the suffix. For citation numbers such as:


enter a left parenthesis as the prefix and a right parenthesis as the suffix.

In the **Alignment** drop-down box, select how to align the reference numbers.

- **Left** will left justify citation numbers and line up the first line of each citation with a tab:


- **Right** will right justify citation numbers and line up the first line of each citation.


• **None**, also referred to as *inline*, will left justify citation numbers and separate citation numbers from the text of the reference with a space.


**Indentation**

Use the Indentation settings to set a paragraph indent, a hanging indent, or no indent at all. You can type the measurements as:

- cm (centimeters)
- " (inches)
- pi (picas)
- li (lines)
- in (inches)
- pt (points)

**Hanging Indent**

To set a hanging indent, such as:


Enter settings such as:

<table>
<thead>
<tr>
<th>First Line</th>
<th>Hanging</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 in</td>
<td>0.5 in</td>
</tr>
</tbody>
</table>

**Paragraph Indent**

To set a paragraph indent, such as:


Enter settings such as:

<table>
<thead>
<tr>
<th>First Line</th>
<th>Hanging</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.5 in</td>
<td>0 in</td>
</tr>
</tbody>
</table>

**Flush with Margin**

To set no indent, such as:


Enter 0 in for both First Line and Hanging.
Line Spacing

To change the line spacing within each reference, click on the arrow next to Line Spacing to select from the list of options:

- **Single** wraps text to the next line.
- **1.5 Lines** leaves one and a half lines between lines of text.
- **Double** leaves a blank line between lines of text.

To change the line spacing *between* references, click on the arrow next to Space After to select from the list of options:

- **None** does not insert space between references.
- **Single** inserts one blank line between references.
- **1.5 Lines** inserts one and a half lines between references.
- **Double** inserts two blank lines between references.
- **Page Break** prints one reference per page. ProCite prints one record and then form feeds to the top of the next page.

Space After is *added* to reference line spacing, so space between citations is never less than that within a citation. For example, with Line Spacing set to Double and Space After set to Single, you get double spacing within citations and triple spacing between citations.
Field Suppression or Substitution

Click on the Fields tab under Configure Bibliography to suppress fields from printing or to enable alternate text substitution.

Optional Fields

The output style determines which fields will print from each record. However, you may occasionally wish to suppress certain fields from printing. For example, you may want to include notes and abstracts when printing drafts for personal use, but when you print the final copy you want the same bibliography without the notes and abstracts.

The Optional Fields feature allows you to suppress any of the listed ProCite fields from printing. To use this feature:

• Every field you want to print must be listed in the output style used for printing. If a field is not listed in the output style, it will never print.

• Even though an optional field is included in the output style, it does not print unless it is checked for inclusion under Optional Fields.
These optional fields are often not required by style standards. To show a specific field, click the appropriate check box:

- **Show Record IDs** to include the database record ID
- **Show Reprint Status** to include *Reprint Status (12)*
- **Show Notes** to include *Notes (42)*
- **Show Abstracts** to include *Abstract (43)*
- **Show Call Numbers** to include *Call Number (44)*
- **Show Keywords** to include *Keywords (45)*

In a reference formatted using one of the supplied output styles, the record ID prints first. Notes, Abstract, Call Number, and Keywords appear at the end of the reference, with each field starting at the beginning of a new line. If you want the fields in a different position, you must modify the output style. For more information about modifying output styles, see *Chapter 23: Creating and Modifying Output Styles*.

**Short Form**

If you want to further limit the fields included in a reference, use the **Short Form** option. You can limit the number of fields that would otherwise be printed according to an output style. You can create a bibliography with as few or as many fields you want.

When you use Short form, ProCite prints abbreviated versions of all workforms, printing only the fields you specify. You cannot create a separate short form for each workform; the same short form field list applies to all workforms.

To limit the fields printed, select the **Use Short Form** box. Click the **Select Fields** button to display a list of the 45 ProCite fields. Select only those fields you wish to print. Keep in mind that a field will print only when it is included for printing in the selected output style.

**Alternate Text**

The **Alternate Text** option allows you to substitute text on output. For example, you could switch between printing “NY” and “New York.”

Select the **Enable Alternate Text Substitution** box to use alternate text from your ALTERNAT.TXT file.

If you want to substitute abbreviations for journal titles, you should instead substitute text by referencing a journal title list in your output style. For information about substituting text on output, see *Chapter 20: Using Alternate Text*. 
Page Layout

Click on the Page Layout tab under Configure Bibliography to change page layout settings. Page layout options include font, size, margins, and page numbering.

Font and Size Settings

To change the print font or size, use the appropriate pull-down lists. The font and size you set here affect output only, and may be different than the font used to display your record list onscreen.

Margins

Page margins represent the space between the paper edge and reference text. To change margins, enter your changes in the appropriate box: Left, Right, Top, Bottom. You can insert margin settings as:

- cm (centimeters)  • in (inches)  • pi (picas)
- " (inches)  • li (lines)  • pt (points)

When you click OK to leave Configure Bibliography, measurements are automatically translated to the default measurement for your computer.
**Page Numbers**

To print page numbers, select the **Number Pages** box. To set the starting page number, enter the number in the **Beginning With** text box.

When you number pages, you have the option of suppressing the first page number. This allows you to number all pages of your output except for the first page.

Use the **Location** pull-down list to select the location for page numbers:

- **Header** prints page numbers in the top margin
- **Footer** prints page numbers in the bottom margin.

Use the **Alignment** pull-down list to print page numbers at the **Left** margin, at the **Right** margin, or **Centered**.

**Saving Your Bibliography Settings**

When you click **OK** to leave the Configure Bibliography dialog, all settings are saved. You can access the Configure Bibliography options for three different types of bibliographies. The type of bibliography will determine where the settings are saved.

**Simple Bibliography**

For a simple bibliography, the Configure Bibliography options are reached by selecting either **Print Bibliography** from the **File** menu in ProCite or by clicking on the Configure Bibliography icon on the Bibliography toolbar.

These bibliography options are saved as a program preference, so they are available from every database you open. If you change the output style while in one database, that output style is in effect for all databases.

**Subject Bibliography**

For a subject bibliography, the Configure Bibliography options are reached by selecting **Print Subject Bibliography** from the **File** menu in ProCite. The dialog includes an additional tab titled **Subject Bibliography**.

These setup options are saved with the database, so you could have different subject bibliography settings for each of your databases.
Bibliography from a Manuscript

In a manuscript, the Configure Bibliography options are reached by selecting **Generate Bibliography** from the **Tools** menu in your word processor. The linked citations will always print, and the bibliography is automatically appended to the manuscript.

The setup options are saved with the document, so you could have different settings for each of your manuscripts.

Printing a Subject Bibliography

A Subject List is a sorted listing of unique terms (words or phrases) that occur in particular fields of the records you choose to print. Each term in the list is a Subject Term.

A Subject Bibliography is a bibliography with sorted references grouped under sorted Subject Terms, which are then called Subject Headings. So a subject bibliography is just a subject list that has formatted references under each of the Subject Headings.

<table>
<thead>
<tr>
<th>Subject List</th>
<th>Subject Bibliography</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIDS</td>
<td>AIDS</td>
</tr>
<tr>
<td>Audio-Visual Material</td>
<td>Art</td>
</tr>
<tr>
<td>Computers</td>
<td>...</td>
</tr>
</tbody>
</table>

Subject Bibliographies have diverse uses including generating lists of journal abstracts; current awareness lists; subject indexes; or lists of holdings by category. Typical subject bibliography headings are by Keyword, Author, Journal Title, or Call Number.

A general bibliography is a continuous listing of citations in a particular order. A subject bibliography is made up of smaller listings, each appearing under a distinct heading. Despite the name, a subject bibliography (or a subject list) can be based on any ProCite field or combination of fields, or on the workform(s) used by the references. You can print entire bibliographic citations, information from one or more fields, record IDs, or nothing at all under each heading.
A list of subject terms can be used to create an index for a bibliography by generating a list of record IDs for each subject heading. ProCite does not produce book indexes with page number references, although you can do this by editing a subject list with a word processor.

Printing a subject list to disk allows you to generate a term list or journal title list. This chapter covers only subject bibliographies. For information about creating or using term lists, journal title lists, or alternate text lists, see Chapter 18: Building List Files, Chapter 19: Printing Lists, and Chapter 20: Using Alternate Text.

**Basic Procedure**

To print a subject bibliography,

1. Display in the current record list the records you wish to print in a subject bibliography.

2. From the File menu, select **Print Subject Bibliography**. ProCite displays a list of the 45 ProCite fields by field number and default field name.

   ![Subject Fields](image)

   Notice that you can create a list by workform as well as by particular ProCite fields.

3. Highlight the field(s) whose contents you wish to use as subject headings. You can include any number of fields. If you build the list of headings from more than one field, the subject headings generated from these fields are combined into a single list.

   If you mix date fields with other fields, dates will sort before alphabetic subject headings.
To quickly select all fields or no fields, use the buttons to the right of the dialog. You can click on individual fields to select or deselect them.

Terms in the Keywords (45) field, which are separated by slashes (/) or carriage returns, always list as separate headings.

Use the check boxes at the bottom to determine whether authors and other fields should print as whole fields or whether subfields should be used as separate subject headings.

ProCite can interpret these characters as separators between multiple entries in a single field:

<table>
<thead>
<tr>
<th>fields</th>
<th>separators</th>
</tr>
</thead>
<tbody>
<tr>
<td>Author fields</td>
<td>// ; carriage return</td>
</tr>
<tr>
<td>All other fields</td>
<td>/ // carriage return</td>
</tr>
</tbody>
</table>

4. Click OK to display the terms found in the fields you selected.

Select those terms you wish to include as subject headings. To quickly select all terms or no terms, use the buttons to the right of the dialog. You may want to select all terms and then click to deselect the few terms you do not want included.

5. Click OK to format the subject bibliography on the screen.

If you want to modify the term selections you just set, to either add or remove terms from the selected field(s), click on the Term button.
Note: Subject headings print as they appear in your records. No special formatting of author names and no journal title substitution is applied.

6. Click on the Configure button to modify the layout and style of your subject bibliography. Verify the settings in the Reference List, Fields, and Page Layout tabs (all three tabs are discussed earlier in this chapter), particularly these items on the Reference List tab:

   • Output Style, which determines the bibliographic style used to format each reference.
   
   • Reference List Title, which prints at the top of the bibliography
   
   • Reference List Order, which determines the order of references under each subject heading

7. Under Configure Bibliography, click the Subject Bibliography tab to set options specifically for subject bibliographies. These settings are described in the next section of this chapter. Click OK to save changes.
8. Once your subject bibliography is set up the way you want it, you can:

- Print to your printer by clicking the **Print** button. A Print dialog will appear. Verify settings and click **Print**.

- Print to a disk file (word processor or HTML) by clicking the **Save** button. A dialog appears for you to name the file. Choose the file type, name and place the file, and click **Save**.

- **Close** the preview when you are done viewing it.

### Subject Bibliography Settings

When you print a subject bibliography from the **File** menu, a **Configure** option is available. The **Subject Bibliography** tab available from Configure Bibliography appears specifically for setting up Subject Bibliographies.

### Printing a Subject List or a Subject Bibliography

In the **Reference List** area of the **Subject Bibliography** tab, select one of the two radio buttons:

- **Subject Terms Only** will print each unique subject term. It will NOT print formatted references below each term. Printing lists such as these is described in more detail in *Chapter 19: Printing Lists*.

- **Subject Terms and Reference List** will print each subject term with related references listed below it.

When printing subject terms with reference lists, ProCite typically prints each unique subject heading only once with the related references listed below. You can select the **Repeating Subject Terms** box to print a subject term before each formatted reference. For example:
Pharmacology

Pharmacology

Renal Failure

Select the Recycling Reference Numbers box to restart reference numbering for each subject heading. For example:

<table>
<thead>
<tr>
<th>Recycling Reference Numbers</th>
<th>Continuous Reference Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Heading Number One</strong></td>
<td></td>
</tr>
<tr>
<td>1. First formatted reference</td>
<td>1. First formatted reference</td>
</tr>
<tr>
<td>2. Second formatted reference</td>
<td>2. Second formatted reference</td>
</tr>
<tr>
<td><strong>Heading Number Two</strong></td>
<td></td>
</tr>
<tr>
<td>1. First formatted reference</td>
<td>3. First formatted reference</td>
</tr>
</tbody>
</table>

Including Subject Term Counts or Record IDs

In the Include area of the Subject Bibliography tab you can check a box to include, for the records selected for output:

- **Subject Term Counts** will print a number next to the subject term to indicate how many records contain the term. For example:

  Computer Software (6)
  Biblio-Link (8)
  Information Management (3)

Subject Term Counts are always output on the same line as the subject term, surrounded by parentheses, and separated from the term by three spaces.
• **List of Record IDs** will print the record IDs of the records that contain the term. You can print the list of record IDs on the same line as the subject term (set apart by three spaces) or on the next line. For example:

  Computer Software 20, 150, 240, 250, 280, 320
  Information Management 30, 70, 180
  
  or

  Computer Software
  20, 150, 240, 250, 280, 320
  Information Management
  30, 70, 180

When you print these items on the same line as the term, they are always separated by three spaces. That way, you can output to a word processor, replace the three spaces by a tab character, and convert the text to a table, using the tab as a separator.

You can print both term counts and record IDs:

Computer Software (6)
  20, 150, 240, 250, 280, 320
Information Management (3)
  30, 70, 180

**Sorting the Subject Terms**

Sorting of Subject Terms is by Date for date fields, by *Library of Congress or Dewey Decimal Number for the Call Number field*, and alphanumeric order for all other fields.

You can print your subject terms in **Ascending** (A to Z) or **Descending** (Z to A) order. Click the appropriate radio button on the **Subject Bibliography** tab. This affects subject headings only. If you want to change the order of the references printed below each heading, do so on the **Reference List** tab of the Configure Bibliography dialog.
Inserting Space or Text Around Subject Terms

Use the **Text Before** and the **Text After** text boxes to print text or punctuation before or after each subject term.

The term may include a subject term count and/or a list of record IDs. The order of output is:

Text Before | Subject Term | Subject Term Count | List of Record IDs | Text After | Reference List

You can use these special formatting codes in the text boxes:

<table>
<thead>
<tr>
<th></th>
<th>Windows</th>
<th>Macintosh</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>New Paragraph</strong></td>
<td>^p</td>
<td>^p</td>
</tr>
<tr>
<td><strong>New Line</strong></td>
<td>^l</td>
<td>^l</td>
</tr>
<tr>
<td><strong>Tab</strong></td>
<td>^t</td>
<td>^t</td>
</tr>
<tr>
<td><strong>Bold</strong></td>
<td>Ctrl+b</td>
<td>Command+b</td>
</tr>
<tr>
<td><strong>Italics</strong></td>
<td>Ctrl+i</td>
<td>Command+i</td>
</tr>
<tr>
<td><strong>Underlining</strong></td>
<td>Ctrl+u</td>
<td>Command+u</td>
</tr>
</tbody>
</table>

By default, the **Text After** box contains “^p^p” to leave a blank line between each subject heading and the first citation listed below it.

When you print Subject Terms Only, you will probably want to output only one “^p” after each term, so each subject term begins on a new line with no blank lines between them.

**Applying Styles**

In the **Styles** area of the **Subject Bibliography** tab, check the appropriate boxes to separately apply styles to Subject Terms, Subject Term Counts, and the Lists of Record IDs. You can combine styles in any way, such as:

**PHARMACOLOGY** *(2)* 180, 240


Apply styles to bibliographic references by modifying the output style.
Examples of Subject Bibliographies

Using Author Names as Subject Headings

This example uses author names as subject headings. The **List each author separately** box was checked on the **Subject Fields** dialog, so that single author names are used for headings rather than entire author fields. Uppercasing was applied to the Subject Terms.

**BLUM, ROBERT**


**BORGMAN, CHRISTINE L.**


**BOWER, JAMES**

Using Keywords as Subject Headings

This example uses keywords as subject headings, and restarts reference numbering after each subject heading. The starting reference number is set in the Configure Bibliography dialog under the Reference List tab.

Business


History


Cross Referencing Subject Headings

You can include records in the database that are used only for cross-referencing. For example, if references under each heading are sorted by title, you can create a custom sort that outputs records with empty title fields first. With these two records:

<table>
<thead>
<tr>
<th>Field</th>
<th>record 1</th>
<th>record 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Developing a plan to prevent pollution</td>
<td>Environ Prot.</td>
</tr>
<tr>
<td>Journal</td>
<td></td>
<td>see also WATER POLLUTION CONTROL</td>
</tr>
<tr>
<td>Keyword</td>
<td>Pollution Control</td>
<td>Pollution Control/ Water Pollution</td>
</tr>
</tbody>
</table>

the resulting subject bibliography could look something like:

POLLUTION CONTROL
see also WATER POLLUTION CONTROL
Developing a plan to prevent pollution. Environ Prot., Dec 93.
...

WATER POLLUTION
see also WATER POLLUTION CONTROL
...
Using Call Numbers as Subject Headings

You can create a two-column output with Call Numbers, such as:

Q123 Whitney, Gretchen. Languages in Bibliographic
W52 Databases. Metuchen, New Jersey: Scarecrow Press,
1990 1990, bound in blue and white.

To create a two-column output:

1. On the Subject Bibliography tab, select Subject Terms and Reference List with Repeating Subject Terms.
2. Insert a tab between each subject heading and reference with the Text After box.
3. In the Subject Fields dialog, select the Call Number (44) field.
4. Save the subject bibliography to a word processor file.
5. With your word processor, convert the output to a two-column table, adjust the column widths, and reformat the paragraph style.
Overview

Contents

Creating Term Lists and Journal Lists ........................................ 368
  Description of the List Formats ........................................... 368
  Term Lists ........................................................................ 368
  Journal Title Lists ......................................................... 369
Opening a List ........................................................................ 370
  Creating a New List ........................................................ 370
  Opening an Existing List .................................................. 370
Entering, Editing, or Deleting Items ........................................ 371
Importing Items from a Text File ........................................... 372
  Creating the Text File ..................................................... 372
  Importing the File .......................................................... 376
Styled Text in a List .............................................................. 377
Creating an Alternate Text List ............................................... 377

ProCite supports three types of external lists that can be shared by multiple databases:

• **Term Lists:** Term lists are lists of standard terms (such as author names or keywords) that can be used in data entry and searching.

• **Journal Title Lists:** Journal title lists contain journal names with corresponding abbreviations and can be used to standardize data entry and searching, and to substitute journal title abbreviations in output.

• **Alternate Text List:** A single alternate text list can be used to substitute text other than journal titles in formatted output.

The **Field Content Lists**, *Authors, Journals, Titles*, and *Keywords*, are automatically generated by ProCite. They are compiled from data in the appropriate fields of each database, so are unique for each database. You cannot manually build or edit a field content list.

You may create and use as many term lists and journal title lists as you like, with each list containing as many terms as you wish. They are stored in individual files that you can edit and share between databases.
When a term list or journal title list is in the ProCite Lists folder it automatically appears in the list of choices along with field content lists in the places where such lists can be used. When using the term list or journal title list for data entry, text in the record is replaced by the selected text exactly as it appears in the term list, including styled text.

You may use only one alternate text list at a time. It can be in your database folder or the ProCite folder.

For information about printing list files, see the next chapter in this manual, Chapter 19: Printing Lists. For information about using lists in data entry and searching, see Chapter 6: Entering and Editing Records and Chapter 13: Searching and Finding Records. For information about using journal title lists or the alternate text list for output substitution, see Chapter 20: Using Alternate Text. For information about printing lists of references, see Chapter 17: Printing Bibliographies.

Creating Term Lists and Journal Lists

Several journal title lists are included with the ProCite program. You can modify these lists and create additional term lists and journal title lists.

Description of the List Formats

Term lists and journal title lists follow a similar format. Journal title lists, however, include an additional column for journal title abbreviations.

Term Lists

Term lists provide consistency in data entry and searching. They allow you to select terms from a list and paste those terms into ProCite records or into a Search Expression.

A term list is comprised of a two-column table, with an alphabetic list of terms in the first column and an optional corresponding note (comment or descriptive text) in the second column. Each column can contain entries that are up to 255 characters in length. If the item you enter is wider than the column width, not all of the item will display in the list. Maximizing the window may display more of the item.

<table>
<thead>
<tr>
<th>Term</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shamanism</td>
<td>Use Indigenous Medicine</td>
</tr>
<tr>
<td>Sheep</td>
<td></td>
</tr>
<tr>
<td>Small Ruminants</td>
<td>Use only if individual type is not specified</td>
</tr>
<tr>
<td>Small-scale Enterprises</td>
<td></td>
</tr>
</tbody>
</table>
Journal Title Lists

Journal title lists are used to help with data entry, constructing search expressions, and printing in various forms. Journal title lists can be linked to an output style to replace full journal titles with abbreviations in formatted output. For information on using journal title lists for output substitution, see Chapter 20: Using Alternate Text.

A journal title list is comprised of a three-column table, with the primary title in the first column, the alternative form of the title in the second column, and an optional corresponding note (comment or descriptive text) in the third column. For example:

<table>
<thead>
<tr>
<th>Journal Title</th>
<th>Journal Abbreviation</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acta Biochimica Polonica</td>
<td>Acta Biochim Pol</td>
<td></td>
</tr>
<tr>
<td>Acta Chemica Scandinavica</td>
<td>Acta Chem Scand</td>
<td></td>
</tr>
</tbody>
</table>

Each column can contain entries that are up to 255 characters in length. If the item you enter is wider than the column width, it may not all appear in the list.

Enter the primary journal title in your records and in search expressions. The entire contents of the journal field in the record must exactly match the primary form in the journal list. Normally the primary form is the full journal title, which is the case with lists supplied with ProCite. You may use an abbreviated form if you prefer:

<table>
<thead>
<tr>
<th>Journal Title</th>
<th>Journal Abbreviation</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>PNAS</td>
<td>Proc Natl Acad Sci U S A</td>
<td></td>
</tr>
</tbody>
</table>

Each output style can use a different journal title list, so you might have different journal title lists for different disciplines. For example, you might have one journal title list for output styles used when submitting papers to biomedical journals, and a different journal title list for output styles used when submitting papers to chemistry journals.

For an output style used for chemistry papers, you can create a list using standard abbreviations of the American Chemical Society (ACS), which include periods:

<table>
<thead>
<tr>
<th>Journal Title</th>
<th>Journal Abbreviation</th>
<th>Note</th>
</tr>
</thead>
</table>
For an output style used for biomedical papers you can create a list using the standard Index Medicus abbreviations, which do not include periods:

<table>
<thead>
<tr>
<th>Journal Title</th>
<th>Journal Abbreviation</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acta Biochimica Polonica</td>
<td>Acta Biochim Pol</td>
<td></td>
</tr>
<tr>
<td>Acta Chemica Scandinavica</td>
<td>Acta Chem Scand</td>
<td>(Index Medicus)</td>
</tr>
</tbody>
</table>

### Opening a List

You can create a new list or you can open an existing list to edit, add, or delete items.

### Creating a New List

**To create a term list or journal title list:**

1. From the ProCite **File** menu, choose **New** to display the New dialog.
2. Highlight **Term List** or **Journal List** and click **OK** to display a file dialog.
3. In the file dialog, type a name for the list file. Click **OK** to display a File Properties dialog.
4. You can enter comments about the list. Click **OK** to create the file and display the new (empty) term list or journal title list.

### Opening an Existing List

**To edit a term list or journal list:**

1. From the ProCite **File** menu, choose **Open** to display a File Open dialog:
2. Open the Lists folder and highlight the list you wish to edit.
   - To list only list files, select **Term List** or **Journal List** in the List Files of Type pull-down list.
3. Click **OK** to open the list for editing.
Entering, Editing, or Deleting Items

1. Create a new list or open an existing list.

2. Add a new item or select an item to edit:

   - To add a new item, click the Add button on the toolbar. This option is also available from the Terms or Journals menu.
   - To edit an existing item, highlight the line and click the Edit button on the toolbar. Or, highlight the line and choose Edit from the Terms or Journals menu.

If you are working on a term list, ProCite displays:

![Edit Term](image)

If you are working on a journal title list, ProCite displays:

![Edit Journal](image)
3. Enter or edit text in the text boxes:
   - Type primary text into the **Term** or **Journal Title** text box. This is the text that is entered into ProCite records and search expressions.
   - In journal title lists only, you may enter a **Journal Abbreviation** that can print in place of the journal title in formatted output.
   - Enter comments in the Note text box if you wish.

4. Click **OK** to add the item to the list.

5. To enter or edit another item, go back to step 2. As you add more items, the list updates to maintain alphabetic order.

6. To permanently delete an item, highlight the item (or items) that you want to delete and click **Delete**.

7. When you are done modifying the list, choose **Close** from the **File** menu. The list is saved and available for use in ProCite.

You can keep Lists open for editing while you are entering or editing ProCite records. As you add new terms to your database, you can copy them to the clipboard and paste them into the appropriate list.

### Importing Items from a Text File

You can add items to a list directly from a text file. You create the text file, open the list file, and then import the text file.

### Creating the Text File

You can easily create a text file to import into a term list or journal title list. Either type each item into a word processor document and save the document as Text Only, or automatically create a text file from existing ProCite records.
With a Word Processor or Editor

Create a text file, typing a single item on each line.

Each line in a term list can contain:

• a single term, or

• a term and a note, with the note separated by a tab or delimited by curly braces

For example:

Neruda, Pable [tab] Reyes, Neftalí Ricardo
Newbolt, Henry
Smithson, John

or:

Neruda, Pable {Reyes, Neftalí Ricardo}
Newbolt, Henry
Smithson, John

Each line in a journal title list can contain either:

• a single journal title

• a journal title and a journal abbreviation separated by tab or delimited by curly braces

• a journal title, journal abbreviation, and note, each separated by a tab or with the journal abbreviation delimited by curly braces

For example:


or:

European Heart Journal {Eur Heart J} London
Occupational Medicine {Occup Med} Philadelphia

When you are done entering items, Save the document as a Text Only file. See the next section, “Importing the File” for step-by-step instructions about importing the text file of items into a term list or journal title list.
With ProCite

ProCite can create a single list of items from selected ProCite fields. If you wish to add Journal Abbreviations or Notes to any of the items, you can add them to the resulting text file with a word processor or with ProCite after importing the text into a term list or journal title list.

To create a text file of terms from existing ProCite records:

1. Open the database from which you wish to create the list.

2. From the File menu, choose Print Subject Bibliography to display a Subject Fields dialog:

3. Highlight the fields of information you want included in your list. If you are creating a journal title list, select only the Journal Title (10) field. Click OK to display the List of Subject Terms dialog.

4. Highlight those items you want included in the list. To include everything, click the Select All button. Click OK to display a preview with the new settings.

5. In the Show drop-down list, select the set of records from which you want to compile the list.

6. Click on the Configure button and then the Subject Bibliography tab to select these settings:
   - Under Reference List, click the Subject Terms Only radio button.
   - Under Include, do not select anything.
   - Under Subject Term Layout, do not enter any Text Before. Enter caret p (^p) as Text After to start each item as a new paragraph.
• Under **Styles**, do not apply any styles to **Subject Terms**.

Click **OK** to update the preview with the new settings.

7. Click on the **Save** button to display a Save As dialog,
   - **Save as Text Only**.
   - Enter a unique name for the file.

   Click **OK** to save the file to disk.

The text file will contain a single column of terms. You can add Journal Abbreviations or Comments from ProCite after importing the list.

See the next section, “Importing the File” for step-by-step instructions about importing the text file of items into a term list or journal title list.
Importing the File

To import multiple items at once:

1. Create a document with each term or journal title on a single line, as described in the previous section. Save the file as Text Only. Note that any styled text will revert to plain text.

2. Start ProCite.

3. Open or create the term list or journal title list to which you wish to add items.

4. From the **Tools** menu, select **Import Text File**. An Open dialog appears.

5. Locate and open the text file of terms you wish to Import.

6. (Windows Only) ProCite prompts:

   Do you wish to translate DOS extended characters to the closest match in the Windows characters set?

   Extended characters include accented characters (diacritics) and other symbols. These characters have different character codes in DOS and Windows.

   • If you are importing a file created by a DOS word processor, respond **Yes**.
   
   • If you are importing a file created by a Windows word processor, respond **No**.

7. ProCite imports each line of text as a single item and automatically maintains sorted order.

**Note:** If a duplicate entry is encountered in the import file, or if the import file contains a duplicate of an entry already in the list, you are given the option of overwriting the existing entry. Only the first column is compared for duplicates.

When you are done modifying the list, choose **Close** from the **File** menu. The list is saved and available for use in ProCite.
Styled Text in a List

In general, styles should be applied by your output style. However, you can apply styles in a list by highlighting text and using the standard keyboard shortcuts:

<table>
<thead>
<tr>
<th>Stylist</th>
<th>Windows</th>
<th>Macintosh</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bold:</strong></td>
<td>Ctrl+B</td>
<td>Command+B</td>
</tr>
<tr>
<td><strong>Italics:</strong></td>
<td>Ctrl+I</td>
<td>Command+I</td>
</tr>
<tr>
<td><strong>Underlining</strong></td>
<td>Ctrl+U</td>
<td>Command+U</td>
</tr>
<tr>
<td><strong>Subscript</strong></td>
<td>Ctrl+=</td>
<td>Command+=</td>
</tr>
<tr>
<td><strong>Superscript</strong></td>
<td>Ctrl+Shift+=</td>
<td>Command+Shift+=</td>
</tr>
</tbody>
</table>

You can see styled text in a list only when you add or edit a term; styled text doesn't appear in the list.

Apply styles in a list only when you want to apply it to one part of a term or only selected terms in the list.

When using a term list or journal title list for data entry, each term is entered into your record exactly as it was entered in the list, including styled text.

In formatted output, output style formatting is applied after the journal title list substitution has taken place. Styles associated with the original (replaced) text in the record is ignored.

Creating an Alternate Text List

The alternate text feature lets you substitute text from an alternate text file in place of text in your records when you format output. It does not affect the appearance of your records in the abbreviated record lists.

If you want to substitute journal title abbreviations, we recommend you use a journal title list. A single alternate text list is allowed for substitution on other fields. See Chapter 20: Using Alternate Text for more information about using the two types of lists for substitution on output.
An alternate text list is a plain text file that can contain up to three components on each line:

- **The primary term** that matches the text found in a record.
  
  See Chapter 20: Using Alternate Text for information about delimiting text in your records for substitution by surrounding it with the « and » characters.

- **The substitution text** that prints in formatted output. The substitution text in your alternate text list must be surrounded by curly braces { }.

- **Notes** may be included after the substitution text, but are ignored by ProCite.

For example, a single entry in an alternate text list could be:

Clemens, Samuel {Twain, Mark} birth and death dates

Since an alternate text list is a plain text file, you can create it using the word processor or editor of your choice.

**To create an alternate text list:**

1. Open a new file with your word processor or editor.

2. Type each entry on a new line. You can include the primary term, the substitution text, and optional comments. Typically only the first two elements are used, as in:

   AL {Alabama}
   AK {Alaska}
   AS {American Samoa}

   Each line can contain thousands of characters, but entries will be more manageable if they are kept below two or three hundred characters.

   Do not apply styles to text (bold, italics, underline, etc.), since all styles are stripped when the file is saved as text.

   You may want to sort the list to make it easy to edit later.

3. Save your file:

   a. Save the file as plain text (Text Only).

   b. Name the file ALTERNAT.TXT.

   c. Place the file in your Database folder or in your ProCite program folder.
Overview

Contents

Printing a Subject List ........................................................... 379
Printing an Indexed Subject List ........................................... 384
Printing a Field Content List ................................................. 386
Printing a Term List or Journal Title List .............................. 387
Printing an Alternate Text List .............................................. 387

You can print subject lists based on any of the ProCite fields. By selecting the appropriate fields from all records, you can print lists that match the automatic field content Lists.

Refer to Chapter 17: Printing Bibliographies for information about printing subject bibliographies, where formatted citations are printed below each subject heading.

Printing a Subject List

A subject list is a sorted list of unique terms (words or phrases) that occur in particular fields of the records you choose. You can base a subject list on any ProCite field or combination of fields.

To print a subject list:

1. Display in the current record list the records from which you wish to create the subject list.
2. From the File menu, choose Print Subject Bibliography. ProCite displays the Subject Fields dialog, which lists the 45 ProCite fields by field number and default field name:

![Subject Fields dialog]

3. Highlight the field(s) whose contents you wish to use as subject headings. You can include any number of fields. If you build the list from more than one field, the terms generated from the fields are combined into a single list.

To quickly select all fields or no fields, use the buttons to the right of the dialog. You can click on individual fields to select or deselected them.

Terms in the 45 Keywords field, which are separated by slashes (/) or new paragraphs, always list as separate headings.

Use the check boxes at the bottom to determine whether authors and other fields should print as whole fields or whether subfields should be used as separate terms. ProCite can interpret these characters as separators between multiple entries in a single field:

<table>
<thead>
<tr>
<th>Fields</th>
<th>Separators</th>
</tr>
</thead>
<tbody>
<tr>
<td>Author fields</td>
<td>// ; new paragraph</td>
</tr>
<tr>
<td>Keywords field</td>
<td>/ new paragraph</td>
</tr>
<tr>
<td>All other fields</td>
<td>/ ; new paragraph</td>
</tr>
</tbody>
</table>
4. Click **OK** to display the terms found in the field(s) you selected.

Select those terms you wish to include as subject headings. To quickly select all terms or no terms, use the buttons to the right of the dialog. You may want to select all terms and then click to deselect the few terms you do not want included.

5. Click **OK** to print a preview of your subject list.

If the preview doesn't display a simple list of terms, you need to modify settings in the Configure Bibliography dialog.
6. Click the **Configure** button to access the Configure Bibliography dialog. The Reference List tab displays first:

7. Enter a **Reference List Title**, which will print at the top of the list. The First Line indent is used for each item in the List.

   When you print a subject list, many of the settings on the Reference List tab are simply ignored. Items in the list automatically sort in alphabetic order, date order, or call number order depending on the fields used as headings. Output style, spacing, and numbering are ignored because you are not printing formatted references.

8. Click on the Page Layout tab if you wish to change the font, size, or page margins.

9. On the **Subject Bibliography** tab:
   - **Reference List** must be set to Subject Terms Only.
   - **Include** may include Subject Term Counts and/or a List of Record IDs if you wish.
   - **Subject Term Layout** can be set to print terms in Ascending or Descending order. Do not include Text Before, and include a caret-p (^p) as Text After so each term prints as a new paragraph on a new line.
• **Apply styles** as you wish. However, when you print to a text file all styles are stripped on output.

10. Click **OK** to save changes to Configure Bibliography and update the preview.

If the preview still doesn't show the list you need, you can click on the **Terms** button to select or deselect terms from the selected field(s) or click **Configure** to make more changes to the Configure Bibliography dialog.

11. Print or dismiss the preview.

• Click **Print** to print to a printer. The Print dialog appears. Verify settings and click **Print**.

• Click **Save** to print to a disk file. A file dialog appears for you to name the file. Choose the file type (text, word processor, HTML), name the file, and click **Save**.

• Click **Close** to dismiss the preview and return to your record list.

Terms are printed as they appear in your records. No special formatting of author names and no journal title substitutions are applied.
Printing an Indexed Subject List

You can print a subject list that is indexed to ProCite record IDs. If the ProCite record IDs match the citation numbers in your bibliography, you can automatically create an index for your printed bibliography.

To create a subject list indexed for your ProCite records and bibliography:

1. Sort your record list in the order you wish to print the records.

2. Renumber your records in the sorted order:
   a. From the Database menu, select Renumber Database.
      
         • Select the sort order you plan to use for printing.
         • Set the Starting Record Number to 1.
         • Set the Increment to 1.

   b. Click OK to renumber your database.

3. Print a simple bibliography:
   a. From the File menu, choose Print Bibliography to display a preview.

   b. Click the Configure button.

   c. On the Reference List tab:
      
         • Under Reference List Order, select the same sort order used to renumber the database.
         • Select the box to Number References, Beginning with 1.

   d. Click OK to update the bibliography preview, which you can then print to your printer or save to a disk file.

Note: The citation number that prints before each reference should match each record’s ProCite record ID.
4. **Close** the bibliography preview and then print an indexed subject list:
   a. From the **File** menu, choose **Print Subject Bibliography**.
   b. At the bottom of the Selected Fields list, select the (45) Keywords field and click **OK**.
   c. On the Subject Terms dialog, **Select All** (or only the specific terms you want to list in the index) and click **OK** to display a preview.
   d. Click the **Configure** button.
   e. On the Subject Bibliography tab:
      - Under Reference List, select **Subject Terms Only**.
      - Under Include, select **List of Record IDs and On Same Line**.
   f. Click **OK** to display the indexed subject list, which you can then print to your printer or save to a disk file.

The numbers that appear after each subject term in the subject list match the citation numbers in the simple bibliography (and the corresponding ProCite record IDs). This example illustrates:

### Reference List


### Index

<table>
<thead>
<tr>
<th>Art</th>
<th>1, 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Biography</td>
<td>1</td>
</tr>
<tr>
<td>Chemistry</td>
<td>2, 3</td>
</tr>
<tr>
<td>Epoxidation</td>
<td>3</td>
</tr>
<tr>
<td>Etching</td>
<td>4</td>
</tr>
<tr>
<td>Nature</td>
<td>1</td>
</tr>
<tr>
<td>Sol-Gel</td>
<td>2</td>
</tr>
</tbody>
</table>
Printing a Field Content List

You cannot directly print a field content list, but you can print almost exactly the same list. Follow the directions earlier in this chapter, under Printing a Subject List, with the settings below in the Subject Fields dialog (step 2-3).

Note: Select all terms in the List of Subject Terms (step 4) to create a complete list. The list may not exactly match the automatic field content list, since field content lists ignore minor punctuation variations.

Authors List

Select the four author fields, so their contents are used as subject headings. From the list of 45 ProCite fields, highlight:

- (01) Author, Analytic
- (07) Author, Monographic
- (16) Author, Subsidiary
- (30) Series Editor

Check the List each author separately box so each individual author name becomes a separate list item.

Titles List

Select the title fields, so their contents are used as subject headings. From the list of 45 ProCite fields, highlight:

- (04) Title, Analytic
- (09) Title, Monographic
- (11) Title
- (32) Series Title

Do not check the check boxes, which could split titles into multiple entries.

Journals List

Select the (10) Journal Title field, so its contents are used as subject headings.

Keywords List

Select the (45) Keywords field, so its contents are used as subject headings.
Printing a Term List or Journal Title List

To print a Term List or Journal Title List:

1. In ProCite, go to the File menu and choose Open to display a file dialog.
2. Locate and open the term list or journal title list to display the list window.
3. From the Tools menu, choose Export List to display a file save dialog.
4. Type a file name and click Save. ProCite exports the contents of the list to the text file.
   - Since ProCite exports to a text-only file, styles are ignored.
   - ProCite inserts tabs between columns. For a term list, each line contains a Term only, or a Term and Note separated by a tab. For a journal title list, each line contains a Journal Title only, or a Journal Title, Journal Abbreviation, and Note separated by tabs.
5. Start your word processor and open the text file.
6. You may want to move the tab stops to line up columns in the list.
7. Print the file from your word processor.

Once you print the list, you may find items that require editing. You can edit the text file with your word processor, and then import the tab-delimited text into a new list file. Keep in mind, however, that styles are removed as items are exported. See Chapter 18: Building List Files for more information about importing items into a list file.

Printing an Alternate Text List

An alternate text list is simply a text file with the disk filename ALTERNAT.TXT. To print the file, open it and print it with your word processor. If you make changes to the list and save it, remember to save the file as Text Only.
Chapter 20
Using Alternate Text

Overview

Contents

Substitution with Journal Title Lists ........................................ 390
  Building a Journal Title List ........................................ 390
  Inserting ProCite Records .......................................... 390
  Using a Journal Title List for Substitution ..................... 391
  Applying Styles ....................................................... 393
Substitution with Alternate Text Lists .................................... 393
  Building the Alternate Text List .................................. 393
  Preparing the ProCite Records .................................... 394
  Activating the Alternate Text List ................................ 394
  Applying Styles ....................................................... 396

The alternate text features of ProCite let you substitute primary text in a record with replacement text from a list when you print a bibliography. The substitution is for output only. It does not affect searching or any other operation.

For example, you can enter “Journal of the American Medical Association” as primary text in the journal title field and substitute that text in a formatted citation with the abbreviation “JAMA.” You can switch between two forms of the same title depending on the bibliographic style you need.

Two types of Lists can be used for alternate text:

- **Journal Title Lists**, which can substitute alternate journal names when printing the *Journal Title (10)* field.

- **Alternate Text Lists**, which can substitute alternate text for any ProCite field, provided you insert special delimiters in your records.
Substitution with Journal Title Lists

You can create any number of journal title lists that contain any number of unique journal titles. Each line in a list can contain a primary journal title along with a single alternate form for the journal title.

To substitute text:

1. Build a journal title list where each line contains a primary journal title and a journal title abbreviation to be used for substitution.

2. Enter journal titles into your ProCite records exactly as the primary journal titles appear in the journal title list. You can enter the titles manually or select them from the journal title list.

3. Link the journal title list to the output style you use for printing.

Building a Journal Title List

You create journal title lists from within ProCite. Add each item by typing it or copying and pasting from ProCite records. Or, build a list in your word processor, save it as text, and then import the text into a journal title list. To build the list in your word processor:

- Each line must contain a single journal entry.
- The primary text (which ProCite will match to text in your ProCite record) must be in the first column, with the substitution text in the second column. For example:

<table>
<thead>
<tr>
<th>Journal Title</th>
<th>Journal Abbreviation</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Journal of the American Medical Association</td>
<td>JAMA</td>
<td></td>
</tr>
</tbody>
</table>

See Chapter 18: Building List Files for more information about creating journal title lists.

Inserting ProCite Records

If you plan to substitute journal titles with an alternate from a journal title list, the journal title in the record must exactly match a primary journal title in the journal title list. The easiest way to do this is to create the journal title list first, and then pick a journal title from the journal title list as you enter a record.
To insert journal titles in your ProCite records from a list:

1. In the ProCite record, place the cursor in the *10 Journal Title* field.
2. Click the arrow next to the field to display the Insert Term dialog.
3. In the upper right drop-down list, select your journal title list.
4. In the lower list box, highlight the journal title you wish to insert, click **Insert Term**, and then click **Close** to dismiss the dialog.

When you do not substitute, the journal title prints as entered into the record. When you do substitute, the journal title prints as entered into the Journal Abbreviation column of the journal title list.

Do not put any special delimiters around the journal title in your records. When attempting to substitute text, ProCite compares the full contents of the field *Journal Title 10* to each item in the first column of the journal title list.

**Using a Journal Title List for Substitution**

Journal title substitution is linked to output styles. Individual output styles determine whether substitution is active and which journal title list to use for substitution.

**To turn journal title substitution on for an output style:**

1. Place the journal title list in ProCite’s Lists folder.

   **Note:** If you place the journal title list in a different folder, you must select **Options** from the **Tools** menu and add that folder to the **File Locations** tab.

2. Create or open an output style.
3. On the Bibliography tab, click on a workform that contains journal titles in field 10.

4. From the **Fields** menu, choose **Journals (10)** to display the dialog:

5. In the bottom list box, titled **Journal List to use for substitution**, select the list you want ProCite to use for substitution on output.

6. Click **OK** to save changes to the dialog.

You can link a single journal title list to each output style. When you change the journal title list linked to a single workform, that list is used for any other workform that uses substitution (in that output style only).

Journal title substitution will not take place for an individual journal if:

- The journal title in the record does not exactly match a journal title in the journal title list.
• The primary journal title in the list does not have an alternate form entered in the Journal Abbreviation column.

If you want to turn off substitution, return to step 2. At step 5, select None from the list box titled Journal List to use for substitution.

**Applying Styles**

When matching a journal title in a record to a primary title in a journal title list, ProCite ignores styles. Even if the text in your record has italics applied, it still matches a plain-text journal title in a journal title list.

In most cases, you should apply styles with your output style rather than in the ProCite record or journal title list. An exception is when you want to apply a style to only part of the title.

You can apply styles to items in a journal title list. When you substitute journal titles, ProCite will use the journal abbreviation exactly as it appears in the list. Styles applied to the original text in the record are ignored.

When the output style is applied, substitution text from the journal title list is treated as if it were text from the record. Styles indicated in the output style will apply to the text.

---

**Substitution with Alternate Text Lists**

**Building the Alternate Text List**

To substitute text with an alternate text list, you must first build the list:

• The disk file must be titled Alternat.txt.

• The file must be a Text-Only file.

• Each line must contain a single item, with the primary text first, followed by the substitution text surrounded by curly braces. For example:

  NM {New Mexico}
  National Education Association {NEA}
  American Medical Association {AMA}

See Chapter 18: Building List Files for more information about creating an alternate text list.
Preparing the ProCite Records

To substitute text in records, you need to prepare records by inserting primary text and marking that text with special formatting characters.

You can place the primary text (the text to be replaced) in any position of any field in a record. Insert the primary text in a record and surround the text with the special formatting characters « and ». These characters tell ProCite to replace the record text with alternate text from an alternate text list when you print a bibliography.

To enter these formatting characters into a record:

1. Move the cursor to the appropriate place in the record.
2. From the Edit menu, select Insert Symbol.
3. Select the appropriate character, « or », and click Insert to insert it at the cursor. Click Close to dismiss the dialog.

For example, this record has primary text (NM) that may be replaced with alternate text on output:

Activating the Alternate Text List

To substitute alternate text:

1. Place your Alternat.txt file in either the folder where your database resides or in the ProCite program folder.

   ProCite will first look for the Alternat.txt file in the Database folder and then in the ProCite program folder. If you want a list linked to a single database, put the list and the database in a separate folder.

2. Display ProCite’s Configure Bibliography dialog. This dialog appears in several situations:
• When you select **Print Bibliography** from the **File** menu in ProCite and then click on the **Configure** button. Changes made to this Configure Bibliography dialog are saved for all databases opened with your copy of ProCite. You can also use the Bibliography toolbar icon to display the dialog.

• When you select **Print Subject Bibliography** from the **File** menu in ProCite and then click on the **Configure** button. Changes made to this Configure Bibliography dialog are saved for this database only.

• When you select **Generate Bibliography** from the **Tools** menu in your word processor (when the *cite while you write* feature is installed). Changes made to this Configure Bibliography dialog are saved for this word processor document only.

3. Click on the Fields tab to display the Alternate Text option:

![Alternate Text Options](image)

4. Select the **Enable Alternate Text Substitution** box.

5. Click **OK** to save the changes.
When alternate text substitution is enabled, ProCite looks for the Alternat.txt file before formatting references.

- When ProCite finds the file, it matches delimited text in your records to primary text in your alternate text list. When a match is made, the alternate text is used for output.

- If ProCite cannot find the file, no substitution takes place. The records print as they appear in your records. The delimiters « and » are ignored and do not print.

**Applying Styles**

Text in your records is matched to primary text in the alternate text list without regard for styles. If the text in the ProCite record contains styled characters, it will still match plain text in the alternate text list.

When the output style is applied, substitution text from the alternate text list is treated as if it were actually text in the record—with the same style as the first character of the text within the special characters « and ».

Styles indicated in the output style also apply to the text. For example, if the text in a record is underlined, the substituted text is also underlined. You cannot apply a style to only part of the substituted text, such as a single superscript character.
Record IDs are used as one form of identification in ProCite. The program assigns a numerical ID to every record as it is created. You can change record IDs, or the interval between record IDs, at any time. Unless you use record IDs to link to a physical file or want to track the order in which records were entered, you may not care about record IDs at all.

Using Record IDs

Record IDs are used to identify specific records. A unique ID is assigned to each record when it is created, but can be changed at any time.

Do not confuse record IDs with citation numbers! A record ID is part of each ProCite record and is permanently assigned unless you change it. Citation numbers are used to consecutively number records on output.

Record IDs are assigned for your convenience in searching for and locating records. You can:

- Retain original record IDs, automatically assigned by ProCite, which would reflect the order in which your records were entered.
- Manually assign record IDs that link to a physical file system, possibly including duplicate record IDs.
Once your records are entered and record IDs are assigned, you can:

- Display each record’s ID in the record list. See Chapter 5: Viewing Records for more information.
- Sort your records in record ID order from the Sort menu.
- Search for record IDs by using the “RECORD ID” field identifier.
- Print record IDs on output by including them for printing in your Output Style and selecting Show Record IDs on the Fields tab of Configure Bibliography.
- Ignore record IDs altogether!

### Assigning Record IDs

As each record is entered, it is assigned a record ID. You can let ProCite automatically number each record, or you can manually assign any alphanumeric ID.

### Automatic Numbering

ProCite automatically assigns a record ID as soon as a new record is added to a database. The program adds a record number interval to the largest record ID in the database when assigning a new number, so ProCite will not initially assign the same ID to two different records.

A new installation of ProCite assigns the record ID 10 to the first record entered into a database, and uses a record number interval of 10 to assign subsequent record IDs in the database. So, the first record ID assigned is 10, the second record ID is 20, the third record ID is 30, etc. The gap between numbers is useful if you want to later manually assign a record ID that falls between two existing numbers.
Changing the Settings for New Databases

You can change the first record ID, and you can change the record number interval to allow any amount of distance between records. Make these changes before creating a new database (although you can always renumber your database later).

To change the default starting record ID and increment for new databases:

1. From the Tools menu, choose Options.
2. Click the Edit Defaults button and select the Record IDs tab to display:

3. Change the Starting Record ID and/or Increment in the appropriate text box and click OK to save the changes in your ProCite preference file. The new settings will be used for all new databases created from your machine.
Changing the Record Number Increment

To change the record number increment in an existing database without renumbering the existing records:

1. Insert a new record or open a record for editing.
2. From the View menu, choose Configure Edit Record to display:

3. Type the new Record Number Increment in the appropriate text box and click OK to save the change. ProCite will add this number to the highest record ID in the database to determine the next record’s ID.

Manual Numbering

You may wish to manually enter record IDs to maintain your own numbering system. You can assign record IDs as you insert records, or you can edit record IDs later.

To manually enter an ID for a single record:

1. Insert a new record or open a record for editing.
2. Highlight the current record ID at the top of the window and type in the new record ID. You can enter any combination of up to 20 numeric and alphabetic characters.
3. Save changes when you close the record.

ProCite assigns subsequent automatic record IDs by adding the increment to the highest record ID in the database. For example, if you type record ID 2 in the first record you insert, and the increment is 10, subsequent records would automatically number: 12, 22, 32, 42, etc.

**Duplicate Record IDs**

Duplicate record IDs are allowed in a single database. Once a record ID is assigned, it does not change unless you specifically make the change.

You may purposely assign duplicate record IDs to multiple records. Or, duplicates may occur when you copy records between databases or merge entire databases.

Because you may use record IDs to link with your personal filing system, ProCite will never change a record ID without your explicit instruction.

**Renumbering Records**

You can renumber an entire database with one simple process. However, if you have assigned your own record IDs in a database, and you want to maintain those numbers, *never* renumber the records as described here. All changes are permanent until changed again; there is no way to revert to previous record IDs.

If record numbering is left to ProCite, record ID order corresponds to the order in which you entered the records. Because ProCite allows duplicate record IDs, and lets you change IDs at will, there may be no logical order to the record IDs in your database.
Renumbering allows you to assign new record IDs in the same relative order (possibly to eliminate record number gaps created by deleted records), or assign new IDs to completely reorder the records.

**To renumber your database:**

1. From the **Database** menu, choose **Renumber Database**.

2. In the drop-down list box, choose the order in which you wish to number the database. You can choose from the available sort orders. Renumber in **Record ID** order if you want to keep the records in the same relative order.

3. Type the **Starting Record Number** in the appropriate text box.

4. Type the **Increment** in the appropriate text box. ProCite will add this number to the highest record ID in the database to determine the next record ID.

5. Click **OK** to start renumbering. ProCite will ask for verification before any changes are made.

6. Click **OK** to continue, and all records in the database are renumbered.

---

**Note:** Record IDs automatically assigned after this point will use the new record number increment.
Chapter 22

Creating and Modifying Workforms

Overview

Contents

When to Create a Workform .................................................. 404
   Special Document Types ................................................. 404
   Relationship to Output Styles ........................................ 404
Implications of Modifying Workforms .................................. 405
   Changing the Workform Definition ............................... 405
   Renaming a Workform ................................................ 406
Creating or Modifying a Workform ....................................... 406
   Opening the Workform ............................................... 406
      Basing a New Workform on an Existing Workform .......... 406
      Opening a New Blank Workform ............................... 407
      Editing an Existing Workform .................................. 408
   Selecting the Fields ................................................... 408
   Assigning Field Names .............................................. 409
   Saving the Workform ................................................. 409
Sharing Workforms ............................................................ 410
Deleting Workforms .......................................................... 411
Selecting the Appropriate ProCite Fields .............................. 411
   Fields and Their Default Names .................................. 412
   Special Fields ......................................................... 412
      Author Fields .................................................... 413
      Date Fields ........................................................ 413
      Call Number Field ............................................... 413
      Keywords Field .................................................... 414
      Location in Work Field .......................................... 414
      Title Fields ........................................................ 414
      Selecting the Field Numbers ................................. 414

Multiple workforms make it easier to manage and print different types of reference information. You can have any number of workforms; they are stored in individual disk files and are available to all databases. If a predefined workform does not exist for the type of work you are citing, you can create a new workform.
If you have several workforms for similar types of materials, it could get confusing. First consider whether a reference will work in an existing workform. See Chapter 8: Choosing a Workform for guidelines in choosing a workform. Often a single reference will not use all of the fields included in a workform. You don’t necessarily want to change the workform, since a later reference may include more information and require the additional fields.

**When to Create a Workform**

If a workform contains many more fields than you need or needs several additional fields, you can modify that workform. When you change the definition of a predefined workform, we recommend that you also change the name of the workform. This will make it clear to other ProCite users that the workform definition is different from the original.

**Special Document Types**

Although ProCite is intended for bibliographic information, you can use it for special types of information. You can create workforms for memos, mailing labels, chemical substances, a butterfly collection, or an anthology of favorite quotations.

**Relationship to Output Styles**

Workforms and output styles are directly related. Output styles specify which of the fields listed in the workform will be printed (rarely do you want to print all of them), in what order, and with what preceding and following punctuation. Because each output style has a default behavior that will be applied to any new workform, you need to consider how your existing output styles will format data entered in a new workform.

Most likely you will need to modify the output styles you use to make specific changes for your custom workforms. For special applications, such as non-bibliographic material, you will need to create an entirely new output style.

Any changes or additions to workforms will affect the **Workform** output style. This style prints records as they appear in ProCite. You must manually edit the **Workform** output style to include new workforms or field names or to remove fields.

See Chapter 23: Creating and Modifying Output Styles for more information about modifying output styles to work with custom workforms.
Implications of Modifying Workforms

You can rename any workform. You can also change the definition of any workform by changing the fields used or renaming the fields used in a workform.

We do not recommend making changes to the predefined ProCite workforms, as changes could affect:

- exchanging data with colleagues
- converting databases from prior versions of ProCite
- importing delimited files from software that exports data in “ProCite format”
- importing files from software that exports data to tagged text files

Changing the Workform Definition

When you change the definition of a workform, it impacts all records that use that workform; this affects other users that use the same workforms from a network drive.

Data in fields that are not part of the new workform definition is not lost, but remains in the original fields (by field number). When you view a full record, such fields (which are not part of the current workform definition) are indicated by the field number and a line of dashes in place of the field name.

To move information from a field that was in the original workform definition to a different field that is part of the new workform definition, you can Cut the field information and Paste it into the new field for each record. Or, you can move field information for several records at once with the Global Move Field command. See Chapter 10: Global Editing for more information about the Global Move Field feature.

Because the name of the workform has not changed, the output style formatting won’t change, although the results may differ as information is now in different fields.
Renaming a Workform

You can rename a workform by opening it and using the Rename command from ProCite’s File menu. Your databases and output styles will automatically display the new workform name. Remember, however, that output style definitions for that workform have not changed.

Before renaming a workform, remember that all of your databases could use that workform. If you share databases and workforms with colleagues, they may be surprised to encounter a workform that looks like Book Long Form and is formatted like Book Long Form, but has a different name.

Creating or Modifying a Workform

Design your workform before you create it with ProCite. The fields you use for particular types of information will affect searching, sorting, and output. When you modify a workform, it affects every ProCite database that uses it. There is no limit on the number of workforms, and they can be shared by different ProCite databases.

You can base a new workform on an existing workform. This simplifies searching and is a good idea if you plan to convert records from an existing workform to a new workform.

Opening the Workform

Basing a New Workform on an Existing Workform

The easiest way to create your own workform is to edit an existing workform and use Save As from the File menu to save the modified workform under a new file name.

To base a new workform on an existing workform:

1. Determine which existing workform is closest to what you want.
2. Go to the File menu in ProCite and choose Open.
3. Locate and open the Forms folder.
4. From the list of workforms displayed, double-click on the workform you wish to modify. This accesses the workform definition window.
5. Go to the **File** menu and choose **Save As** to display a file dialog.

6. Type a new disk file name for the workform, make sure ProCite's Forms folder is selected, and click **Save**. ProCite creates the file. The fields used in the original workform are listed onscreen.

Next, choose the fields to include in the workform. Go to *Selecting the Fields* later in this chapter.

### Opening a New Blank Workform

Start with a blank workform if you are setting one up for a special document type (one that does not resemble any of the existing workforms).

**To create a new workform:**

1. Go to the **File** menu and pick **New**.

2. Choose **Workform** as the type of new file that you wish to create. You are presented with an empty template to which you can add fields.

Next, choose the fields to include in the workform. Go to *Selecting the Fields* on the next page.
Editing an Existing Workform

When you edit a workform, changes apply to all records affiliated with that workform.

To modify an existing workform:

1. Go to the File menu in ProCite and choose Open.
2. Locate and open the Forms folder.
3. In the file type box, select Workform to display only workform files.
4. From the list of workforms displayed, double-click the workform you wish to modify. This accesses the workform definition window.

Next, select the fields to include in the workform.

Selecting the Fields

To select the workform fields:

1. Click the Set Fields button. The 45 ProCite fields appear in a list, in field number order and with default field names.

2. Highlight the fields you want to include in the workform. If you are basing this workform on an existing workform, you may need to select or deselect only a few fields.

3. Click OK to return to the Workform Definition window.

Next, you can assign field names to each field as described in the next section.
Assigning Field Names

Because a ProCite database uses the same fields to hold information for diverse types of materials, the field names that appear in each workform are customizable. Be consistent in how you use fields across workforms, and avoid creating too many different names for the same field in different workforms.

Each field has a constant field number; no matter what the field is named, ProCite can always tell to which field you are referring. ProCite also uses the field number to identify fields with special attributes. For example, if you rename the Author, Analytic (01) field to Title (01), ProCite will continue to treat information entered in that field as an author name.

In the workform definition window, the default field name is shown beside the workform specific field name. To change the field name displayed in your workform, type the new name into the text box alongside the corresponding default field name and number.

Saving the Workform

When you are done making changes to the fields:

1. Give the workform a unique title in the Workform Title text box at the top of the window. This title displays in workform lists when you use ProCite, so it is best to keep it fairly short. You can associate more information with a workform at any time by picking Properties from the File menu.

2. Close the dialog. You can do this in one of two ways:

   - If you are modifying an existing workform, you may want to choose Save As from the File menu so the original workform stays intact. In the file dialog box, enter a new file name for the workform and make sure ProCite’s Forms folder is selected. Click OK to save the workform to disk.
From the **File** menu, choose **Close**. ProCite asks whether you wish to save changes. Click **Yes** to save changes.

If you were editing an existing workform, the window closes and the changes are saved.

The first time you save a new workform you must provide it with a unique file name. In the file dialog box, enter a file name for the workform, and select ProCite’s Forms folder. Click **Save** to save the new workform to disk.

The workform is available to any ProCite database accessed from your computer when you edit a record or build a search expression.

---

**Note:** If you use Biblio-Link II, you may need to modify your field mappings in order to correctly transfer information.

---

If you have records in your database that you want to switch to the new workform, mark the records you wish to change and use Global Change Workform. See *Chapter 10: Global Editing* for more information about the Global Change Workform operation.

### Sharing Workforms

Workforms are stored in separate files. This allows multiple databases to share the same workforms.

If you want to send a workform to someone else for use with a different copy of ProCite, you can do one of two things:

- Copy and send the appropriate workform file for that user to include in his or her ProCite Forms directory. To share a ProCite for the Macintosh workform with a ProCite for Windows user, add the extension .PWF to the disk file.

- You can include the workform definition when exporting data from a ProCite database. Exporting records with workform definitions creates a delimited, plain-text file (all special styles and fonts are ignored). When the recipient imports that delimited file into a ProCite database, workform files are created in the Forms folder.

A workform file is opened only when you edit the workform itself. If the workform is on a network drive, you will not be able to edit it if it is being edited by someone else.
Deleting Workforms

You can delete certain workforms to prevent them from being used for data entry. First, make sure you don’t have any records in any database assigned to the workform that you plan to delete. If you delete a workform that was in use, those records will remain in your database. However, the next time you open the database, the records will not be affiliated with any workform and will not contain field names.

To permanently delete a workform, use the Delete command from the ProCite File menu. If you prefer, you can delete the file from the desktop by dragging it to the recycle bin (Windows) or the trash (Macintosh). Look in ProCite’s Forms folder for the file.

You can later reinstall a predefined workform from the ProCite CD-ROM. See Chapter 2: Installation for guidance.

Selecting the Appropriate ProCite Fields

ProCite has 45 fields available. Individual workforms use only a subset of the available fields, with each workform typically containing between 15 and 20 fields. This subset is a compromise between having enough fields to hold all of the information that could be applicable to a particular type of work, and not having so many fields that it interferes with data entry.

You will almost certainly want one or more author fields. Your workform should include either, or both, fields 01 and 07 (the primary author fields). The workform is likely to need one (or both) of the primary title fields, 04 and 09. The primary date should always be in field 20.

The name used for a particular field can vary between workforms and should be the most appropriate for each type of work.

In most cases, the intended use for a ProCite field is obvious from the field name (such as Edition, or Abstract). Or, you can figure out a field’s use by looking at the fields next to it in the workform. For example, Connective Phrase (06) qualifies Author Monographic (07) and Title (09) information, whereas Connective Phrase (36) qualifies Availability (37).

Some fields occur in pairs because one field is used to hold information that qualifies the information in another field. For example, in the Dissertation workform, the field Extent of Work (26) holds a numeric value whose units are described in the Packaging Method (27) field.
Fields and Their Default Names

You can include up to 45 fields in a single workform. Try to choose your fields so that related elements of a reference can be grouped together to simplify data entry.

The default field name indicates the type of information intended to be stored in a particular field, and each field name has an associated field number. Fields always appear on the screen in field number order 01 through 45. For more efficient data entry, keep related fields together using consecutive field numbers whenever possible. The field number and default field name is used for searching, sorting, etc.

Using the same fields for different types of materials makes it easier to manage a database containing a variety of types of materials. Consistent field usage between workforms is important for fields used in searching or sorting. For example, when searching for works by a particular author, you most likely will want to find all works by that author—whether books, journal articles, or video recordings.

The supplied workforms Map, Motion Picture, Computer Program, and Data File use the analytic title field and the monographic author field. This layout will affect the sort order of records when you use the Author-Title special field sorting—records in these workforms will sort by analytic title because the analytic author field is missing. Some styles require the title to precede the medium designator and the author for these works.

Special Fields

Some ProCite fields have special properties no matter how you use them or what you name them. ProCite compiles field content lists from certain fields. Output styles can manipulate output from certain fields. These fields have special properties, as described in this section: author fields, date fields (including reprint status), the call number field, the keyword field, the location in work field, and title fields.
Author Fields

Every workform should contain either field 01 or field 07, as these are used to compile many of the predefined sort orders.

All four author fields have special properties. You can insert multiple author names in a single author field, and ProCite can manipulate the names for output. The fields are:

- (01) Author, Analytic
- (07) Author, Monographic
- (16) Author, Subsidiary
- (30) Series Editor

You can include any combination of the four author fields in your workform. Author names from the four author fields are compiled to create the Authors field content list, which is used for data entry and searching.

We recommend that you use the four author fields for author names only (personal authors and/or corporate authors). If you enter text other than an author name, you could get strange results on output.

Date Fields

ProCite converts text in the Date fields to a consistent internal date format that is seen and used only by the program. This allows correct date sorting and allows you to print dates in different forms. This special conversion applies to these three date fields:

- (12) Date of Meeting (or Reprint Status)
- (20) Date of Publication
- (21) Date of Copyright

If your workform requires one date field, use field 20. If it requires two date fields, use fields 20 and 21. The default sort orders compare field 20 or 21 from each record—the first which contains data.

When you name field 12 "Reprint Status," ProCite displays a pull-down list in each record that you can use to choose In File, Not in File, or On Request. When you choose On Request, ProCite can fill in the current date.

Call Number Field

The Call Number (44) field allows special sorting for Library of Congress or Dewey Decimal Call Numbers. You can also use this field to sort whole numbers.
Keywords Field

While any field can be used to generate a “subject bibliography,” the Keywords (45) field is used most often. You should include this field in every workform you create, since the most efficient way of searching for a record is often by using keywords.

Multiple terms can be entered into this field. They will also appear in the Keywords field content list for data entry and searching.

Location in Work Field

The Location in Work (25) field allows you to control how page ranges are formatted on output. This is the appropriate field to use for page numbers.

Title Fields

You can apply variations on capitalization to the title fields. This works best when you have entered titles with sentence capitalization, where only the first word of the title, the first word of any subtitle, and proper nouns are capitalized. The title fields are:

- (04) Title, Analytic
- (09) Title, Monographic
- (10) Journal Title
- (11) Title
- (32) Series Title

You should always include at least one title field in your workforms: field 04, field 09, or field 10. Those fields are used in the default sort orders. Always use field 10 for journal titles. Field 10 allows you to use journal lists for data entry and print alternate journal titles.

Titles from 04, 09, 11, and 32 are used to compile the Titles field content list. Titles from field 10 are compiled for the Journals field content list.

Selecting the Field Numbers

You may want to use the table on the next page to help plan a custom workform. The left column lists the default field names.
<table>
<thead>
<tr>
<th>Default Field Name</th>
<th>Workform Specific Field Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>(01) Author, Analytic</td>
<td></td>
</tr>
<tr>
<td>(02) Author Role</td>
<td></td>
</tr>
<tr>
<td>(03) Author Affiliation</td>
<td></td>
</tr>
<tr>
<td>(04) Title, Analytic</td>
<td></td>
</tr>
<tr>
<td>(05) Medium Designator</td>
<td></td>
</tr>
<tr>
<td>(06) Connective Phrase</td>
<td></td>
</tr>
<tr>
<td>(07) Author, Monographic</td>
<td></td>
</tr>
<tr>
<td>(08) Author Role</td>
<td></td>
</tr>
<tr>
<td>(09) Title, Monographic</td>
<td></td>
</tr>
<tr>
<td>(10) Journal Title</td>
<td></td>
</tr>
<tr>
<td>(11) Title</td>
<td></td>
</tr>
<tr>
<td>(12) Reprint Status</td>
<td></td>
</tr>
<tr>
<td>(13) Place of Meeting</td>
<td></td>
</tr>
<tr>
<td>(14) Medium Designator</td>
<td></td>
</tr>
<tr>
<td>(15) Edition</td>
<td></td>
</tr>
<tr>
<td>(16) Author, Subsidiary</td>
<td></td>
</tr>
<tr>
<td>(17) Author Role</td>
<td></td>
</tr>
<tr>
<td>(18) Place of Publication</td>
<td></td>
</tr>
<tr>
<td>(19) Publisher Name</td>
<td></td>
</tr>
<tr>
<td>(20) Date of Publication</td>
<td></td>
</tr>
<tr>
<td>(21) Date of Copyright</td>
<td></td>
</tr>
<tr>
<td>(22) Volume ID</td>
<td></td>
</tr>
<tr>
<td>(23) Report ID</td>
<td></td>
</tr>
<tr>
<td>(24) Issue ID</td>
<td></td>
</tr>
<tr>
<td>(25) Location in Work</td>
<td></td>
</tr>
<tr>
<td>(26) Extent of Work</td>
<td></td>
</tr>
<tr>
<td>(27) Packaging Method</td>
<td></td>
</tr>
<tr>
<td>(28) Size</td>
<td></td>
</tr>
<tr>
<td>(29) Reproduction Ratio</td>
<td></td>
</tr>
<tr>
<td>(30) Series Editor</td>
<td></td>
</tr>
<tr>
<td>(31) Series Editor Role</td>
<td></td>
</tr>
<tr>
<td>(32) Series Title</td>
<td></td>
</tr>
<tr>
<td>(33) Series Volume ID</td>
<td></td>
</tr>
<tr>
<td>(34) Series Issue ID</td>
<td></td>
</tr>
<tr>
<td>(35) Document Type</td>
<td></td>
</tr>
<tr>
<td>(36) Connective Phrase</td>
<td></td>
</tr>
<tr>
<td>(37) Address/Availability</td>
<td></td>
</tr>
<tr>
<td>(38) Location/URL</td>
<td></td>
</tr>
<tr>
<td>(39) CODEN</td>
<td></td>
</tr>
<tr>
<td>(40) ISSN</td>
<td></td>
</tr>
<tr>
<td>(41) ISBN</td>
<td></td>
</tr>
<tr>
<td>(42) Notes</td>
<td></td>
</tr>
<tr>
<td>(43) Abstract</td>
<td></td>
</tr>
<tr>
<td>(44) Call Number</td>
<td></td>
</tr>
<tr>
<td>(45) Keywords</td>
<td></td>
</tr>
</tbody>
</table>
Many predefined output styles ship with ProCite. They are set up to format records in popular bibliographic styles. You will need to modify an existing style (or create a new one) if none of the existing output styles match the style you need. When you create or modify a workform, you may need to modify each output style you use to get appropriate output for records entered into that workform.
How Output Styles Work

Output styles define how records print. Bibliographic styles follow formatting guidelines that are specific to the type of work being cited. To accommodate this, each output style is comprised of workform styles. Each workform style affects a single workform in your ProCite database, and is comprised of a list of fields in the order that you want them to print in formatted output.

Each output style contains:

• A series of in-text citation workform styles that determine how citations print in a *cite while you write* document. For each workform, you determine which fields to print, in what order to print the fields, and what text and/or punctuation to print before and after each field.

• In-text citation options that determine layout of citations in your *cite while you write* manuscript.

• A series of reference list workform styles that define how records in each workform print in a bibliography, whether you print the bibliography directly from ProCite or from a word processor with the *cite while you write* feature. For each workform, you can determine which fields to print, in what order to print the fields, and what text and/or punctuation to print before and after each field.

• Bibliography options that determine the sort order and layout.

Output styles are individual files kept in ProCite’s Styles folder. This allows multiple databases to share the same output styles. An output style is opened only for editing or while it is being used to format records. You cannot edit an output style when it is in use formatting records or being edited by someone else. Similarly, if you are generating a bibliography, another user won’t be able to edit the output style you are using.

Creating and Modifying Output Styles

The easiest way to create your own output style is to find an existing output style that is similar to the one you want to create, copy it, and modify the copy.
Creating a New Output Style

To create a new output style, without basing it on an existing style:

1. From the ProCite File menu, select New to display this dialog:

   ![New dialog](image)

2. Double click on Output Style to display the output style editor:

   ![Output Style editor](image)

This window includes a tab to define in-text citation formatting and a tab to define bibliography formatting. Each tab displays:

- A workform list at the left
  
  Workform names in bold text have a workform style defined for them. Those in plain text use the Default workform style.

- A text box to the right of the workform list where you list fields to print from the selected workform

  The In-Text Citations tab has two text boxes — one for the first instance of a citation, and one for subsequent uses of the same citation.
• A bottom Preview box which displays an example record formatted according to the current definition

3. On the In-Text Citations tab, click on a workform name and use the **Insert Field** button to list the fields you want to print from that workform, in the order you want them to print. Include the appropriate punctuation between fields. You can define a unique list of fields for each workform, or define the *Default* workform style for workforms that do not require a unique workform style.

See *Defining Workform Styles* later in this chapter for more information about setting up workform styles.

**Note:** If you plan to print only bibliographies, you can ignore the In-Text Citations tab and skip to step 6.

4. If you want a bibliography included at the end of your manuscript, select the box at the top of the tab, **Include Bibliography with each document.**

5. Click the **In-text Citations Settings** button and set options for in-text citations. Click **OK** to save changes.

6. On the Bibliography tab, click each workform name and use the **Insert Field** button to list the fields you want to print from that workform, in the order you want them to print. Include the appropriate punctuation between fields.

See *Defining Workform Styles* later in this chapter for more information about setting up workform styles.

**Note:** If you plan to print only in-text citations (such as full footnotes), and will never print a bibliography, you can ignore the Bibliography settings and skip to step 8.

7. Click the **Bibliography Settings** button to set layout options for your bibliographies. Enter the appropriate reference list title, sort order, numbering, indentation, and spacing for your references. Click **OK** to save any changes.

8. Choose **Close** from the **File** menu. ProCite asks whether you want to save changes to the file.

9. Click **Save** to display a file dialog.

10. Enter a unique file name for the output style, locate ProCite’s **Styles** folder to add the new file to the list of output styles, and click **Save.** ProCite displays a File Properties dialog.
11. Enter comments and click **OK** to save the file to disk.

Once the new output style is saved, it automatically appears in ProCite’s list of output styles and is available under Configure Bibliography for formatting output. Because output styles are independent files, they are available to all ProCite databases.

### Modifying an Output Style

When you want to modify an existing output style, we recommend that you first save a copy of the existing style and give the copy a different name. Then, make changes to the copy.

**To modify an output style:**

1. From the ProCite **File** menu, select **Open** to display a file dialog.

2. Locate ProCite’s **Styles** folder and open the output style that you want to edit. ProCite displays the output style editor:

![Output Style Editor](image)

3. From the **File** menu, choose **Save As** to display a file dialog.

4. Enter a name for the new output style and click **Save**. This prevents you from permanently changing an existing output style.

**Tip:** From the **File** menu, you may want to select **Properties** to modify comments on the File Properties dialog.
5. Make your modifications to the file. Full details about the options available are included in this chapter. See *Defining Workform Styles* and *Formatting Special Fields*.

6. When you close the file, ProCite asks whether you want to save changes. Click **Save**.

### Deleting an Output Style

To permanently delete an output style, use the **Delete** command from the ProCite **File** menu.

You may prefer to use the Explorer (Windows) or Finder (Macintosh) to drag the output style from ProCite’s **Styles** folder to the recycle bin or trash.

### Renaming an Output Style

To rename an output style, use the **Rename** command from the ProCite **File** menu.

You may prefer to use the Explorer (Windows) or Finder (Macintosh) to rename the output style in ProCite’s **Styles** folder. If you are using ProCite for Windows, remember to leave the .POS extension intact.

### Defining In-Text Citation Formatting

The In-Text Citations tab defines the appearance of formatted citations in the text of a manuscript.

**Note**: You can set up a unique format for each workform, but it is not required. The **Default** in-text citation format applies to workforms that do not have a unique format defined.

ProCite uses the in-text citation format in these instances:

- In a word processor document, link ProCite records and use **Generate Bibliography** to format citations directly from your manuscript. This is described in *Chapter 16: Cite While You Write*.

- From ProCite's **Edit** menu, go to the **Copy Special** submenu and **Copy In-text Citation** to format a citation to the clipboard. You can then paste the citation into any word processor document.
Basic Procedure

To define an in-text citation workform style:

1. Click the In-Text Citations tab in your output style.

2. For each workform in the list, build a list of fields that you want to print for each citation, in the order you want them printed.

   If all references to a citation are to print the same way, use only the First Citation text box. If you want to print subsequent citations differently, you can define two different output formats.

   a. Click the Insert Field button.

   b. Double click on the field you want to insert, or highlight the field that you want to insert and click OK. ProCite inserts a delimited field number and name at the cursor.

At the top of the list of fields are “generic” fields. Use these for the Default workform, since different workforms may use different fields for the primary author and title. If you define individual workform styles, you should use specific field numbers.

- **Author** prints the first author to appear in a record (field 01 or 07).

- **Author-Title** prints the first author or title to appear in a record (field 01, 04, 07, 09, 10, or 11).
• **Title** prints the first title to appear in a record (field 04, 09, 10, or 11).

• **Date** prints the first date to appear in a record (field 20 or 21).

Another special item in the list is **Citation Number**. Select **Citation Number** when you want numbers to indicate in-text citations.

c. Return to item (a) and repeat this procedure for each field you wish to print in a citation.

3. Insert punctuation around each field as needed. See *Defining Workform Styles* later in this chapter for guidance.

4. Click **In-text Citation Settings** to display an Options dialog:
a. In the Delimiters text boxes, enter any delimiters you want to surround citations and a citation separator for multiple citations.

b. The other options on the dialog are specific to the type of citation:

- If you listed Citation Number to print, use the Numeric Citations box to determine what to do with multiple citations at the same point in the manuscript.

- If you listed text fields to print, such as an author-date style or full footnotes, use the Text Citations box to select the sort order for citations that appear as multiple citations at the same point in the manuscript.

c. Click OK to save your settings on the dialog.

5. At the top of the In-text Citations tab is a box labelled Include a bibliography with each document. Check the box if you want to include a bibliography at the end of each document. If you want to format only in-text citations (such as footnotes), you don’t want a bibliography at all.

Note: The Fields tab in ProCite’s Configure Bibliography dialog (to suppress output of fields) does not affect the fields listed for output in an in-text citation.

Note: If you do not want any in-text citations, but do want to build a bibliography from linked references in your manuscript, you can leave the in-text citations text box empty. When you Generate Bibliography from within your manuscript, ProCite can read the linked citations, build a bibliography from them, and then replace them with nothing.

**Numeric Citations**

For a numeric in-text citation style, you only need to define the Default workform style; it is used for all workforms that don’t have a specific style defined.

Click the Default workform and list only the special Citation Number field in the text box. If you want to superscript the number, select the Citation Number field in the text box (including delimiters) and click the superscript button on the toolbar.
Citation Number Order

By default, the same number is assigned to multiple occurrences of the same reference.

When you Generate Bibliography from your word processor, you may change the sort order of your reference list to change how numbers are assigned to citations. For example:

- When you Generate Bibliography, set the sort order to Author/Title/Date. ProCite sequentially numbers the reference list at the end of the document in Author/Title/Date order, and uses those numbers to replace the corresponding in-text citations found earlier in the document.

- When you Generate Bibliography, set the sort order to Manuscript Order. ProCite sequentially numbers each reference as it is found in the manuscript, and lists the bibliography in that order at the end of the document.

When several citations appear at the same point in the manuscript, ProCite arranges the numbers in ascending order, such as:

... the thymic microenvironment is equally as complex as the T-cell differentiation it regulates\(^{14,16,21,27,33,39,40}\).

Delimiters and Separators

Click the In-text Citation Settings button and use the Delimiters boxes to enter optional citation delimiters and separators:

- To surround your Citation Number with delimiters, enter the appropriate character(s) in the Left Delimiter and Right Delimiter text boxes.
For example, to surround your citation numbers with brackets, as in:

Tables for a large number of electronic states exist [22]...

enter a left bracket in the **Left Delimiter** box and a right bracket in the **Right Delimiter** box. Enter delimiters here, rather than as punctuation in the workform style, so ProCite will surround multiple citations with a single set of delimiters. Rather than:

Tables for a large number of electronic states exist [22], [23]...

you would get:

Tables for a large number of electronic states exist [22,23]...

If you do not want delimiters around your citations, delete all text from the Delimiter text boxes.

- In the **Citation Separator** text box, enter the separator you want to print between multiple citations at the same point in your manuscript. For numeric citations, the separator between each citation is usually a comma (,) or a space. Some examples:

  ... the thymic microenvironment is equally as complex as the T-cell differentiation it regulates\textsuperscript{14,16,21,27,33,39,40}.

Tables for a large number of electronic states exist [22, 23]...

... none of the drugs has really been proven effective regarding mortality.\textsuperscript{17,18}

### Number Ranges

Click the **In-text Citation Settings** button and use the settings in the **Numeric Citations** area to determine how number ranges print.

- If you always want the number for each citation to print, even in a list of multiple citations, leave the **Use Number Ranges** box unchecked. For example:

  Tables for a large number of electronic states exist [22, 23, 24, 25]...

- If you want to abbreviate a range of citation numbers, select the **Use Number Ranges** box and enter a **Range Separator** in the text box. This example uses a hyphen as the Range Separator:

  Tables for a large number of electronic states exist [22-25]...
Author-Date Citations

Many bibliographic styles require Author-Date citations in a manuscript. You typically need to print a combination of author, date, and possibly title fields.

- If you want all workforms cited the same way, you may be able to define only the Default workform style. You can define specific workform styles for those workforms that require output different than the Default style.

- If all occurrences of the same work should format the same, you can use only the First Occurrence text box. Use the Subsequent Citations box only when you want to define an alternate format for subsequent citations of the same work.

- To insert fields for printing and supply preceding and following punctuation, follow the procedures described later in this chapter under Defining Workform Styles.

- Typically, only the author and publication date is included in each in-text citation. When a work has no primary author, however, you may need to cite the primary title instead. Do this by listing the generic Author-Title field for output. It avoids the problem of printing both the author and the title when only one is required.

- When defining the Default workform style, insert the generic Author-Title field and the 20 Date of Publication field. Because this format can apply to all workforms, the fields used for the primary author and primary title could vary. The Default style would look like this:
There is a limit of 255 characters for an individual in-text citation.

In order to differentiate between citations that refer to different works but have the same author name and year, ProCite will add letters to the year. For example:

(Smith and Brown, 1997a)
(Smith and Brown, 1997b)

**Delimiters, Separators, and Sorting**

Click the *In-text Citation Settings* button and use the *Delimiters* box to enter optional citation delimiters and separators:

- To surround your in-text citation with delimiters, enter the appropriate character(s) in the *Left Delimiter* and *Right Delimiter* text boxes. For example, to surround your citations with parentheses, as in:

  ... research suggests that dysfunctional thought processes lead to depression or unhappiness (Olinger, Kuiper, & Shaw, 1987).

  enter a left parenthesis in the *Left Delimiter* box and a right parenthesis in the *Right Delimiter* box. The delimiters are entered here, rather than as preceding and following punctuation in the workform style, so ProCite will surround multiple citations with a single set of delimiters. Rather than:

  ... research suggests that dysfunctional thought processes lead to depression or unhappiness (Kuiper et al., 1987); (Olinger, Kuiper, & Shaw, 1987); (Wierzbicki & Rexford, 1989); (Wise & Barnes, 1986).

  you would get:

  ... research suggests that dysfunctional thought processes lead to depression or unhappiness (Kuiper et al., 1987; Olinger, Kuiper, & Shaw, 1987; Wierzbicki & Rexford, 1989; Wise & Barnes, 1986).

  If you do not want delimiters around your citations, delete all text from the Delimiter text boxes.

- In the *Citation Separator* text box, enter the separator you want to print between multiple citations at the same point in your manuscript.

  For author-date citations, the separator between each citation is usually a semicolon and a space.
Some styles vary in the use of parentheses as delimiters. For example:

…cultural factors appear even more important than economic ones (Lipset et al. 1993: 168-70; see also Huntington 1991:298-311). Dahl (1970:6), Kennan (1977:41:43), and Lewis (1993:93-94) have emphasized that…

See Chapter 16: Cite While You Write for ideas on how to deal with variable in-text citation formats.

Use the Sorted By box to determine the sort order of multiple citations. When two or more citations print at the same location, you can sort the citations by:

- Citation Order
- Author/Date
- Date (Ascending)
- Date (Descending)

**Author Formatting**

The Author Formatting options are described in more detail later in this chapter under Formatting Special Fields. When the In-Text Citations tab is active, the Author Formatting Options change slightly and apply to the In-Text Citations format. This allows you to control author name formatting for in-text citations independently from author name formatting for references in your bibliography.

To set Author Formatting, click the In-Text Citations tab, then click the Configure Fields button to select the appropriate author field. If you have listed the generic Author field to print, make sure you define Author Formatting for both field 01 and field 07, since either one may be used as a primary author field in a workform.

The Author Formatting tabs include:

- **Author List**: The Author List tab determines how many author names print when there are multiple authors (for the first and subsequent occurrences of a citation to the same reference), and what to do if an author field is empty.

- **Separators**: The Separators tab lets you replace for output any double slash “/”, semicolon “;” or carriage return that separates author names in your records. You can customize punctuation between two authors, between multiple authors, and before the last author when there are more than two.
• **Names:** Use the Names dialog to control the format of individual author names, and whether the name of the first author of a work with multiple authors is formatted the same way as subsequent authors. The Name Order, Initials, and Uppercasing settings are each set for the first author individually, and then for all subsequent authors in the same ProCite field. For Name Order, select **Last** to print only last names in your citations.

• **Text:** You can set field dependent preceding and following text. Use the Text tab if you need punctuation that depends on whether a reference has a single author or multiple authors (editors).

The Author List tab is slightly different than that used for formatted references. For some journals, the forms of the first and subsequent citations are the same. For example, if the rule for “three or more authors” is simply to list the first author followed by “et al.”, this can be accomplished on the Author List tab with:

<table>
<thead>
<tr>
<th>Abbreviated Author List</th>
<th>Abbreviate with</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>First Citation:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>If 3 or more list 1</td>
<td>et al.</td>
<td>Glazner et al.</td>
</tr>
<tr>
<td><strong>Subsequent Citations:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>If 3 or more list 1</td>
<td>et al.</td>
<td>Glazner et al.</td>
</tr>
</tbody>
</table>

An example of different rules for first and subsequent citations (remember that subsequent citations refer to the same work by the same authors) is:

• For works by one or two authors, list all author names for each occurrence.

• For works by three to five authors, list all names in the first citation in the text; thereafter just list the first followed by “et al.”

• For works by more than five authors, list the first author’s name followed by “et al.” for all occurrences.

This can be satisfied on the Author List tab with:

<table>
<thead>
<tr>
<th>Abbreviated Author List</th>
<th>Abbreviate with</th>
<th>Example of first &amp; second occurrence</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>First Citation:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>If 6 or more list 1</td>
<td>et al.</td>
<td>Lipset, Seong, and Torres</td>
</tr>
<tr>
<td><strong>Subsequent Citations:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>If 3 or more list 1</td>
<td>et al.</td>
<td>Lipset et al.</td>
</tr>
</tbody>
</table>
Other Special Fields Formatting

Formatting of Titles, Journals, Dates, Page Numbers and Keywords fields is described later in this chapter under Formatting Special Fields. In-text citation formats typically include only author names and dates or citation numbers. In most Author-Date formats, the Date is shortened to year only. You can ignore formatting for those fields not listed to print.

Including Page Numbers

Many in-text citation formats include page numbers. The page numbers in your ProCite records often encompass the entire work or article. The page numbers you include in your in-text citation should indicate what part of the work you are citing.

When using ProCite from within a word processor, you can supply page numbers that are not included in the bibliographic record. Enter the page numbers as following text after the date in the in-text citation by including it after a "/ft" switch. This lets you handle text that can differ for different citations referencing the same work, as in:

(Lipset, Seong, and Torres 1993 ft/156-58)

followed later by

(Lipset et al. 1993 ft/168-70)

How to use additional text in a manuscript is described in Chapter 16: Cite While You Write. There is a limit of 255 characters for an individual in-text citation, including additional text.

Footnotes

You can include footnotes in your manuscript. The easiest way is to use the footnote capabilities of your word processor to insert in-text citations and place footnotes at the bottom of the page. Then, within the footnote, insert ProCite in-text citations. In the output style, define the footnote format on the In-Text Citations tab. You can define an author/date format or a full text format. When you Generate Bibliography in your manuscript, ProCite formats the linked citations in your footnotes.

Tip: In the output style, use the Include a bibliography with each document box to include or exclude a bibliography at the end of the manuscript.
Defining Bibliography Formatting

The Bibliography tab in an output style defines the format of records in a bibliography. To accommodate different formatting guidelines for different types of work, you can set up a unique workform style for each workform. Each workform style is comprised of a list of fields in the order that you want them to print in formatted output.

Basic Procedure

To define a bibliographic style:

1. Click the Bibliography tab in your output style.

2. For each workform in the list, define a workform style. Build a list of fields that you want to print for each citation, in the order you want them printed.

Note: If you want to print all references exactly the same, or you use only a single workform type in your database, you can set up only the Default workform style. The Default style applies to every workform that does not have a unique workform style defined.
a. Click the **Insert Field** button.

b. Double click on the field you want to insert, or highlight the field that you want to insert and click **OK**. ProCite inserts a delimited field number and name at the cursor.

At the top of the list of fields are “generic” fields. Use these for the **Default** workform, since different workforms may use different fields for the primary author and title.

- **Author** prints the first author in a record (field 01 or 07).
- **Author-Title** prints the first author or title in a record (field 01, 04, 07, 09, 10, or 11).
- **Title** prints the first title in a record (field 04, 09, 10, or 11).
- **Date** prints the first date in a record (field 20 or 21).

c. Return to item (a) and repeat this procedure for each field you wish to print in a citation.

3. Insert punctuation around each field as needed. For detailed information, see the next section, **Defining Workform Styles**.

4. Click the **Bibliography Settings** button to display an Options dialog:

![Bibliography Settings dialog box]

Many bibliographic styles require a specific sort order, reference numbering, indentation, and spacing for your bibliography. Customize these settings here. For detailed information about these options, see **Setting up your Bibliography** in **Chapter 17: Printing Bibliographies**.
Note: These settings are also available when you choose Print Bibliography or Print Subject Bibliography from the File menu in ProCite and click Configure. They are also available when you Generate Bibliography from a manuscript. You can override these output style settings before printing.

5. Click OK to save the new settings.

Defining Workform Styles

ProCite’s output style editor allows you to define workform styles for in-text citations separately from workform styles for bibliographies. These are tips that may help you in setting up workform styles:

• When a workform style is defined for a particular workform, that workform name appears in bold type. Workforms that do not have a specific workform style defined are listed in plain text and use the Default workform style.

• If no Default workform style is defined, nothing prints for those workforms that do not have a specific workform style defined.

• You can reset a workform to use the Default workform style by highlighting the workform name and deleting that workform’s unique style definition, leaving the text box empty.

• You can attach punctuation to each field in a workform style, so that if a field is empty the attached punctuation is also omitted. Additional text that is not attached to a particular field always prints. Punctuation and additional text can include parentheses, a following period, blank lines, and even full words.

• You may associate punctuation with a group of fields by using grouping operators. In this case, the punctuation will be output unless all fields in the group are empty. One use of this is when you want a single comma or period to always appear at the end of a group of fields, no matter what combination of the fields actually contain data and appear in the formatted output.

• Some ProCite fields have additional formatting characteristics associated with them. For example, you can define the separators to print between multiple authors, and you can control the capitalization of titles. These are described under Formatting Special Fields later in this chapter.
• Empty fields in records are not included in the formatted output, and punctuation associated with a field is output only if there is data in that field.

ProCite cannot output columns or automatically break words and hyphenate them to fit in columns. This must be done by the publisher or by you with a word processor.

**Basic Procedure**

The procedure is the same whether you are defining a workform style for an in-text citation or a reference in a bibliography.

**To define a workform style for each available workform:**

1. Click on a workform name or *Default* to select the workform style to customize. If that workform style is already defined, fields are displayed for editing. Otherwise, the text box is blank.

   **Note:** When defining a workform style for in-text citations, two text boxes are displayed. If all references to a citation are to print the same way, use only the First Citation text box. If you want to print subsequent citations differently, you can define two different output formats.

2. Build a list of fields that are included in the workform, in the order you want them printed.

   a. Click *Insert Field*. Only those fields used in the current workform appear. If you are setting up the *Default* workform style, all 45 ProCite fields appear. If you are setting up an in-text citation style, you can select Citation Number rather than a field.
b. Double click on the field you want to insert, and ProCite inserts it at the cursor. Fields are inserted with the field number and name as defined for that workform, such as:

```
<01 Author, Analytic>
```

c. Return to item (a) and repeat this procedure for each field you wish to print in a reference.

For more information, see the *Inserting and Deleting Fields* section found next in this chapter.

3. Use the mouse and keyboard to add the appropriate punctuation to print before and after each field. “Punctuation” can actually be made up of any characters, such as periods, blank lines, parentheses, text, etc. You can include:

- **Preceding Punctuation**, which prints *before* the field text.
- **Ending Punctuation**, which prints *after* the field text.
- **Additional Text**, which prints whether there is text in a field or not.

Vertical bars determine to which field the punctuation is attached. For example:

```
<01 Author, Analytic>. |<04 Title, Analytic>.| (<20 Date of Publication>).
```

This example prints a period and space after the author name, a period after the title, a space and left parentheses before the date, and a right parentheses and period after the date. The reference appears as:

```
```

Punctuation can include formatting characters for new paragraphs, tabs, etc. You can also apply styles to punctuation or field text. Each of these items is discussed further in this chapter.

4. Return to step (1) and repeat the procedure for each available workform you use in ProCite.

A later section in this chapter, *Formatting Special Fields*, describes additional formatting allowed for special fields:

- **Author Formatting** affects how author names print from each author field.

- **Title Formatting** determines the case and capitalization used for each title field.
• **Journal Formatting** determines the case, capitalization and journal title substitution used for journal titles in field 10.

• **Date Formatting** determines the order and style of the month, day, and year for each date field.

• **Page Number Formatting** determines the text to print before or after page numbers, and how to format page ranges.

• **Keyword Formatting** determines how keywords are separated for printing.

### Inserting and Deleting Fields

The first step in defining a workform style is selecting the fields you wish to print from that workform. Insert the fields in the order you want them to print. You can list all fields found in the workform, or limit printing to only a few fields.

#### Inserting a Field

**To insert a field:**

1. Click **Insert Field** to display a list of ProCite fields:

   ![Insert Field Window](image)

   Fields that are included in the current workform are indicated by field numbers and names. When you are editing the Default workform style, ProCite displays default names for all 45 ProCite fields.

   At the top of the list of fields are “generic” fields. These are most often used for the Default workform style, because the default applies to any workform for which an individual workform style is not
defined. Different workforms may use different fields for the primary author and title.

- **Author** prints the first author in a record (field 01 or 07).
- **Title** prints the first title in a record (field 04, 09, 10, or 11).
- **Author-Title** prints the first author or title in a record (field 01, 04, 07, 09, 10, or 11).
- **Date** prints the first date in a record (field 20 or 21).

2. Double click on the field you want to insert, or highlight the field that you want to insert and click **OK**.

   ProCite inserts the field name delimited by special characters. For example, when you insert field 20, ProCite displays:

   `<20 Date of Publication>`

   (You can manually type the field name in this format if you wish, making sure that it appears exactly as it would if you entered it using Insert Field.)

3. Repeat the process, inserting fields in the order they should print.

**Deleting a Field**

When you remove a field from a workform style, that field will no longer print for the workform when you select this output style for printing.

To remove a field from a workform style:

1. Highlight the field you want to remove, including the field name and delimiters. For example, to remove the publisher name from printing, make sure you highlight the complete item:

   `<19 Publisher Name>`

   You may also wish to delete existing preceding and/or following punctuation. If you do not, it may become part of the previous or following field’s punctuation.

2. Press the **Delete** key.

   Remember that the field is deleted for the current workform style only. If you do not ever want the field to print, make sure it is removed from all workform styles.
If you want to switch between printing a certain field and then not printing it at another time, you can include the field in the workform style and suppress it for printing as needed. This allows you, for example, to print with or without Notes—without changing your output style each time. For more information about Field Suppression, see Chapter 17: Printing Bibliographies.

Inserting Punctuation

By adding punctuation with an output style, rather than including it with text in a ProCite field, your output is very flexible. You can insert punctuation before a field, after a field, or between fields.

Note: ProCite’s output styles insert a single space after periods, colons, etc. because most publishers require it for electronic submissions. You will need to modify each output style you use if you want to insert two spaces after each period.

Punctuation consists not only of the punctuation marks that commonly appear in formatted references, such as commas and periods, but any characters or words that you want to include before or after a field of text.

Formatting characters that you can use include those listed in the following table, and are discussed further in this chapter. You can insert these with the Insert Special button.
### Preceding and Following Punctuation

If every record always contained information in every field listed in the workform style for printing, it would be straightforward to just include any necessary punctuation between fields. However, there will always be cases when ProCite fields are empty. You need to be able to associate punctuation with a specific field, so that when the field is empty its associated punctuation will not print.

- To enter punctuation, position the cursor between fields listed in the workform style and enter the text as you want it to appear.
- ProCite assumes that any punctuation after a field name is following punctuation for that field.
- To apply text as preceding punctuation for a field, separate it from the preceding field name with a vertical bar (|).
• If a field in your record is empty, the preceding and following punctuation associated with that field will automatically be omitted.

Look at the following examples for guidance:

**Example 1:**

```
<01 Author, Analytic>. |<04 Title, Analytic>. |<20 Date of Publication>.
```

This will always print a period and space after each field. When a field is empty, the period and space following it is not printed.

**Example 2:**

```
<01 Author, Analytic>. |<04 Title, Analytic>.| (<20 Date of Publication>).
```

The primary date is surrounded by parentheses, preceded by a space, and followed by a period. The vertical bar forces the space and left parentheses “(” to print before 20 Date of Publication rather than as following punctuation for 04 Title, Analytic. If you suppress the date from output, ProCite will not print an unmatched left parentheses after the title.

**Example 3:**

```
<12 Date of Meeting>|, <13 Place of Meeting>
```

The comma and space between Date of Meeting and Place of Meeting is entered as preceding punctuation for 13 Place of Meeting, so that it is only printed if 13 Place of Meeting is printed.

It is usually best to insert the combination of comma followed by a space as preceding punctuation for a field, rather than including it as following punctuation for the previous field. You want to avoid the possibility of ending a reference with a comma.

**Example 4:**

```
|Title: <04 Title, Analytic>. |Abstract: <43 Abstract>
```

The initial vertical bar prints “Title: ” as preceding punctuation for 04 Title, Analytic. The title is followed by a period and space. The next vertical bar forces the text “Abstract: ” to print before 43 Abstract.
Suppressing Extraneous Punctuation

ProCite suppresses double punctuation after a field, so you don’t end up with two periods or two commas between fields.

Do not enter ending punctuation in fields of your ProCite records unless it is a special character that is part of the title or term (such as a title ending with a question mark). Suppressing punctuation is most useful after importing references from an information service—some with periods at the end of a field and some without. ProCite makes sure that if a period is at the end of the text in your ProCite record and a period is supposed to be applied by the output style, you don’t end up with double periods.

ProCite first formats the content of the field (including Special Fields Formatting). If there is punctuation at the end, ProCite uses it and suppresses extra punctuation found in following text in the output style. If punctuation is used from the record or from following text in the output style, ProCite suppresses extra punctuation from preceding punctuation for the next field. ProCite strips extraneous punctuation as follows:

<table>
<thead>
<tr>
<th>Last character in record, then following punctuation, then preceding punctuation:</th>
<th>ProCite will print the first found:</th>
</tr>
</thead>
<tbody>
<tr>
<td>double spaces</td>
<td>space</td>
</tr>
<tr>
<td>double commas ,</td>
<td>, comma</td>
</tr>
<tr>
<td>double semicolons ;</td>
<td>; colon</td>
</tr>
<tr>
<td>double question marks ??</td>
<td>? question mark</td>
</tr>
<tr>
<td>double exclamation points !!</td>
<td>! exclamation point</td>
</tr>
<tr>
<td>double periods ..</td>
<td>. period</td>
</tr>
<tr>
<td>comma and period ,</td>
<td>, comma</td>
</tr>
<tr>
<td>question mark, period ?</td>
<td>? question mark</td>
</tr>
<tr>
<td>question mark, exclamation point ?!</td>
<td>? question mark</td>
</tr>
<tr>
<td>exclamation point, period !</td>
<td>! exclamation point</td>
</tr>
<tr>
<td>exclamation point, question mark !?</td>
<td>! exclamation point</td>
</tr>
<tr>
<td>period, question mark .?</td>
<td>? question mark</td>
</tr>
<tr>
<td>period, exclamation point .!</td>
<td>. period</td>
</tr>
</tbody>
</table>

ProCite will not suppress a period and comma combination (,.), which is useful for “et al.,” and other abbreviations.
Applying Punctuation to Groups of Fields

You can apply preceding and ending punctuation to a group of fields by surrounding the entire group with grouping operators. This is helpful when you want a series of fields separated with commas and ending with a period; the only way to end with a period if one (or more) of the fields is missing is to use grouping operators.

To insert the left or right grouping operator, « or », use the Insert Special button.

A typical use of grouping operators is to end author information with a period, whether or not an Author Role exists in the record. In this example:

«<01 Author, Analytic>|, <02 Author Role, Analytic>|. »

- The grouping operators surround the group of two fields.
- The first vertical bar (|) makes the comma and space preceding punctuation for the 02 Author Role, Analytic field.
- The second vertical bar (|) associates the ending period and space with the group of fields rather than ending punctuation for the preceding 02 Author Role, Analytic.
- Because the ending period followed by a space is enclosed within the grouping operators, it is printed whenever any element from the group is printed.
- If there is no 02 Author Role text in the record, the period follows the 01 Author, Analytic.
- This allows output such as:
  
  Allen Smith, Editor.
  David Kochalko.
  John Brown, Inventor.

When you use grouping operators, it is important to determine whether punctuation between fields should be included as following punctuation for a field or as preceding punctuation for the next field. The choice depends on which field(s) you think are most likely to be empty.
Example 1:

«<25 Location in Work>|, <23 Report ID>|, <19 Publisher Name>|, <18 Place of Publication>|.»

The comma and space have been inserted as preceding punctuation before each field. If field 25 Location in Work is empty, the group will begin with a comma and space. The comma may be suppressed if there is double punctuation. This is an appropriate setup if your records will almost always contain a location in work (such as page numbers).

Example 2:

«(<30 Series Editor>|, <31 Series Editor Role>|. »<32 Series Title>|; <33 Series Volume ID>|).»

This example shows nested grouping operators. ProCite processes the inner set of grouping operators separately from the outer set of grouping operators. This example prints two sentences enclosed in parentheses:

(Harris, John H., Jr., editor. Golden’s diagnostic radiology series; 1).

The outermost grouping operators ensure that no matter which fields contain data, the fields that print are surrounded by parentheses and followed by a period.

Note: If you want to actually print the characters that are used as grouping operators (« or »), precede the character with a backslash (\), as in “\«”.

Inserting Additional Text

Additional text is used when:

- You always want to print text before or after a field — even when the field is empty.

- You want to print text that is associated with the output style or workform style, but is not associated with any particular field in a record. For example, information that is part of a standard form, or typesetting codes that you want to include as part of a bibliography.

Since Additional Text is not associated with any particular field, it is always included in output, even if you have suppressed fields from printing with the Configure Bibliography dialog before printing.

An output style that uses extensive Additional Text is the Workform output style, where field names are always printed for each field in each workform.
Use vertical bars (|) to separate Additional Text from punctuation attached to the surrounding fields. Type the Additional Text between the vertical bars, exactly as you want it to appear.

**Example 1:**

\[<04 \text{Article Title}>. | \text{Available from: |}<37 \text{Availability}>.\]

In this example, the text “Available from: ” prints even when the 37 Availability field is empty in the record or is suppressed for printing.

**Example 2:**

Writer’s Name: |<01 Author, Analytic>.

In this example, the text "Writer’s Name: " will always print.

**Example 3:**

\[<04 \text{Article Title}>.| \text{Requested by}\]

This example shows additional text at the end of a workform style.

## Inserting Formatting Characters

You can include formatting characters as punctuation in a workform style. Use the **Insert Special** button to insert these formatting characters:

- **Line Breaks** move the cursor to the indent on the next line.
- **New Paragraphs** move the cursor to the left margin on the next line.
- **Page Breaks** move the cursor to the top of the next page.
- **Tabs** move the cursor to the next tab stop.

**New Lines and New Paragraphs**

Output styles differentiate between line breaks and new paragraphs. Use the **Insert Special** button, or:

- To insert a line break, type Shift+Enter (Windows) or Shift+Return (Macintosh) to display (→). When printing, the cursor moves to the indent on the next line.
- To insert a paragraph mark, type Enter (Windows) or Return (Macintosh) to display (¶). When printing, the cursor moves to the left margin on the next line.
For example, to start both the 42 Notes field and the 43 Abstract field on a new line, insert a line break as preceding punctuation before each field:

<01 Author, Analytic>. |<04 Title, Analytic>. |<20 Date of Publication>.|¬
Notes: <42 Notes>.|¬
Abstract: <43 Abstract>.

This example produces:

   Notes: Dedicated to James Brown and his Mandolin Club.
   Abstract: A ragtime two-step for piano.

If either 42 Notes or 43 Abstract is empty, the line break associated with that field will be suppressed.

Paragraph marks stored in a record are interpreted as line breaks in formatted output.

**Blank Lines**

To insert a blank line between fields, enter two line breaks or two paragraphs marks. For example:

To insert a blank line before an abstract, and keep paragraph indenting, press Shift+Enter (Windows) or Shift+Return (Macintosh) twice to insert two line breaks:

<18 Place of Publication>. |¬
¬
<43 Abstract>

The first line break starts the abstract on its own line, and the next line break moves the abstract down a line, leaving a blank line:


   A manual giving detailed instructions on the use of ProCite 5, a bibliographic database management program.

The line breaks keep the entire reference in the same paragraph, which may be useful when reformatting in a word processor. If you insert paragraph marks rather than line breaks:

<18 Place of Publication>. |¶
¶
<43 Abstract>
The abstract starts at the left margin rather than at the indent:


A manual giving detailed instructions on the use of ProCite 5, a bibliographic database management program.

Paragraph indents are set on the Reference List tab. The default line spacing within individual references and between each reference is also controlled there. For more information about these settings, see Chapter 17: Printing Bibliographies.

**Page Breaks**

To insert a page break in your workform style, use the Insert Special button or type Ctrl+Enter (Windows) or Control+Return (Macintosh). Use this in your workform style when you always want a page break (for example, when generating a form).

A page break as the last character of each workform style would ensure that each reference starts on a new page. However, you can also insert page breaks between references on the Reference List tab. On the Reference List tab, set **Space After** to **Page Break**. ProCite will start each reference on a new page.

**Tabs**

Enter tabs with the Insert Special button or Alt+09 (Windows) or Command+Tab (Macintosh). They are indicated in your workform style by white space that extends to the next tab stop.

When printing from ProCite directly to a printer, tab stops are permanently set at the hanging indent level (set on the Reference List tab) and at each subsequent half inch.

When printing to a word processor, the tab jumps to the next tab stop set by your word processor. You can then easily reformat your references with your word processor. One example is where a tab has been inserted after 44 Call Number:

```
<44 Call Number>[TAB]<07 Author, Monographic>. <09 Title, Monographic>. <18 Place of Publication>|: <19 Publisher>|: |, <20 Date of Publication>|: |, <27 Packaging Method>.»
```
It is fairly easy to use your word processor to convert the formatted references to a two-column table, adjust the column widths, and reformat the paragraph style to produce:


### Applying Type Styles

By applying type styles (bold, italics, and underlining) with output styles, you can use different type styles to meet the requirements of various bibliographic styles. For example, you can italicize titles in one bibliography and underline titles in another.

You should not apply type styles in your ProCite records unless you want to affect only a portion of the field or you always want a style applied—for example, when you use superscripts or subscripts or when you always want to italicize Latin terms.

A default font and size setting is used for display when editing output styles, and will be replaced for printing with the font and size indicated on the Configure Bibliography dialog. Any font, size, or style you specifically apply to text in a workform style will override the Configure Bibliography settings and will be used in formatted output.

**To apply bold, italics, underlining, superscript, or subscript in a workform style:**

1. Highlight any combination of the preceding text, following text, additional text, or field name (including the field number and delimiters) to which you wish to apply the style.

2. Click on the appropriate style icon on the toolbar.

Styles applied to a field name apply to the full field contents from the ProCite record. Text that is already in bold, italics, or underline in a record will be printed with those same attributes, plus any styles applied by the output style. For example:

<table>
<thead>
<tr>
<th>Style in Record</th>
<th>Style Applied by Output Style</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>plain</td>
<td>bold italic</td>
<td>bold italic</td>
</tr>
<tr>
<td>plain</td>
<td>plain</td>
<td>plain</td>
</tr>
<tr>
<td>italic</td>
<td>plain</td>
<td>italic</td>
</tr>
<tr>
<td>italic</td>
<td>bold</td>
<td>bold italic</td>
</tr>
<tr>
<td>underline</td>
<td>underline</td>
<td>underline</td>
</tr>
</tbody>
</table>
When you highlight a field name and apply a different font or size, text from that field in a record is printed using the different font and size indicated in the output style rather than the font selected in Configure Bibliography. In the same way, any text in the record that has been specifically changed from the default font is printed using the font in the record; for example, Greek characters entered with a Greek font.

When you change the style of a field name, any preceding or following punctuation specified in the Special Fields Formatting is automatically changed to the same style. You can override this by styling the text in the Special Fields Formatting dialog (see Formatting Special Fields below).

When you use a Journal Title List to substitute text in a record, ProCite will use the substitution text (including any styles applied) as though it were text from the ProCite record. When you use an Alternate Text List to substitute text in a record, the substitution text (which cannot include styles) inherits the style of the corresponding text in the record. This is described in more detail in Chapter 18: Building List Files and Chapter 20: Using Alternate Text.

---

**Formatting Special Fields**

You have the ability to manipulate data from certain fields in ProCite. This is necessary to meet various formatting styles required by publishers. You can apply Special Fields Formatting to each workform style for:

- each author field (01, 07, 16, and 30)
- each title field (04, 09, 11, and 32)
- the 10 Journal Title field
- each date field (12, 20 and 21)
- the 25 Location in Work field (typically contains page numbers)
- the 45 Keywords field

For example, the Index Medicus style requires author names to print last name first, with first initials, such as:

**Aroney MJ, Davies MS, Hambley TW, Pierens RK**

*Science Magazine* prefers that the same author names be printed as:

**M. J. Aroney, M. S. Davies, T. W. Hambley, R. K. Pierens**

The Turabian style limits the number of authors printed and prints full first names, as in:

**Aroney, Manuel J. and others**

Special Fields Formatting allows you to meet each of these conventions.
Basic Procedure

Special Fields Formatting is set individually for each workform style. You can even set them separately for the first citation and subsequent citations on the In-Text Citations tab.

To set Special Fields Formatting:

1. Click on the workform style for which you want to modify the special fields formatting.

2. From the Fields menu, select the field for which you want to define formatting (or use the Configure Fields button on the toolbar):

ProCite displays a dialog of options for the field you selected.

3. Make changes to the dialog as desired. Each of the special fields formatting options is described next in this chapter.

You can apply or remove styles from text in any text box by highlighting the text and using keyboard commands:

<table>
<thead>
<tr>
<th></th>
<th>Windows</th>
<th>Macintosh</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bold</td>
<td>Ctrl+B</td>
<td>Command+Shift+B</td>
</tr>
<tr>
<td>Italics</td>
<td>Ctrl+I</td>
<td>Command+Shift+I</td>
</tr>
<tr>
<td>Underlining</td>
<td>Ctrl+U</td>
<td>Command+Shift+U</td>
</tr>
<tr>
<td>Superscript</td>
<td>Ctrl+Shift+=</td>
<td>Command+Shift+=</td>
</tr>
<tr>
<td>Subscript</td>
<td>Ctrl+=</td>
<td>Command+=</td>
</tr>
</tbody>
</table>
4. Click **OK** to save changes. Remember that any changes apply only to the current workform style. You may need to change formatting for each of the workforms you use in ProCite.

If your workform style lists a generic Author, Title, Author-Title, or Date field (described previously in this chapter under *Inserting and Deleting Fields*), formatting is applied based on the field actually used in formatted output. For example, if you use the generic Author field, and the field that actually gets printed for a particular record is *07 Author, Monographic*, ProCite applies the special fields formatting for field *07 Author*.

If you have set up special fields formatting for a field that is not listed in the workform style to print, special fields formatting for that field is ignored.

## Author Formatting

The Author Formatting tabbed dialog appears when you select any of the Authors fields from the **Fields** menu:

- **Authors (01)**
- **Authors (07)**
- **Authors (16)**
- **Authors (30)**

Author formatting controls the appearance of authors in a formatted reference. You can define different formats for each of the different author fields in each workform style. This section describes the four tabs that make up author formatting: Author List, Separators, Names, and Text.
Author List

The Author List tab allows you to specify how many author names print when there are multiple authors listed, what to do if an author field is empty, and how to format multiple works by the same author.

**Multiple Authors**

Use the Author List tab to indicate formatting of multiple authors.

To print all author names from the field, deselect the Abbreviated Author List box.

If a list of authors in a ProCite record ends with the multiple author indicator “////”, the four slashes are replaced on output with the Abbreviate with text. Typically this is a text string such as “, et al.” or “and others”. You can style the Abbreviate with text by highlighting it and using the appropriate shortcut keys.

If a bibliographic style requires that you limit the number of authors listed:

1. Select the Abbreviated Author List box to limit the number of author names printed from the single ProCite author field.

2. Type the number of authors to list in the appropriate text boxes.
3. Enter the appropriate **Abbreviate with** text, which is printed when all author names are not printed.

For a particular style you may want to print up to six authors in full, but for more than six authors you want to abbreviate to one author followed by “ et al.” Enter the numbers you need into the appropriate boxes, such as:

![Abbreviate with options](image)

With these settings, a formatted reference with six authors would look like this:

Bartels PH, Bibbo M, Graham A, Paplanus S, Shoemaker RL, Thompson D

and for more than six authors:

Bartels PH et al.

### Empty Author Fields

When an author field in your workform is empty, ProCite uses the **If Author Field Is Empty** options to determine output. ProCite ignores these settings when using the generic **Author-Title** field, since a title will replace an empty author field.

- Select **No Substitution** to simply not print the author field. This is the standard behavior for any field. If no data in the field exists, ProCite suppresses the field and any punctuation entered for that field.

- Select **Move Corresponding Title to Author Position** to replace an empty author field with a subsequent corresponding title field.

For example, the APA bibliographic style specifies that “In a reference to a work with no author, move the title to the author position, before the date of publication...” For a journal that requires manuscripts in the APA style, the output style could include a list of fields like:

```
<07 Author, Monographic>. <20 Publication Date>. <09 Title, Monographic>.
```

When you select this check box for **07 Author, Monographic**, an empty author field is replaced with **09 Title, Monographic**.
References with or without authors are output with fields in the correct order, as in:


and


Unlike using the generic Author-Title field, this allows you to reorder the fields on output, based on the content of the record, and prevent the Title field from printing twice.

In a style where the Title field always prints immediately after the Author field, you would not need to use this feature, as the Title would automatically take the place of an empty Author field.

When you use the generic Author field and set the formatting for 01 Author to Move Corresponding Title to Author Position, the corresponding 04 Title prints only when both field 01 and field 07 are empty.

- Select Print Text to replace an empty Author field with specific text. Type the replacement text, such as Anonymous or Anon. in the text box.

When you use the generic Author field, and set the formatting for 01 Author to print Anonymous, the supplied text prints only when both field 01 and field 07 are empty.

**Multiple Works by the Same Author**

Use the Subsequent Works by the Same Author box to indicate how author names should format when there are multiple works by the same author(s).

**Note:** This option is available only when you are modifying a workform style on the Bibliography tab. If you are modifying a workform style on the In-Text Citations tab, use the Subsequent Citations text box on that tab.
• To repeat the author name(s) as defined, select **Print the Author List as Defined Above**. In an alphabetized list where author names print first, the author name is repeated for each reference. For example:

Dokka, R.K., 1983, Displacement on late Cenozoic strike-slip faults of the central Mojave Desert, California: Geology, v. 11, p. 305-308


• To replace repeated occurrences of the same author(s) with a text string, select **Replace Repeated Authors With**.

Enter the text that you want to print in the text box. For example, some styles specify a certain number of underscore characters “________”, hyphens “- - -”, en-dashes “– – –”, or em-dashes “— — —”.

For subsequent works by the same author(s), the replacement string will appear in place of the author in the formatted reference list. For example,


If you elect to replace repeated authors, but do not enter any text in the replacement text box, the author name will not print, but any preceding or following punctuation for that field will still print.

• To suppress repeated author(s) names altogether, select **Suppress the Author List**. The author name prints only for the first work by that author.

Tentori, Tullio

1979 Note e memorie per una discussione sulla impostazione della antropologia culturale in Italia negli anni ’50. Problemi del socialismo 16:95-122.


Preceding or following punctuation for the author field is also suppressed.
## Separators

The Separators tab allows you to replace for output any double slash “//”, semicolon “;” or carriage return that separates author names in your records. It allows you to customize the punctuation between two authors, between multiple authors, and before the last author when there are more than two.

These are examples of how to meet the most common requirements:

<table>
<thead>
<tr>
<th>Between Exactly Two Authors</th>
<th>Between Each Author</th>
<th>Before the Last Author</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>,</td>
<td>,</td>
<td></td>
<td>Dunn J., Dale N.</td>
</tr>
<tr>
<td>and</td>
<td>,</td>
<td>,</td>
<td>Dunn J. and Dale N.</td>
</tr>
<tr>
<td>&amp;</td>
<td>,</td>
<td>,</td>
<td>Dunn J. &amp; Dale N.</td>
</tr>
</tbody>
</table>
Do not forget to include spaces as needed. You would enter a comma and a space between authors. To print each author name on a separate line, enter "^p" in each text box to insert a new paragraph between author names.

**Name Formatting**

The Names tab controls:

- the format of individual author names
- whether the first author name in a work by multiple authors is formatted the same as the subsequent author names

The Name Order, Initials, and Uppercasing settings are set for the first author only, and then for all subsequent authors in the same ProCite field.
**Name Order**

The elements of an author’s name can be arranged in several different ways:

<table>
<thead>
<tr>
<th>Name Order</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Middle Last</td>
<td>Mark Ransom Anderson George R.</td>
</tr>
<tr>
<td>Last, First Middle</td>
<td>Anderson, Mark Ransom</td>
</tr>
<tr>
<td></td>
<td>Saunders, George R.</td>
</tr>
<tr>
<td>Last First Middle</td>
<td>Anderson Mark Ransom</td>
</tr>
<tr>
<td></td>
<td>Saunders George R</td>
</tr>
<tr>
<td>Last</td>
<td>Anderson</td>
</tr>
<tr>
<td></td>
<td>Saunders</td>
</tr>
</tbody>
</table>

You must enter settings for both the **First Author** and **All Other Authors**. In most cases, the settings will be the same for both. The most common variation is when only the first author name is listed with the surname first for works by multiple authors:

<table>
<thead>
<tr>
<th>First Author</th>
<th>All Other Authors</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last, First Middle</td>
<td>First Middle Last</td>
<td>Gibson, James L. and Raymond M. Duch</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Marcus, G. E., and M. M. J. Fischer</td>
</tr>
</tbody>
</table>

**Initials**

The **Initials** list box allows you to choose the format of the authors’ first and middle names.

<table>
<thead>
<tr>
<th>Initials</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Middle</td>
<td>Hegel, Georg Wilhelm Friedrich</td>
</tr>
<tr>
<td>First M.</td>
<td>Hegel, Georg W. F.</td>
</tr>
<tr>
<td>F. M.</td>
<td>Hegel G. W. F.</td>
</tr>
<tr>
<td>F.M.</td>
<td>Hegel G.W.F.</td>
</tr>
<tr>
<td>F M</td>
<td>Hegel G W F</td>
</tr>
<tr>
<td>FM</td>
<td>Hegel GWF</td>
</tr>
</tbody>
</table>
If initials are used in the record itself, the name is output with initials even if a different format is set here. We recommend that you enter full author names into your records wherever possible. ProCite can strip to initials, but cannot possibly determine a full name from initials. If you do enter initials in your ProCite record, enter them with the first and middle initial separated by a space and/or period.

ProCite recognizes two letters followed by a period as a “two-letter” initial that is used in some languages. Such a combination will be treated as if it is already abbreviated and will be printed “as is.”

Hyphenated first and middle names are automatically turned into hyphenated initials if both parts of the name start with a capital letter. If only one letter is capitalized, it is used as the initial and the hyphen is suppressed.

Some examples:

<table>
<thead>
<tr>
<th>Names in the ProCite Record</th>
<th>Stripped to Initials (F.M.) for Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>Anderson, Mark Ransom</td>
<td>Anderson, M.R.</td>
</tr>
<tr>
<td>Robinson, JH</td>
<td>Robinson, J.</td>
</tr>
<tr>
<td>Robinson, J.H.</td>
<td>Robinson, J.H.</td>
</tr>
<tr>
<td>Robinson, J H</td>
<td>Robinson, J.H.</td>
</tr>
<tr>
<td>Koplatadze, A. M./Bondarev, Iu. A.</td>
<td>Koplatadze A.M., Bondarev Iu.A.</td>
</tr>
<tr>
<td>Stevens, Norman St. John</td>
<td>Stevens, N. St. J.</td>
</tr>
<tr>
<td>Wu, Yun-Dong</td>
<td>Wu, Y.-D.</td>
</tr>
<tr>
<td>Chan, Tai-chien</td>
<td>Chan, T.</td>
</tr>
</tbody>
</table>

**Uppercasing Author Names**

The **Uppercasing** option allows you to change the letter case used for author names. Uppercasing can be applied to the first author independently of all other authors. Your choices include:

- **None**, which prints Author names as they appear in your ProCite record:

  Anderson, Mark Ransom

- **Last Name Only**, which uppercases only the last name:

  ANDERSON, Mark Ransom

- **Entire Name**, which uppercases the entire author name:

  ANDERSON, MARK RANSOM
For example, to output only the first author’s last name in uppercase letters, choose the Uppercasing option Last Name Only for the First Author and None for All Other Authors, as in:

ANDERSON, Robert J and Schrier, Robert W.

Field Dependent Preceding and Following Text

Use the Text tab if you need punctuation that depends on whether a reference has a single author or multiple authors (editors).

For example, you could have a workform specifically for contributions to books with editors, where you know that author field 07 will always contain an editor or editors. You can print the author role in one of these ways:

- Enter the word “editor” or “editors” in the 08 Author Role field of the ProCite record. Since the text is printed as entered, you will not get the correct output for bibliographic styles that require an abbreviated role.

- Enter “editor” or “editors” as punctuation in the workform style. It will only be correct for either a single editor or multiple editors.

- Enter the full words or the abbreviations in the workform style as preceding or following text on the Author Formatting Text tab, as shown here:

![Author Formatting Text Tab](image-url)
The preceding and following text entered into this dialog is inserted between the contents of the field and any preceding or following punctuation indicated in the workform style. If you have an output style containing:

<01 Author, Analytic>. |<04 Title, Analytic>. |<09 Title, Monographic>. |<07 Editor>.

and the preceding text for the 07 Editor field was “Edited by ” (including a following space), the word “Edited” would be preceded by a period and space in formatted output because of the following punctuation from field 09 Title, Monographic.

Similarly, if field 01 Author, Analytic had following text of “, inventor”, a period and space would follow “inventor” in formatted output due to the following punctuation for field 01.

Examples:

Preceding text: ed. ed. T. Theophanides
eds. eds. T. Theophanides et al.

Following text: (ed) Ebbesson SOE (ed)
(eds) Dudel J, Menzel R, Schmidt RF (eds)

**Title Formatting**

Title case is applied individually to each title field in each workform style. To specify Title formatting, select the appropriate Title field from the **Fields** menu:

- Titles (04)
- Titles (09)
- Titles (11)
- Titles (32).

These options are available for modifying the case of text.
Title case is set separately for each title field in each workform style. This allows you to format the contents of a title field based on document type. For example, you may want 09 Title, Monographic in headline case for the title of a book, but 04 Title, Analytic unchanged for the title of a chapter in that book.

This is how title case is applied:

<table>
<thead>
<tr>
<th>Title Case</th>
<th>Effect on Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unchanged</td>
<td>The Title is output as it appears in the ProCite record. For example, “The pharmacological basis of therapeutics”.</td>
</tr>
<tr>
<td>Uppercase</td>
<td>The entire title is UPPERCASED. For example, “THE PHARMACOLOGICAL BASIS OF THERAPEUTICS”</td>
</tr>
<tr>
<td>Lowercase</td>
<td>The entire title is lowercased. For example, “the pharmacological basis of therapeutics”.</td>
</tr>
<tr>
<td>Headline</td>
<td>The first word and each significant word in the title (and subtitle) are capitalized. Words not capitalized (unless it is the first word in the title) include specific articles, prepositions, and conjunctions such as: a, an, and, but, by, for, in, into, nor, of, on, or, the, to. For example, “The Pharmacological Basis of Therapeutics”. Note that letters uppercased in the ProCite record will not be lowercased.</td>
</tr>
</tbody>
</table>

In most instances, you should enter your titles and subtitles with sentence capitalization, where the first letter of the first word of the title and subtitle are uppercased, as well as the first letter of all proper nouns. This allows ProCite to correctly apply any of the title case formatting options.
If you plan to always print titles in Headline or Uppercase, you can enter the titles in your records in Headline case. However, since the Headline option will capitalize words but will not lowercase any letters, you should enter your titles with Sentence capitalization if you think you may need to print with a different case at some time. Always capitalize proper nouns.

You may need to edit titles imported into ProCite from other sources, to identify and capitalize proper nouns. Headline capitalization will capitalize words like “from,” “before,” and “between.” You might want to print to a word processor file and edit the file to lowercase these words.

By default, all title fields are set to Unchanged in a new output style.

### Journal Title Formatting

The Journal Title Formatting dialog appears when you select Journals (10) from the Fields menu:

Set the appropriate title case as described in the Title Formatting section above. Since journal titles are typically entered with Headline case, you may want to set Title Case to Unchanged. If there are variations in your records, and you always want journal titles printed in Headline case, you can set Title Case to Headline.

Under Journal List used for substitution, ProCite will display all journal title lists found in the ProCite Lists directory. Select the appropriate list to use for substituting journal titles on output, or select None to print the titles from your records.

When substitution is used, any title in a record that does not find a matching entry in the selected journal title list will be output using the text that appears in the record with the selected Title Case applied. For more information about using journal title lists, see Chapter 18: Building List Files and Chapter 20: Using Alternate Text.
Date Formatting

To specify Date Formatting, select the appropriate Date field from the Fields menu:

- Dates (12)
- Dates (20)
- Dates (21)

ProCite displays the Dates dialog:

Date formatting must be set separately for each Date field in each workform style.

- To print dates as they appear in your records, with no special formatting applied, deselect the Enable Date Formatting check box at the top of the dialog.

- To apply date formatting to output, select the Enable Date Formatting box. Then, set up the appropriate output format as described below.

Any part of the field that is recognized by ProCite as a valid date or range of dates is formatted for output. See Chapter 7: Entering Data Field-by-Field for a list of date formats. If ProCite does not recognize the date, the field text is printed “as is.”
To set up date formatting:

1. Select the output order of the date elements. Use the three drop-down list boxes along the top to select the elements in the order you want them to print. If you are not using all three elements, you can set any of the elements to None. For example, you could set them at:

<table>
<thead>
<tr>
<th>Output Desired</th>
<th>First List</th>
<th>Second List</th>
<th>Third List</th>
</tr>
</thead>
<tbody>
<tr>
<td>month, then day, then year</td>
<td>month</td>
<td>day</td>
<td>year</td>
</tr>
<tr>
<td>month and year</td>
<td>month</td>
<td>year</td>
<td>none</td>
</tr>
<tr>
<td>year only</td>
<td>year</td>
<td>none</td>
<td>none</td>
</tr>
<tr>
<td>year only</td>
<td>none</td>
<td>none</td>
<td>year</td>
</tr>
</tbody>
</table>

2. Enter the appropriate separating text between each date element. For example, you could place a hyphen or slash between each element. Or, you could put a space between the month and day and then a comma and space between day and year.

3. In the Month Format list box, select the appropriate form to be used for Months. The choices are Full, Abbreviated (MLA), 3 characters with no periods, Numeric, or Roman:

<table>
<thead>
<tr>
<th>Full</th>
<th>Abbr.</th>
<th>3 char</th>
<th>Numeric</th>
<th>Roman</th>
</tr>
</thead>
<tbody>
<tr>
<td>January</td>
<td>Jan.</td>
<td>1 or 01</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>February</td>
<td>Feb.</td>
<td>2 or 02</td>
<td>II</td>
<td></td>
</tr>
<tr>
<td>March</td>
<td>Mar.</td>
<td>3 or 03</td>
<td>III</td>
<td></td>
</tr>
<tr>
<td>April</td>
<td>Apr.</td>
<td>4 or 04</td>
<td>IIII</td>
<td></td>
</tr>
<tr>
<td>May</td>
<td>May</td>
<td>5 or 05</td>
<td>V</td>
<td></td>
</tr>
<tr>
<td>June</td>
<td>June</td>
<td>6 or 06</td>
<td>VI</td>
<td></td>
</tr>
<tr>
<td>July</td>
<td>July</td>
<td>7 or 07</td>
<td>VII</td>
<td></td>
</tr>
<tr>
<td>August</td>
<td>Aug.</td>
<td>8 or 08</td>
<td>VIII</td>
<td></td>
</tr>
<tr>
<td>September</td>
<td>Sept.</td>
<td>9 or 09</td>
<td>IX</td>
<td></td>
</tr>
<tr>
<td>October</td>
<td>Oct.</td>
<td>10</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>November</td>
<td>Nov.</td>
<td>11</td>
<td>XI</td>
<td></td>
</tr>
<tr>
<td>December</td>
<td>Dec.</td>
<td>12</td>
<td>XII</td>
<td></td>
</tr>
</tbody>
</table>

If you have not elected to print the month, or if no month was entered into the ProCite record, this setting is ignored.

4. In the Day Format list box, select the appropriate form for days: Numeric or Roman. If you have not elected to print the day, or no day was entered into the ProCite record, this setting is ignored.
5. In the Year Format list box, select the appropriate form for years: 2 digit, 4 digit, or Roman.

Selecting 2 digit will truncate years, such as “97”. Years before 1900 or after 1999 will always output in full, such as "1894" or "2003".

6. Select the Pad Numeric Components with Leading Zeros check box if you want to add a leading zero to expand each numeric day or month number to two digits. For example,

<table>
<thead>
<tr>
<th>Check Box Not Selected</th>
<th>Check Box Selected</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>01</td>
</tr>
<tr>
<td>2</td>
<td>02</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
</tr>
<tr>
<td>12</td>
<td>12</td>
</tr>
</tbody>
</table>

7. Click OK to have your changes take effect.

Extra text in the ProCite field, preceding or following the date, is included in the formatted output, as in:

Copyright (c) 1994
c. 1795
Monday, May 16, 1994
(1994)

The date format for a particular date field is used for each occurrence of that date field in the workform style. If you want to format the same date in two different ways in the same reference, as in:

De Martino, Ernesto

you must enter the date into two different date fields in the ProCite record and format those fields differently.

If a valid date range is recognized in a record, both the starting date and the ending date are formatted, so “Dec-Jan 1992-93” can be printed as:

December 1992 - January 1993

You can override date formatting for an individual record by entering an equal sign “=” as the first character of the date field in the ProCite record. Do this only when you never want date formatting applied to that date, no matter what output style is applied.
Page Numbering

Page number formatting applies only to ProCite field 25 Location in Work. Make formatting changes to each workform style. Access Page Number Formatting by selecting Page Numbers (25) from the Fields menu.

These settings apply only when you enter page numbers correctly in your ProCite records. Always enter full page numbers, as in “170-190”. See Chapter 7: Entering Data Field-by-Field for more information about entering page numbers.

Field Dependent Preceding and Following Text

Some bibliographic styles require you to punctuate references to single pages differently than references to multiple pages. Enter the appropriate Preceding Text or Following Text in the text boxes.

Examples of preceding text:

<table>
<thead>
<tr>
<th>Single Page No. Preceding Text</th>
<th>Page Range Preceding Text</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>p</td>
<td>pp</td>
<td>p 206</td>
</tr>
<tr>
<td></td>
<td></td>
<td>pp 173-196,203</td>
</tr>
<tr>
<td>p.</td>
<td>pp.</td>
<td>p. 206</td>
</tr>
<tr>
<td></td>
<td></td>
<td>pp. 206-8</td>
</tr>
<tr>
<td>P.</td>
<td>Pp.</td>
<td>P. 206</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Pp. 203-27</td>
</tr>
</tbody>
</table>
If the entire element is surrounded by parentheses, as in “(pp. 165-194)”, the parentheses should be entered in the workform style as part of the normal preceding and following punctuation for field 25, and not into the record itself nor the field dependent preceding and following text.

**Page Range Formats**

Use the **Page Range Format** box to choose the output format for page ranges. Click the appropriate radio button. Several examples are shown here so you can see the slight variations between the different styles:

<table>
<thead>
<tr>
<th>Form</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full</td>
<td>52-53, 101-104, 200-203, 558-561, 871-879</td>
</tr>
<tr>
<td>Abbreviated</td>
<td>52-3, 101-4, 200-3, 558-61, 871-9</td>
</tr>
<tr>
<td>Chicago</td>
<td>52-53, 101-4, 200-203, 558-61, 871-79</td>
</tr>
<tr>
<td>MLA</td>
<td>52-53, 101-04, 200-03, 558-61, 871-79</td>
</tr>
<tr>
<td>Start page only</td>
<td>52, 101, 200, 558, 871</td>
</tr>
</tbody>
</table>

**Keywords**

Access the Keyword Formatting dialog by selecting **Keywords (45)** from the **Fields** menu. The Keyword separator indicated here will replace (for output only) the slashes or carriage returns entered as separators between keywords in your ProCite records.

You can choose any character(s) to separate keywords in formatted output, as in:

- Historical Article /History of Medicine, 20th Cent. /Human /Male
- Historical Article ; History of Medicine, 20th Cent. ; Human ; Male

To print each Keyword on a separate line, use caret-l (^l) to insert a line break as the separator or caret-p (^p) to insert a new paragraph.
Chapter 24
Exporting Delimited Records

Overview

Contents

Basic Procedure ................................................................. 471
Setting Export Options ......................................................... 474
  Comma Delimited .......................................................... 475
  Tab Delimited ................................................................ 476
  Custom ........................................................................... 477

Use ProCite’s Export feature to create a delimited text file from a ProCite database. You can then import the delimited file into a different ProCite database or into another database program.

A delimited file format is where each field in a record is in a specific position and is separated by a special character. Some delimited formats also surround each field with a special character. The most common formatting types are Comma Delimited and Tab Delimited, so we have predefined a format for each. You also have the option of creating a custom delimited format.

ProCite allows you to select the type of delimited output you want and the records and fields you want exported.

Basic Procedure

To export records:

1. Mark the records you want to export. Display the Marked Records tab to verify the list of records to be exported.

2. From the Tools menu, select Export Marked Records to display the Export Marked Records dialog:
3. Select the appropriate **Export Format** in the drop-down list:

- **Comma Delimited**, where each field is enclosed in quotation marks and separated from the next field by a comma, and each record ends with a carriage return. Each record includes a field for the workform indicator, a field for a record ID, and all 45 ProCite fields, with empty place holders for fields that either do not contain data or do not exist in the workform.

- **Tab Delimited**, where each field is separated from the next by a tab, and each record ends with a carriage return. Each record includes a field for the workform indicator, a field for a record ID, and then only those fields used in the workform, with empty place holders for fields that do not contain data.

- **Custom**, where ProCite uses custom options. You can specify any single character as a field separator, delimiter, or end-of-record character.

See *Setting Export Options* later in this chapter for more information about selecting the appropriate file format and setting the Custom options.
4. Click on the **Exported Data** tab to determine how much field data is exported.

![Export Marked Records dialog box]

- **Export data for all fields** exports all data from the marked records.

- **Export data only for selected fields** can limit the field data exported from the marked records. Click on the **Select Fields** button and select only those fields whose data you wish to export. For example, you may want to export everything but notes.

You may want to **Export workflow definitions** if the export file will be imported into another ProCite database. A different user may not have your workforms, especially if you have created new workforms or modified the workforms supplied with ProCite.

See *Setting Export Options* later in this chapter for more information about these options.

5. Click **OK**. Since you are exporting records to a Text Only file, ProCite reminds you:

   All styles, including superscript and subscript, are removed from the exported text.

6. Click **OK** to display a file dialog.
7. Type a unique name for the export file and click **Save**. ProCite begins exporting the records, and when done returns you to the database.

Once the process is complete, you can leave ProCite and use the exported text file. You can open the file with your word processor for editing and/or import the file into a different ProCite database or another database system.

### Setting Export Options

To set exporting options, go to the **Tools** menu in ProCite and select **Export Marked Records**. ProCite displays:

![Export Marked Records window](image)

Select the file format that tells ProCite what you want your export file to look like. There are three possible formats from which to choose: Comma Delimited, Tab Delimited, and Custom.

If you are exporting records to share with another ProCite user, you should use the default Comma Delimited format. If you are exporting records for another database system, you must first find out what format that system requires. The exporting options are fully explained under **Custom** at the end of this chapter.
Chapter 24: Exporting Delimited Records

Comma Delimited

The predefined Comma Delimited format exports records with these settings on the Delimited Format tab and the Exported Data tab:

**Fields Separated With:** Commas

**Records Terminated With:** Carriage Returns

**Optional Field Delimiters:** Selected

- Delimit Fields with: ” (double quote)
- Replacement Character: ‘ (single quote)

**Included Fields:**
- Workform Indicators: Selected
- Record IDs: Selected
- All 45 Fields: Selected

**Fields:**
- Export Data For All Fields

**Workform Definitions:**
- Export Workform Definitions: Selected

---

**Note:** If you plan to import into another ProCite database, use the default settings.

This example export file shows the Monograph and Newspaper workform definitions that would appear at the beginning of a file, and then comma delimited records that use those workforms:

```
<Workform Definition>"Monograph","---","---","---","---","---","---","Author, Monographic","Author Role, Monographic","Title, Monographic","---","---","Reprint Status","---","---","Place of Publication","Publisher Name","Date of Publication","---","---","---","---","---","---","Address/Availability","Location/URL","---","---","ISBN","Notes","Abstract","Call Number","Keywords"¶

<Workform Definition>"Newspaper","Author, Analytic","Author Role, Analytic","---","Article Title","Medium Designator","Connective Phrase","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---","---"```
Notice there is a place holder for each of the 45 ProCite fields, whether or not that field exists in the workform.

**Tab Delimited**

The predefined Tab Delimited format exports your records with these settings on the Delimited Format tab and the Exported Data tab:

- **Fields Separated With:** Tabs
- **Records Terminated With:** Carriage Returns
- **Optional Field Delimiters:** NOT Selected
- **Included Fields:** Workform Indicators: Selected, Record IDs: Selected, All 45 Fields: NOT Selected
- **Fields:** Export Data For All Fields
- **Workform Definitions:** Export Workform Definitions: Selected

**Note:** If you plan to import into another ProCite database, it is best to use the default settings.

This example shows the *Monograph* workform definition that would appear at the beginning of the file, and then a tab delimited record that uses the *Monograph* workform:

```
<Workform Definitions>"Monograph","---","---","---","---","---","Author, Monographic","Author Role, Monographic","Title, Monographic","---","---","Reprint Status","---","---","Edition","---","---","Place of Publication","Publisher Name","Date of Publication","---","---","---","---","---","---","---","---","---","---","Address/Availability","Location/URL","---","---","ISBN","Notes","Abstract","Call Number","Keywords"

Monograph

Adams, Alexander, B>>John James Audubon: A Biography

Traces the checkered career of artist and Naturalist, John James Audubon (1785-1851)

```

Notice the delimited record contains only those fields included in the workform indicated. If there is no data for a field, an empty place holder is left.
Custom

You define the custom export format. You can specify any single character as a field separator, delimiter, or end-of-record character. You can use this custom format for minor modifications to the standard formats.

You can change or verify the custom export options on the Export Marked Records dialog. First, set these items on the Delimited Format tab:

Fields Separated With:

Indicate the character that you want to separate each field in your export file. Click on the Comma, Tabs, Carriage Returns, or Other radio button. If you select Other, type a single character in the text box.

Records Terminated With:

Indicate the character that should separate each record in your export file. Click on the Carriage Returns or Other button. If you select Other, type a single character in the text box.
Optional Field Delimiters:

Select the **Delimit Fields** box if you want delimiters in your file. Delimiters enclose individual fields in addition to the field separators. For example, in the default Comma Delimited format, a set of quotation marks (”) encloses each field.

A delimiter may be a character that could appear as punctuation in a record, as in the case with double quotes. For example, a field can contain information in quotation marks—such as a title in the abstract field. This could cause confusion when another program tries to import the file.

With the **Replacement Character** text box, you tell ProCite to export the replacement character whenever it encounters a character in the ProCite field that matches the delimiter. In the predefined Comma Delimited format, any double quotes in your records will be translated to single quotes on export.

Included Fields:

**Workform Indicators:** Select this check box if you want the first field of each record to contain a workform letter or name. ProCite will export the letters A-T for the first twenty workforms listed here and full workform names for all other workforms:

<table>
<thead>
<tr>
<th>Workforms by Letter</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>A</strong> Book Long Form</td>
</tr>
<tr>
<td><strong>B</strong> Book Short Form</td>
</tr>
<tr>
<td><strong>C</strong> Journal Long Form</td>
</tr>
<tr>
<td><strong>D</strong> Journal Short Form</td>
</tr>
<tr>
<td><strong>E</strong> Report</td>
</tr>
<tr>
<td><strong>F</strong> Newspaper</td>
</tr>
<tr>
<td><strong>G</strong> Dissertation</td>
</tr>
<tr>
<td><strong>H</strong> Trade Catalog</td>
</tr>
<tr>
<td><strong>I</strong> Letter</td>
</tr>
<tr>
<td><strong>J</strong> Manuscript</td>
</tr>
<tr>
<td><strong>K</strong> Conference Proceedings</td>
</tr>
<tr>
<td><strong>L</strong> Map</td>
</tr>
<tr>
<td><strong>M</strong> Music Score</td>
</tr>
<tr>
<td><strong>N</strong> Sound Recording</td>
</tr>
<tr>
<td><strong>O</strong> Motion Picture</td>
</tr>
<tr>
<td><strong>P</strong> Audiovisual Material</td>
</tr>
<tr>
<td><strong>Q</strong> Video Recording</td>
</tr>
<tr>
<td><strong>R</strong> Art Work</td>
</tr>
<tr>
<td><strong>S</strong> Computer Program</td>
</tr>
<tr>
<td><strong>T</strong> Data Files</td>
</tr>
</tbody>
</table>
**Record IDs:** Select this check box if you want the export file to include the record ID from each record. ProCite will export the record ID in the first field position (the second field position if you also export a workform indicator).

**All 45 Fields:** Select this check box if you want to export a field for each of the 45 ProCite fields for each record. Empty place holders will represent fields that do not exist in the workform and fields that are in the workform but don’t contain data.

Click on the **Exported Data** tab to determine how much field data is exported:

![Exported Data Tab](image)

**Fields:**

**Export Data For All Fields:** Select this radio button to export all data from the marked records. If a field in your record contains data, that data will be exported to the delimited file.

**Export Data Only For Selected Fields:** Select this radio button to limit the field data exported from the marked records. Click on the **Select Fields** button to display the list of 45 ProCite fields.
Select only those fields whose data you wish to export. For example, if you want to export everything but abstracts, Click on the Select All button to select all fields, then click on the Abstract field to deselect it. Click OK to save the change. Your exported records will contain an empty placeholder for the Abstract field.

**Workform Definitions:**

Select this check box when you want to export workform definitions. This is helpful when a ProCite user will be importing your export file. Another user may not have your workforms, especially if you have created new workforms or modified the workforms supplied with ProCite.

When you are finished setting all exporting options, click the OK button to save changes and display a file dialog. Enter a file name and click Save to begin exporting the Marked records.
Appendix A
Troubleshooting

Overview

Contents

Editing: Fields appear to be missing from my records in the Edit Record window ..................................................... 482
Editing: Workform lists all fields ............................................ 482
Internet Searching: “Failed to Connect...” .............................. 482
Internet Searching: No records were found. ........................... 483
Pressing keys and clicking the mouse has no effect; my computer is locked. ........................................................... 483
Printing: Fields of information are not printing, although my records contain data in those fields. .................................. 483
Printing: Only a few of the records in my record list are marked. When I print marked records, even more records are printed. .................................................................. 484
Printing: Some records print as a blank formatted reference. 484
Startup: I start ProCite, and a List file, Workform, or Output Style opens for editing. ................................................... 484
Startup: I can't start ProCite! ................................................... 485
Toolbars are Missing ............................................................... 485
“Unexpected File Format.” ..................................................... 485
Word Processor: I generated a bibliography in my manuscript, and my in-text citations disappeared. ............... 485
Word Processor: I marked records in my database, but when I tried to Insert Marked Records, a message says, "There are no marked references to insert." .................... 486
Word Processor: "The database (name of database) does not contain the referenced citation." ................................. 486
Word Processor: "Please move the insert point outside of the reference list." ............................................................... 486
Word Processor: ProCite commands do not appear on the Tools menu in My Word Processor. ....................... 486
This appendix describes, in bold text, several error messages and other situations you may encounter while using ProCite along with possible solutions discussed below them. Some items are grouped by what command or part of the program is being used: Editing, Internet Searching, Printing, Startup, or Word Processor.

Editing: Fields appear to be missing from my records in the Edit Record window.

Empty fields have been suppressed. From the View menu, choose Configure Edit Record and make sure Show Empty Fields is selected. This item can suppress the display of all empty fields in your records. A toolbar icon is also available to turn the display of empty fields on or off.

Editing: Workform lists all fields

When you open a record for editing, all 45 ProCite fields appear, and no workform name appears in the workform drop-down list.

The workform used for the record cannot be found. It may have been moved or even deleted. Do one of these:

- Choose Options from the Tools menu. On the File Locations tab, select the appropriate Workforms path where the workform is currently located.
- From the desktop, move the workform to ProCite’s Forms folder.
- Create a new workform with appropriate fields for the records, mark the records that use the unknown workform, then do a Global Change Workform to assign the new workform to those records. Give the workform the original name, so you won’t have to modify output styles to define output for the new workform.

Internet Searching: “Failed to Connect...”

There are various reasons why you may not be able to connect. First, check the modem connection itself. Are you able to use your browser? Are you able to access email messages?

If you have a firewall security system, it may be blocking access to the database you want to search. Your network administrator may be able to allow access simply by enabling the correct port. Other firewalls, known as proxy servers, require additional information. See the section titled Allowing Access Through Firewalls in Chapter 15: Internet Capabilities.
Many databases offered by commercial information providers require an account and password for access (Ovid, OCLC, SilverPlatter, etc.). To gain access to a restricted database, you need to contact the information provider directly to set up an account. Then, modify the host configuration with ProCite to add the additional information.

**Internet Searching: No records were found.**

The list of searchable fields varies between different online hosts, and sometimes even between databases offered by the same host. To make sure you are searching valid fields, first select a single database for searching. On the Internet Search tab, the list of fields to search updates to reflect settings for that database. Enter your search expression and try the search again.

The word or phrase for which you are searching may not be in the correct form for the database you are searching. For example, you may need to enter a journal abbreviation rather than a full journal name. Check the host’s web site or contact the host directly to find out whether you can obtain lists of journal titles, keywords, etc., used in the database.

Your search criteria may be too specific. Search for a more general topic. If you get many matching records, you can narrow the search further.

**Pressing keys and clicking the mouse has no effect; my computer is locked.**

Restart your computer. If your reset keys are locked, turn the power off, wait a few seconds, then turn the power back on. If you had a database open when the lockup occurred, you should rebuild the database.

**Printing: Fields of information are not printing, although my records contain data in those fields.**

Either fields have been suppressed for printing, or your output style does not list those fields to print:

- In the **Configure Bibliography** dialog, check the **Fields** tab. This tab is used to suppress fields from printing.

Make sure the **Short Form** box is not selected and that the appropriate **Optional Fields** are selected to print. The options on this **Fields** tab allow you to print abbreviated references without modifying your output style. You can easily print Notes and Abstracts, and then suppress them the next time you print.
• Bibliographic styles vary as to the type of information to include in a formatted reference, so all styles do not print every ProCite field.

A field of information will not print unless the current output style lists it to print. Open the output style, locate the appropriate workform style for the record, and make sure the field is listed to print.

If a workform style is not set up for a particular workform, the Default workform style is used. You may want to set up a unique workform style for the workform in question.

Printing: Only a few of the records in my record list are marked. When I print marked records, even more records are printed.

You can mark records across record lists. To make sure you see all of the marked records onscreen, display the Marked Records tab before you print. The status line at the bottom of the window indicates how many records are marked.

Before you begin marking a new set of records, make sure you first click the Clear Marked icon on the toolbar.

Printing: Some records print as a blank formatted reference.

If a record does not display any text when viewed in the Preview Pane, or if it is missing when printing a bibliography, there is most likely no workform style defined for the workform used by the record, and the output style has no Default style defined. You must edit the output style to define output for the workform.

Startup: I start ProCite, and a List file, Workform, or Output Style opens for editing.

ProCite can automatically open the last-opened file, whether a database, journal title list, term list, workform, or output style. The last time ProCite was used on your machine, someone opened the output style or list for editing. Simply close the file and pick your database from the list of previously-opened files on the File menu, or choose Open from the File menu to locate and open the database.

To turn off this setting (always starting with the last-opened file), go to the Tools menu and select Options. Deselect the Reload last file option.
StartUp: I can't start ProCite!

ProCite will not start in these situations:

- ProCite may be set to automatically open the last-opened file. If that file is severely damaged, ProCite attempts to open it and stalls. To start the ProCite program only, without the last-opened file, hold down the Shift key during startup.

  You may need to rebuild the database ProCite originally attempted to open.

- You created a shortcut or alias, and the ProCite program was deleted or moved from the folder it accesses. Locate the ProCite program and create a new shortcut or alias.

- You tried to execute ProCite from a network, but the network is not currently connected. If you are using ProCite from a network, make sure the network is connected.

Toolbars are Missing

In ProCite, turn any of the toolbars on or off from the View menu. In your word processor, you can turn the ProCite toolbar on or off.

“Unexpected File Format.”

You have tried to open a file that is either damaged or is not a ProCite 5 file.

An authority list from ProCite 2.x cannot be used directly with ProCite 5. In this case you should create a new term list or journal title list, and use the Import List command to import data from the old authority list.

Word Processor: I generated a bibliography in my manuscript, and my in-text citations disappeared.

When you Generate Bibliography, each linked citation is replaced with formatted text as defined in your output style. When your output style has nothing defined for in-text citations, the linked citation is replaced with nothing. Open your output style and set up a Default In-text Citation format.
Word Processor: I marked records in my database, but when I tried to Insert Marked Records, a message says, "There are no marked references to insert."

An edit record window, output style, or other window is the active window in ProCite. The record list window must be active in ProCite to allow insertion of marked records. Close or minimize the other window(s) to make the record list active.

Word Processor: "The database (name of database) does not contain the referenced citation."

You linked an in-text citation to a record in a ProCite database. Someone later deleted that ProCite record. When you generated a bibliography, ProCite could not find the linked ProCite record.

You must either delete the citation or insert the record in your database, **Revert to Original Text** the in-text citation, and then **Insert** the citation again to update the link.

Word Processor: "Please move the insert point outside of the reference list."

This message appears when you attempt to regenerate a bibliography in a word processor.

Your cursor is inside the bookmark ProCite created at the beginning of the reference list. You can see the bookmark only if field codes are displayed. Move your cursor to the beginning of the document before you regenerate the bibliography.

Word Processor: ProCite commands do not appear on the Tools menu in My Word Processor.

The necessary word processor files were not found. These files are installed when you install ProCite, but you may have installed your word processor after installing ProCite. Run the ProCite installation program again or see *Chapter 2: Installation* for information about how to install word processor support manually.

**Note**: ProCite supports only Microsoft Word for Windows or Macintosh and Corel’s WordPerfect for Windows. Other word processors cannot use the cite while you write features.
Appendix B
ProCite Workforms and Fields

Overview

Each record in a database uses a single workform. Each workform makes use of a subset of the 45 fields available in ProCite. For example, fields 01, 07, 16, and 30 are all author fields, but each is intended for a different type of author. A single workform typically will not include all four of these fields. The workforms listed here are included with ProCite. You can modify them or create any number of new workforms to meet special requirements.

This appendix lists the fields included in each of the workforms supplied with ProCite. Field names can be changed, but field numbers remain constant for searching purposes. So even if you rename an author field, a ProCite search by author will still scan that field.

Supplied Workforms

- Abstract
- Art Work
- Audiovisual Material
- Bill-Resolution
- Book Chapter
- Book Long Form
- Book Short Form
- Book Whole
- Case
- Computer Program
- Conference Proceedings
- Data File
- Dissertation
- Electronic Citation
- Email
- Generic
- Hearing
- In Press
- Journal Article
- Journal Long Form
- Journal Short Form
- Journal Whole
- Letter
- Magazine Article
- Manuscript
- Map
- Monograph
- Motion Picture
- Music Score
- Newspaper
- Patent
- Report
- Sound Recording
- Statute
- Trade Catalog
- Unenacted Bill-Resolution
- Unpublished Work
- Video Recording
- Web Page
<table>
<thead>
<tr>
<th>Abstract</th>
<th>Art Work</th>
<th>Audiovisual Material</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Author(s)</td>
<td>1 Artist</td>
<td>1 Author, Analytic</td>
</tr>
<tr>
<td>2 ———</td>
<td>2 Artist Role</td>
<td>2 Author Role</td>
</tr>
<tr>
<td>3 ———</td>
<td>3 Title</td>
<td>3 ———</td>
</tr>
<tr>
<td>4 Title</td>
<td>4 Title/Subject</td>
<td>4 Title, Analytic</td>
</tr>
<tr>
<td>5 ———</td>
<td>5 Medium</td>
<td>5 Medium Designator</td>
</tr>
<tr>
<td>6 ———</td>
<td>6 Connective Phrase</td>
<td>6 Connective Phrase</td>
</tr>
<tr>
<td>7 ———</td>
<td>7 Author, Monographic</td>
<td>7 Author, Monographic</td>
</tr>
<tr>
<td>8 ———</td>
<td>8 Author Role</td>
<td>8 Author Role</td>
</tr>
<tr>
<td>9 ———</td>
<td>9 Title, Monographic</td>
<td>9 Title, Monographic</td>
</tr>
<tr>
<td>10 ———</td>
<td>10 ———</td>
<td>10 ———</td>
</tr>
<tr>
<td>11 ———</td>
<td>11 ———</td>
<td>11 ———</td>
</tr>
<tr>
<td>12 Reprint Status</td>
<td>12 Reprint Status</td>
<td>12 Reprint Status</td>
</tr>
<tr>
<td>13 ———</td>
<td>13 ———</td>
<td>13 ———</td>
</tr>
<tr>
<td>14 ———</td>
<td>14 Edition</td>
<td>14 Edition</td>
</tr>
<tr>
<td>15 ———</td>
<td>15 ———</td>
<td>15 Edition</td>
</tr>
<tr>
<td>16 ———</td>
<td>16 Place of Publication</td>
<td>16 Author, Subsidiary</td>
</tr>
<tr>
<td>17 ———</td>
<td>17 Publisher Name</td>
<td>17 Author Role</td>
</tr>
<tr>
<td>18 ———</td>
<td>18 Date of Publication</td>
<td>18 Place of Publication</td>
</tr>
<tr>
<td>19 ———</td>
<td>19 Publisher Name</td>
<td>19 Publisher Name</td>
</tr>
<tr>
<td>20 Date of Publication</td>
<td>20 Date of Publication</td>
<td>20 Date of Publication</td>
</tr>
<tr>
<td>21 ———</td>
<td>21 ———</td>
<td>21 ———</td>
</tr>
<tr>
<td>22 Volume ID</td>
<td>22 Volume ID</td>
<td>22 Volume ID</td>
</tr>
<tr>
<td>23 ———</td>
<td>23 ———</td>
<td>23 ———</td>
</tr>
<tr>
<td>24 Issue ID</td>
<td>24 ———</td>
<td>24 ———</td>
</tr>
<tr>
<td>25 Page(s)</td>
<td>25 Location in Work</td>
<td>25 Location in Work</td>
</tr>
<tr>
<td>26 ———</td>
<td>26 ———</td>
<td>26 ———</td>
</tr>
<tr>
<td>27 ———</td>
<td>27 ———</td>
<td>27 ———</td>
</tr>
<tr>
<td>28 Size</td>
<td>28 Size</td>
<td>28 Size</td>
</tr>
<tr>
<td>29 ———</td>
<td>29 ———</td>
<td>29 ———</td>
</tr>
<tr>
<td>30 ———</td>
<td>30 ———</td>
<td>30 ———</td>
</tr>
<tr>
<td>31 ———</td>
<td>31 ———</td>
<td>31 ———</td>
</tr>
<tr>
<td>32 Series Title</td>
<td>32 Series Title</td>
<td>32 Series Title</td>
</tr>
<tr>
<td>33 ———</td>
<td>33 ———</td>
<td>33 ———</td>
</tr>
<tr>
<td>34 ———</td>
<td>34 ———</td>
<td>34 ———</td>
</tr>
<tr>
<td>35 ———</td>
<td>35 ———</td>
<td>35 ———</td>
</tr>
<tr>
<td>36 Connective Phrase</td>
<td>36 Connective Phrase</td>
<td>36 Connective Phrase</td>
</tr>
<tr>
<td>37 Address/Availability</td>
<td>37 Address/Availability</td>
<td>37 Address/Availability</td>
</tr>
<tr>
<td>38 Location/URL</td>
<td>38 Location/URL</td>
<td>38 Location/URL</td>
</tr>
<tr>
<td>39 ———</td>
<td>39 ———</td>
<td>39 ———</td>
</tr>
<tr>
<td>40 ———</td>
<td>40 ———</td>
<td>40 ———</td>
</tr>
<tr>
<td>41 ———</td>
<td>41 ———</td>
<td>41 ———</td>
</tr>
<tr>
<td>42 Notes</td>
<td>42 Notes</td>
<td>42 Notes</td>
</tr>
<tr>
<td>43 Abstract</td>
<td>43 Abstract</td>
<td>43 Abstract</td>
</tr>
<tr>
<td>44 Call Number</td>
<td>44 Call Number</td>
<td>44 Call Number</td>
</tr>
<tr>
<td>45 Keywords</td>
<td>45 Keywords</td>
<td>45 Keywords</td>
</tr>
<tr>
<td>Bill-Resolution</td>
<td>Book Chapter</td>
<td>Book Long Form</td>
</tr>
<tr>
<td>-------------------------</td>
<td>----------------------------------------</td>
<td>--------------------------------------</td>
</tr>
<tr>
<td>1 Author(s)</td>
<td>1 Author, Analytic</td>
<td>1 Author, Analytic</td>
</tr>
<tr>
<td>2 ____</td>
<td>2 ____</td>
<td>2 Author Role</td>
</tr>
<tr>
<td>3 ____</td>
<td>3 ____</td>
<td>3 ____</td>
</tr>
<tr>
<td>4 Act Name</td>
<td>4 Title, Analytic</td>
<td>4 Title, Analytic</td>
</tr>
<tr>
<td>5 ____</td>
<td>5 Medium Designator</td>
<td>5 Medium Designator</td>
</tr>
<tr>
<td>6 ____</td>
<td>6 Connective Phrase</td>
<td>6 Connective Phrase</td>
</tr>
<tr>
<td>7 ____</td>
<td>7 Author, Monographic</td>
<td>7 Author, Monographic</td>
</tr>
<tr>
<td>8 ____</td>
<td>8 Author Role</td>
<td>8 Author Role</td>
</tr>
<tr>
<td>9 ____</td>
<td>9 Title, Monographic</td>
<td>9 Title, Monographic</td>
</tr>
<tr>
<td>10 ____</td>
<td>10 ____</td>
<td>10 ____</td>
</tr>
<tr>
<td>11 ____</td>
<td>11 ____</td>
<td>11 ____</td>
</tr>
<tr>
<td>12 Reprint Status</td>
<td>12 Reprint Status</td>
<td>12 Reprint Status</td>
</tr>
<tr>
<td>13 ____</td>
<td>13 ____</td>
<td>13 ____</td>
</tr>
<tr>
<td>14 ____</td>
<td>14 ____</td>
<td>14 ____</td>
</tr>
<tr>
<td>15 ____</td>
<td>15 Edition</td>
<td>15 Edition</td>
</tr>
<tr>
<td>16 ____</td>
<td>16 ____</td>
<td>16 ____</td>
</tr>
<tr>
<td>17 ____</td>
<td>17 ____</td>
<td>17 ____</td>
</tr>
<tr>
<td>18 Code</td>
<td>18 Place of Publication</td>
<td>18 Place of Publication</td>
</tr>
<tr>
<td>19 ____</td>
<td>19 Publisher Name</td>
<td>19 Publisher Name</td>
</tr>
<tr>
<td>20 Date of Code</td>
<td>20 Date of Publication</td>
<td>20 Date of Publication</td>
</tr>
<tr>
<td>21 ____</td>
<td>21 ____</td>
<td>21 ____</td>
</tr>
<tr>
<td>22 Bill/Res Number</td>
<td>22 Volume ID</td>
<td>22 Volume ID</td>
</tr>
<tr>
<td>23 ____</td>
<td>23 ____</td>
<td>23 ____</td>
</tr>
<tr>
<td>24 ____</td>
<td>24 Issue ID</td>
<td>24 Issue ID</td>
</tr>
<tr>
<td>25 Section(s)</td>
<td>25 Page(s)</td>
<td>25 Page(s)</td>
</tr>
<tr>
<td>26 ____</td>
<td>26 ____</td>
<td>26 ____</td>
</tr>
<tr>
<td>27 ____</td>
<td>27 ____</td>
<td>27 ____</td>
</tr>
<tr>
<td>28 ____</td>
<td>28 ____</td>
<td>28 ____</td>
</tr>
<tr>
<td>29 ____</td>
<td>29 ____</td>
<td>29 ____</td>
</tr>
<tr>
<td>30 ____</td>
<td>30 Series Editor</td>
<td>30 Series Editor</td>
</tr>
<tr>
<td>31 ____</td>
<td>31 Series Editor Role</td>
<td>31 Series Editor Role</td>
</tr>
<tr>
<td>32 ____</td>
<td>32 Series Title</td>
<td>32 Series Title</td>
</tr>
<tr>
<td>33 ____</td>
<td>33 Series Volume Identification</td>
<td>33 Series Volume ID</td>
</tr>
<tr>
<td>34 ____</td>
<td>34 Series Issue Identification</td>
<td>34 ____</td>
</tr>
<tr>
<td>35 ____</td>
<td>35 ____</td>
<td>35 ____</td>
</tr>
<tr>
<td>36 ____</td>
<td>36 Connective Phrase</td>
<td>36 ____</td>
</tr>
<tr>
<td>37 Address/Availability</td>
<td>37 Address/Availability</td>
<td>37 Address/Availability</td>
</tr>
<tr>
<td>38 Location/URL</td>
<td>38 Location/URL</td>
<td>38 Location/URL</td>
</tr>
<tr>
<td>39 ____</td>
<td>39 ____</td>
<td>39 ____</td>
</tr>
<tr>
<td>40 ____</td>
<td>40 ____</td>
<td>40 ____</td>
</tr>
<tr>
<td>41 ____</td>
<td>41 ____</td>
<td>41 ____</td>
</tr>
<tr>
<td>42 Notes</td>
<td>42 Notes</td>
<td>42 Notes</td>
</tr>
<tr>
<td>43 Abstract</td>
<td>43 Abstract</td>
<td>43 Abstract</td>
</tr>
<tr>
<td>44 Call Number</td>
<td>44 Call Number</td>
<td>44 Call Number</td>
</tr>
<tr>
<td>45 Keywords</td>
<td>45 Keywords</td>
<td>45 Keywords</td>
</tr>
<tr>
<td>Book Short Form</td>
<td>Book Whole</td>
<td>Case</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------</td>
<td>------</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>4</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>5</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>6</td>
<td>6</td>
<td>6</td>
</tr>
<tr>
<td>7</td>
<td>7</td>
<td>7</td>
</tr>
<tr>
<td>8</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>9</td>
<td>9</td>
<td>9</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>10</td>
</tr>
<tr>
<td>11</td>
<td>11</td>
<td>11</td>
</tr>
<tr>
<td>12</td>
<td>12</td>
<td>12</td>
</tr>
<tr>
<td>13</td>
<td>13</td>
<td>13</td>
</tr>
<tr>
<td>14</td>
<td>14</td>
<td>14</td>
</tr>
<tr>
<td>15</td>
<td>15</td>
<td>15</td>
</tr>
<tr>
<td>16</td>
<td>16</td>
<td>16</td>
</tr>
<tr>
<td>17</td>
<td>17</td>
<td>17</td>
</tr>
<tr>
<td>18</td>
<td>18</td>
<td>18</td>
</tr>
<tr>
<td>19</td>
<td>19</td>
<td>19</td>
</tr>
<tr>
<td>20</td>
<td>20</td>
<td>20</td>
</tr>
<tr>
<td>21</td>
<td>21</td>
<td>21</td>
</tr>
<tr>
<td>22</td>
<td>22</td>
<td>22</td>
</tr>
<tr>
<td>23</td>
<td>23</td>
<td>23</td>
</tr>
<tr>
<td>24</td>
<td>24</td>
<td>24</td>
</tr>
<tr>
<td>25</td>
<td>25</td>
<td>25</td>
</tr>
<tr>
<td>26</td>
<td>26</td>
<td>26</td>
</tr>
<tr>
<td>27</td>
<td>27</td>
<td>27</td>
</tr>
<tr>
<td>28</td>
<td>28</td>
<td>28</td>
</tr>
<tr>
<td>29</td>
<td>29</td>
<td>29</td>
</tr>
<tr>
<td>30</td>
<td>30</td>
<td>30</td>
</tr>
<tr>
<td>31</td>
<td>31</td>
<td>31</td>
</tr>
<tr>
<td>32</td>
<td>32</td>
<td>32</td>
</tr>
<tr>
<td>33</td>
<td>33</td>
<td>33</td>
</tr>
<tr>
<td>34</td>
<td>34</td>
<td>34</td>
</tr>
<tr>
<td>35</td>
<td>35</td>
<td>35</td>
</tr>
<tr>
<td>36</td>
<td>36</td>
<td>36</td>
</tr>
<tr>
<td>37</td>
<td>37</td>
<td>37</td>
</tr>
<tr>
<td>38</td>
<td>38</td>
<td>38</td>
</tr>
<tr>
<td>39</td>
<td>39</td>
<td>39</td>
</tr>
<tr>
<td>40</td>
<td>40</td>
<td>40</td>
</tr>
<tr>
<td>41</td>
<td>41</td>
<td>41</td>
</tr>
<tr>
<td>42</td>
<td>42</td>
<td>42</td>
</tr>
<tr>
<td>43</td>
<td>43</td>
<td>43</td>
</tr>
<tr>
<td>44</td>
<td>44</td>
<td>44</td>
</tr>
<tr>
<td>45</td>
<td>45</td>
<td>45</td>
</tr>
<tr>
<td>Computer Program</td>
<td>Conference Proceedings</td>
<td>Data File</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>1</td>
<td>Author, Analytic</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>Author Role</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>Author Affiliation</td>
<td>3</td>
</tr>
<tr>
<td>4</td>
<td>Paper/Section Title</td>
<td>4</td>
</tr>
<tr>
<td>5</td>
<td>Medium Designator</td>
<td>5</td>
</tr>
<tr>
<td>6</td>
<td>Connective Phrase</td>
<td>6</td>
</tr>
<tr>
<td>7</td>
<td>Editor/Compiler</td>
<td>7</td>
</tr>
<tr>
<td>8</td>
<td>Editor/Compiler Role</td>
<td>8</td>
</tr>
<tr>
<td>9</td>
<td>Proceedings Title</td>
<td>9</td>
</tr>
<tr>
<td>10</td>
<td>Proceedings Title</td>
<td>10</td>
</tr>
<tr>
<td>11</td>
<td>Title</td>
<td>11</td>
</tr>
<tr>
<td>12</td>
<td>Reprint Status</td>
<td>12</td>
</tr>
<tr>
<td>13</td>
<td>Date of Meeting</td>
<td>13</td>
</tr>
<tr>
<td>14</td>
<td>Place of Meeting</td>
<td>14</td>
</tr>
<tr>
<td>15</td>
<td>Version</td>
<td>15</td>
</tr>
<tr>
<td>16</td>
<td>Place of Publication</td>
<td>16</td>
</tr>
<tr>
<td>17</td>
<td>Publisher Name</td>
<td>17</td>
</tr>
<tr>
<td>18</td>
<td>Date of Publication</td>
<td>18</td>
</tr>
<tr>
<td>19</td>
<td>Date of Copyright</td>
<td>19</td>
</tr>
<tr>
<td>20</td>
<td>Date of Copyright</td>
<td>20</td>
</tr>
<tr>
<td>21</td>
<td>Place of Publication</td>
<td>21</td>
</tr>
<tr>
<td>22</td>
<td>Publisher Name</td>
<td>22</td>
</tr>
<tr>
<td>23</td>
<td>Date of Publication</td>
<td>23</td>
</tr>
<tr>
<td>24</td>
<td>Date of Copyright</td>
<td>24</td>
</tr>
<tr>
<td>25</td>
<td>Location in Work</td>
<td>25</td>
</tr>
<tr>
<td>26</td>
<td>Extent of Work</td>
<td>26</td>
</tr>
<tr>
<td>27</td>
<td>Packaging Method</td>
<td>27</td>
</tr>
<tr>
<td>28</td>
<td>Packaging Method</td>
<td>28</td>
</tr>
<tr>
<td>29</td>
<td>Series Editor</td>
<td>29</td>
</tr>
<tr>
<td>30</td>
<td>Series Editor Role</td>
<td>30</td>
</tr>
<tr>
<td>31</td>
<td>Series Title</td>
<td>31</td>
</tr>
<tr>
<td>32</td>
<td>Series Volume ID</td>
<td>32</td>
</tr>
<tr>
<td>33</td>
<td>Series Volume ID</td>
<td>33</td>
</tr>
<tr>
<td>34</td>
<td>Series Title</td>
<td>34</td>
</tr>
<tr>
<td>35</td>
<td>Series Volume ID</td>
<td>35</td>
</tr>
<tr>
<td>36</td>
<td>Connective Phrase</td>
<td>36</td>
</tr>
<tr>
<td>37</td>
<td>Address/Availability</td>
<td>37</td>
</tr>
<tr>
<td>38</td>
<td>Location/URL</td>
<td>38</td>
</tr>
<tr>
<td>39</td>
<td>Location/URL</td>
<td>39</td>
</tr>
<tr>
<td>40</td>
<td>Notes</td>
<td>40</td>
</tr>
<tr>
<td>41</td>
<td>ISBN</td>
<td>41</td>
</tr>
<tr>
<td>42</td>
<td>Notes</td>
<td>42</td>
</tr>
<tr>
<td>43</td>
<td>Abstract</td>
<td>43</td>
</tr>
<tr>
<td>44</td>
<td>Call Number</td>
<td>44</td>
</tr>
<tr>
<td>45</td>
<td>Keywords</td>
<td>45</td>
</tr>
<tr>
<td>Dissertation</td>
<td>Electronic Citation</td>
<td>Email</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------------</td>
<td>-------</td>
</tr>
<tr>
<td>1 Author, Analytic</td>
<td>1 Author(s)</td>
<td>1 Author(s)</td>
</tr>
<tr>
<td>2 ———</td>
<td>2 ———</td>
<td>2 Author E-mail</td>
</tr>
<tr>
<td>3 ———</td>
<td>3 ———</td>
<td>3 Author Affiliation</td>
</tr>
<tr>
<td>4 Title, Analytic</td>
<td>4 Title</td>
<td>4 Subject</td>
</tr>
<tr>
<td>5 Medium Designator</td>
<td>5 Medium</td>
<td>5 ———</td>
</tr>
<tr>
<td>6 ———</td>
<td>6 ———</td>
<td>6 ———</td>
</tr>
<tr>
<td>7 ———</td>
<td>7 Editors</td>
<td>7 Recipient</td>
</tr>
<tr>
<td>8 ———</td>
<td>8 ———</td>
<td>8 Recipient E-mail</td>
</tr>
<tr>
<td>9 ———</td>
<td>9 ———</td>
<td>9 ———</td>
</tr>
<tr>
<td>10 ———</td>
<td>10 Source</td>
<td>10 ———</td>
</tr>
<tr>
<td>11 ———</td>
<td>11 ———</td>
<td>11 ———</td>
</tr>
<tr>
<td>12 Reprint Status</td>
<td>12 Reprint Status</td>
<td>12 Reprint Status</td>
</tr>
<tr>
<td>13 ———</td>
<td>13 ———</td>
<td>13 ———</td>
</tr>
<tr>
<td>14 ———</td>
<td>14 ———</td>
<td>14 ———</td>
</tr>
<tr>
<td>15 ———</td>
<td>15 Edition</td>
<td>15 ———</td>
</tr>
<tr>
<td>16 ———</td>
<td>16 ———</td>
<td>16 ———</td>
</tr>
<tr>
<td>17 ———</td>
<td>17 ———</td>
<td>17 ———</td>
</tr>
<tr>
<td>18 Place of Publication</td>
<td>18 ———</td>
<td>18 ———</td>
</tr>
<tr>
<td>19 University</td>
<td>19 Publisher Name</td>
<td>19 ———</td>
</tr>
<tr>
<td>20 Date of Publication</td>
<td>20 Last Update</td>
<td>20 Date of Message</td>
</tr>
<tr>
<td>21 Date of Copyright</td>
<td>21 Access Date</td>
<td>21 ———</td>
</tr>
<tr>
<td>22 ———</td>
<td>22 Volume ID</td>
<td>22 ———</td>
</tr>
<tr>
<td>23 ———</td>
<td>23 ———</td>
<td>23 ———</td>
</tr>
<tr>
<td>24 ———</td>
<td>24 ———</td>
<td>24 ———</td>
</tr>
<tr>
<td>25 ———</td>
<td>25 Page(s)</td>
<td>25 ———</td>
</tr>
<tr>
<td>26 ———</td>
<td>26 ———</td>
<td>26 ———</td>
</tr>
<tr>
<td>27 ———</td>
<td>27 ———</td>
<td>27 ———</td>
</tr>
<tr>
<td>28 ———</td>
<td>28 ———</td>
<td>28 ———</td>
</tr>
<tr>
<td>29 ———</td>
<td>29 ———</td>
<td>29 ———</td>
</tr>
<tr>
<td>30 ———</td>
<td>30 ———</td>
<td>30 ———</td>
</tr>
<tr>
<td>31 ———</td>
<td>31 ———</td>
<td>31 ———</td>
</tr>
<tr>
<td>32 ———</td>
<td>32 ———</td>
<td>32 ———</td>
</tr>
<tr>
<td>33 ———</td>
<td>33 ———</td>
<td>33 ———</td>
</tr>
<tr>
<td>34 ———</td>
<td>34 ———</td>
<td>34 ———</td>
</tr>
<tr>
<td>35 ———</td>
<td>35 ———</td>
<td>35 ———</td>
</tr>
<tr>
<td>36 Connective Phrase</td>
<td>36 ———</td>
<td>36 ———</td>
</tr>
<tr>
<td>37 Address/Availability</td>
<td>37 Address/Availability</td>
<td>37 Address/Availability</td>
</tr>
<tr>
<td>38 Location/URL</td>
<td>38 Location/URL</td>
<td>38 Location/URL</td>
</tr>
<tr>
<td>39 ———</td>
<td>39 ———</td>
<td>39 ———</td>
</tr>
<tr>
<td>40 ———</td>
<td>40 ———</td>
<td>40 ———</td>
</tr>
<tr>
<td>41 ———</td>
<td>41 ———</td>
<td>41 ———</td>
</tr>
<tr>
<td>42 Notes</td>
<td>42 Notes</td>
<td>42 Notes</td>
</tr>
<tr>
<td>43 Abstract</td>
<td>43 Abstract</td>
<td>43 Abstract</td>
</tr>
<tr>
<td>44 Call Number</td>
<td>44 Call Number</td>
<td>44 Call Number</td>
</tr>
<tr>
<td>45 Keywords</td>
<td>45 Keywords</td>
<td>45 Keywords</td>
</tr>
<tr>
<td>Generic</td>
<td>Hearing</td>
<td>In Press</td>
</tr>
<tr>
<td>---------</td>
<td>---------</td>
<td>----------</td>
</tr>
<tr>
<td>1 Author, Analytic</td>
<td>1 Author(s)</td>
<td>1 Author(s)</td>
</tr>
<tr>
<td>2 ———</td>
<td>2 Author Role</td>
<td>2 ———</td>
</tr>
<tr>
<td>3 ———</td>
<td>3 Author Affiliation</td>
<td>3 ———</td>
</tr>
<tr>
<td>4 Title, Analytic</td>
<td>4 Title</td>
<td>4 Title</td>
</tr>
<tr>
<td>5 ———</td>
<td>5 Medium Designator</td>
<td>5 ———</td>
</tr>
<tr>
<td>6 ———</td>
<td>6 ———</td>
<td>6 ———</td>
</tr>
<tr>
<td>7 Author, Monographic</td>
<td>7 ———</td>
<td>7 ———</td>
</tr>
<tr>
<td>8 ———</td>
<td>8 ———</td>
<td>8 ———</td>
</tr>
<tr>
<td>9 Title, Monographic</td>
<td>9 ———</td>
<td>9 ———</td>
</tr>
<tr>
<td>10 Journal Title</td>
<td>10 ———</td>
<td>10 Journal Title</td>
</tr>
<tr>
<td>11 ———</td>
<td>11 ———</td>
<td>11 ———</td>
</tr>
<tr>
<td>12 Reprint Status</td>
<td>12 Reprint Status</td>
<td>12 Reprint Status</td>
</tr>
<tr>
<td>13 ———</td>
<td>13 ———</td>
<td>13 ———</td>
</tr>
<tr>
<td>14 ———</td>
<td>14 ———</td>
<td>14 ———</td>
</tr>
<tr>
<td>15 ———</td>
<td>15 ———</td>
<td>15 ———</td>
</tr>
<tr>
<td>16 ———</td>
<td>16 ———</td>
<td>16 ———</td>
</tr>
<tr>
<td>17 ———</td>
<td>17 ———</td>
<td>17 ———</td>
</tr>
<tr>
<td>18 Place of Publication</td>
<td>18 Committee</td>
<td>18 ———</td>
</tr>
<tr>
<td>19 Publisher Name</td>
<td>19 Subcommittee</td>
<td>19 ———</td>
</tr>
<tr>
<td>20 Date of Publication</td>
<td>20 Hearing Date</td>
<td>20 ———</td>
</tr>
<tr>
<td>21 Date of Copyright</td>
<td>21 Date</td>
<td>21 ———</td>
</tr>
<tr>
<td>22 Volume ID</td>
<td>22 Bill Number</td>
<td>22 ———</td>
</tr>
<tr>
<td>23 ———</td>
<td>23 ———</td>
<td>23 ———</td>
</tr>
<tr>
<td>24 Issue ID</td>
<td>24 Issue ID</td>
<td>24 ———</td>
</tr>
<tr>
<td>25 Location in Work</td>
<td>25 Location in Work</td>
<td>25 ———</td>
</tr>
<tr>
<td>26 ———</td>
<td>26 ———</td>
<td>26 ———</td>
</tr>
<tr>
<td>27 ———</td>
<td>27 ———</td>
<td>27 ———</td>
</tr>
<tr>
<td>28 ———</td>
<td>28 ———</td>
<td>28 ———</td>
</tr>
<tr>
<td>29 ———</td>
<td>29 ———</td>
<td>29 ———</td>
</tr>
<tr>
<td>30 Series Editor</td>
<td>30 ———</td>
<td>30 ———</td>
</tr>
<tr>
<td>31 ———</td>
<td>31 ———</td>
<td>31 ———</td>
</tr>
<tr>
<td>32 Series Title</td>
<td>32 ———</td>
<td>32 ———</td>
</tr>
<tr>
<td>33 ———</td>
<td>33 ———</td>
<td>33 ———</td>
</tr>
<tr>
<td>34 ———</td>
<td>34 ———</td>
<td>34 ———</td>
</tr>
<tr>
<td>35 ———</td>
<td>35 ———</td>
<td>35 ———</td>
</tr>
<tr>
<td>36 ———</td>
<td>36 ———</td>
<td>36 ———</td>
</tr>
<tr>
<td>37 Address/Availability</td>
<td>37 Address/Availability</td>
<td>37 Address/Availability</td>
</tr>
<tr>
<td>38 Location/URL</td>
<td>38 Location/URL</td>
<td>38 Location/URL</td>
</tr>
<tr>
<td>39 ———</td>
<td>39 ———</td>
<td>39 ———</td>
</tr>
<tr>
<td>40 ISSN</td>
<td>40 ———</td>
<td>40 ———</td>
</tr>
<tr>
<td>41 ———</td>
<td>41 ———</td>
<td>41 ———</td>
</tr>
<tr>
<td>42 Notes</td>
<td>42 Notes</td>
<td>42 Notes</td>
</tr>
<tr>
<td>43 Abstract</td>
<td>43 Abstract</td>
<td>43 Abstract</td>
</tr>
<tr>
<td>44 Call Number</td>
<td>44 Call Number</td>
<td>44 Call Number</td>
</tr>
<tr>
<td>45 Keywords</td>
<td>45 Keywords</td>
<td>45 Keywords</td>
</tr>
<tr>
<td>Journal Article</td>
<td>Journal Long Form</td>
<td>Journal Short Form</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>1 Author, Analytic</td>
<td>1 Author, Analytic</td>
<td>1 Author, Analytic</td>
</tr>
<tr>
<td>2 ———</td>
<td>2 Author Role</td>
<td>2 ———</td>
</tr>
<tr>
<td>3 ———</td>
<td>3 Author Affiliation</td>
<td>3 ———</td>
</tr>
<tr>
<td>4 Article Title</td>
<td>4 Article Title</td>
<td>4 Article Title</td>
</tr>
<tr>
<td>5 Medium Designator</td>
<td>5 Medium Designator</td>
<td>5 ———</td>
</tr>
<tr>
<td>6 Connective Phrase</td>
<td>6 Connective Phrase</td>
<td>6 ———</td>
</tr>
<tr>
<td>7 ———</td>
<td>7 Author, Monographic</td>
<td>7 ———</td>
</tr>
<tr>
<td>8 ———</td>
<td>8 Author Role</td>
<td>8 ———</td>
</tr>
<tr>
<td>9 ———</td>
<td>9 ———</td>
<td>9 ———</td>
</tr>
<tr>
<td>10 Journal Title</td>
<td>10 Journal Title</td>
<td>10 Journal Title</td>
</tr>
<tr>
<td>11 Translated Title</td>
<td>11 Reprint Status</td>
<td>11 ———</td>
</tr>
<tr>
<td>12 Reprint Status</td>
<td>12 Reprint Status</td>
<td>12 ———</td>
</tr>
<tr>
<td>13 ———</td>
<td>13 ———</td>
<td>13 ———</td>
</tr>
<tr>
<td>14 ———</td>
<td>14 ———</td>
<td>14 ———</td>
</tr>
<tr>
<td>15 ———</td>
<td>15 ———</td>
<td>15 ———</td>
</tr>
<tr>
<td>16 ———</td>
<td>16 ———</td>
<td>16 ———</td>
</tr>
<tr>
<td>17 ———</td>
<td>17 ———</td>
<td>17 ———</td>
</tr>
<tr>
<td>18 ———</td>
<td>18 ———</td>
<td>18 ———</td>
</tr>
<tr>
<td>19 ———</td>
<td>19 ———</td>
<td>19 ———</td>
</tr>
<tr>
<td>20 Date of Publication</td>
<td>20 Date of Publication</td>
<td>20 Date of Publication</td>
</tr>
<tr>
<td>21 ———</td>
<td>21 ———</td>
<td>21 ———</td>
</tr>
<tr>
<td>22 Volume ID</td>
<td>22 Volume ID</td>
<td>22 Volume ID</td>
</tr>
<tr>
<td>23 ———</td>
<td>23 ———</td>
<td>23 ———</td>
</tr>
<tr>
<td>24 Issue ID</td>
<td>24 Issue ID</td>
<td>24 Issue ID</td>
</tr>
<tr>
<td>25 Page(s)</td>
<td>25 Page(s)</td>
<td>25 Page(s)</td>
</tr>
<tr>
<td>26 ———</td>
<td>26 ———</td>
<td>26 ———</td>
</tr>
<tr>
<td>27 ———</td>
<td>27 ———</td>
<td>27 ———</td>
</tr>
<tr>
<td>28 ———</td>
<td>28 ———</td>
<td>28 ———</td>
</tr>
<tr>
<td>29 ———</td>
<td>29 ———</td>
<td>29 ———</td>
</tr>
<tr>
<td>30 ———</td>
<td>30 ———</td>
<td>30 ———</td>
</tr>
<tr>
<td>31 ———</td>
<td>31 ———</td>
<td>31 ———</td>
</tr>
<tr>
<td>32 ———</td>
<td>32 ———</td>
<td>32 ———</td>
</tr>
<tr>
<td>33 ———</td>
<td>33 ———</td>
<td>33 ———</td>
</tr>
<tr>
<td>34 ———</td>
<td>34 ———</td>
<td>34 ———</td>
</tr>
<tr>
<td>35 ———</td>
<td>35 ———</td>
<td>35 ———</td>
</tr>
<tr>
<td>36 ———</td>
<td>36 ———</td>
<td>36 ———</td>
</tr>
<tr>
<td>37 Address/Availability</td>
<td>37 Address/Availability</td>
<td>37 Address/Availability</td>
</tr>
<tr>
<td>38 Location/URL</td>
<td>38 Location/URL</td>
<td>38 Location/URL</td>
</tr>
<tr>
<td>39 ———</td>
<td>39 CODEN</td>
<td>39 ———</td>
</tr>
<tr>
<td>40 ISSN</td>
<td>40 ISSN</td>
<td>40 ISSN</td>
</tr>
<tr>
<td>41 ———</td>
<td>41 ———</td>
<td>41 ———</td>
</tr>
<tr>
<td>42 Notes</td>
<td>42 Notes</td>
<td>42 Notes</td>
</tr>
<tr>
<td>43 Abstract</td>
<td>43 Abstract</td>
<td>43 Abstract</td>
</tr>
<tr>
<td>44 Call Number</td>
<td>44 Call Number</td>
<td>44 Call Number</td>
</tr>
<tr>
<td>45 Keywords</td>
<td>45 Keywords</td>
<td>45 Keywords</td>
</tr>
<tr>
<td>Journal Whole</td>
<td>Letter</td>
<td>Magazine Article</td>
</tr>
<tr>
<td>---------------</td>
<td>--------</td>
<td>-----------------</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>4</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>5</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>6</td>
<td>6</td>
<td>6</td>
</tr>
<tr>
<td>7 Editor</td>
<td>7 Recipient</td>
<td>7 Recipient</td>
</tr>
<tr>
<td>8</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>9</td>
<td>9</td>
<td>9</td>
</tr>
<tr>
<td>10 Journal Title</td>
<td>10</td>
<td>10 Magazine Title</td>
</tr>
<tr>
<td>11</td>
<td>11</td>
<td>11</td>
</tr>
<tr>
<td>12 Reprint Status</td>
<td>12 Reprint Status</td>
<td>12 Reprint Status</td>
</tr>
<tr>
<td>13</td>
<td>13</td>
<td>13</td>
</tr>
<tr>
<td>14 Medium Designator</td>
<td>14</td>
<td>14</td>
</tr>
<tr>
<td>15 Edition</td>
<td>15</td>
<td>15</td>
</tr>
<tr>
<td>16</td>
<td>16</td>
<td>16</td>
</tr>
<tr>
<td>17</td>
<td>17</td>
<td>17</td>
</tr>
<tr>
<td>18 Place of Publication</td>
<td>18 Place of Publication</td>
<td>18 Place of Publication</td>
</tr>
<tr>
<td>19 Publisher Name</td>
<td>19 Date of Letter</td>
<td>19 Publisher Name</td>
</tr>
<tr>
<td>20 Date of Publication</td>
<td>20 Date of Letter</td>
<td>20 Date of Publication</td>
</tr>
<tr>
<td>21</td>
<td>21</td>
<td>21</td>
</tr>
<tr>
<td>22 Volume ID</td>
<td>22</td>
<td>22</td>
</tr>
<tr>
<td>23</td>
<td>23</td>
<td>23</td>
</tr>
<tr>
<td>24 Issue ID</td>
<td>24</td>
<td>24</td>
</tr>
<tr>
<td>25</td>
<td>25</td>
<td>25</td>
</tr>
<tr>
<td>26 Extent of Work</td>
<td>26 Extent of Letter</td>
<td>26 Extent of Letter</td>
</tr>
<tr>
<td>27 Packaging Method</td>
<td>27 Packaging Method</td>
<td>27 Packaging Method</td>
</tr>
<tr>
<td>28</td>
<td>28</td>
<td>28</td>
</tr>
<tr>
<td>29 Frequency of Publication</td>
<td>29</td>
<td>29</td>
</tr>
<tr>
<td>30</td>
<td>30</td>
<td>30</td>
</tr>
<tr>
<td>31</td>
<td>31</td>
<td>31</td>
</tr>
<tr>
<td>32</td>
<td>32</td>
<td>32</td>
</tr>
<tr>
<td>33</td>
<td>33</td>
<td>33</td>
</tr>
<tr>
<td>34</td>
<td>34</td>
<td>34</td>
</tr>
<tr>
<td>35</td>
<td>35</td>
<td>35</td>
</tr>
<tr>
<td>36 Connective Phrase</td>
<td>36 Connective Phrase</td>
<td>36 Connective Phrase</td>
</tr>
<tr>
<td>37 Address/Availability</td>
<td>37 Address/Availability</td>
<td>37 Address/Availability</td>
</tr>
<tr>
<td>38 Location/URL</td>
<td>38 Location/URL</td>
<td>38 Location/URL</td>
</tr>
<tr>
<td>39 CODEN</td>
<td>39</td>
<td>39</td>
</tr>
<tr>
<td>40 ISSN</td>
<td>40</td>
<td>40</td>
</tr>
<tr>
<td>41</td>
<td>41</td>
<td>41</td>
</tr>
<tr>
<td>42 Notes</td>
<td>42 Notes</td>
<td>42 Notes</td>
</tr>
<tr>
<td>43 Abstract</td>
<td>43 Abstract</td>
<td>43 Abstract</td>
</tr>
<tr>
<td>44 Call Number</td>
<td>44 Call Number</td>
<td>44 Call Number</td>
</tr>
<tr>
<td>45 Keywords</td>
<td>45 Keywords</td>
<td>45 Keywords</td>
</tr>
<tr>
<td>Manuscript</td>
<td>Map</td>
<td>Monograph</td>
</tr>
<tr>
<td>------------</td>
<td>-----</td>
<td>-----------</td>
</tr>
<tr>
<td>1 Author, Analytic</td>
<td>1 ______</td>
<td>1 ______</td>
</tr>
<tr>
<td>2 Author Role</td>
<td>2 ______</td>
<td>2 ______</td>
</tr>
<tr>
<td>3 ______</td>
<td>3 ______</td>
<td>3 ______</td>
</tr>
<tr>
<td>4 Title, Analytic</td>
<td>4 Map Title</td>
<td>4 ______</td>
</tr>
<tr>
<td>5 Medium Designator</td>
<td>5 Map Type</td>
<td>5 ______</td>
</tr>
<tr>
<td>6 Connective Phrase</td>
<td>6 ______</td>
<td>6 ______</td>
</tr>
<tr>
<td>7 ______</td>
<td>7 Cartographer</td>
<td>7 ______</td>
</tr>
<tr>
<td>8 ______</td>
<td>8 Cartographer Role</td>
<td>8 ______</td>
</tr>
<tr>
<td>9 Collection Title</td>
<td>9 ______</td>
<td>9 ______</td>
</tr>
<tr>
<td>10 ______</td>
<td>10 ______</td>
<td>10 ______</td>
</tr>
<tr>
<td>11 ______</td>
<td>11 ______</td>
<td>11 ______</td>
</tr>
<tr>
<td>12 Reprint Status</td>
<td>12 Reprint Status</td>
<td>12 Reprint Status</td>
</tr>
<tr>
<td>13 ______</td>
<td>13 Area</td>
<td>13 ______</td>
</tr>
<tr>
<td>14 ______</td>
<td>14 Medium Designator</td>
<td>14 ______</td>
</tr>
<tr>
<td>15 ______</td>
<td>15 Edition</td>
<td>15 ______</td>
</tr>
<tr>
<td>16 ______</td>
<td>16 ______</td>
<td>16 ______</td>
</tr>
<tr>
<td>17 ______</td>
<td>17 ______</td>
<td>17 ______</td>
</tr>
<tr>
<td>18 ______</td>
<td>18 Place of Publication</td>
<td>18 Place of Publication</td>
</tr>
<tr>
<td>19 ______</td>
<td>19 Publisher Name</td>
<td>19 Publisher Name</td>
</tr>
<tr>
<td>20 Date of Publication</td>
<td>20 Date of Publication</td>
<td>20 Date of Publication</td>
</tr>
<tr>
<td>21 ______</td>
<td>21 Date of Copyright</td>
<td>21 ______</td>
</tr>
<tr>
<td>22 ______</td>
<td>22 ______</td>
<td>22 ______</td>
</tr>
<tr>
<td>23 ______</td>
<td>23 ______</td>
<td>23 ______</td>
</tr>
<tr>
<td>24 ______</td>
<td>24 ______</td>
<td>24 ______</td>
</tr>
<tr>
<td>25 ______</td>
<td>25 ______</td>
<td>25 ______</td>
</tr>
<tr>
<td>26 ______</td>
<td>26 Extent of Work</td>
<td>26 Extent of Work</td>
</tr>
<tr>
<td>27 ______</td>
<td>27 Packaging Method</td>
<td>27 Packaging Method</td>
</tr>
<tr>
<td>28 ______</td>
<td>28 Size</td>
<td>28 ______</td>
</tr>
<tr>
<td>29 ______</td>
<td>29 Scale</td>
<td>29 ______</td>
</tr>
<tr>
<td>30 ______</td>
<td>30 ______</td>
<td>30 ______</td>
</tr>
<tr>
<td>31 ______</td>
<td>31 ______</td>
<td>31 ______</td>
</tr>
<tr>
<td>32 ______</td>
<td>32 Series Title</td>
<td>32 ______</td>
</tr>
<tr>
<td>33 ______</td>
<td>33 Series Volume ID</td>
<td>33 ______</td>
</tr>
<tr>
<td>34 ______</td>
<td>34 Series Issue ID</td>
<td>34 ______</td>
</tr>
<tr>
<td>35 ______</td>
<td>35 ______</td>
<td>35 ______</td>
</tr>
<tr>
<td>36 ______</td>
<td>36 Connective Phrase</td>
<td>36 ______</td>
</tr>
<tr>
<td>37 ______</td>
<td>37 Address/Availability</td>
<td>37 Address/Availability</td>
</tr>
<tr>
<td>38 ______</td>
<td>38 Location/URL</td>
<td>38 Location/URL</td>
</tr>
<tr>
<td>39 ______</td>
<td>39 ______</td>
<td>39 ______</td>
</tr>
<tr>
<td>40 ______</td>
<td>40 ______</td>
<td>40 ______</td>
</tr>
<tr>
<td>41 ______</td>
<td>41 ______</td>
<td>41 ______</td>
</tr>
<tr>
<td>42 Notes</td>
<td>42 Notes</td>
<td>42 Notes</td>
</tr>
<tr>
<td>43 Abstract</td>
<td>43 Abstract</td>
<td>43 Abstract</td>
</tr>
<tr>
<td>44 Call Number</td>
<td>44 Call Number</td>
<td>44 Call Number</td>
</tr>
<tr>
<td>45 Keywords</td>
<td>45 Keywords</td>
<td>45 Keywords</td>
</tr>
<tr>
<td>Motion Picture</td>
<td>Music Score</td>
<td>Newspaper</td>
</tr>
<tr>
<td>------------------------</td>
<td>------------------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>1</td>
<td>1 Composer</td>
<td>1 Author, Analytic</td>
</tr>
<tr>
<td>2</td>
<td>2 Composer Role</td>
<td>2 Author Role</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>3</td>
</tr>
<tr>
<td>4</td>
<td>Title, Analytic</td>
<td>4 Article Title</td>
</tr>
<tr>
<td>5</td>
<td>Medium Designator</td>
<td>5 Medium Designator</td>
</tr>
<tr>
<td>6</td>
<td></td>
<td>6 Connective Phrase</td>
</tr>
<tr>
<td>7</td>
<td>Producer</td>
<td>7 Editor/Compiler</td>
</tr>
<tr>
<td>8</td>
<td>Producer Role</td>
<td>8 Editor/Compiler Role</td>
</tr>
<tr>
<td>9</td>
<td></td>
<td>9 Title, Monographic</td>
</tr>
<tr>
<td>10</td>
<td></td>
<td>10</td>
</tr>
<tr>
<td>11</td>
<td></td>
<td>11 Reprint Status</td>
</tr>
<tr>
<td>12</td>
<td>Reprint Status</td>
<td>12 Reprint Status</td>
</tr>
<tr>
<td>13</td>
<td></td>
<td>13</td>
</tr>
<tr>
<td>14</td>
<td></td>
<td>14 Medium Designator</td>
</tr>
<tr>
<td>15</td>
<td></td>
<td>15 Edition</td>
</tr>
<tr>
<td>16</td>
<td>Director</td>
<td>16 Author, Subsidiary</td>
</tr>
<tr>
<td>17</td>
<td>Director Role</td>
<td>17 Author Role</td>
</tr>
<tr>
<td>18</td>
<td>Place of Publication</td>
<td>18 Place of Publication</td>
</tr>
<tr>
<td>19</td>
<td>Distributor</td>
<td>19 Publisher Name</td>
</tr>
<tr>
<td>20</td>
<td>Date of Publication</td>
<td>20 Date of Publication</td>
</tr>
<tr>
<td>21</td>
<td></td>
<td>21 Copyright Date</td>
</tr>
<tr>
<td>22</td>
<td></td>
<td>22 Volume ID</td>
</tr>
<tr>
<td>23</td>
<td></td>
<td>23 Report ID</td>
</tr>
<tr>
<td>24</td>
<td></td>
<td>24 Plate Number</td>
</tr>
<tr>
<td>25</td>
<td></td>
<td>25 Location in Work</td>
</tr>
<tr>
<td>26</td>
<td>Timing</td>
<td>26 Extent of Work</td>
</tr>
<tr>
<td>27</td>
<td>Packaging Method</td>
<td>27 Packaging Method</td>
</tr>
<tr>
<td>28</td>
<td>Size</td>
<td>28</td>
</tr>
<tr>
<td>29</td>
<td></td>
<td>29</td>
</tr>
<tr>
<td>30</td>
<td></td>
<td>30 Series Editor</td>
</tr>
<tr>
<td>31</td>
<td></td>
<td>31 Series Editor Role</td>
</tr>
<tr>
<td>32</td>
<td>Series Title</td>
<td>32 Series Title</td>
</tr>
<tr>
<td>33</td>
<td></td>
<td>33 Series Volume ID</td>
</tr>
<tr>
<td>34</td>
<td></td>
<td>34 Series Issue ID</td>
</tr>
<tr>
<td>35</td>
<td></td>
<td>35</td>
</tr>
<tr>
<td>36</td>
<td>Connective Phrase</td>
<td>36 Connective Phrase</td>
</tr>
<tr>
<td>37</td>
<td>Address/Availability</td>
<td>37 Address/Availability</td>
</tr>
<tr>
<td>38</td>
<td>Location/URL</td>
<td>38 Location/URL</td>
</tr>
<tr>
<td>39</td>
<td></td>
<td>39</td>
</tr>
<tr>
<td>40</td>
<td></td>
<td>40</td>
</tr>
<tr>
<td>41</td>
<td>ISBN</td>
<td>41 ISBN</td>
</tr>
<tr>
<td>42</td>
<td>Notes</td>
<td>42 Notes</td>
</tr>
<tr>
<td>43</td>
<td>Abstract</td>
<td>43 Abstract</td>
</tr>
<tr>
<td>44</td>
<td>Call Number</td>
<td>44 Call Number</td>
</tr>
<tr>
<td>45</td>
<td>Keywords</td>
<td>45 Keywords</td>
</tr>
</tbody>
</table>
### Patent

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Inventor</td>
</tr>
<tr>
<td>2</td>
<td>———</td>
</tr>
<tr>
<td>3</td>
<td>Address</td>
</tr>
<tr>
<td>4</td>
<td>Patent Title</td>
</tr>
<tr>
<td>5</td>
<td>———</td>
</tr>
<tr>
<td>6</td>
<td>———</td>
</tr>
<tr>
<td>7</td>
<td>Assignee</td>
</tr>
<tr>
<td>8</td>
<td>———</td>
</tr>
<tr>
<td>9</td>
<td>Title, Short Form</td>
</tr>
<tr>
<td>10</td>
<td>———</td>
</tr>
<tr>
<td>11</td>
<td>Title, Long Form</td>
</tr>
<tr>
<td>12</td>
<td>Abstract Journal Date</td>
</tr>
<tr>
<td>13</td>
<td>Country</td>
</tr>
<tr>
<td>14</td>
<td>Document Type</td>
</tr>
<tr>
<td>15</td>
<td>Patent Number</td>
</tr>
<tr>
<td>16</td>
<td>———</td>
</tr>
<tr>
<td>17</td>
<td>———</td>
</tr>
<tr>
<td>18</td>
<td>Abstract Journal Title</td>
</tr>
<tr>
<td>19</td>
<td>———</td>
</tr>
<tr>
<td>20</td>
<td>Date of Patent Issue</td>
</tr>
<tr>
<td>21</td>
<td>Application No./Date</td>
</tr>
<tr>
<td>22</td>
<td>Abstract Journal Volume</td>
</tr>
<tr>
<td>23</td>
<td>———</td>
</tr>
<tr>
<td>24</td>
<td>Abstract Journal Issue</td>
</tr>
<tr>
<td>25</td>
<td>Abstract Journal Page(s)</td>
</tr>
<tr>
<td>26</td>
<td>Extent of Work</td>
</tr>
<tr>
<td>27</td>
<td>Packaging Method</td>
</tr>
<tr>
<td>28</td>
<td>———</td>
</tr>
<tr>
<td>29</td>
<td>———</td>
</tr>
<tr>
<td>30</td>
<td>———</td>
</tr>
<tr>
<td>31</td>
<td>———</td>
</tr>
<tr>
<td>32</td>
<td>———</td>
</tr>
<tr>
<td>33</td>
<td>———</td>
</tr>
<tr>
<td>34</td>
<td>———</td>
</tr>
<tr>
<td>35</td>
<td>Language</td>
</tr>
<tr>
<td>36</td>
<td>Connective Phrase</td>
</tr>
<tr>
<td>37</td>
<td>Address/Availability</td>
</tr>
<tr>
<td>38</td>
<td>Location/URL</td>
</tr>
<tr>
<td>39</td>
<td>Class Code, National</td>
</tr>
<tr>
<td>40</td>
<td>Class Code, International</td>
</tr>
<tr>
<td>41</td>
<td>Related Document Number</td>
</tr>
<tr>
<td>42</td>
<td>Notes</td>
</tr>
<tr>
<td>43</td>
<td>Abstract</td>
</tr>
<tr>
<td>44</td>
<td>Registry Number</td>
</tr>
<tr>
<td>45</td>
<td>Keywords</td>
</tr>
</tbody>
</table>

### Report

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Author, Analytic</td>
</tr>
<tr>
<td>2</td>
<td>Author Role</td>
</tr>
<tr>
<td>3</td>
<td>Author Affiliation</td>
</tr>
<tr>
<td>4</td>
<td>Section Title</td>
</tr>
<tr>
<td>5</td>
<td>Medium Designator</td>
</tr>
<tr>
<td>6</td>
<td>Connective Phrase</td>
</tr>
<tr>
<td>7</td>
<td>Author, Monographic</td>
</tr>
<tr>
<td>8</td>
<td>Author Role</td>
</tr>
<tr>
<td>9</td>
<td>Report Title</td>
</tr>
<tr>
<td>10</td>
<td>———</td>
</tr>
<tr>
<td>11</td>
<td>———</td>
</tr>
<tr>
<td>12</td>
<td>Reprint Status</td>
</tr>
<tr>
<td>13</td>
<td>———</td>
</tr>
<tr>
<td>14</td>
<td>———</td>
</tr>
<tr>
<td>15</td>
<td>Edition</td>
</tr>
<tr>
<td>16</td>
<td>Author, Subsidiary</td>
</tr>
<tr>
<td>17</td>
<td>Author Role</td>
</tr>
<tr>
<td>18</td>
<td>Place of Publication</td>
</tr>
<tr>
<td>19</td>
<td>Publisher Name</td>
</tr>
<tr>
<td>20</td>
<td>Date of Publication</td>
</tr>
<tr>
<td>21</td>
<td>———</td>
</tr>
<tr>
<td>22</td>
<td>———</td>
</tr>
<tr>
<td>23</td>
<td>Report ID</td>
</tr>
<tr>
<td>24</td>
<td>———</td>
</tr>
<tr>
<td>25</td>
<td>———</td>
</tr>
<tr>
<td>26</td>
<td>Extent of Work</td>
</tr>
<tr>
<td>27</td>
<td>Packaging Method</td>
</tr>
<tr>
<td>28</td>
<td>———</td>
</tr>
<tr>
<td>29</td>
<td>———</td>
</tr>
<tr>
<td>30</td>
<td>———</td>
</tr>
<tr>
<td>31</td>
<td>———</td>
</tr>
<tr>
<td>32</td>
<td>Series Title</td>
</tr>
<tr>
<td>33</td>
<td>Series Volume ID</td>
</tr>
<tr>
<td>34</td>
<td>Series Issue ID</td>
</tr>
<tr>
<td>35</td>
<td>———</td>
</tr>
<tr>
<td>36</td>
<td>Connective Phrase</td>
</tr>
<tr>
<td>37</td>
<td>Address/Availability</td>
</tr>
<tr>
<td>38</td>
<td>Location/URL</td>
</tr>
<tr>
<td>39</td>
<td>CODEN</td>
</tr>
<tr>
<td>40</td>
<td>———</td>
</tr>
<tr>
<td>41</td>
<td>Notes</td>
</tr>
<tr>
<td>42</td>
<td>Abstract</td>
</tr>
<tr>
<td>43</td>
<td>Call Number</td>
</tr>
<tr>
<td>44</td>
<td>Call Number</td>
</tr>
<tr>
<td>45</td>
<td>Keywords</td>
</tr>
</tbody>
</table>

### Sound Recording

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Composer</td>
</tr>
<tr>
<td>2</td>
<td>Composer Role</td>
</tr>
<tr>
<td>3</td>
<td>———</td>
</tr>
<tr>
<td>4</td>
<td>Title, Analytic</td>
</tr>
<tr>
<td>5</td>
<td>Medium Designator</td>
</tr>
<tr>
<td>6</td>
<td>Connective Phrase</td>
</tr>
<tr>
<td>7</td>
<td>Editor/Compiler</td>
</tr>
<tr>
<td>8</td>
<td>Editor/Compiler Role</td>
</tr>
<tr>
<td>9</td>
<td>Recording Title</td>
</tr>
<tr>
<td>10</td>
<td>———</td>
</tr>
<tr>
<td>11</td>
<td>———</td>
</tr>
<tr>
<td>12</td>
<td>Reprint Status</td>
</tr>
<tr>
<td>13</td>
<td>———</td>
</tr>
<tr>
<td>14</td>
<td>———</td>
</tr>
<tr>
<td>15</td>
<td>Edition</td>
</tr>
<tr>
<td>16</td>
<td>Performer</td>
</tr>
<tr>
<td>17</td>
<td>Performer Role</td>
</tr>
<tr>
<td>18</td>
<td>Place of Publication</td>
</tr>
<tr>
<td>19</td>
<td>Publisher Name</td>
</tr>
<tr>
<td>20</td>
<td>Date of Publication</td>
</tr>
<tr>
<td>21</td>
<td>Date of Copyright</td>
</tr>
<tr>
<td>22</td>
<td>Acquisition Number</td>
</tr>
<tr>
<td>23</td>
<td>Matrix Number</td>
</tr>
<tr>
<td>24</td>
<td>———</td>
</tr>
<tr>
<td>25</td>
<td>———</td>
</tr>
<tr>
<td>26</td>
<td>Extent of Work</td>
</tr>
<tr>
<td>27</td>
<td>Packaging Method</td>
</tr>
<tr>
<td>28</td>
<td>Size</td>
</tr>
<tr>
<td>29</td>
<td>Reproduction Ratio</td>
</tr>
<tr>
<td>30</td>
<td>———</td>
</tr>
<tr>
<td>31</td>
<td>———</td>
</tr>
<tr>
<td>32</td>
<td>Series Title</td>
</tr>
<tr>
<td>33</td>
<td>———</td>
</tr>
<tr>
<td>34</td>
<td>———</td>
</tr>
<tr>
<td>35</td>
<td>———</td>
</tr>
<tr>
<td>36</td>
<td>———</td>
</tr>
<tr>
<td>37</td>
<td>Address/Availability</td>
</tr>
<tr>
<td>38</td>
<td>Location/URL</td>
</tr>
<tr>
<td>39</td>
<td>ISBN</td>
</tr>
<tr>
<td>40</td>
<td>———</td>
</tr>
<tr>
<td>41</td>
<td>Notes</td>
</tr>
<tr>
<td>42</td>
<td>Abstract</td>
</tr>
<tr>
<td>43</td>
<td>Call Number</td>
</tr>
<tr>
<td>44</td>
<td>Call Number</td>
</tr>
<tr>
<td>45</td>
<td>Keywords</td>
</tr>
<tr>
<td>Statute</td>
<td>Trade Catalog</td>
</tr>
<tr>
<td>---------</td>
<td>---------------</td>
</tr>
<tr>
<td>1 Author(s)</td>
<td>1 Catalog Author</td>
</tr>
<tr>
<td>2 ———</td>
<td>2 ———</td>
</tr>
<tr>
<td>3 ———</td>
<td>3 ———</td>
</tr>
<tr>
<td>4 Statute Title</td>
<td>4 Catalog Title</td>
</tr>
<tr>
<td>5 ———</td>
<td>5 Medium Designator</td>
</tr>
<tr>
<td>6 ———</td>
<td>6 ———</td>
</tr>
<tr>
<td>7 ———</td>
<td>7 ———</td>
</tr>
<tr>
<td>8 ———</td>
<td>8 ———</td>
</tr>
<tr>
<td>9 ———</td>
<td>9 ———</td>
</tr>
<tr>
<td>10 ———</td>
<td>10 ———</td>
</tr>
<tr>
<td>11 ———</td>
<td>11 ———</td>
</tr>
<tr>
<td>12 Reprint Status</td>
<td>12 Reprint Status</td>
</tr>
<tr>
<td>13 ———</td>
<td>13 ———</td>
</tr>
<tr>
<td>14 ———</td>
<td>14 ———</td>
</tr>
<tr>
<td>15 ———</td>
<td>15 Edition</td>
</tr>
<tr>
<td>16 ———</td>
<td>16 ———</td>
</tr>
<tr>
<td>17 ———</td>
<td>17 ———</td>
</tr>
<tr>
<td>18 Code</td>
<td>18 Place of Publication</td>
</tr>
<tr>
<td>19 ———</td>
<td>19 Publisher Name</td>
</tr>
<tr>
<td>20 Date of Publication</td>
<td>20 Date of Publication</td>
</tr>
<tr>
<td>21 Date</td>
<td>21 ———</td>
</tr>
<tr>
<td>22 Title/Code Number</td>
<td>22 Catalog Number</td>
</tr>
<tr>
<td>23 ———</td>
<td>23 ———</td>
</tr>
<tr>
<td>24 ———</td>
<td>24 Issue ID</td>
</tr>
<tr>
<td>25 Section(s)</td>
<td>25 ———</td>
</tr>
<tr>
<td>26 ———</td>
<td>26 Extent of Work</td>
</tr>
<tr>
<td>27 ———</td>
<td>27 Packaging Method</td>
</tr>
<tr>
<td>28 ———</td>
<td>28 ———</td>
</tr>
<tr>
<td>29 ———</td>
<td>29 ———</td>
</tr>
<tr>
<td>30 ———</td>
<td>30 ———</td>
</tr>
<tr>
<td>31 ———</td>
<td>31 ———</td>
</tr>
<tr>
<td>32 History</td>
<td>32 ———</td>
</tr>
<tr>
<td>33 ———</td>
<td>33 ———</td>
</tr>
<tr>
<td>34 ———</td>
<td>34 ———</td>
</tr>
<tr>
<td>35 ———</td>
<td>35 ———</td>
</tr>
<tr>
<td>36 Connective Phrase</td>
<td>36 ———</td>
</tr>
<tr>
<td>37 Address/Availability</td>
<td>37 Address/Availability</td>
</tr>
<tr>
<td>38 Location/URL</td>
<td>38 Location/URL</td>
</tr>
<tr>
<td>39 ———</td>
<td>39 ———</td>
</tr>
<tr>
<td>40 ———</td>
<td>40 ———</td>
</tr>
<tr>
<td>41 ———</td>
<td>41 ———</td>
</tr>
<tr>
<td>42 Notes</td>
<td>42 Notes</td>
</tr>
<tr>
<td>43 Abstract</td>
<td>43 Abstract</td>
</tr>
<tr>
<td>44 Call Number</td>
<td>44 Call Number</td>
</tr>
<tr>
<td>45 Keywords</td>
<td>45 Keywords</td>
</tr>
<tr>
<td>Unpublished Work</td>
<td>Video Recording</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>1 Author(s)</td>
<td>1 Author, Analytic</td>
</tr>
<tr>
<td>2 ———</td>
<td>2 ———</td>
</tr>
<tr>
<td>3 ———</td>
<td>3 ———</td>
</tr>
<tr>
<td>4 Title</td>
<td>4 Title, Analytic</td>
</tr>
<tr>
<td>5 ———</td>
<td>5 Medium Designator</td>
</tr>
<tr>
<td>6 ———</td>
<td>6 ———</td>
</tr>
<tr>
<td>7 Editor(s)</td>
<td>7 Producer</td>
</tr>
<tr>
<td>8 ———</td>
<td>8 Producer Role</td>
</tr>
<tr>
<td>9 ———</td>
<td>9 ———</td>
</tr>
<tr>
<td>10 ———</td>
<td>10 ———</td>
</tr>
<tr>
<td>11 ———</td>
<td>11 ———</td>
</tr>
<tr>
<td>12 Reprint Status</td>
<td>12 Reprint Status</td>
</tr>
<tr>
<td>13 ———</td>
<td>13 ———</td>
</tr>
<tr>
<td>14 ———</td>
<td>14 ———</td>
</tr>
<tr>
<td>15 ———</td>
<td>15 ———</td>
</tr>
<tr>
<td>16 ———</td>
<td>16 Director</td>
</tr>
<tr>
<td>17 ———</td>
<td>17 Director Role</td>
</tr>
<tr>
<td>18 Place of Publication</td>
<td>18 Place of Publication</td>
</tr>
<tr>
<td>19 ———</td>
<td>19 Distributor</td>
</tr>
<tr>
<td>20 Date of Publication</td>
<td>20 Date of Publication</td>
</tr>
<tr>
<td>21 Date of Copyright</td>
<td>21 ———</td>
</tr>
<tr>
<td>22 ———</td>
<td>22 ———</td>
</tr>
<tr>
<td>23 ———</td>
<td>23 ———</td>
</tr>
<tr>
<td>24 ———</td>
<td>24 ———</td>
</tr>
<tr>
<td>25 Pages</td>
<td>25 ———</td>
</tr>
<tr>
<td>26 ———</td>
<td>26 Extent of Work</td>
</tr>
<tr>
<td>27 ———</td>
<td>27 Packaging Method</td>
</tr>
<tr>
<td>28 ———</td>
<td>28 Size</td>
</tr>
<tr>
<td>29 ———</td>
<td>29 ———</td>
</tr>
<tr>
<td>30 ———</td>
<td>30 ———</td>
</tr>
<tr>
<td>31 ———</td>
<td>31 ———</td>
</tr>
<tr>
<td>32 ———</td>
<td>32 Series Title</td>
</tr>
<tr>
<td>33 ———</td>
<td>33 ———</td>
</tr>
<tr>
<td>34 ———</td>
<td>34 ———</td>
</tr>
<tr>
<td>35 ———</td>
<td>35 ———</td>
</tr>
<tr>
<td>36 ———</td>
<td>36 Connective Phrase</td>
</tr>
<tr>
<td>37 Address/Availability</td>
<td>37 Address/Availability</td>
</tr>
<tr>
<td>38 Location/URL</td>
<td>38 Location/URL</td>
</tr>
<tr>
<td>39 ———</td>
<td>39 ———</td>
</tr>
<tr>
<td>40 ———</td>
<td>40 ———</td>
</tr>
<tr>
<td>42 Notes</td>
<td>42 Notes</td>
</tr>
<tr>
<td>43 Abstract</td>
<td>43 Abstract</td>
</tr>
<tr>
<td>44 Call Number</td>
<td>44 Call Number</td>
</tr>
<tr>
<td>45 Keywords</td>
<td>45 Keywords</td>
</tr>
</tbody>
</table>
Appendix C

The ProCite Toolbars

Overview

Contents

Standard Toolbar ................................................................. 502
Text Toolbar ........................................................................ 503
Bibliography Toolbar ............................................................. 504
Copy Special Toolbar ............................................................. 504
Record List Toolbar .............................................................. 505
Edit Record Toolbar .............................................................. 506
Search Toolbar ...................................................................... 507
Duplicate Toolbar ................................................................. 507
PubMed and Internet Search Toolbars ................................. 508
Output Style Toolbar ............................................................ 509
Term List and Journal List Toolbar ....................................... 509
Cite While You Write Toolbar .............................................. 510

Use ProCite toolbars to access common commands by clicking on an icon. If you are not sure what a toolbar icon does, hold the cursor over the icon for a moment to display a tooltip. If tooltips do not appear, go to the Tools menu, choose Options, and select the Tooltips box.

Some of the toolbars can be turned on or off from ProCite’s View menu. Many of the toolbars are dimmed and unavailable when no database is open.

These are other easy ways to access ProCite commands:

• Access context-sensitive menus with a right mouse click (Windows) or control+click (Macintosh). Depending on where you are in the program, the menu displays a list of common commands compiled from the various menus.

• If you are working from your keyboard and do not want to switch to your mouse, learn the command keys indicated on the menus and described in Appendix D: Keyboard Commands.
Standard Toolbar

Use the Standard Toolbar for basic file commands and clipboard commands.

- **New** Displays the New dialog, where you can create a new database, output style, list, or workform
- **Open** Displays a file dialog so you can open a ProCite file
- **Save** Saves the current file to disk, whether a database, output style, list, or workform
- **Print** Prints a bibliography to your printer with the current settings
- **Cut** Cuts highlighted text and places it on the clipboard
- **Copy** Copies highlighted text and places it on the clipboard
- **Paste** Pastes clipboard text at the cursor
- **Clear** Deletes highlighted text
Text Toolbar

Font, size, and type styles are typically applied by an output style. Use them in a record only when you always want it to apply—such as applying italics to Latin terms.

- **Font** Applies a font to selected text
- **Size** Applies a point size to selected text
- **Bold** Applies bold style to selected text
- **Italic** Applies italic style to selected text
- **Underline** Applies underline style to selected text
- **Superscript** Applies superscript style to selected text
- **Subscript** Applies subscript style to selected text
- **Insert Symbol** Displays the Insert Symbol dialog where you can select a symbol to insert at the cursor
- **Show/Hide Invisibles** Displays a visible character for spaces and new paragraphs
Bibliography Toolbar

Use the Bibliography Toolbar to generate a bibliography and send it specifically to the screen, your printer, or a disk file.

- **Configure Bibliography**: Displays a dialog where you can select an output style and other formatting options to apply to the bibliography created by the other Bibliography Toolbar commands
- **Preview Bibliography**: Displays the bibliography on-screen
- **Print Bibliography**: Sends the bibliography to your printer
- **Save Bibliography**: Displays a file dialog so you can save the bibliography to a text file, word processor file, or HTML file

Copy Special Toolbar

Use the Copy Special Toolbar to copy a formatted in-text citation or formatted bibliographic reference to the clipboard. You can then paste into any application that accepts text from the clipboard.

- **Configure Copy Special**: Displays a dialog where you can select an output style and other formatting options to apply to the other Copy Special options
- **Copy Formatted Records**: Formats the highlighted record(s) according to the current output style and copies it to the clipboard
- **Copy In-Text Citations**: Formats the highlighted record(s) as an in-text citation based on the current output style and copies it to the clipboard
### Record List Toolbar

This toolbar is always available when a record list is displayed.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mark Selected</td>
<td>Toggles the marked status of the selected records between marked and unmarked</td>
</tr>
<tr>
<td>Mark List</td>
<td>Marks the current list, adding to the existing marked set</td>
</tr>
<tr>
<td>Clear</td>
<td>Removes all record marking in the database</td>
</tr>
<tr>
<td>Configure Record List/Preview Pane</td>
<td>Displays a tabbed dialog where you can modify the display of the record list and/or the preview pane</td>
</tr>
<tr>
<td>Show/Hide Preview Pane</td>
<td>Displays or removes the Preview Pane</td>
</tr>
<tr>
<td>Go to Record</td>
<td>Allows you to jump to a specific record in a record list</td>
</tr>
<tr>
<td>Go to First Record</td>
<td>Goes to the first record displayed in the current list</td>
</tr>
<tr>
<td>Go to Prev Record</td>
<td>Goes to the previous record in the current list</td>
</tr>
<tr>
<td>Go to Next Record</td>
<td>Goes to the next record in the current list</td>
</tr>
<tr>
<td>Go to Last Record</td>
<td>Goes to the last record in the current list</td>
</tr>
<tr>
<td>Copy Marked Records</td>
<td>Copies the set of marked records to another database</td>
</tr>
<tr>
<td>Open File/URL</td>
<td>Starts your browser and goes to the Internet location specified in the <code>Location/URL (38)</code> field of the selected record</td>
</tr>
</tbody>
</table>

**Tip:** Press the Ctrl (Windows) or command (Macintosh) key when selecting a Go to icon to move between Marked records.
Edit Record Toolbar

ProCite displays the Record Toolbar when you display a full record for insertion or editing. To turn this toolbar on or off, select Configure Edit Record from the View menu and select or deselect the Show Record Toolbar option.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workform</td>
<td>Displays the current workform, and allows you to select a different workform for the current record</td>
</tr>
<tr>
<td>Record ID</td>
<td>Displays the current record ID, and allows you to enter a different record ID for the current record</td>
</tr>
<tr>
<td>Toggle Mark</td>
<td>Marks or Unmarks the open record</td>
</tr>
<tr>
<td>Clear Marked Set</td>
<td>Removes all record marking in the database</td>
</tr>
<tr>
<td>Configure Edit Record</td>
<td>Displays a dialog where you can modify the display of full records</td>
</tr>
<tr>
<td>Show/Hide Empty Fields</td>
<td>Displays or suppresses fields that do not contain information</td>
</tr>
<tr>
<td>Go to Record</td>
<td>Allows you to jump to a specific record in the current list</td>
</tr>
<tr>
<td>Go to First Record</td>
<td>Goes to the first record displayed in the current list</td>
</tr>
<tr>
<td>Go to Prev Record</td>
<td>Goes to the previous record in the current list</td>
</tr>
<tr>
<td>Go to Next Record</td>
<td>Goes to the next record in the current list</td>
</tr>
<tr>
<td>Go to Last Record</td>
<td>Goes to the last record in the current list</td>
</tr>
<tr>
<td>Open File/URL</td>
<td>Starts your browser and goes to the Internet location specified by either the selected text or the Location/URL (38) field</td>
</tr>
</tbody>
</table>

Tip: Press the Ctrl (Windows) or command (Macintosh) key when selecting a Go to icon to move between Marked records.
Appendix C: The ProCite Toolbars

**Search Toolbar**

The Search Toolbar appears on the Search tab. Use these icons to help build a search expression and execute a database search.

- **New Search**: Clears the search expression box to prepare for a new search strategy
- **Insert Field**: Displays a list of fields to insert in the search expression box
- **Operators**: Displays a list of logical and relational operators to insert in the search expression box
- **Insert Term**: Displays the Insert Term dialog where you can select a term from a field content list or term list to insert
- **Expressions**: Allows you to save or restore search expressions
- **Search**: Executes the current search expression

**Duplicate Toolbar**

The Duplicate Toolbar appears on the Duplicates tab. Use these icons to help quickly mark and delete duplicates.

- **Mark by Date**: Marks the newest duplicates, so the original entries are left intact
- **Mark by Size**: Marks the duplicate records with the least amount of text, so you retain the most complete records (often those with notes or abstracts)
- **Configure Duplicates**: Displays a dialog where you can change the duplicate record criteria by deciding which fields to compare
PubMed and Internet Search Toolbars

Use these toolbars when searching Internet sources.

- **New Search**: Clears the current search expression
- **New Item**: Adds an additional search line
- **Delete Item**: Deletes the bottom search line
- **Terms**: Displays the Insert Term dialog where you can select and insert a term from a field content list or term list
- **Expressions**: Allows you to save, restore, or delete a search expression
- **Clear Results**: Throws away the current record list before starting the next search
- **Search**: Begins searching the selected databases with the current search expression
- **Stop**: Stops the current search
- **Hosts**: Displays a dialog where you can select the hosts and databases for searching and add or edit hosts or databases
**Output Style Toolbar**

This toolbar is available when creating and editing output styles:

- **Insert Field**: Inserts a field into the current style
- **Insert Special**: Inserts a formatting character
- **Configure Fields**: Configures formatting for special fields: authors, titles, dates, page numbers, and keywords

**Term List and Journal List Toolbar**

This toolbar is available when creating and editing term lists and journal lists:

- **Add**: Adds a new term or journal name
- **Edit**: Edits an existing term or journal name
- **Delete**: Deletes a term or journal name
## Cite While You Write Toolbar

This is the ProCite 5 toolbar installed in Word or WordPerfect:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert Citation</td>
<td>Displays a dialog so you can enter identifying text and insert a citation</td>
</tr>
<tr>
<td>Insert Marked References</td>
<td>Inserts records marked in the ProCite database</td>
</tr>
<tr>
<td>Recall Last Search</td>
<td>Brings up a dialog that displays the last search with identifying text; you can insert any records found in the last ten searches</td>
</tr>
<tr>
<td>Scan Document</td>
<td>Scans the document for citations within delimiters and inserts them</td>
</tr>
<tr>
<td>Generate Bibliography</td>
<td>Formats in-text citations and generates a bibliography from them</td>
</tr>
<tr>
<td>Find Previous Unlinked Citation</td>
<td>Looks toward the beginning of the document for unlinked text within the Scan Document delimiters</td>
</tr>
<tr>
<td>Find Next Unlinked Citation</td>
<td>Looks toward the end of the document for unlinked text within the Scan Document delimiters</td>
</tr>
<tr>
<td>Unformat Citations</td>
<td>Changes formatted citations back to unformatted citations (linked placeholders)</td>
</tr>
<tr>
<td>Revert to Original Text</td>
<td>Changes both formatted citations and unformatted citations back to the original identifying text, removing links</td>
</tr>
<tr>
<td>Help</td>
<td>Displays the ProCite help file</td>
</tr>
</tbody>
</table>
Appendix D

Keyboard Commands

Overview

Contents

File and Print ................................................................. 511
View and Search .............................................................. 512
Copy and Paste ............................................................... 512
Apply Styles (Records, Lists, Output Styles, Dialogs) .... 512
Enter and Edit ............................................................... 513
Output Styles ............................................................... 514
Subject Bibliography Tab .............................................. 514
Help File ........................................................................ 514

Many menu items in ProCite have a corresponding keyboard equivalent and/or toolbar icon. The keyboard equivalent appears on the menu next to the associated command. We list both Windows and Macintosh keyboard equivalents in this appendix.

File and Print

<table>
<thead>
<tr>
<th>Action</th>
<th>Windows Command</th>
<th>Macintosh Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Ctrl+N</td>
<td>Command+N</td>
</tr>
<tr>
<td>Open</td>
<td>Ctrl+O</td>
<td>Command+O</td>
</tr>
<tr>
<td>Close</td>
<td>(none)</td>
<td>Command+W</td>
</tr>
<tr>
<td>Save</td>
<td>Ctrl+S</td>
<td>Command+S</td>
</tr>
<tr>
<td>Print Bibliography</td>
<td>Ctrl+P</td>
<td>Command+P</td>
</tr>
<tr>
<td>Quit</td>
<td>(none)</td>
<td>Command+Q</td>
</tr>
</tbody>
</table>
## View and Search

<table>
<thead>
<tr>
<th>Action</th>
<th>Windows Command</th>
<th>Macintosh Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Preview Pane</td>
<td>Ctrl+T</td>
<td>Command+T</td>
</tr>
<tr>
<td>Go to Record</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Find</td>
<td>Ctrl+R</td>
<td>Command+R</td>
</tr>
<tr>
<td>First</td>
<td>Home</td>
<td></td>
</tr>
<tr>
<td>Previous</td>
<td>Up</td>
<td></td>
</tr>
<tr>
<td>Next</td>
<td>Down</td>
<td></td>
</tr>
<tr>
<td>Last</td>
<td>End</td>
<td></td>
</tr>
<tr>
<td>First Marked</td>
<td>Ctrl+Home</td>
<td>Command+Home</td>
</tr>
<tr>
<td>Prev Marked</td>
<td>Ctrl+Up</td>
<td>Command+Up</td>
</tr>
<tr>
<td>Next Marked</td>
<td>Ctrl+Down</td>
<td>Command+Down</td>
</tr>
<tr>
<td>Last Marked</td>
<td>Ctrl+End</td>
<td>Command+End</td>
</tr>
<tr>
<td>Search</td>
<td>Ctrl+F</td>
<td>Command+F</td>
</tr>
<tr>
<td>Mark Highlighted Records</td>
<td>Ctrl+M</td>
<td>Command+M</td>
</tr>
<tr>
<td>Unmark Highlighted Records</td>
<td>Ctrl+K</td>
<td>Command+K</td>
</tr>
<tr>
<td>Clear Marked Set</td>
<td>Ctrl+Shift+K</td>
<td>Command+Shift+K</td>
</tr>
</tbody>
</table>

## Copy and Paste

<table>
<thead>
<tr>
<th>Action</th>
<th>Windows Command</th>
<th>Macintosh Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>Ctrl+X</td>
<td>Command+X</td>
</tr>
<tr>
<td>Copy</td>
<td>Ctrl+C</td>
<td>Command+C</td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl+V</td>
<td>Command+V</td>
</tr>
<tr>
<td>Clear</td>
<td>Del</td>
<td>Delete</td>
</tr>
<tr>
<td>Select All</td>
<td>Ctrl+A</td>
<td>Command+A</td>
</tr>
</tbody>
</table>

## Apply Styles (Records, Lists, Output Styles, Dialogs)

<table>
<thead>
<tr>
<th>Apply</th>
<th>Windows Command</th>
<th>Macintosh Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bold</td>
<td>Ctrl+B</td>
<td>Command+B</td>
</tr>
<tr>
<td>Italic</td>
<td>Ctrl+I</td>
<td>Command+I</td>
</tr>
<tr>
<td>Underline</td>
<td>Ctrl+U</td>
<td>Command+U</td>
</tr>
<tr>
<td>Superscript</td>
<td>Ctrl+Shift+=</td>
<td>Command+Shift+=</td>
</tr>
<tr>
<td>Subscript</td>
<td>Ctrl+=</td>
<td>Command+=</td>
</tr>
</tbody>
</table>
**Enter and Edit**

<table>
<thead>
<tr>
<th>Action</th>
<th>Windows Command</th>
<th>Macintosh Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Record</td>
<td>F9</td>
<td>F9</td>
</tr>
<tr>
<td>Edit Record</td>
<td>Enter</td>
<td>Return</td>
</tr>
<tr>
<td>Save Record</td>
<td>F10</td>
<td>Command+S</td>
</tr>
<tr>
<td>Delete Record</td>
<td>Ctrl+D</td>
<td>Command+D</td>
</tr>
<tr>
<td>Insert Previous Field</td>
<td>F5</td>
<td>F5</td>
</tr>
<tr>
<td>Insert Previous Record</td>
<td>Shift+F5</td>
<td>Shift+F5</td>
</tr>
<tr>
<td>Insert Symbol</td>
<td>F7</td>
<td>F7</td>
</tr>
<tr>
<td>Insert Term</td>
<td>F8</td>
<td>F8</td>
</tr>
<tr>
<td>Open File/URL</td>
<td>Ctrl+L</td>
<td>Command+L</td>
</tr>
</tbody>
</table>

**Move Insertion Point**

- To Next Field .............. Tab  .......... Tab
- To Previous Field .......... Shift+Tab .......... Shift+Tab
- To Beginning of Line ...... Home ............. Home
- To End of Line ............. End .............. End
- To Beginning of Field ...... Ctrl+Home .......... Control+Home
- To End of Field ............ Ctrl+End .......... Control+End
- To Start of Next Word ...... Ctrl+Right Arrow .... Control+Right Arrow
- Up One Window ............. Page Up ........... Page Up
- Down One Window ............ Page Down ........ Page Down

**Delete**

- Previous Character .......... Backspace .......... Delete
- Following Character .......... Del .................. Del (X)

**Insert**

- New Paragraph ............. Enter ............. Return
- Line Break ................. Shift+Enter .......... Shift+Return
- Tab .......................... Alt+09 .......... Control+Tab
- Nonbreaking Space .......... Ctrl+Shift+Space .... Option+Space
## Output Styles

<table>
<thead>
<tr>
<th>Insert</th>
<th>Windows Command</th>
<th>Macintosh Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grouping Operators</td>
<td>Alt+174</td>
<td>Option+\</td>
</tr>
<tr>
<td></td>
<td>Alt+175</td>
<td>Option+Shift+\</td>
</tr>
<tr>
<td>Line Break</td>
<td>Shift+Enter</td>
<td>Shift+Return</td>
</tr>
<tr>
<td>New Paragraph</td>
<td>Enter</td>
<td>Return</td>
</tr>
<tr>
<td>Tab</td>
<td>Alt+09</td>
<td>Control+Tab</td>
</tr>
<tr>
<td>Page Break</td>
<td>Ctrl+Enter</td>
<td>Control+Return</td>
</tr>
</tbody>
</table>

## Subject Bibliography Tab

<table>
<thead>
<tr>
<th>Insert</th>
<th>Windows Command</th>
<th>Macintosh Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Paragraph</td>
<td>^p</td>
<td>^p</td>
</tr>
<tr>
<td>New Line</td>
<td>^l</td>
<td>^l</td>
</tr>
<tr>
<td>Tab</td>
<td>^t</td>
<td>^t</td>
</tr>
</tbody>
</table>

## Help File

<table>
<thead>
<tr>
<th>Display</th>
<th>Windows Command</th>
<th>Macintosh Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Context-Sensitive Help</td>
<td>F1</td>
<td>Help</td>
</tr>
</tbody>
</table>
Symbols

/ (keyword separator) 380
// (author separator) 380
/// 453
< and > (field delimiters) 441
| (vertical bar) 441, 446
¬ (line break) 441, 446, 447
\ (author separator) 380
\ (keyword separator) 380
\ (new paragraph) 441, 446, 447
« and » (alternate text delimiters) 394
« and » (group operators) 441

A

Abbreviate Journal Titles 390–393
Abbreviated Records, viewing 1 14
Abstract Field 163
ABSTRACT or ABST, in search expression 256
Accents, entering 150
Access Custom Sort Dialog 226
Activate Alternate Text List 394–396
Add Citations 337
Add Independent Reference 326
Add Item to List 371–372, 372–376
Add Page Numbers to Citations 335
Add Records to Group 276
Add Text 221
Additional Text
  entering with citation 334
  inserting in output style 445–446
  vertical bar in output style 441
Address/Availability Field 163
Align Reference Numbers 349
All Records, viewing 1 16
Alphabetic Sorting 234–240
Alphabetical Order
  predefined sort orders 224
Alternate Text 353
  lists 154
Alternate Text List 377–378
  activating 394–396
  building 377–378, 393
  notes 378
  primary term 378
  printing 387
  substitution 393–396
  substitution text 378
AND, in search expression 260
AND NOT, in search expression 260
Apply
  punctuation 444–445
  styles
    alternate text list 396
    journal title list 393
    output style 449–450
    subject bibliography 363
    table of commands 512
Ascending/Descending order 224, 225
  for custom sort 228
Assign Field Names 409
Assign Record IDs 398–401
Associate ProCite Database 337–338
Asterisk (*) 255
Attach Files and URLs 152
Attributes, Database
  Internet searching 300
Author Affiliation Field 167
Author Fields 143, 144–157, 164–167, 413–415
  corporate 145, 166
  entry rules 164
  formatting 430–469, 437, 452–462
  multiple 145
  personal 145, 165–166
  prefix 167
  searching 254
  suffix 167
Author List Tab 453–456
Author Name
  data entry 330–332
    compound 331
    corporate 332
    multiple 330
    repeated 331
    single 330
    repeated 455–456
    sorting 230
Author Name Formatting
abbreviated author list 453
empty author field 454–455
field dependent text 461–462
full name vs. initials 459–460
name order 459
repeated author 455–456
separators 457–469
uppecasing 460
AUTHOR or AUTH, in search expression 256
Author Role Fields 168–169
examples 168
Author, sort by 224
Author Stop List 238
Author-Date Citation
delimiters & separators 429–430
settings 428
Author-Date Citations 325
Authors List 117–131, 386
for quick searching 249
Automatic Record Numbering 398–400
Available Stop Lists 237–238

B
Back Up Files 99–100
BEGIN WITH, in search expression 258
Biblio-Link II 200
Bibliography
changing position in manuscript 323
from multiple documents 327
generating 321–327, 340
previewing 130–131, 342–346
print to HTML file 304, 344
printing 130, 225–240, 342–346
regenerating 323
saving to word processor file 342
short form 353
Bibliography, by Subject
printing 356–358
settings 360–363
Bibliography Settings
in output style 434–435
Bibliography Setup 346–356
changing layout 324–326
field settings 323, 352–353
output style 348
page layout settings 354
page numbering 355
reference list settings 322, 347–351
reference list title 348
saving 355–357
suppress fields 352–353
Bibliography Toolbar 504
Blank Line
in or between references 351
in workform style 447–448
Blank Workform 407–415
Bold Text
applying in a field 150
applying in dialog boxes 451
applying in output styles 449–450
in a list file 377
keyboard command 512
Bookmark, in word processor 323
Braces, as delimiters 314
Brackets, as delimiters 314
Build Alternate Text List 393
Build Journal Title List 390
Building Search Expression 262–265

C
CALL, in search expression 256
Call Number
formatting 448
printing 352–366
Call Number Field 143, 169, 413
as subject headings 366
sorting 236–240
Capitalization, title fields 183, 185
Capitalize Title 462–464
Capture URL 302–303
Catalog Cards, printing to 344–345
Change
bibliography layout 324–326
citations 335–337
global 218–219
group 275
record display 141–142
record ID 151, 400
stop list 238–240
workform 406–410
workform definition 405
workform, global 220
Chapters, generating a cumulative bibliography 327
Character Mapping, Across Platforms 107–108
Character Styles 160
Characters
  inserting for formatting 446–449
  limit within delimiters 315
  special formatting 144, 440
Citation Format 308
Citation Style
  adding letters to year 429
  author formatting 430–431
  author-date settings 428–469
  delimiters 426–469
  including page numbers 432
  number ranges 427
  separators 426–427
  special fields formatting 432
Citations
  adding 337
  associating with database 337–338
  author-date 325
  author-date delimiters & separators 429–430
  changing 335–337
  copying 336
  defining in-text style 422–432
  deleting 337
  delimiters 314
  editing 335–336
  formatted 312
  forms in manuscript 312
  hidden 326
  including endnotes/footnotes 318
  inserting 313–314
  linking to records 312–321
  matching existing 314–317
  matching inappropriate items 317
  matching multiple records 319
  moving 336
  multiple 321, 325
  number order 426
  numbering 324
  numeric settings 425–427
  separator 427, 429
  unformatted 312, 320
  using variable format 326–327
  year only 326–327
Cite While You Write 308
  installing support 30–33
  ProCite toolbar 510
Clear Marked Set 251
Clear Text 216, 217
Clipboard, printing to 346
Close
  database 99
  file 99
  journal list 372
  output style 420–421
  ProCite 99, 112
  record 124, 157
  term list 372
  workform 409
CODEN Field 169
Codes
  Microsoft® Word® 309
  WordPerfect® 311
Column Headers, setting 122
Column Widths, resizing 123
Comma Delimited
  exporting 472, 475–476
  importing 204, 205–213, 210–213
Comma, in search expression 261
Compound Names 331
Configuration File 200
  converting from earlier version 37
  Internet installation 43
Configure Bibliography 346–356
  in manuscript 324–326
  in output style 434–435
  margins 354
  page numbering 355
  reference list settings 347–351
  saving changes 355–357
  suppress fields 352–353
Configure Edit Record 125, 141
  field numbers 126
  hide empty fields 126, 141
  show invisible characters 126
Configure Record List 115, 121–123
Connection, Internet
  connecting 278
  testing a connection 279
Connective Phrase Fields 170
CONTAINS, in search expression 258
Context Sensitive Help 20, 514
Continuous Record Numbers 361
Convert
  database types 34
  from earlier ProCite versions 92
  from EndNote® 34–38
  from Reference Manager® 34–38
Convert from Earlier Version
configuration files 37
database 35–36
lists 36–37
output styles 36–37
punctuation files 36–37
Copy
between records 156
citations 336
field text 156
formatted reference 305, 346
formatted references to clipboard 340
in-text citation 305, 339, 346
keyboard command 512
marked records to manuscript 318
previous field 157
records between databases 137
records within a database 137
references to e-mail messages 305–306
text from word processor 156
text to clipboard 156
to word processor 346
Copy Special Toolbar 504
Corporate Author Stop List 237
Corporate Authors 145, 166, 332
Create
database 89–90
group 272–273
journal list 368–377
list 370–378
new workform 406–415
output style 419–421
search expression 262–270
term list 368–377
text file for import 372–378
Title list 368–377
workform 406–410
Cross Platform Compatibility
character mapping 107–108
databases 91, 101
File Sharing 106–107
list files 104
output styles 103
word processor files 105
workforms 102
Cross Reference Subject Headings 365–366
Cumulative Bibliography
from chapters 327
Custom Display 121–123
Custom Format, for exporting 477–478
Custom Sort 226–230
ascending/descending order 228
authors 230–240
configuring 226–240
dates 230
dialog 226
empty fields 229–240
options 229
selecting fields 227–228
setting field order 228
Cyrillic Sort 232
Czech Sort 232
D
Damaged Database 108
Damaged File 108
database 109
error messages 10
garbled text 10
list 109
lock-up 10
output style 109
workform 109
Danish Sort 232
Dashes
“—–” as a field name 140
repeated author 456
Data Entry 133
author names 330–332
flagging duplicate records 241–242
identifying text 328–335
Data Entry Rules 142
author fields 164–167
author role fields 168–169
date fields 170–173
document type field 174
keywords field 176
location in work field 176–177
medium designator fields 179
packaging method field 180
title fields 184–185
Database
associating 337–338
backing up 99–100
changing association 337–338
closing 99
converting from earlier version 92
converting older versions 34
copying records 137
creating 89–90
damaged 108
definition 23
deleting 100
filename 91
opening 90–91
opening with ProCite for Windows 91, 101
read-only access 91
rebuilding 108
  error messages 110
  garbled text 110
  lock-up 110
  reclaiming disk space 109
  repairing damaged file 110
record limit 88
renaming 100
searching 252–254
setting options 93–99
sharing 30, 91–112, 101
sort effect on sharing 232–233
when to rebuild 109–110
Database Conversion 35–36
Database Files Installed 40
Database Folder 95–112
Database, Internet
  adding a new Z39.50 database 298–301
  searching 286–288
Database Settings, defaults 97–101
Date
  adding letters to year 429
  citation format 432
  entering in a manuscript 332–333
  entering in a record 146
  entering year 2000 and later 146, 171
  finding 269
  formatting ranges 333
  searching 269
  sorting 230
  unknown 148
  unpublished, in press, forthcoming 333
Date Fields 143, 146–157, 170–173, 413
  recognized formats 172–173
Date Formatting 438
DATE, in search expression 256
Date Sorting 235–240
Day Format 466
Default
  database settings 97–101
  display 120
  duplicate detection settings 98–112, 243–244
  field names 412, 415
font & size, edit record window 126
installation folders 38–39
language setting 231
record IDs 398–400
record numbering 399–402
sort orders 233–236
stop lists 237–238, 239
workform 139
Define In-Text Citation Style 422–432
Define Workform Style 433–435
Delete
  a ProCite file 100
  citations 337
  database 100
  duplicate records 243
  field in workform style 439–440
  group 275
  highlighted records 138
  list items 371–372
  marked records 138
  old ProCite files 37
  output style 422
  ProCite 5 44
  record 138
  records from group 276
  saved Internet search expression 293
  search expression 267
  stop list 240
  workforms 411
Delimited Records
  exporting 471–474
  importing 203
Delimiters
  citation style 426–427
  exporting field 478
  importing field 213
  scan document 314
Descending Order 228–240
Descending/Ascending Order 224
Diacritic Character Sorting 234
Diacritics 150
  importing MARC records 288
Dial-up Internet Connections 278
Dialog
  duplicate detection 243
Discard Duplicates on Import 245
Disconnect
  from Internet 278
Disk Space, reclaiming 109
Display
  all records 1 16
  changing font and style 123
custom 121–123
default 120
field numbers 126, 141
groups 1 19
invisible characters 141
marked records 1 16
saving changes 122
sorting 123
status bar 94
tooltips 94
Display, Record List
  changing column width 123
  changing fields 121–131
Document Type Field 174
Document Types, Special 404
Domain Name, Internet Host 297
DOS Database, converting 35–36
Double Spacing 351
Duplicate Detection
  new database defaults 98–1 12
Duplicate Detection Dialog 243
Duplicate Record IDs 401
Duplicate Records
  deleting 243
discard when importing 245
flagging at data entry 241–242
importing 202, 205
marking 242
searching 242–245
set comparison options 243–244
verifying 243
Duplicate Toolbar 507
Dutch Sort 232

E

Edit
  alternate text list 377–378
citations 335–336
global 216–218
Internet search expression 293
journal title list 371–372
marked records 152
  add text 216
  change workflow 220
  clear text 216
  find & replace 218
  global move 221–222
  replace text 216
  search expression 266–270
table of keyboard commands 513
term list 371–372
workform 408
Edit Keys 149
Edit Menu 156
Edit Record 124, 136
  changing display 141
  configure view 125–126
  finding a record 128
  jump to record 248
  saving changes 136
  workform 124
Edit Record Toolbar 506
Edition Field 174
Email
  copying references to 305–306
Email Address, Tech Support 21
Empty Author Fields
  formatting 454–455
Empty Fields
  finding 270
  hiding 126, 141
  sorting 229, 236
EMPTY, in search expression 261
EndNote®
  converting databases 34–38
  uninstalling 37
Endnotes 318
ENDS WITH, in search expression 258
English Sort 232
Enter
  additional text 334
  author names 330–332
dates 332–333
identifying text 328–335
multiple citations 334
record IDs 333
titles 332
Enter List Items 371–372
Entry Rules. See also Fields in Workforms
  author fields 164–167
  author role fields 168–169
date fields 170–173
document type field 174
general 142
keywords field 176
location in work field 176–177
medium designator fields 179
packaging method field 180
title fields 184–185
ErrorMessage 1 10
ErrorMessage 481
EXACTLY, in search expression 258
Exit ProCite 99, 112
Export
all fields 479
comma delimited 472, 475–476
custom format 472, 477–478
delimited records 471–474
field separators 477
optional field delimiters 478
record IDs 479
record terminators 477
replacement character 478
setting options 474–476
tab delimited 472, 476
workform definitions 480
workform indicators 478
Export Journal Titles 387
Export Term List 387
Expression Name 265
Extent of Work Field 174
Extraneous Punctuation 443

F

Failed to Connect
allowing access through firewalls 281–290
Field
default names 415
definition 23
global move 221–222
importing delimiters 213
importing format 205–206
importing order 206–209
importing separators 212
insert previous 157
listed by workform 487
locating by number 161–163
not in current workform 140
optional 352–366
selecting 121–122, 227–228
separators 380
workform style 438–440
Field Codes
Microsoft® Word® 309
WordPerfect® 311
Field Content List 1 17–119
authors 386
keywords 386
printing 386	
titles 386
Field Content Lists 153
quick search 249
Field Display
column headers 122
column widths 123
default 120
saving changes 122
selecting fields 121–122
sort order 123
type style 123
visible fields 122
Field Entry Rules 143–148
Field Identifier 256–257
ABSTRACT or ABST 256
AUTHOR or AUTH 256
CALL 256
DATE 256
JRNL 256
KEYWORDS or KEY 256
NOTE 256
PUBL 256
TITLE or TITL 256
Field Length 151, 160
Field Numbers
displaying 141
selecting 414
Field Separators 358
for exporting 477
Field Settings
alternate text 353
optional fields 352–353
short form 353
Field Substitution 352–353
Field Suppression 352–353
Field Text
adding 216
clearing 216
 copying 156
deleting 216
finding & replacing 218–219
moving 221
replacing 216
Fields

finding empty/not empty 270
formatting special 450

Fields in Workforms
abstract 163
address/availability 163
assigning names 409
author 143, 144–146, 164–167, 413
corporate 145, 166
lists 117–118
multiple 145
personal 145, 165–168
author affiliation 167
author role 168–169
call number 143, 169, 413
CODEN 169
connective phrase 170
date 143, 146–148, 170, 413–415
recognized formats 172–173
default names 412
document type 174
dition 174
extent of work 174
ISBN 175
ISSN 175
issue ID 175
keyword 143, 148, 414
lists 119
location in work 143, 176–177, 414
location/URL 178
medium designator 178
notes 179
order of appearance 412
packaging method 180
place of meeting 180
place of publication 181
publisher name 181
record number 181–182
report ID 182
reprint status 143, 182, 413
reproduction ratio 182
selecting 408, 411
size 183
special 412–414
title 143, 183–185, 414
lists 118, 118–131
volume ID 185
Fields Tab 323

File

closing 99
damaged
  error messages 1 10
  lock-up 1 10
deleting 100
reload on startup 94
repairing damaged 1 10
sharing 101–106
File, backing up 99–100
File Extensions
  for alternate text file 393
  for cross platform compatibility 107
File Locations 38, 94–96
File Locations Tab 29, 39
File Menu 91
File Sharing, Across Platforms 106–107
Filenames
  alternate text 387
databases 40, 91
help 39–40
Internet configuration files 43
journal titles 41
output styles 42
program 39–40
renaming 100
system 40
word processor files 42–43
workforms 41
Find
  dates 269–270
duplicate records 242–245
empty/not empty fields 270
first record in list 128, 142
last record in list 128, 142
next record 128
next record in list 142
previous record in list 142
record 248
record IDs 270
records last entered 270
search term 268–270
Find and Replace 152
Find and Replace, Global 218–219
Find Text 219
Find Unlinked Citations 337
Finnish Sort 232
Firewalls
  allowing access for Internet searching 281–290
  configuring PROXY servers 283
Folders
- default installation 38–39
- file locations 94–96

Following Punctuation 441–469
Following Text 461–462
- added to in-text citation 334

Font
- applying in a field 150–151
- changing display 123
- display for all records 126, 141
- output style 449–450
- printing for all records 125, 354

Footnotes 318, 432

Formatted Citation 312

Formatted References
- copy to clipboard 340
- previewing 345–346
- viewing 129

Formatting
- author fields 164
- date fields 170–173
- dataranges 333
- title fields 183

Formatting Characters 440
- blank lines 447–448
- inserting 446–449
- new lines 446
- new paragraphs 446
- page breaks 448
- table of keyboard commands 514
- tabs 448

Forms Folder 95–112

Forms of Citations 312

French Sort 232

Garbled Text 110

General Options Tab 93

Generate Bibliography 321–327, 324
- from multiple documents 327

Generic Stop List 237–240

German Sort 232

Global Change Workform 220

Global Edit 152, 216–218
- adding text 216
- clearing text 216
- replacing text 216

Global Find and Replace 218–219

Global Move Field 221–222

Go to Record 127–128, 248
- last record in list 128
- next in list 128

Group 19
- adding records 276
- changing 275
- creating 272–273
- deleting 275
- marking records 274–275
- modifying 275
- printing 342–346
- printing records 342
- removing records 276
- renaming 276
- saving 253, 272
- searching records 275
- using 273–275

viewing 119

viewing records 274
Group Operators
  in output styles 441
  inserting in output styles 514
  printing literal characters 445
Guided Tour 45

H
Hanging Indent 350
Hardware Requirements 26
Headline Style
  in title formatting 185
Help
  context sensitive 20
  context-sensitive 514
  F1 key (Windows) 20
  online 20
  technical support 21
  troubleshooting 20
Hidden Citation 326
Hide Empty Fields 126, 141
Hide Invisible Characters 141
Highlight Records 250
Highlighted Records
  deleting 138
  printing 343
Host, Internet
  adding/modifying configuration 296–298
  searching 286–288
  testing a connection 279–280
HTML File
  printing to 304, 344

I
Icon, ProCite 88
ID, Record
  finding 270
Identifying Text
  additional text 334
  author names 330–332
  command switches 335
  dates 332–333
  entering 328–335
  examples of matching records 329
  inserting marked records 318
  multiple citations 318
  record IDs 334
  titles 332
Import
  all fields 213
  comma delimited 204, 205–206, 210
  configuration files 43
  custom delimited format 212
  custom format 204
  delimited records 203
    duplicate detection 205
  discard duplicates 245
  field delimiters 213
  field format 205–206
  field order 206–209
  field separators 212
  from Netscape 302–303
  included fields 213
  list items 372–376
  record IDs 208–209
  record numbers 213
  record terminators 212
  replacement character 213
  setting options 209–212
  tab delimited 204, 206, 211
  tagged records 200–202
    duplicate detection 202
  web page 302–303
  workform indicator 207–208
  workform indicators 213
  Z39.50 278–301
In Press
  date entry 171
  workform selection 197
In-text Citation
  copying to clipboard 305, 346
  defining style 422–432
Include Citations in Footnotes or Endnotes 318
Include Page Numbers 432
Increment
  for record IDs 400
Indentation 350–366
Independent Reference, adding 326
Index
  subject list 384–385
  Indonesian Sort 232
Initials 459–469
Insert
  additional text 445–446
  field in workform style 438–469
  formatting characters 446–449
  marked records in manuscript 318
  operator 263
previous field 157
punctuation in workform style 440–445
records 134–135
search expression 265
special characters 150
symbol 150, 264
term 155, 264
Insert Citation 312, 313–314
Install
configuration files 43
database file list 40
file list 38
folders 38–39
help file 39–40
journal title file list 41
Microsoft® Word® support
Macintosh 33
Microsoft® Word® support for Mac
Windows 31
multi-user 28–30
network user 29
output style files 42
program files 39–40
single user 27
system file list 40
word processor files 42–43
WordPerfect® support 32
Install ProCite 27–33
International Sort Order 230–233
Internet
adding/launching PubMed UIs 303
adding/launching URLs 303
dial-up connections 278
disconnecting 278
importing a web page 302–303
printing to HTML files 304
search expression, sharing 104
sending references via e-mail 305–306
sharing configurations 104
Internet Explorer
import web page 302–303
launching a URL or UI 152
Internet Search
adding databases to search 298–301
adding/modifying host configurations 296–298
allowing access through firewalls 281–290
configuration sharing 104
creating search expressions 290–291
log file of last search 287
options 294–295
saving/discarding search results 289
selecting sites 284
toolbar 508
Internet Search Expression
deleting an expression 293
editing an expression 293
renaming an expression 293
saving 291–292
Internet Server
searching 286–288
Invisible Characters 126, 141
displaying 125
IP Address, Internet Host 297
ISBN Field 175
ISI ResearchSoft 20
technical support 21
ISSN Field 175
Issue ID Fields 175
Italian Sort 232
Italics
applying in a field 150
applying in dialog boxes 451
applying in output styles 449–450
keyboard command 512
J
Journal List
toolbar 509
Journal Title
searching 254
Journal Title Fields 183–185, 184, 414
Journal Title Formatting 438, 464
Journal Title List 153
building 390
creating 368–377
folder 96
inserting in record 390–391
installed 41
printing 387
substitution 353, 390–393
using for substitution 391–393
Journals Field Content List 1
for quick search 249
JRNL, in search expression 256
Jump to Record 127–128, 248
**K**

Keyboard Commands
- applying styles 377
- complete table 51
- special formatting characters 440–469
- styled text 451

Keyboard Equivalent 22, 134

Keys for Editing 149, 513

Keyword Formatting 438, 469

Keywords as Subject Headings 365–366

Keywords Field 143, 148, 414
  - entry rules 176
  - searching 254

Keywords List 19, 386
  - for quick searching 249

KEYWORDS or KEY, in search expression 256

**L**

Language Sorting 230–233

Launch
  - attached files and URLs 152

Layout, Bibliography
  - changing 324–326

Learning ProCite 45

Leave ProCite 12

Left Delimiter 426, 429

Length of Field 151

Length of Text within Delimiters 315

Lesson, Learning ProCite 45

Levels of Sorting 233–240

Library Search, Z39.50 278–301

Line Break
  - in output styles 441
  - inserting in output style 446, 514

Line Spacing 351

Link Citation
  - adding 337
  - associating database 337–338
  - copying 336
  - deleting 337
  - editing 335–336
  - moving 336
  - to manuscript 313–314

Link Text to ProCite Records 312–321

Linked Records
  - working with 338

List
  - port numbers for Internet searching 281

List Format 368–370
  - alternate text 377–378
  - journal list 369–370
  - stop lists 237–238
  - term list 368–378
  - title list 369–370

List Items
  - deleting 371–372
  - editing 371–372
  - entering 371–372
  - exporting to text file 387
  - importing from text file 372–376

Lists 153–156
  - activating alternate text 394–396
  - alternate text 154, 377–378
  - authors 17–18
  - building
    - alternate text 393
    - journal title 390
  - converting files from earlier versions 36–37
  - creating 368–377, 370–378
  - damaged files 109
  - default stop words 99
  - field content 17–19, 153
  - for data entry 154, 155–156
  - for entering text 155–157
  - for searching 154
  - for text substitution 154
  - journal title 153
  - journals 18–131
  - keywords 19
  - modifying 156
  - opening 370
  - opening existing 370
  - printing
    - alternate text 387
    - field content 386
    - journal title 387
    - subject 379–383
    - term 387
    - title 387
  - sharing files 104
  - show buttons 126, 141
  - styled text 377
  - substitution with 390–393, 393–396
  - term 153
  - titles 118
  - workforms 119, 192

Lists Folder 96
Lists, Installed
   database files 40
   journal title list files 41
   word processor files 42–44
Locating Field Descriptions 161–163
Locating Workforms 188
Location in Work Field 143, 176–177, 414
Location/URL Field 178
Lock-up 1 10
Log File
   of last Internet Search 287
Logical Operator 260–261
   AND 260
   AND NOT 260
   NOT 260
   OR 260
Lowercasing Titles 462

M
Macintosh Database, converting 35–36
Macintosh to Windows
   character mapping 107
   file sharing 106–107
Manuscript
   associating database 337–338
   changing bibliography setup 324–326
   changing citations 335–337
   citation forms 312
   entering identify text 328–335
   footnotes/endotes 318
   generating bibliography 321–327
   hidden citation 326
   inserting citation 313–314
   linking to records 312–321
   matching citations 314–317
   scanning document 315
   unformatted citations 320
   using other word processors 339
   using variable citation format 326–327
MARC records
   importing diacritics 288
Margins 350, 354
   in manuscript 323
Mark Duplicate Records 242
Mark Group 274–275
Mark Highlighted Records 1 16, 251
Mark Records 250–251
Marked Record
   inserting in manuscript 318
Marked Records 1 16
   clearing 251
   deleting 138
   editing 152
   printing 343
   viewing 250
Master Document, in word processor 327
Match Dates, in search expression 269
Match Inappropriate Items 317
Match Multiple Records 319
Match Records 328
Matching Existing Citations 314–317
Medium Designator Fields 178
MEDLARS System 201
Medline UI
   adding/launching a PubMed UI 303
   launching from ProCite 152
Memory Restrictions
   opening databases 127
   opening records 127
Microsoft® Word® 309
   bookmark 323
   installing Mac cite-while-you-write support 33
   installing Windows cite-while-you-write support 31
   master document 327
   ProCite toolbar 510
   tools menu 42
   unformatted citation 309
   uninstalling support 44
Modify
   group 275
   lists 156
   output style 421–422
   program options 93–99
   record list display 121–123
   stop list 238–240
   workflow 139, 405–406, 406–410
   workflow definition 405
   workflow, global 220
Month Format 466
Move Citations 336
Move Field, Global 221–222
Move Text 221–222
Multi-User Installation 28–30
Multiple Authors 145, 330
   formatting 453–469
   in unformatted citation 321
   role fields 168
Multiple Citations 321, 325
   entering 334
Multiple Documents
   generating a bibliography 327
Multiple Records
   changing workform 191–192
   viewing 126–127
Multiple Search Terms
   finding 268
Multiple Users 91–112
   sharing databases 30
Multiple Works by Same Author
   formatting 455–456

N
Name
   prefix 167
   suffix 167
Name Formatting 458–469
Name Order 459–469
Names Tab 458–461
Narrowing Search 254
NetProxy 283
Netscape
   import web page 302–303
   launching a URL or UI 152
Network
   cross platform file sharing 106–107
   multiple users 91
Network Installation
   administrator 28–29
   user 29–44
New Feature List 24
New Record 134–135
   selecting workform 139, 188–189
New Workform 406–407
Next Page 130
NLM
   launching a Medline UI 152
Nonbreaking Space
   keyboard command 149, 513
Norwegian Sort 232
Not Empty Fields, finding 270
NOT EMPTY, in search expression 261
NOT, in search expression 260
Note Field 179
Note Field, printing 352–366
NOTE, in search expression 256

Number
   page, formatting & punctuation 177
   pages 355
Number , Fields
   locating 161–163
   selecting 414
Number Ranges 427
Number , Record 151, 181–182, 362
   assigning 270
Number References 349–366
Numbered In-text Citations 324
Numeric Citation Settings 425–427
Numeric Sorting 234–240

O
Online Help 20
Open
   attached file, URL, UI 152
   blank workform 407–415
   current stop list 239
   database 90–112
   database, earlier version 92
   default stop list 239
   existing list 370
   list 370
   output style 421–422
   ProCite 88
   record 136
   stop list 239
   workform 406–408
Open File
   on startup 94
Operators, in search expression 257–262
   logical 260–270
   relational 258–270
   special characters 261–262
   special values 261–270
Optional Field Delimiters
   exporting 478
   importing 213
Optional Fields 352–353
Options
   default database 97–101
   default duplicate detection 98
   default record numbering 97
   default sorting 99
   duplicate detection 243
   file locations 29, 94–96
   Internet and Pubmed searching 294–295
   reload last file 94
splash screen 94
status bar 94
tooltips 94
Options, Program 93–99
OR, in search expression 260
Order
  sorts available 224
Other Word Processors 339
Output Style 324, 348
  applying punctuation 444–445
  applying type styles 449–450
  author formatting 437, 452–462
  author roles 169
  author-date citation settings 428–469
  author-date citations 325
  bibliography settings 434–435
  changing for preview pane 129
  converting from earlier versions 36–37
  creating 419–421
  damaged 109
  date formatting 438, 465–467
  defining in-text citation style 422–432
  deleting 422
  deleting fields 439–440
  formatting special fields 450
  grouping punctuation 444–445
  inserting additional text 445–446
  inserting fields 438–439
  inserting formatting characters 446–449
  inserting punctuation 440–445
  journal title formatting 464
  keyword formatting 438, 469
  modifying 421–422
  numbered citations 324
  numeric citation settings 425–427
  page number formatting 438, 468–469
  punctuation 437, 441–445
  reference format 325–326
  Reference List Layout 434–435
  relation to workforms 404–405
  renaming 422
  share with ProCite for Windows 103
  sharing 103
  special formatting characters 440
  suppressing extraneous punctuation 443
  table of formatting characters 514
  title formatting 437, 462–464
  toolbar 509
  workflow style 433–435
Output Styles Folder 95
Output Styles Installed 42

P
Packaging Method Field 180
Pad Numeric Components 467
Page Break
  inserting in output style 448, 514
Page Formatting 177
Page Layout Tab 354
Page Numbers 355
  following text 468
  formatting 177, 438, 468–469
  including 432
  preceding text 468
  punctuation 177, 468
Page Range Formats 469
Paragraph
  inserting in output style 441, 446, 514
  new line 446
Paragraph Layout
  indent 350
  margin 350, 354
  show invisible characters 125
Parentheses
  as delimiters 314
  in search expression 261
Password, Internet Host 298
Paste Text from Clipboard 156
Perform Search 252–254
Personal Authors 145, 165–166
Place of Meeting Field 180
Place of Publication Field 181
Polish Sort 232
Port Number
  for a host already configured 282
  list of all configured 281
Port Numbers
  enabling for Internet searching 281–282
Portuguese Sort 232
Preceding Punctuation 441–469
Preceding Text 461–462
  added to in-text citation 334
Predefined Sort Orders 224
Predefined Workforms 139
Preferences 29
  bibliography setup 355
  default database 97–101
  default display 120
  default numbering 398–400
  default stop list 237–238
  duplicate detection 98
  file locations 94–96
program 93–99
record numbering 97–12
reload last file 94
sorting 99
splash screen 94
startup file folders 39
status bar 94
stop lists 99
tooltips 94
Prefix, with author name 167
Prepare Records for Substitution 394
Prev Page, preview 130
Preview
  bibliography 130–131, 342–346
  formatted records 129
  formatted references 345–346
Preview Pane 129
Previous Field, copy 157
Previous Record in List 128
Primary Term 378
Print
  alternate text list 387
  bibliography 130, 342–346
  call number 352–353
  field content list 386
  groups 274
  indexed subject list 384–385
  journal title list 387
  note field 352–353
  record IDs 398
  record numbers 352–366
  reprint status 352–366
  search results 342–346
  subject list 360–361, 379–383
  term list 387
  title list 387
  to catalog cards 344–345
  to clipboard 346
  to disk 342–346
  to HTML file 304, 344
  to screen 323
  to word processor file 342–346
Print Bibliography 225
Print Subject Bibliography 356–358
  procedure 357–360
Printing, Sort Order 225
ProCite 5, new features 24
ProCite Files
  deleting old 37
  locating 38
opening 88
sharing 101–106
uninstalling version 5 44
ProCite icon 88
ProCite, Install 27–33
  files lists 38
  multi-user 28–30
  network 28–44
  network user 29–44
  single user 27
Program Files Installed 39–40
Program Options 93–99
Properties 90, 92
Proxy Servers 283
PUBL, in search expression 256
Publisher Name Field 181
PubMed
  launching a UI from ProCite 303
  search toolbar 508
PubMed
  launching a UI from ProCite 152
  searching 286–288
  searching options 294–295
Punctuation
  applying 444–445
  blank line 447
  field dependent 461
  following 441–469
  grouping operators 444–445
  new paragraph 446
  page break 448
  preceding 441–469
  repeated author 456
  sorting 235
  suppressing 443–469
  tab 448
  workform style 437, 440–445
Punctuation File
  converting 36–37
Q
Quick Search 1 17–19, 249
Quick Search view 1 15
Quit ProCite 99, 112
R

Range Separator 427
Ranges, Dates 333
Read-Only Access 91
Read-Write Access 30, 91
Readme File 39
Rebuild Database 108
   error messages  1 10
   garbled text  1 10
   lock-up  1 10
   reclaiming disk space  109
   repairing damaged file  1 10
   when to rebuild  109–1 10
Recall Last Search Command 320
Reclaim Disk Space 109
Record
   changing display 141–142
   configuring list 121, 123
   copying 137
   copying field text 156
   copying text 156
   definition 23
   deleting 138
   editing 124, 136
   entering and editing data 142–152
   finding 248
   finding last entered 270
   highlighting 250
   import from Netscape 302–303
   importing tagged 200–202
   inserting 134–135
   limit in database 88
   linking text 312–321
   mark highlighted 1 16
   marking 250–251
   matching 328
   new 139
   opening 136
   printing 342–346
   saving changes 136
   starting number 97
   unmarking 251
   view multiple 126–127
   viewing 124–127
   viewing groups 274
   working with linked 338
Record IDs 124, 181–182
   assigning 398–401
   automatic numbering 398–400
   changing 151
changing increment 400
changing settings for new database 399–400
default settings 398–400
duplicate numbering 401
entering 333
exporting 479
finding 270
importing 208–209, 213
list 362
manual numbering 400–401
new database preference 97
printing 352–353, 398
renumbering 401–402
scan document 315–340
sorting by 270
using 397–398
Record List Toolbar 505
Record Numbers. See Record IDs
Records
   adding to group 276
   change group 275
   changing workform 189–192
   delete group 275
   deleting duplicates 243
   exporting delimited 471–474
   exporting terminators 477
   importing delimited 203
   importing terminators 212
   marking duplicates 242
   marking group 274–275
   matching multiple while you write 319
   modify group 275
   preparing for substitution 394
   removing from group 276
   saving group 272–273
   setting workform 188–189
   verifying duplicates 243
Recover Citations Command 310
Recycling Reference Numbers 361
Reference
   copying to clipboard 305, 346
   hidden citation 326
Reference Format 325–326
Reference List 321
   deleting 323
   generating 340
Reference List Layout 434–435
Reference List Order 225, 325–326, 348
Reference List Tab 322, 347–351
Reference List Title 348
Reference Manager®
  converting databases 34–38
  scan document for record numbers 315–340
  scanning for record numbers 316
  uninstalling 37
Reference Numbers 349–350, 361
Reference Update 201
Refine Search 253, 254
Regenerate Bibliography 323
Registration 20
Registry File, WordPerfect® 311
Relational Operator 258–260
  < (less than) 258
  <= (less than or equal to) 258
  <> (not equal) 258
  = (equal) 258
  > (greater than) 258
  >= (greater than or equal to) 258
  BEGINS WITH 258
  CONTAINS 258
  ENDS WITH 258
  EXACTLY 258
Reload Last File 94
Remove
  group 276
  old version of ProCite 37
  ProCite 5 44
Rename
  database 100
  group 276
  Internet search expression 293
  output style 422
  ProCite file 100
  search expression 267
  workform 406
Renumbering Records 401–402
Repair Damaged Database 10
Repair Files 109
Repeat Authors 331
Repeat Subject Terms 360
Repeated Author Name 455–469
Replace, Global 218–219
Replace Text 219, 221
Replacement Character
  exporting 478
  importing 213
Report Identification Field 182
Reprint Status 182
  printing 352–353
Reprint Status Field 143, 413–415
Reproduction Ratio Field 182
Requirements
  hardware/software 26
ResearchSoft. See ISI ResearchSoft
Resize Column Widths 123
Restore
  Internet search expression 293
  Restore Search Expression 266–270
Restrictions
  number of records in database 88
Revert to Original Text 336
Right Delimiter 426, 429
Rules, data entry 142–152
  author fields 164–167
  author role fields 168–169
  date fields 170–173
  document type field 174
  keywords field 176
  location in work field 176–177
  medium designator fields 179
  packaging method field 180
  special fields 143–148
  title fields 184–185
Russian Sort 232
S
Sample Database Files 40
Sample Search Expressions 268
Save
  as HTML file 304, 344
  changes to display 122
  Internet search expression 291–292
  record group 272–273
  search results 272
  workform 409–410
Save Changes 136
Save Changes to Record 157
Save Configure Bibliography 355–357
Save Search Expression 265
Scan Document 312, 314
Search
  by date 269
  by record ID 270
  for duplicate records 242–243
  group 275
  internet site 286–288
  performing 252
  refining 254
Search Database 252–270
Index 533

Search Expression 250
  creating 262–270
deleting 267
editing 266
  elements 254–262
  field identifier 256–270
  folder 96
  insert operator 263
  insert symbol 264
  insert term 264
  inserting 265
  naming 265
  operators 257–262
    logical 260–261
    relational 258–260
    special characters 261–262
    special values 261
  renaming 267
  restoring 266
  restoring saved expressions 293
  samples 268
  saving 265–270
  search term 255
  sharing 104
Search, Internet 286–288
  adding/modifying database configurations 298–301
  adding/modifying host configurations 296–298
  options 294–295
  selecting Z39.50 sites 284
Search, Pubmed 286–288
Search Results
  printing 342–346
  saving 272
Search Term 255
  finding 268–270
  finding multiple 268
Search Toolbar 507
Security
  allowing access through firewalls 281–290
Select
  field numbers 414
  fields 353
  visible fields 122
  workflow 138–140, 139, 192
  workflow fields 408, 411
Select Menu 251
Selecting
  fields for custom sort 227–228
  sort order 224
Sentence Style
  in title formatting 185
Separators 358
  citation style 426–427
Separators Tab 457–458
Server Installation 28–29
Server, Internet
  adding/modifying host configurations 296–298
  searching 286–288
  testing a connection 279–280
Set Column Headers 122
Set Duplicate Record Criteria 243–244
Set Export Options 474–476
Set Import Options 209–212
Set Program Options 93–99
Set Up Bibliography 346–356
Setting Field Order 228
Settings
  subject bibliography 360–363
Share
  databases 30, 91, 101
    effect of System sort 232–233
  Internet search configurations 104
  list files 104
  output styles 103
  search expressions 104
  word processor files with links 105–106
  workforms 102, 410
Share Files 101–106
Share with ProCite for Windows
  database 91, 101
  output styles 103
  workforms 102
Short Form Bibliography 353–366
Show
  empty fields 126, 141
  field numbers 126, 141
  invisible characters 126, 141
  record toolbar 126, 141
  term list buttons 126, 141
Show Records
  with field content lists 17–119
SilverPlatter CD-ROM 201
Single Authors 330
Single Spacing 351
Single User Installation 27
Size Field 183
Size, text 125, 354
  applying in a field 150–151
SOCKS Protocol
  configuring PROXY servers 283
Software Requirements 26
Sort
  default settings 99
  display 123
  subject terms 362
Sort By Record Number 270
Sorting
  alphabetic 234
  ascending/descending 224, 225
  available sort orders 224
  call numbers 236
  changing order for printing 225
  changing the language 230–233
  creating custom sorts 226–230
  custom
    ascending/descending by field 228
    authors 230
    dates 230
    empty fields 229
    selecting fields 227–228
    setting order for each field 228
  custom dialog 226
  dates 235–236
  diacritic characters 234
  empty fields 236
  menu 224
  numbers 234
  options tab 229
  selecting the sort order 224
  sort levels 233–234
  symbol removal 235
  viewing the sort order 224
Space, Nonbreaking
  keyboard command 149, 513
Spanish Sort 232
Special Characters
  in search expression 261–262
  inserting in a record 150
Special Document Types 404
Special Field Formatting 450
  author 452–462
  date 465–467
  journal 464
  keywords 469
  page numbers 468–469
  title 462–464
Special Field Rules 143–148
Special Fields
  formatting 432
Special Formatting Characters 144, 440–469
Special Values, in search expression 261
  EMPTY 261
  NOT EMPTY 261
Splash Screen 94
Standard Toolbar 502
Start ProCite 88
Starting Record Number 97
Status Bar 94, 114
Stop List
  adding items 240
  available 237–238
  changing 238–240
  corporate author 237
  deactivating 240
  default 237–238
  deleting item 240
  generic 237–238
  keywords 237
  modifying 238–240
  modifying item 240
  opening 239
  opening current 239
  opening default 239
  personal author 238
  titles 237
Styled Text 125
  alternate text list 396
  changing display 123
  in list 377
  in output style 449–450, 451
  journal title list 393
  keyboard commands 377, 451
  table of commands 512
Styles
  applying in a field 150–151
  applying to subject headings 363
  data entry 160
Styles Folder 95–12
Subject Bibliography
  examples 364
  including record numbers 362
  occurrence count 361–366
  printing 356–358
  procedure 357–360
  reference numbers 361
  settings 360–363
Subject Bibliography  Tab 360–363
Subject Headings
  cross referencing 365
  using call numbers 366
  using keywords 365
Subject List 356
  indexed 384–385
  printing 379–383
Subject Terms
  inserting space or text 363
  sorting 362
Subject Terms and Reference List 360
Subject Terms Only 360
Subscript
  applying in Output Style 449
  in a field 150
  keyboard command 512
Substitute Text 353
Substitution
  text 378
  with alternate text list 393–396
  with journal title list 390–393
Suffix, with author name 167
Superscript
  applying in Output Style 449
  in a field 150
  keyboard command 512
Support
  contacting the help desk 21
Suppress
  author names 335
  citation 335
Suppress Author Name
  in citations 326–327
Suppress Citation 326
Suppress Extraneous Punctuation 443–469
Suppress Fields 352–353
Suppress Splash Screen 94
Swedish Sort 232
Switch
  to add preceding or following text 334
Symbol, inserting 150
Symbol Removal for Sorting 235
System Files Installed 40
System Specific Sort 232

T

Tab
  in Output Styles 441
  inserting in output style 448, 514
Tab Delimited
  exporting 472, 476–480
  importing 204, 206, 211–213
Table of Switches, for CWYW 335
Tagged Records
  importing 200–202
Technical Support 21
Term List 153
  creating 368–377
  exporting 387
  printing 387
  toolbar 509
Term List Folder 96
Test
  server connection 279–280
Text
  adding 216, 221
  alternate 353
  changing display font and style 123
  clearing 216
  copying between records 156
  creating file for import to list 372
  deleting 216
  find and replace 152
  finding 219
  font 125, 150–151, 354
  garbled 110
  indentation 350
  invisible characters 125
  keyboard commands for applying styles 512
  length within delimiters 315
  line spacing 351
  linking to ProCite records 312–321
  moving 221–222
  replacing 216, 219, 221
  reverting to original 336
  size 125, 150–151, 354
  special characters 150, 261–262
  style 125, 150–151
  style in list 377, 393, 396
  substitution 353
  symbols 150
Text After 363
Text Before 363
Text Tab 461–462
Text Toolbar 503
Text-Only File
 alternate text list 378, 387, 393
 exporting from database 473
 exporting from list 387
 importing to database 205
 importing to list 372–376
 Tilde, entering 150
 Title Case 463
 Title Fields 143, 183–185, 414
 entry rules 184
 record list 122
 searching 254
 Title Formatting 437, 462–464
 Title Lists 386
 creating 368–377
 inserting in record 390–391
 printing 387
 substitution 390–393
 using for substitution 391–393
 TITLE or TTITLE, in search expression 256
 Titles
 entering 332
 substitution 353
 Titles Field Content List
 for quick searching 249
 Titles Lists 1 18–131
 Toolbar 1 14
 commands 22, 134
 edit record 126, 141
 go to record 128
 Toolbars, Listing 501
 Tools Menu 42
 Tooltips 94, 501
 Tour of ProCite 45
 Troubleshooting 20, 481
 Truncation Character 255–270
 Tutorial 45
 Two Page, preview 130
 Type Styles
 in a list file 377
 in output style 449–450, 451
 keyboard commands 377, 451

U
 Umlaut, entering 150
 Underline. See Styled Text
 Unformat Citations 338
 Unformatted Citation 312, 320
 in Microsoft® Word® 309
 in WordPerfect® 311

Uninstall
 EndNote 37
 old version of ProCite 37
 ProCite 5 44
 Reference Manager 37
 Unknown Date 148, 171
 Unmark Records 251
 Uppercase, author names 460
 URL
 adding and launching 303
 import from Netscape 302–303
 URL Field 178
 URL, launching from a record 152
 Use
 group 273–275
 record IDs 397–398
 Use Attributes, Internet Search 301
 Use Short Form 353
 Use Variable Citation Format 326–327
 UserName, Internet Host 298
 User-Defined Workforms 139

V
 Variable Citation Format 326–327
 Verify Duplicate Records 243
 Vertical Bar , for additional text 441
 View
 abbreviated records 14
 bibliographies 130
 formatted references 129
 full records 124–127
 group 274
 groups 1 19
 marked records 1 16, 250
 multiple records 126–127
 quick search 1 15
 sort order 224
 View Menu 141
 Visible Fields, selecting 122
 Volume ID Field 185

W
 Web Page
 importing from Netscape 302–303
 launching from ProCite 152
 Web Poster 278
 When to Rebuild Database 109–110
 Wildcard Character 255
 Window Menu 126
Windows
  sharing databases 91, 101
  sharing output styles 103
  sharing workforms 102
Windows to Macintosh
  character mapping 108
  file sharing 106–107
Windows® Registry
  WordPerfect® 31 1
WinGate 283
Word Processor
  associating database 337–338
  changing citations 335–337
  copying text from 156
  destination of bibliography 340
  entering identifying text 328–335
  generating bibliography 321–327
Microsoft® Word® 309
other 31 1
  printing to file 342–346
  scanning document 315
  sharing files 105–106
  using other 339
  WordPerfect® 31 1
Word Processor Files Installed 42–43
WordPerfect® 31 1
  codes 31 1
  installing cwlyw support 32
  ProCite toolbar 510
  unformatted citation 31 1
  Windows® Registry File 31 1
Work with Linked Records 338
Workform 1 19, 138–140
  assigning field names 409
  basing new on existing 406–407
  changing 140, 189–192, 406–410
  changing settings 139
  converting from earlier version 35–36
  creating 406–410
  damaged 109
  default 139
  definition 23
    changing 405
  deleting 41 1
  edit record window 124
  editing existing 408
  exporting definitions 480
  exporting indicators 478
  fields 139
  global change 220
importing indicators 207–208, 213
in press 197
list by name and letter 207
list of those supplied 487
locating 188
modifying 139, 405–406, 406–410
opening 406–408
opening blank 407
recommended selections 194–196
relation to output styles 404
renaming 406
saving 409–410
searching by 268
selecting 138–140, 188–189, 192
  for books 198
  for journals 197
selecting fields 408, 411
share with ProCite for Windows 102
sharing 102, 410
special fields 412–414
Workform Files Installed 41
Workform Style
  additional text 437
  applying type styles 449–450
  author name formatting 452–462
  date formatting 465–467
  default 435
  defining 433–435
  delete field 439–440
  formatting 437–438
  insert field 438–439
  inserting additional text 445–446
  inserting blank lines 447–448
  inserting formatting characters 446–449
  inserting new lines 446
  inserting new paragraphs 446
  inserting page breaks 448
  inserting punctuation 440–445
  inserting tabs 448
  journal title formatting 464
  keyword formatting 469
  page number formatting 468–469
  punctuation 437
  title formatting 462–464
Workforms Folder 95–96
Y

Y2K Dates 146, 171
Year 2000 dates 146, 171
Year Format 170–173, 467

Z

Z39.50
  adding a database for searching 298–301
  adding/modifying host configurations 296–298
  allowing access through firewalls 281–290
  definition 278
  searching databases 286–288
  selecting sites to search 284
Zoom In, preview 130
Zoom Out, preview 130